After you install Vegas and start it for the first time, the registration wizard appears. This wizard offers easy steps that enable you to register Vegas online with Sonic Foundry. Alternately, you may register Vegas online at www.sonicfoundry.com at any time.

Registering your product provides you with exclusive access to a variety of technical support options, notification of product updates, and special promotions exclusive to registered Vegas users.

Registration assistance

If you do not have access to the Internet, registration assistance is available during normal weekday business hours. Please contact our Customer Service Department by dialing one of the following numbers:

<table>
<thead>
<tr>
<th>Telephone/Fax</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-577-6642 (toll-free)</td>
<td>US, Canada, and Virgin Islands</td>
</tr>
<tr>
<td>+800-000-76642 (toll-free)</td>
<td>Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan</td>
</tr>
<tr>
<td>+608-204-7703</td>
<td>All other countries</td>
</tr>
<tr>
<td>1-608-250-1745 (Fax)</td>
<td>All countries</td>
</tr>
</tbody>
</table>

Customer service/sales

For a detailed list of customer service options, we encourage you to visit www.sonicfoundry.com. For support during normal office hours:

<table>
<thead>
<tr>
<th>Telephone/Fax/E-mail</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-577-6642 (toll-free)</td>
<td>US, Canada, and Virgin Islands</td>
</tr>
<tr>
<td>+800-000-76642 (toll-free)</td>
<td>Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan</td>
</tr>
<tr>
<td>+608-204-7703</td>
<td>All other countries</td>
</tr>
<tr>
<td>1-608-250-1745 (Fax)</td>
<td>All countries</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:customerservice@sonicfoundry.com">customerservice@sonicfoundry.com</a></td>
</tr>
</tbody>
</table>

Technical support

For a detailed list of technical support options, we encourage you to visit www.sonicfoundry.com/support.

- To listen to your support options, please call 608-256-5555.
- Customers who have purchased the full version of Vegas receive 60 days of complimentary phone support. The complimentary support begins the date of your first call. (Registration is required to receive this complimentary support.) Please call (608) 204-7704 if you need assistance with your product.
# Table of Contents

**Introduction** ................................................................. 15
  Welcome to Sonic Foundry Vegas ........................................... 15
  System requirements ....................................................... 15
  Technical support .............................................................. 15
  Installing Vegas ................................................................. 16
  Registration ................................................................. 16
  Using online help ............................................................. 16

**Overview** ................................................................. 18
  Main window ...................................................................... 18
  Toolbar ............................................................................... 18
  Time display ...................................................................... 19
  Ruler .................................................................................... 19
  Marker bar ........................................................................... 19
  Command bar ...................................................................... 19
  CD layout bar ..................................................................... 20
  Track list ............................................................................. 20
  Track view ........................................................................... 20
  Transport bar controls ....................................................... 20
  Status bar ............................................................................ 21
  Scrub control ..................................................................... 21
  Window docking area .......................................................... 21
  Keyboard command reference ............................................. 27
  Cursor indications .............................................................. 33
  Audio signal flow ............................................................... 34

**Getting Started** ............................................................ 37
  Creating projects ............................................................... 37
    Setting video properties based on a media file ....................... 38
    Saving a project .................................................................. 38
    Renaming a project (using Save As) .................................... 39
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting media files</td>
<td>39</td>
</tr>
<tr>
<td>Selecting media</td>
<td>39</td>
</tr>
<tr>
<td>Previewing a media file</td>
<td>40</td>
</tr>
<tr>
<td>Using the Media Pool</td>
<td>40</td>
</tr>
<tr>
<td>Adding media to the timeline</td>
<td>44</td>
</tr>
<tr>
<td>Working with events</td>
<td>46</td>
</tr>
<tr>
<td>Understanding files and events</td>
<td>46</td>
</tr>
<tr>
<td>Moving events along the timeline</td>
<td>47</td>
</tr>
<tr>
<td>Working with tracks</td>
<td>48</td>
</tr>
<tr>
<td>Using the track view</td>
<td>48</td>
</tr>
<tr>
<td>Using the track list</td>
<td>50</td>
</tr>
<tr>
<td>Viewing playbacks and previews</td>
<td>52</td>
</tr>
<tr>
<td>Using playback in Vegas</td>
<td>52</td>
</tr>
<tr>
<td>Scrubbing</td>
<td>53</td>
</tr>
<tr>
<td>Previewing to media player</td>
<td>54</td>
</tr>
<tr>
<td>Prerendering video previews</td>
<td>54</td>
</tr>
<tr>
<td>Rendering a Vegas project</td>
<td>55</td>
</tr>
<tr>
<td>Creating a movie</td>
<td>55</td>
</tr>
<tr>
<td>Basic Editing Techniques</td>
<td>57</td>
</tr>
<tr>
<td>Getting around</td>
<td>57</td>
</tr>
<tr>
<td>Moving the cursor</td>
<td>57</td>
</tr>
<tr>
<td>Changing focus</td>
<td>57</td>
</tr>
<tr>
<td>Making selections</td>
<td>58</td>
</tr>
<tr>
<td>Selecting multiple events</td>
<td>58</td>
</tr>
<tr>
<td>Selecting a time range</td>
<td>59</td>
</tr>
<tr>
<td>Looping playback</td>
<td>60</td>
</tr>
<tr>
<td>Selecting events and a time range</td>
<td>60</td>
</tr>
<tr>
<td>Editing events</td>
<td>61</td>
</tr>
<tr>
<td>Copying events</td>
<td>61</td>
</tr>
<tr>
<td>Cutting events</td>
<td>62</td>
</tr>
<tr>
<td>Pasting events</td>
<td>63</td>
</tr>
<tr>
<td>Duplicating events</td>
<td>65</td>
</tr>
<tr>
<td>Inserting empty events and time</td>
<td>65</td>
</tr>
<tr>
<td>Trimming events</td>
<td>66</td>
</tr>
<tr>
<td>Splitting events</td>
<td>68</td>
</tr>
<tr>
<td>Slipping and sliding events</td>
<td>70</td>
</tr>
<tr>
<td>Deleting events</td>
<td>71</td>
</tr>
</tbody>
</table>
Applying post-edit ripples ................................................................. 72
  Applying a post-edit ripple manually .......................................... 73
  Applying a post-edit ripple automatically .................................... 73
Shuffling events ................................................................. 74
Crossfading events ....................................................... 74
  Using automatic crossfades .................................................. 74
  Manually setting a crossfade ................................................ 75
  Changing crossfade curves .................................................. 75
  Sliding a crossfade ............................................................. 75
Using undo and redo .............................................................. 76
  Using undo ........................................................................... 76
  Using redo ........................................................................... 77
  Clearing the edit history ....................................................... 77
Adding project markers and regions ......................................... 77
  Working with markers .......................................................... 77
  Working with regions ............................................................ 79
  Working with command markers ............................................. 81
  Working with CD layout markers ............................................ 84
Using an external audio editing program .................................... 84
  Setting up an audio editing program ......................................... 84
  Opening an audio editor from Vegas ......................................... 85

Advanced Editing Techniques .................................................... 87
Snapping events ................................................................. 87
  Turning snapping on and off .................................................. 87
  Quantizing to frames ........................................................... 87
  Using the event snap offset ................................................... 88
  Snapping to the cursor or a selection ....................................... 88
Pitch shifting audio events ........................................................ 89
Time compressing/stretching events ........................................ 90
  Time compressing/stretching video ......................................... 90
Working with takes ................................................................. 91
  Adding takes ........................................................................ 91
  Selecting takes ..................................................................... 91
  Previewing and selecting Takes .............................................. 92
  Deleting takes ....................................................................... 92
  Working with take names ...................................................... 92
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Trimmer window</td>
<td>93</td>
</tr>
<tr>
<td>Opening a file in the Trimmer</td>
<td>93</td>
</tr>
<tr>
<td>Moving frame-by-frame in the Trimmer window</td>
<td>94</td>
</tr>
<tr>
<td>Making selections in the Trimmer</td>
<td>94</td>
</tr>
<tr>
<td>Adding selections to the timeline</td>
<td>94</td>
</tr>
<tr>
<td>Adding and saving regions and markers to a media file</td>
<td>96</td>
</tr>
<tr>
<td>Opening a file in an external audio editor from the Trimmer</td>
<td>97</td>
</tr>
<tr>
<td>Using the Edit Details window</td>
<td>97</td>
</tr>
<tr>
<td>Viewing the Edit Details window</td>
<td>98</td>
</tr>
<tr>
<td>Customizing the Edit Details window</td>
<td>100</td>
</tr>
<tr>
<td>Working with Tracks</td>
<td>101</td>
</tr>
<tr>
<td>Managing tracks</td>
<td>101</td>
</tr>
<tr>
<td>Inserting an empty track</td>
<td>101</td>
</tr>
<tr>
<td>Duplicating a track</td>
<td>101</td>
</tr>
<tr>
<td>Deleting a track</td>
<td>102</td>
</tr>
<tr>
<td>Naming or renaming a track</td>
<td>102</td>
</tr>
<tr>
<td>Organizing tracks</td>
<td>102</td>
</tr>
<tr>
<td>Reordering tracks</td>
<td>102</td>
</tr>
<tr>
<td>Changing track color</td>
<td>103</td>
</tr>
<tr>
<td>Changing track height</td>
<td>103</td>
</tr>
<tr>
<td>Using the track list</td>
<td>104</td>
</tr>
<tr>
<td>Using the volume fader (audio only)</td>
<td>104</td>
</tr>
<tr>
<td>Using the multipurpose slider (audio only)</td>
<td>104</td>
</tr>
<tr>
<td>Using the composite level slider (video only)</td>
<td>105</td>
</tr>
<tr>
<td>Bypassing motion blur envelopes (video only)</td>
<td>105</td>
</tr>
<tr>
<td>Using track motion (video only)</td>
<td>105</td>
</tr>
<tr>
<td>Phase inverting a track (audio only)</td>
<td>106</td>
</tr>
<tr>
<td>Muting a track</td>
<td>106</td>
</tr>
<tr>
<td>Muting all audio or video tracks</td>
<td>106</td>
</tr>
<tr>
<td>Soloing a track</td>
<td>106</td>
</tr>
<tr>
<td>Setting default track properties</td>
<td>107</td>
</tr>
<tr>
<td>Working with track envelopes</td>
<td>107</td>
</tr>
<tr>
<td>Adding track envelopes</td>
<td>107</td>
</tr>
<tr>
<td>Hiding track envelopes</td>
<td>110</td>
</tr>
<tr>
<td>Removing track envelopes</td>
<td>110</td>
</tr>
<tr>
<td>Using the Envelope Edit tool</td>
<td>110</td>
</tr>
<tr>
<td>Locking envelopes to events</td>
<td>112</td>
</tr>
<tr>
<td>Usage</td>
<td>Page</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>Using audio bus tracks</td>
<td>112</td>
</tr>
<tr>
<td>Adding envelopes to an audio bus track</td>
<td>112</td>
</tr>
<tr>
<td>Adding effects to audio bus tracks</td>
<td>112</td>
</tr>
<tr>
<td>Muting or soloing an audio bus track</td>
<td>112</td>
</tr>
<tr>
<td>Resizing audio bus tracks</td>
<td>113</td>
</tr>
<tr>
<td>Using video bus tracks</td>
<td>113</td>
</tr>
<tr>
<td>Adding keyframes to the video bus track</td>
<td>113</td>
</tr>
<tr>
<td>Adding a fade-to-color envelope</td>
<td>113</td>
</tr>
<tr>
<td>Adding a motion blur envelope</td>
<td>113</td>
</tr>
<tr>
<td>Adding a video supersampling envelope</td>
<td>114</td>
</tr>
<tr>
<td>Adding effects to video bus tracks</td>
<td>114</td>
</tr>
<tr>
<td>Muting the video output</td>
<td>114</td>
</tr>
<tr>
<td>Bypassing video effects and envelopes</td>
<td>114</td>
</tr>
<tr>
<td>Resizing video bus tracks</td>
<td>114</td>
</tr>
<tr>
<td>Rendering to a new track</td>
<td>115</td>
</tr>
<tr>
<td>Working with Events</td>
<td>117</td>
</tr>
<tr>
<td>Setting event switches</td>
<td>117</td>
</tr>
<tr>
<td>Mute</td>
<td>117</td>
</tr>
<tr>
<td>Lock</td>
<td>117</td>
</tr>
<tr>
<td>Loop</td>
<td>117</td>
</tr>
<tr>
<td>Invert phase (audio only)</td>
<td>118</td>
</tr>
<tr>
<td>Normalize (audio only)</td>
<td>118</td>
</tr>
<tr>
<td>Maintain aspect ratio (video only)</td>
<td>119</td>
</tr>
<tr>
<td>Reduce interlace flicker (video only)</td>
<td>119</td>
</tr>
<tr>
<td>Resample (video only)</td>
<td>119</td>
</tr>
<tr>
<td>Accessing event properties</td>
<td>120</td>
</tr>
<tr>
<td>Adjusting audio channels</td>
<td>120</td>
</tr>
<tr>
<td>Copying and pasting event attributes</td>
<td>121</td>
</tr>
<tr>
<td>Using audio event envelopes (ASR)</td>
<td>121</td>
</tr>
<tr>
<td>Setting an audio event’s volume</td>
<td>121</td>
</tr>
<tr>
<td>Setting an event’s fade in and out</td>
<td>122</td>
</tr>
<tr>
<td>Using video event envelopes</td>
<td>122</td>
</tr>
<tr>
<td>Using opacity envelopes</td>
<td>123</td>
</tr>
<tr>
<td>Using velocity envelopes</td>
<td>123</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Grouping events</td>
<td>125</td>
</tr>
<tr>
<td>Creating a new group</td>
<td>125</td>
</tr>
<tr>
<td>Adding an event to an existing group</td>
<td>126</td>
</tr>
<tr>
<td>Removing events from a group</td>
<td>126</td>
</tr>
<tr>
<td>Clearing a group</td>
<td>126</td>
</tr>
<tr>
<td>Selecting all members of a group</td>
<td>126</td>
</tr>
<tr>
<td>Suspending grouping temporarily</td>
<td>126</td>
</tr>
<tr>
<td>Adding Audio Effects</td>
<td>127</td>
</tr>
<tr>
<td>Using audio effects</td>
<td>127</td>
</tr>
<tr>
<td>Using plug-in chains</td>
<td>128</td>
</tr>
<tr>
<td>Creating a plug-in chain</td>
<td>128</td>
</tr>
<tr>
<td>Adding plug-ins to a plug-in chain</td>
<td>128</td>
</tr>
<tr>
<td>Saving customized plug-in presets</td>
<td>130</td>
</tr>
<tr>
<td>Arranging the order of plug-ins</td>
<td>130</td>
</tr>
<tr>
<td>Bypassing plug-ins on the chain</td>
<td>131</td>
</tr>
<tr>
<td>Removing plug-ins from a chain</td>
<td>131</td>
</tr>
<tr>
<td>Saving plug-in chains</td>
<td>132</td>
</tr>
<tr>
<td>Editing saved plug-in chains</td>
<td>132</td>
</tr>
<tr>
<td>Organizing your plug-ins</td>
<td>133</td>
</tr>
<tr>
<td>Applying non-real-time event effects</td>
<td>133</td>
</tr>
<tr>
<td>Bypassing all audio effects</td>
<td>134</td>
</tr>
<tr>
<td>Using the Mixer</td>
<td>135</td>
</tr>
<tr>
<td>Using the Mixer window</td>
<td>135</td>
</tr>
<tr>
<td>Viewing the Mixer window</td>
<td>135</td>
</tr>
<tr>
<td>Using the Mixer toolbar</td>
<td>136</td>
</tr>
<tr>
<td>Using the Mixer Preview fader</td>
<td>136</td>
</tr>
<tr>
<td>Using busses</td>
<td>137</td>
</tr>
<tr>
<td>Adding busses to a project</td>
<td>137</td>
</tr>
<tr>
<td>Deleting busses from a project</td>
<td>138</td>
</tr>
<tr>
<td>Routing busses to hardware</td>
<td>138</td>
</tr>
<tr>
<td>Working with busses</td>
<td>138</td>
</tr>
<tr>
<td>Assigning audio tracks to busses</td>
<td>140</td>
</tr>
<tr>
<td>Using assignable effects chains</td>
<td>140</td>
</tr>
<tr>
<td>Assigning audio tracks to assignable effects chains</td>
<td>141</td>
</tr>
<tr>
<td>Routing assignable effects chains to busses</td>
<td>141</td>
</tr>
<tr>
<td>Automating busses and assignable effects</td>
<td>141</td>
</tr>
<tr>
<td>Viewing bus tracks</td>
<td>142</td>
</tr>
<tr>
<td>Adding track envelopes</td>
<td>142</td>
</tr>
<tr>
<td>Modifying track envelopes</td>
<td>142</td>
</tr>
</tbody>
</table>
# Recording Audio

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up your equipment</td>
<td>143</td>
</tr>
<tr>
<td>Basic setup</td>
<td>143</td>
</tr>
<tr>
<td>Setup with mixer</td>
<td>144</td>
</tr>
<tr>
<td>Setup with digital multitrack</td>
<td>144</td>
</tr>
<tr>
<td>Preparing to record</td>
<td>145</td>
</tr>
<tr>
<td>Arming the track for recording</td>
<td>145</td>
</tr>
<tr>
<td>Selecting recording settings</td>
<td>146</td>
</tr>
<tr>
<td>Using the metronome</td>
<td>146</td>
</tr>
<tr>
<td>Recording</td>
<td>147</td>
</tr>
<tr>
<td>Recording into an empty track</td>
<td>147</td>
</tr>
<tr>
<td>Recording into a time selection</td>
<td>148</td>
</tr>
<tr>
<td>Recording into an event</td>
<td>148</td>
</tr>
<tr>
<td>Recording into an event with a time selection</td>
<td>149</td>
</tr>
<tr>
<td>Triggering from MIDI timecode</td>
<td>149</td>
</tr>
<tr>
<td>Working with multiple recorded takes</td>
<td>150</td>
</tr>
<tr>
<td>Specifying where recordings are stored</td>
<td>150</td>
</tr>
<tr>
<td>Changing where recorded files are stored when arming a track</td>
<td>150</td>
</tr>
<tr>
<td>Changing where recorded files are stored when starting to record</td>
<td>150</td>
</tr>
<tr>
<td>Changing where recorded files are stored in the Project Properties dialog</td>
<td>151</td>
</tr>
<tr>
<td>Monitoring audio levels</td>
<td>151</td>
</tr>
<tr>
<td>Monitoring recording input with track effects</td>
<td>152</td>
</tr>
<tr>
<td>Working with 5.1 Surround</td>
<td>153</td>
</tr>
<tr>
<td>What is 5.1 surround?</td>
<td>153</td>
</tr>
<tr>
<td>Setting up surround hardware</td>
<td>153</td>
</tr>
<tr>
<td>Setting up surround projects</td>
<td>154</td>
</tr>
<tr>
<td>Routing to hardware in the mixer</td>
<td>155</td>
</tr>
<tr>
<td>Assigning audio to the LFE channel</td>
<td>156</td>
</tr>
<tr>
<td>Panning audio</td>
<td>156</td>
</tr>
<tr>
<td>Panning tracks</td>
<td>156</td>
</tr>
<tr>
<td>Panning mixer controls</td>
<td>157</td>
</tr>
<tr>
<td>Using the Surround Panner window</td>
<td>158</td>
</tr>
<tr>
<td>Automating panning</td>
<td>160</td>
</tr>
<tr>
<td>Turning on panning keyframes</td>
<td>160</td>
</tr>
<tr>
<td>Adding panning keyframes</td>
<td>160</td>
</tr>
<tr>
<td>Working with keyframes</td>
<td>161</td>
</tr>
<tr>
<td>Rendering surround projects</td>
<td>163</td>
</tr>
<tr>
<td>Creating a DVD with DVD Architect</td>
<td>164</td>
</tr>
</tbody>
</table>
# Using Advanced Video Features

8

Cropping video .......................................................... 165
Cropping ................................................................. 166
Rotating ................................................................. 167
Adding animation ...................................................... 168

Working with still images ........................................... 168
Creating still images for use in Vegas ......................... 168
Capturing a timeline snapshot .................................... 169
Creating a slide show .................................................. 170

Creating titles ........................................................... 170
Creating titles from images ....................................... 171
Fading titles ............................................................. 172

Adding closed captioning to Windows Media Video (WMV) files ............................................ 172
Adding closed captioning line-by-line ......................... 172
Adding closed captioning from a script ...................... 172
Displaying closed captioning .................................... 174

Resampling video ......................................................... 175

Using Edit Decision Lists (EDL). ................................. 176
Creating an EDL ......................................................... 176
Opening an EDL ........................................................ 176

Working in DV format .................................................. 176
Selecting source media .............................................. 177
Setting project properties ......................................... 177
Selecting templates ................................................. 177
Eliminating out-of-range colors ................................. 177

Modifying video properties ....................................... 178
Modifying project video properties ......................... 178
Modifying media file properties .............................. 179
Modifying output properties .................................... 180

Using Video FX, Compositing, and Masks .................. 181

Using video effects ..................................................... 181
Adding a video effects plug-in ................................. 182
Working with video effects plug-in chains .................. 184
Modifying a video effects plug-in ......................... 186
Saving custom plug-in settings as a preset ............... 186
Using keyframe animation with plug-ins .................. 186

Using generated media ............................................ 187
Adding a generated media event .............................. 187
Duplicating a generated media event ....................... 188
Compositing ................................................................. 188
Understanding the parent/child track relationship .................................. 188
Selecting compositing modes ................................................................. 189
Changing the overlay mode for a parent track ........................................... 192
Creating masks ................................................................. 192
Creating image masks .............................................................................. 192
Creating video masks .............................................................................. 194
Fine-tuning masks ................................................................................ 195
Using the Mask Generator ....................................................................... 196
Chromakeying ..................................................................................... 198

Adding Video Transitions and Motion ...................................................... 201
Understanding basic transitions ............................................................... 201
Cuts ......................................................................................... 201
Crossfades .................................................................................. 201
Using transition effects ........................................................................... 201
Adding a transition .................................................................................. 202
Adding a transition to the end of an event ................................................. 202
Adding a transition to all selected events ................................................ 203
Understanding track layers ..................................................................... 204
Converting a cut to a transition ............................................................... 204
Converting a crossfade or transition to a cut ............................................. 205
Previewing a transition .......................................................................... 205
Modifying a transition ........................................................................... 206
Saving custom settings as a preset ........................................................... 206
Using keyframe animation ..................................................................... 207
Understanding the keyframe controller ..................................................... 207
Adding keyframes ................................................................................ 208
Deleting keyframes .................................................................................. 208
Navigating in the keyframe controller ..................................................... 208
Modifying keyframes ............................................................................. 208
Working with keyframes in track view .................................................... 210
Sample uses for keyframe animation ...................................................... 211
Animating event panning and cropping ................................................... 211
Animating video effects plug-ins ........................................................... 213
Animating generated text ....................................................................... 214
# Table of Contents

**Adding track motion** ................................................. 215
  - Using the track motion shortcut menu ................................ 216
  - Controlling the track motion workspace ................................ 216
  - Using keyframes in track motion ..................................... 217
  - Creating a picture-in-picture effect .................................. 218
  - Animating the overlay .................................................. 218
  - Rotating the overlay .................................................... 219
  - Flipping the overlay .................................................... 220

**Previewing and Analyzing Video** .............................. 221
  - Understanding the Video Preview window. .......................... 221
    - Using the Video Preview window shortcut menu ................. 222
  - Optimizing the Video Preview window ............................... 223
    - Reducing preview quality ........................................... 223
    - Prerendering video .................................................. 223
    - Building dynamic RAM previews ................................... 224
  - Using split-screen previewing ......................................... 225
    - Previewing affected and unprocessed video ...................... 225
    - Showing the video at the cursor position and the contents of the clipboard ........................................... 226
    - Changing the selection for displaying split-screen views ........ 226
  - Identifying safe areas ................................................. 226
  - Viewing the grid ....................................................... 227
  - Isolating color channels ............................................... 227
  - Monitoring video with scopes ........................................ 227
    - Displaying chrominance using the vectorscope monitor ........ 228
    - Displaying luminance using the waveform monitor .............. 229
    - Displaying color levels and contrast using the histogram monitor .......................................................... 229
    - Displaying RGB components with RGB parade monitor .......... 230
  - Previewing in a player .................................................. 231
  - Using an external monitor ............................................ 232
    - Setting up an external monitor ..................................... 232
    - Configuring an external monitor ................................... 233
    - Verifying the external monitor configuration .................... 233

**Saving, Rendering, and Printing Projects** .................. 235
  - Saving a project ....................................................... 235
    - Creating a copy of a project (using Save As...) ................ 236
    - Saving a project with media ......................................... 236
    - Autosaving a project ................................................. 237
    - Rendering a project .................................................. 237
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting a file format</td>
<td>238</td>
</tr>
<tr>
<td>More about the MPEG format</td>
<td>238</td>
</tr>
<tr>
<td>More about the Wave64 and Perfect Clarity Audio formats</td>
<td>239</td>
</tr>
<tr>
<td>More about video formats</td>
<td>239</td>
</tr>
<tr>
<td>Customizing the rendering process</td>
<td>240</td>
</tr>
<tr>
<td>Customizing the Render As settings</td>
<td>240</td>
</tr>
<tr>
<td>Saving custom settings as a template</td>
<td>240</td>
</tr>
<tr>
<td>Creating custom rendering settings for AVI files</td>
<td>241</td>
</tr>
<tr>
<td>Project tab</td>
<td>241</td>
</tr>
<tr>
<td>Video tab</td>
<td>241</td>
</tr>
<tr>
<td>Audio tab</td>
<td>242</td>
</tr>
<tr>
<td>Printing with Video Capture</td>
<td>243</td>
</tr>
<tr>
<td>Printing to DV tape</td>
<td>244</td>
</tr>
<tr>
<td>Establishing a connection to the recording device</td>
<td>244</td>
</tr>
<tr>
<td>Printing to DV tape</td>
<td>245</td>
</tr>
<tr>
<td>Burning CDs</td>
<td>247</td>
</tr>
<tr>
<td>Understanding track-at-once and disc-at-once</td>
<td>247</td>
</tr>
<tr>
<td>Track-at-once</td>
<td>247</td>
</tr>
<tr>
<td>Disc-at-once (Single Session or Red Book)</td>
<td>247</td>
</tr>
<tr>
<td>Understanding tracks and indices</td>
<td>247</td>
</tr>
<tr>
<td>Setting up to burn audio CDs</td>
<td>248</td>
</tr>
<tr>
<td>Viewing the ruler and time display</td>
<td>248</td>
</tr>
<tr>
<td>Setting project properties</td>
<td>248</td>
</tr>
<tr>
<td>Setting preferences</td>
<td>248</td>
</tr>
<tr>
<td>Importing CD Architect files</td>
<td>248</td>
</tr>
<tr>
<td>Creating audio CD layout projects</td>
<td>249</td>
</tr>
<tr>
<td>Adding media as CD tracks to a new project</td>
<td>249</td>
</tr>
<tr>
<td>Marking tracks in an existing project</td>
<td>250</td>
</tr>
<tr>
<td>Working with tracks and indices</td>
<td>251</td>
</tr>
<tr>
<td>Navigating to and selecting tracks and indices</td>
<td>251</td>
</tr>
<tr>
<td>Moving track and index markers</td>
<td>251</td>
</tr>
<tr>
<td>Renaming track and index markers</td>
<td>251</td>
</tr>
<tr>
<td>Deleting track and index markers</td>
<td>251</td>
</tr>
<tr>
<td>Editing markers using the Edit Details window</td>
<td>252</td>
</tr>
<tr>
<td>Copying a track list from the Edit Details window</td>
<td>252</td>
</tr>
<tr>
<td>Burning audio CDs</td>
<td>252</td>
</tr>
<tr>
<td>Burning single tracks (track-at-once)</td>
<td>252</td>
</tr>
<tr>
<td>Burning a disc (disc-at-once)</td>
<td>253</td>
</tr>
<tr>
<td>Burning video CDs</td>
<td>254</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

**Creating a multimedia CD** .......................................................... 255

**Using Scripting** ................................................................. 257

- Running a script ................................................................. 257
- Creating shortcuts for frequently used scripts ......................... 258
  - Storing a script .............................................................. 258
  - Recalling a stored script ................................................. 258
- Creating a script ................................................................. 258
- Editing an existing script .................................................... 259

**Customizing Vegas** ............................................................. 261

- Displaying frame numbers .................................................... 261
- Changing the ruler format .................................................... 261
  - Editing the ruler offset .................................................. 262
- Changing grid spacing .......................................................... 263
- Using the Time Display window ............................................. 263
  - Changing the time display settings .................................... 263
  - Changing the time display colors ...................................... 264
  - Setting the time display to monitor MIDI timecode ............... 264
- Working with project properties ............................................ 265
  - Video tab .............................................................................. 265
  - Audio tab ............................................................................. 266
  - Ruler tab .............................................................................. 266
  - Summary tab ........................................................................ 267
  - Audio CD tab ....................................................................... 267
- Using the toolbar ................................................................. 267
  - Hiding and displaying the toolbar ....................................... 267
  - Reordering toolbar buttons ............................................... 267
  - Adding buttons to the toolbar ............................................ 268
  - Removing buttons from the toolbar .................................... 269
- Setting Vegas preferences .................................................... 270
  - General tab .......................................................................... 270
  - Video tab .............................................................................. 272
  - Video device tab .................................................................. 272
  - Audio tab .............................................................................. 273
  - Audio Device tab .................................................................. 273
  - Editing tab ............................................................................ 275
  - CD Settings tab ................................................................... 276
  - Sync tab ................................................................................ 276
# Troubleshooting

- Troubleshooting resources ....................................................... 279
- Common questions ..................................................................... 279
  - Why are some of my DirectX plug-ins not working correctly? ........ 279
  - Why do I hear gaps in my audio playback? ................................. 279
  - Why do mono events increase 6 dB when panning a track hard? .... 280
  - Why do buffer underruns occur during a test or real write to a CD? ... 280
  - Why can’t I work with footage captured using an MJPEG card? ...... 280

- Trouble-free video: software solutions ........................................ 281

- Trouble-free video: hardware solutions ...................................... 281
  - Video subsystem ...................................................................... 281
  - Hard disk ................................................................................ 282
  - CPU and RAM (memory) ........................................................... 282

- Audio proxy files (.sfap0) ............................................................ 283

- Interlacing and field order .......................................................... 283

- Timecode ................................................................................... 285
  - SMPTE timecode types ............................................................ 285
  - Timecode in Vegas ................................................................. 286

- Troubleshooting DV hardware issues ......................................... 287

# Glossary .................................................................................... 289

# Index ......................................................................................... i
Welcome to Sonic Foundry Vegas

Sonic Foundry Vegas™ is an innovative and advanced multitrack media-editing system. Vegas was designed to create an efficient audio/video production environment without sacrificing the quality and processing power that you expect from Sonic Foundry. Whether it's the standard and familiar Windows navigation commands or the clean and uncluttered interface, you'll find Vegas to be a tool that will be mastered in minutes. Beneath the unique and customizable interface, you'll find a product that is both powerful and flexible.

System requirements

In order to use Vegas, your computer must satisfy the following minimum specifications:

- 400 MHz processor
- Windows-compatible sound card
- Supported CD-R/RW drive (for CD burning)
- 7200 RPM hard-disk drive
- FireWire® capture card (for DV capture and print-to-tape tools only)
- 24-bit color display recommended
- 128 MB RAM
- 40 MB hard-disk space for program installation
- Microsoft® Windows® 98SE, Me, 2000, or XP
- Microsoft DirectX® 8 or later (included on CD-ROM)
- Internet Explorer 5.0 or later (included on CD-ROM)
- Microsoft.NET Framework (for scripting support only. Available from the Windows Update site. Choose Windows Update from the Start menu.)

Technical support

The Web site at http://www.sonicfoundry.com/support has technical support, reference information, program updates, tips and tricks, user forums, and a knowledge base.
About this version of Vegas

The Vegas family of products includes Vegas and Vegas LE. Both versions boast a suite of professional level multitrack audio tools, as well as advanced NLE (nonlinear editing) features, making them a true all-in-one multimedia editing solution.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Vegas</th>
<th>Vegas LE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video tracks</td>
<td>Unlimited</td>
<td>2</td>
</tr>
<tr>
<td>Audio tracks</td>
<td>Unlimited</td>
<td>4</td>
</tr>
<tr>
<td>Multiple compositing modes</td>
<td>X</td>
<td>Source alpha only</td>
</tr>
<tr>
<td>Dynamic RAM preview</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Video envelopes: fade to color, composite level, velocity</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Video effects</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Video transitions</td>
<td>X</td>
<td>Presets only</td>
</tr>
<tr>
<td>Audio effects (DirectX plug-ins) included</td>
<td>X (XFX 1, 2, and 3)</td>
<td>Express FX 1 and 2 only</td>
</tr>
<tr>
<td>Assignable effects chains</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Multiple audio busses</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Rubber audio (time-stretch and pitch-shift events)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Render to new track</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Customizable render to streaming media formats</td>
<td>X</td>
<td>Presets only</td>
</tr>
<tr>
<td>Print to tape from timeline</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>MPEG 1 and 2 encoding</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Project compacting (copy and trim media with project)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>External monitor support</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CD burning</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bit depth/sample rate</td>
<td>24/96Khz</td>
<td>16/48Khz</td>
</tr>
<tr>
<td>Overall level of video control</td>
<td>High</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

Most versions can be immediately upgraded to a more advanced version over the Internet. From the Help menu, choose Instant Upgrade to purchase a license and unlock these more powerful features.

This manual covers all of the features available in both Vegas and Vegas LE. Since different versions have different features, more advanced features available only in the full version of Vegas are marked with a special icon.
Installing Vegas

1. Insert the Vegas CD-ROM. The Vegas 4.0 Setup screen appears (if CD-ROM AutoPlay is enabled).
   If CD-ROM AutoPlay is not enabled, click the Start button and choose Run. In the Run window that appears, type the CD-ROM drive's letter and add \setup.exe. Click OK to start the installation.

2. Click Install Vegas 4.0. The installation process begins.

3. Follow the screen prompts and enter the necessary information when required.

4. At the last screen prompt, click Finish to conclude the installation.

---

Note: Vegas uses the Windows Installer for all versions of Windows (e.g., 98SE, Me). Vegas installs the Windows Installer and then asks you to restart your system.

Registration

The registration dialog that appears when you start Vegas allows you to quickly and easily register:

- Choose Register online to instantly register the product over the Internet.
- Choose Register from another computer if the computer you’ve installed Vegas on does not have an Internet connection, but you have another computer that does.
- Choose Register over the phone to call Sonic Foundry to register manually.
- Choose Register later to continue using Vegas for a limited time without registering.

Follow the instructions in the registration dialog to complete your Vegas registration.

Using online help

You can access two varieties of help within Vegas:

- Online help
- What’sThis? help (also referred to as context-sensitive help)
Online help

To access online help, choose Contents and Index from the Help menu or press [F1].

**Note:** To view online help, Internet Explorer 4.0 or later must be installed on your system. Internet Explorer 5.0 is included on the Vegas CD-ROM for your convenience.

The online help window has four tabs that you can use to find the information that you need.

![Online help window with four tabs: Contents, Index, Search, Favorites.](image)

The Contents tab provides a list of available help topics. Double-click a closed book (📚) to open the pages and then click a topic page (📖).

The Index tab provides a complete listing of the help topics available. Scroll through the list of available topics or type a word in the Type in the keyword to find box to quickly locate topics related to that word. Select the topic and click Display.

The Search tab allows you to enter a keyword and display all of the topics in the online help that contain the keyword you have entered. Type a keyword in the word(s) to search for box and click UnTopics. Select the topic from the list and click Display.

The Favorites tab allows you to keep topics that you revisit often in a separate folder. To add a topic to your favorites, click Add on the Favorites tab.

**What’s This? help**

What’s This? help allows you to view pop-up descriptions of Vegas menus, buttons, and dialog boxes.

1. Click the What’s This Help button (❔) in the toolbar or the question mark (?) in the upper-right corner of a dialog box. Alternately, you can choose What’s This? from the Help menu or press Shift + F1. The cursor changes to a question mark icon (❓).

2. Click an item in the program’s interface. A pop-up description of the item appears.

**Help on the Web**

Additional Vegas help and information is available on the Sonic Foundry Web site. From the Help menu, choose Sonic Foundry on the Web to view a listing of Web pages pertaining to Vegas and Sonic Foundry.
Overview

Vegas is designed to be an easy-to-use program with many tools that provide power and flexibility when creating and working with multimedia files. Many Vegas operations, menu items, and shortcut keys are consistent with other popular Windows software applications.

The following sections provide a graphical tour of the Vegas workspace.

Main window

This is the window that appears when you open Vegas. The work area is subdivided into three primary areas: the track list, the track view (or timeline), and the window docking area. You can resize the track list, track view, and window docking area by dragging the dividers between them.

Toolbar

The toolbar allows you to quickly access the most commonly used functions and features in Vegas. From the Options menu, choose Customize Toolbar to specify which buttons are displayed.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Open existing project</td>
</tr>
<tr>
<td>Save project</td>
<td>Open project properties</td>
</tr>
<tr>
<td>Cut selected events or time range</td>
<td>Copy selected events or time range</td>
</tr>
<tr>
<td>Paste items from clipboard into project</td>
<td>Undo</td>
</tr>
<tr>
<td>Redo</td>
<td>Enable automatic crossfades</td>
</tr>
<tr>
<td>Enable automatic ripple editing</td>
<td>Lock envelopes to events</td>
</tr>
<tr>
<td>Ignore event grouping</td>
<td>Normal edit tool</td>
</tr>
<tr>
<td>Envelope edit tool</td>
<td>Selection edit tool</td>
</tr>
<tr>
<td>Zoom edit tool</td>
<td>What’s This? help</td>
</tr>
</tbody>
</table>
Time display

The Time Display window reflects the cursor’s position on the timeline and the end point of a time selection. You can customize time display settings, including what time the window displays and colors are used in the display. For more information, see Using the Time Display window on page 265.

You can move the Time Display window from its docked position above the track list to float on the Vegas workspace or dock in the window docking area.

Ruler

The ruler is the timeline for your project. You may specify how the ruler measures time: seconds, measures and beats, frames, etc. For more information, see Changing the ruler format on page 263.

Marker bar

The marker bar is the area where you can place, name, and position markers and regions along the project’s timeline. These informational tags can serve as cues or reminders highlighting important events in your project. For more information, see Adding project markers and regions on page 77.

Command bar

The command bar displays when you add a command to your project. Commands add metadata to media files to create effects such as closed captioning. For more information, see Adding project markers and regions on page 77.
CD layout bar

The CD layout bar displays tracks and indices in an audio CD layout project for disc-at-once (DAO) CD burning. For more information, see Burning CDs on page 249.

Track list

This area identifies the track order in your project and contains controls used to determine track compositing and mixing. For more information, see Using the track list on page 51.

Track view

All arranging and editing is done in the track view or timeline. This area contains all of a project's events. For more information, see Using the track view on page 49.

Transport bar controls

The transport bar contains the playback and cursor positioning buttons frequently used while working on and previewing your project.
Status bar

The status bar is located at the bottom of the main program window and displays information about roughly how much space is left on your computer to record audio (Record Time). During the rendering processes, the left side of the status bar also contains information about the progress of the render.

The Video Preview window also has its own status bar that displays project specific information. For more information, see Understanding the Video Preview window on page 223.

Scrub control

The scrub control is used to play your project forward or backward for editing purposes. You may adjust playback speed by setting the speed control marker located beneath the scrub control. For more information, see Scrubbing on page 54.

Window docking area

This area allows you to keep frequently used windows available but out of the way while you are working with a project. To dock a window, drag it to the docking area. Windows can be docked next to each other, subdividing the docking area, or they can be docked in a stack. When stacked, each window has a tab at the bottom with its name on it. Click the window’s tab to bring it to the top.

Drag the handle on the left side of a docked window to remove a window from the docking area and float it.
Explorer window - Alt+1

The Explorer window is similar to the Windows Explorer. Use the Explorer window to select media files to drag to the project timeline or add to the Media Pool. You can also use the Explorer to perform common file management tasks such as creating folders, renaming files and folders, deleting files and folders. Use the Start Preview ( ) and Auto Preview ( ) buttons to preview files before adding them to the project.

Trimmer window - Alt+2

The Trimmer window is a good place to edit any media file. When a media file is placed in the Trimmer window, you can place portions of the file on separate tracks by dragging and dropping. For more information, see Using the Trimmer window on page 93.
Mixer window - Alt+3

The Mixer window gives you access to your project's audio properties, bus assignments, output levels, and plug-in chains. For more information, see Using the Mixer window on page 137.

Edit Details window - Alt+4

This window serves as a highly detailed and customizable database of all of the events in a project. The database can be organized and sorted according to a large number of attributes. For more information, see Using the Edit Details window on page 97.
Media Pool - Alt +5

The Media Pool helps you organize the media files you’re using in a project. The information about these files is displayed in a highly flexible database that can be instantly sorted. You can also use the Media Pool to apply effects and plug-ins to media files and set the specific properties of these files. For more information, see Using the Media Pool on page 41.

Video Preview window - Alt-6

This window displays a project’s video during project editing and playback. For more information, see Previewing and Analyzing Video on page 223.
Transitions window - Alt+7

The Transitions window contains all of the transitions available in Vegas. The thumbnails display animated examples of each transition. You can drag transitions from this window to replace the crossfade between two video events or to replace the fade-in or fade-out region of a video event. For more information, see Understanding basic transitions on page 203.

Video FX window - Alt+8

The Video FX window contains the video effects available in Vegas. The thumbnails display animated examples of each plug-in preset. You can drag plug-ins from this window to an event, track, or to the Video Preview window (video output effects). For more information, see Using video effects on page 183.
Media Generators window - Alt+9

The Media Generators window contains the different media generators provided in Vegas. Media generators make it easy to create events containing text, credit rolls, test patterns, color gradients, and solid color backgrounds. You can drag a media generator to the timeline to create a new generated media event. For more information, see Using generated media on page 189.

Plug-Ins window - Ctrl+Alt+1

This window organizes all of the plug-ins available in Vegas, including video and audio effects, media generators, and transitions. The plug-ins, which are organized in a folder structure, can be dragged into the project. For more information, see Using audio effects on page 129 or Using video effects on page 183.
# Keyboard command reference

## Project file commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Create new project and bypass Project Properties dialog</td>
<td>Ctrl+Shift+N</td>
</tr>
<tr>
<td>Open existing project or media file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Open project’s properties</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>Close current project</td>
<td>Ctrl+F4</td>
</tr>
<tr>
<td>Exit Vegas</td>
<td>Alt+F4</td>
</tr>
</tbody>
</table>

## Window view commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus to track view</td>
<td>Alt+0</td>
</tr>
<tr>
<td>Explorer (show/hide window if not docked)</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Trimmer (show/hide window if not docked)</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Mixer (show/hide window if not docked)</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Edit Details (show/hide window if not docked)</td>
<td>Alt+4</td>
</tr>
<tr>
<td>Media Pool (show/hide window if not docked)</td>
<td>Alt+5</td>
</tr>
<tr>
<td>Video Preview (show/hide window if not docked)</td>
<td>Alt+6</td>
</tr>
<tr>
<td>Transitions (show/hide window if not docked)</td>
<td>Alt+7</td>
</tr>
<tr>
<td>Video FX (show/hide window if not docked)</td>
<td>Alt+8</td>
</tr>
<tr>
<td>Media Generators (show/hide window if not docked)</td>
<td>Alt+9</td>
</tr>
<tr>
<td>Plug-ins (show/hide window if not docked)</td>
<td>Ctrl+Alt+1</td>
</tr>
<tr>
<td>Video Scopes (show/hide window if not docked; available only in the full version of Vegas)</td>
<td>Ctrl+Alt+2</td>
</tr>
<tr>
<td>Surround Panner (show/hide window if not docked)</td>
<td>Ctrl+Alt+3</td>
</tr>
<tr>
<td>Next window</td>
<td>F6 or Ctrl+Tab</td>
</tr>
<tr>
<td>Previous window</td>
<td>Shift+F6 or Ctrl+Shift+Tab</td>
</tr>
<tr>
<td>Toggle focus between track list and timeline (and bus track list and timeline if bus tracks are visible)</td>
<td>Tab</td>
</tr>
<tr>
<td>Show/hide audio bus tracks (available only in the full version of Vegas)</td>
<td>B</td>
</tr>
<tr>
<td>Show/hide video bus track (available only in the full version of Vegas)</td>
<td>Ctrl+Shift+B</td>
</tr>
</tbody>
</table>

## Playback, recording, and preview commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playback</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Stop playback</td>
<td>Esc</td>
</tr>
<tr>
<td>Looped playback mode</td>
<td>Q</td>
</tr>
<tr>
<td>Play/pause</td>
<td>Enter</td>
</tr>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Arm track for record</td>
<td>Ctrl+Alt+R</td>
</tr>
<tr>
<td>Arm for record and set recording path</td>
<td>Ctrl+Alt+Shift+R</td>
</tr>
<tr>
<td>Play back from any window</td>
<td>Ctrl+Spacebar or F12</td>
</tr>
<tr>
<td>Scrub playback</td>
<td>J/K/L (pg. 55)</td>
</tr>
<tr>
<td>Build dynamic RAM preview</td>
<td>Shift+B (pg. 226)</td>
</tr>
<tr>
<td>Preview in player</td>
<td>Ctrl+Shift+M</td>
</tr>
<tr>
<td>Prerender video</td>
<td>Shift+M</td>
</tr>
<tr>
<td>Generate MIDI timecode</td>
<td>F7</td>
</tr>
<tr>
<td>Generate MIDI clock</td>
<td>Shift+F7</td>
</tr>
<tr>
<td>Trigger from MIDI timecode</td>
<td>Ctrl+F7</td>
</tr>
<tr>
<td>Preview cursor position</td>
<td>Numeric keypad 0</td>
</tr>
</tbody>
</table>

You can specify the length of time Vegas will preview using the Cursor preview duration field on the Editing tab of the Preferences dialog.
## Edit commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z or Alt+Backspace</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z or Ctrl+Y</td>
</tr>
<tr>
<td>Cut selection</td>
<td>Ctrl+X or Shift+Delete</td>
</tr>
<tr>
<td>Copy selection</td>
<td>Ctrl+C or Ctrl+Insert</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V or Shift+Insert</td>
</tr>
<tr>
<td>Paste repeat</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Paste insert</td>
<td>Ctrl+Shift+V</td>
</tr>
<tr>
<td>Delete selection</td>
<td>Delete</td>
</tr>
<tr>
<td>Split event(s)</td>
<td>S</td>
</tr>
<tr>
<td>Trim/crop selected events</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Normal Edit Tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Switch to next editing tool</td>
<td>D</td>
</tr>
<tr>
<td>Switch to previous editing tool</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Open in audio editor</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Run script 1 to 10</td>
<td>Ctrl+1 to 0</td>
</tr>
<tr>
<td>Set script number 1 to 10</td>
<td>Ctrl+Shift+1 to 10</td>
</tr>
</tbody>
</table>

## Cursor placement commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home or W</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End or E</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Go to</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Jump to Marker #</td>
<td>0-9 keys (not numeric keypad)</td>
</tr>
<tr>
<td>Move one frame</td>
<td>Alt+Left or Right Arrow</td>
</tr>
<tr>
<td>Center in View</td>
<td>\</td>
</tr>
<tr>
<td>Jog left/right (when not in edge-trimming mode or during playback)</td>
<td>F3/F9</td>
</tr>
<tr>
<td>Move left to marker(s)</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Move right to marker(s)</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>Move left to event edit points</td>
<td>Ctrl+Alt+Left Arrow</td>
</tr>
<tr>
<td>Move right to event edit points</td>
<td>Ctrl+Alt+Right Arrow</td>
</tr>
<tr>
<td>Nudge cursor one pixel on timeline (when Quantize to Frames is turned off)</td>
<td>Left or Right Arrow</td>
</tr>
<tr>
<td>Jump to next audio CD track region or index</td>
<td>Period</td>
</tr>
<tr>
<td>Jump to previous audio CD track region or index</td>
<td>Comma</td>
</tr>
<tr>
<td>Jump to next audio CD track region</td>
<td>Ctrl+Period</td>
</tr>
<tr>
<td>Jump to previous audio CD track region</td>
<td>Ctrl+Comma</td>
</tr>
</tbody>
</table>
Time selection commands

**Note:** Many of the preceding cursor placement commands, when combined with the Shift key, are also selection commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap select to event edge</td>
<td>Ctrl+Shift+Alt+Left or Right Arrow</td>
</tr>
<tr>
<td>Select loop region</td>
<td>Shift+Q</td>
</tr>
<tr>
<td>Recover previous 5 selection areas</td>
<td>Backspace</td>
</tr>
<tr>
<td>Select left by grid marks</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Select right by grid marks</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>Mark in/out locations</td>
<td>I (in) and O (out)</td>
</tr>
<tr>
<td>Create time selection while dragging on an event</td>
<td>Ctrl+Shift+drag with mouse</td>
</tr>
<tr>
<td>Expand selection one frame</td>
<td>Shift+Alt+Left or Right Arrow</td>
</tr>
<tr>
<td>Select to next audio CD track marker</td>
<td>Shift+. (period)</td>
</tr>
<tr>
<td>Select to previous audio CD track marker</td>
<td>Shift+. (comma)</td>
</tr>
<tr>
<td>Enter location for end of selection</td>
<td>Ctrl+Shift+G</td>
</tr>
</tbody>
</table>

View commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase track height</td>
<td>Ctrl+Shift+Up Arrow</td>
</tr>
<tr>
<td>Decrease track height</td>
<td>Ctrl+Shift+Down Arrow</td>
</tr>
<tr>
<td>Minimize all tracks</td>
<td></td>
</tr>
<tr>
<td>Set track height smaller</td>
<td>Shift+`</td>
</tr>
<tr>
<td>Set track heights to default size</td>
<td>Ctrl+`</td>
</tr>
<tr>
<td>Zoom in time (incremental)</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Zoom in time until each video thumbnail represents one frame</td>
<td>Alt+Up Arrow</td>
</tr>
<tr>
<td>Zoom out time (incremental)</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Zoom in on audio waveforms</td>
<td>Shift+Up Arrow</td>
</tr>
<tr>
<td>Zoom out on audio waveforms</td>
<td>Shift+Down Arrow</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl+Up Arrow</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl+Down Arrow</td>
</tr>
<tr>
<td>Show/hide window docking area</td>
<td>F11 or Alt+`</td>
</tr>
<tr>
<td>Show/hide track list</td>
<td>Shift+F11 or Shift+Alt+`</td>
</tr>
<tr>
<td>Show/hide window docking area and track list</td>
<td>Ctrl+F11</td>
</tr>
<tr>
<td>Display all tracks at uniform height</td>
<td>(Shift+)</td>
</tr>
</tbody>
</table>
### Event commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move or trim selected event(s) left/right one pixel</td>
<td>Numeric keypad 4/6</td>
</tr>
<tr>
<td>Move or trim selected events one frame left/right</td>
<td>Numeric keypad 1/3</td>
</tr>
<tr>
<td>Move selected event(s) left/right on grid</td>
<td>Ctrl+numeric keypad 4/6</td>
</tr>
<tr>
<td>Move selected event(s) left/right by the project frame period</td>
<td>Alt+Right Arrow numeric keypad 4/6</td>
</tr>
<tr>
<td>Move selected event(s) left/right by the first selected event's length</td>
<td>Ctrl+Alt+Right Arrow numeric keypad 4/6</td>
</tr>
<tr>
<td>Move selected event(s) up/down one track</td>
<td>Numeric keypad 8/2</td>
</tr>
</tbody>
</table>

### Event editing commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slip: move media within event without moving the event</td>
<td>Alt+drag inside the event</td>
</tr>
<tr>
<td>Slip Trim: move the media with the edge as it is trimmed</td>
<td>Alt+drag edge of event</td>
</tr>
<tr>
<td>Slide: trim both ends of event simultaneously</td>
<td>Ctrl+Alt+drag middle of event</td>
</tr>
<tr>
<td>Slide Crossfade: move crossfade</td>
<td>Ctrl+Alt+drag over a crossfade</td>
</tr>
<tr>
<td>Trim Adjacent: trim selected event and adjacent event simultaneously</td>
<td>Ctrl+Alt+drag edge of event</td>
</tr>
<tr>
<td>Stretch (compress) the media in the event while trimming</td>
<td>Ctrl+drag edge of event</td>
</tr>
<tr>
<td>Open in audio editor</td>
<td>Ctrl+E</td>
</tr>
</tbody>
</table>

### Event selection commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range selection</td>
<td>Shift+click range of objects</td>
</tr>
<tr>
<td>Multiple selection</td>
<td>Ctrl+click individual objects</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Unselect all</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Select all events in group</td>
<td>Shift+G</td>
</tr>
</tbody>
</table>
### Track commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New audio track</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td>New video track</td>
<td>Ctrl+Shift+Q</td>
</tr>
<tr>
<td>Enable/disable snapping</td>
<td>F8</td>
</tr>
<tr>
<td>Quantize to frames</td>
<td>Alt+F8</td>
</tr>
<tr>
<td>Snap to markers</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>Ripple edit mode</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Auto crossfade mode</td>
<td>Ctrl+Shift+X</td>
</tr>
<tr>
<td>Normal edit tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Next tool</td>
<td>D</td>
</tr>
<tr>
<td>Previous tool</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Mix to new track</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Change the track that has focus</td>
<td>Alt+Shift+Up/Down Arrow</td>
</tr>
<tr>
<td>Mute selected tracks</td>
<td>Z</td>
</tr>
<tr>
<td>Mute selected tracks and remove other tracks from mute group</td>
<td>Shift+Z</td>
</tr>
<tr>
<td>Solo selected tracks</td>
<td>X</td>
</tr>
<tr>
<td>Solo selected track and remove other tracks from solo group</td>
<td>Shift+X</td>
</tr>
<tr>
<td>Override snapping</td>
<td>Shift+drag</td>
</tr>
<tr>
<td>Bypass snapping</td>
<td>Shift+drag</td>
</tr>
<tr>
<td>Post-edit ripple affected tracks</td>
<td>F</td>
</tr>
<tr>
<td>Post-edit ripple affected tracks, bus tracks, Ctrl+F markers, and regions</td>
<td></td>
</tr>
</tbody>
</table>

### Trimmer commands

Many of the shortcuts that apply to the timeline (e.g., cursor placement, selection commands, etc.) also work in the Trimmer.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Media From Cursor</td>
<td>A</td>
</tr>
<tr>
<td>Add Media to Cursor</td>
<td>Shift+A</td>
</tr>
<tr>
<td>Transfer time selection from timeline to Trimmer after cursor</td>
<td>T</td>
</tr>
<tr>
<td>Transfer time selection from timeline to Trimmer before cursor</td>
<td>Shift+T</td>
</tr>
<tr>
<td>Toggle selected stream: audio/video/both</td>
<td>Tab</td>
</tr>
<tr>
<td>Toggle audio/video stream height</td>
<td>Ctrl+Shift+Up/Down Arrow</td>
</tr>
<tr>
<td>Next media file in Trimmer</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Previous media file in Trimmer</td>
<td>Ctrl+Shift+Tab</td>
</tr>
</tbody>
</table>
## Surround panner commands

For finer, more precise movements on the shortcuts in this section, add the [Ctrl] key.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constrain motion to 45-degree increments</td>
<td>Shift+drag the pan point (only when Move Freely is selected)</td>
</tr>
<tr>
<td>Constrain motion to a constant radius from the center</td>
<td>Alt+drag the pan point (only when Move Freely is selected) or Alt+mouse wheel</td>
</tr>
<tr>
<td>Constrain motion to the maximum circle that will fit in the Surround Panner</td>
<td>Alt+Shift+drag the pan point (only when Move Freely is selected) or Alt+Shift+mouse wheel</td>
</tr>
<tr>
<td>Move the pan point forward/back (when the pan point is selected)</td>
<td>Up/down arrow or Page Up/Page Down or mouse wheel</td>
</tr>
<tr>
<td>Move the pan point left/right (when the pan point is selected)</td>
<td>Left/Right Arrow or Shift+Up/Page Down or Shift + mouse wheel forward/back</td>
</tr>
<tr>
<td>Move the pan point to a corner, edge, or center of the Surround Panner (when the pan point is selected)</td>
<td>Numeric Keypad</td>
</tr>
<tr>
<td>Move the pan point to a corner on the largest circle that will fit in the Surround Panner (when the pan point is selected)</td>
<td>Ctrl+Numeric Keypad 1,3,7,9</td>
</tr>
</tbody>
</table>

## Miscellaneous commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online help</td>
<td>F1</td>
</tr>
<tr>
<td>What’s This? help</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Change relative keyframe spacing</td>
<td>Alt+drag keyframes</td>
</tr>
<tr>
<td>Make fine fader/slider adjustments</td>
<td>Ctrl+drag fader/slider</td>
</tr>
<tr>
<td>Shortcut menu</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Rebuild audio peaks</td>
<td>F5</td>
</tr>
<tr>
<td>Move both region markers or audio CD track region markers</td>
<td>Alt+drag region marker</td>
</tr>
</tbody>
</table>

## Mouse wheel shortcuts

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in/out on timeline</td>
<td>Default mouse wheel behavior</td>
</tr>
<tr>
<td>Zoom in/out in Event Pan/Crop or Track Motion windows</td>
<td>Default mouse wheel behavior</td>
</tr>
<tr>
<td>Vertical scroll</td>
<td>Ctrl+wheel</td>
</tr>
<tr>
<td>Horizontal scroll</td>
<td>Shift+wheel</td>
</tr>
<tr>
<td>Move the cursor in small increments</td>
<td>Ctrl+Shift+wheel</td>
</tr>
<tr>
<td>Move cursor one frame at a time</td>
<td>Ctrl+Shift+Alt+wheel</td>
</tr>
<tr>
<td>Auto-scroll</td>
<td>Press mouse wheel and move mouse left or right</td>
</tr>
<tr>
<td>Move fader/slider</td>
<td>Hover over fader and use wheel</td>
</tr>
<tr>
<td>Move fader/slider with fine control</td>
<td>Ctrl+hover over fader and use wheel</td>
</tr>
</tbody>
</table>
Cursor indications

The cursor in Vegas changes depending on which functions are available.

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Indicates</th>
<th>Modifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Arrow" /></td>
<td>Standard</td>
<td>none</td>
<td>This is the standard arrow cursor that means events can be dragged.</td>
</tr>
<tr>
<td><img src="image" alt="Trim" /></td>
<td>Trim</td>
<td>none</td>
<td>Position the cursor over the edge of an event and drag to trim the event shorter or longer.</td>
</tr>
<tr>
<td><img src="image" alt="Slip Trim" /></td>
<td>Slip Trim</td>
<td>Alt</td>
<td>Position the cursor over the edge of an event, press Alt, and drag to trim. The media within the event moves with the edge. This is useful to preserve the beginning or end of an event while trimming.</td>
</tr>
<tr>
<td><img src="image" alt="Stretch" /></td>
<td>Stretch</td>
<td>Ctrl</td>
<td>Position the cursor over the edge of an event, press Ctrl, and drag the edge to stretch or compress it. This makes the media in the event play slower or faster.</td>
</tr>
<tr>
<td><img src="image" alt="Slip" /></td>
<td>Slip</td>
<td>Alt</td>
<td>Press Alt and drag on the middle of a clip to move the media within the event without moving the event itself.</td>
</tr>
<tr>
<td><img src="image" alt="Trim Adjacent" /></td>
<td>Trim Adjacent</td>
<td>Ctrl+Alt</td>
<td>Position the cursor over the boundary between two adjacent events, press Ctrl+Alt, and drag. Both events are edge trimmed simultaneously.</td>
</tr>
<tr>
<td><img src="image" alt="Slide" /></td>
<td>Slide</td>
<td>Ctrl+Alt</td>
<td>Position the cursor over the middle of an event, press Ctrl+Alt, and drag to simultaneously trim both ends.</td>
</tr>
<tr>
<td><img src="image" alt="Slide Crossfade" /></td>
<td>Slide Crossfade</td>
<td>Ctrl+Alt</td>
<td>Position cursor over a crossfade, press Ctrl+Alt, and drag on a crossfade to move it.</td>
</tr>
</tbody>
</table>
Multiple audio busses and assignable effects are only available in the full version of Vegas.
Video signal flow

Vegas provides unlimited video tracks and fourteen compositing modes. Vegas LE limits you to two video tracks and source alpha compositing.

- Velocity envelope
- Media interpretation (field order, frame rate, alpha channel, etc.)
- Media FX
- Event opacity
- Event FX
- Event pan/crop
- Transitions
- Track FX
- Track fade to color envelopes
- Track motion + composite envelope + compositing
- Video Output FX
- Motion Blur Envelope
- Video Supersampling Envelope
Getting Started

Vegas is a new way of creating multimedia productions. Whether you are an experienced multimedia author or a budding novice, the powerful features and capabilities of Vegas are organized to increase your creativity and productivity. The following chapter summarizes the basic functions and operations of Vegas.

Creating projects

The process of creating a multimedia production can be a complicated undertaking, involving hundreds of shots, takes, voiceovers, music beds, audio tracks, and special effects. Organization is a critical issue in this process. In Vegas, organization is handled by a small project file (VEG) that saves information about source file locations, edits, cuts, insertion points, transitions, and special effects. This project file is not a multimedia file, but is instead used to create (render) the final file when editing is finished.

The advantage Vegas offers is not just organization, however, but the fact that Vegas edits a project file and not the original source files. When you copy, cut, paste, trim, and otherwise edit your project, the process is nondestructive. You can edit without worrying about corrupting your source files. This not only gives you a strong sense of security, but it also gives you the freedom to experiment.

1. From the File menu, choose New. The New Project dialog appears.

   Note: The first time you run Vegas, a new project will automatically be started for you.

2. Enter your project settings on the various tabs. For more information, see Working with project properties on page 267.
   - The Video tab allows you to select the video format and other video parameters.
   - The Audio tab allows you to set up the basic audio settings.
   - The Ruler tab allows you to choose the way the ruler is delineated (beats, seconds, etc.).
   - The Summary tab allows you to enter any relevant information and reminders about your project.
   - The Audio CD tab allows you to enter information for burning audio CDs from Vegas.

   Tip: The easiest way to set the often complex properties on the Video tab is to select a template that matches your media (e.g., NTSC DV (720x480, 29.970 fps)).

3. Click OK.
4. From the **File** menu, choose **Save**. Enter a name, browse for a location, and click **Save** to save your project (VEG file).

You can change project settings at any time while working on a project. From the **File** menu, choose **Properties** to change any of these settings.

**Setting video properties based on a media file**

You can automatically set your project video properties to match an existing video file.

1. From the **File** menu, choose **Properties**.
2. On the Video tab of the Project Properties dialog, click the **Match Media Settings** button ( ).
3. Browse for a media file that has the settings you wish you use for the project.
4. Click **Open**.

Vegas automatically detects the frame size, frame rate, pixel aspect ratio, and field order of this file and sets the project properties to match.

**Tip:** To save this information for future use, enter a name in the **Template** box and click the **Save Template** button ( ). If your projects typically use these settings, select the **Start all new projects with these settings** check box.

5. Click **OK** to save the new project properties.

**Saving a project**

When you save your work, it is saved in a project file (VEG). Project files are not rendered media files.

1. From the **File** menu, choose **Save**.

The first time you save a project, the **Save As** dialog appears. In subsequent saves, the dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.

2. Select the drive and folder where you want to store the project.
3. Type the project name in the **File Name** box.
4. Click Save.

**Tip:** Select the Copy and trim media with project check box to save both the project file and copies of the media files to a common location. For more information, see Saving a project with media on page 238.

**Renaming a project (using Save As)**

After you have been working with your project, you may use the Save As command in the File menu to save a copy of a project with a new name. This is useful for backing up different versions of a project. For more information, see Creating a copy of a project (using Save As...) on page 238.

**Getting media files**

You can add media from a variety of sources to a Vegas project. You can add audio and video files, record audio into a track, capture video from a video camera, or extract music from a CD. You can also create media such as text overlays, backgrounds, and credit rolls from within Vegas. For more information, see Using generated media on page 189.

**Note:** To have Vegas automatically remove pulldown fields when opening 24 fps progressive-scan DV video files, select the Allow pulldown removal when opening 24p DV checkbox on the General tab of the Preferences dialog. To open your 24p DV video files as 29.97 fps interlaced video (60i), clear this check box.

**Selecting media**

Vegas supports a wide range of media file types. You may select any of the media file types listed below to add to your Vegas project.

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIF</td>
<td>.gif</td>
<td>256 index color, lossless image and animation format widely used on the Internet.</td>
</tr>
<tr>
<td>JPEG</td>
<td>.jpg</td>
<td>True color, lossy Internet image format.</td>
</tr>
<tr>
<td>Macintosh Audio Interchange File Format File</td>
<td>.aif</td>
<td>Standard audio format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>.mpg</td>
<td>MPEGs, files compressed using a lossy audio/video compression method, can be used with Vegas.</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>.mp3</td>
<td>Highly compressed audio file.</td>
</tr>
<tr>
<td>Ogg Vorbis</td>
<td>.ogg</td>
<td>A patent-free audio encoding and streaming technology.</td>
</tr>
<tr>
<td>Photoshop</td>
<td>.psd</td>
<td>Adobe Photoshop® proprietary image format (flattened).</td>
</tr>
<tr>
<td>Portable Network Graphic</td>
<td>.png</td>
<td>True color or indexed color, lossy or lossless Internet image format.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>.mov, .qt</td>
<td>QuickTime standard audio/video format used on Macintosh computers.</td>
</tr>
<tr>
<td>Sonic Foundry Audio</td>
<td>.sfa</td>
<td>Sonic Foundry proprietary uncompressed format that should only be used for compatibility with other Sonic Foundry applications.</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity Audio</td>
<td>.pca</td>
<td>Sonic Foundry proprietary lossless audio compression format.</td>
</tr>
<tr>
<td>Sonic Foundry Wave 64</td>
<td>.w64</td>
<td>Sonic Foundry proprietary Wave64 audio file that does not have a limited file size (unlike Windows WAV files that are limited to ~2GB).</td>
</tr>
<tr>
<td>TARGA</td>
<td>.tga</td>
<td>True color, lossless image format that supports alpha channel transparency.</td>
</tr>
<tr>
<td>Format</td>
<td>Extension</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TIFF</td>
<td>.tif</td>
<td>Tagged Image File Format, a common bitmap format. You must have QuickTime installed to use TIFF files in Vegas.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>.avi</td>
<td>Standard audio/video format used on Windows-based computers.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>.wav</td>
<td>Standard audio format used on Windows-based computers.</td>
</tr>
<tr>
<td>Wave (Scott Studios)</td>
<td>.wav</td>
<td>Standard audio format used with Scott Studios systems.</td>
</tr>
<tr>
<td>Windows Bitmap</td>
<td>.bmp</td>
<td>Standard graphic format used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>.wmv</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
</tbody>
</table>
Previewing a media file

You may preview files before placing them in your project. The Explorer window has a mini-transport bar with Play, Stop, and Auto Preview buttons ( ). When you preview a file, its stream is sent to the Mixer window's preview bus (for audio files) or to the Video Preview window (for video files).

**Tip:** You can use the same mini-transport bar buttons in the Media Pool window to preview files in the Media Pool.

1. Select a file in the Explorer window.
2. Click the Play button ( ) to listen to the file.
3. Click the Stop button ( ) or select a different file to stop previewing the file.

**Tip:** To automatically preview selected files, click the Auto Preview button ( ) on the Explorer window's transport bar.

Using the Media Pool

Media files, both video and audio, tend to be the largest files on your hard drive. It is therefore not always easy to move them around and impractical to store multiple copies of these files. You can add media files to the Media Pool in Vegas to organize them before any editing begins. Once you begin working on a project, all files you add to the timeline are automatically included in the Media Pool. From the View menu, choose Media Pool to open this window if it is not already visible.

Using Media Pool views

You can control the information that is displayed in the Media Pool by clicking the Views button ( ) and selecting a view.

The Detailed view displays all the properties for each file. The information is presented in a table format. You can customize the information displayed:

- Reorder columns (fields) by dragging the column label to a new position.
- Hide a column by dragging the column label off of the Media Pool window. To display a hidden column, right-click the Media Pool, choose View from the shortcut menu, and choose the column name from the submenu.
- Sort the files in the Media Pool according to a category by clicking the column label for that category.
- Use the Comments field to add your own annotations to a file's entry in the Media Pool. Double-click the field to enter text. This information is saved with the project and is not saved with the media file itself.
Adding media to the Media Pool

1. Click the Import Media button ( ) in the Media Pool. The Import Media dialog appears.

2. Navigate to and select a media file to add to the Media Pool. You can use Ctrl or Shift to select multiple files.

3. Click Open.

   The media file is added to the Media Pool.

Adding media to the Media Pool from the Explorer window

1. Navigate to and select a file to add to the Media Pool. You can use Ctrl or Shift to select multiple media files.

2. Right-click the file and choose Add to Media Pool from the shortcut menu.

   The selected file is added to the Media Pool.

Replacing media in the Media Pool

You may replace a file in the Media Pool with a different file. When changing the media file that an event contains, every occurrence of the event on the timeline is updated with the new media file contents.

1. Right-click a file in the Media Pool.

2. Choose Replace from the shortcut menu.

3. In the Replace Media File dialog, browse for and select the file that you want to replace the current file.

4. Click Open. The selected file replaces the old file in the Media Pool, and any events in the timeline containing the old file are updated to contain the new media file.

Capturing video

You can use Sonic Foundry's Video Capture application (installed with Vegas) to capture video clips from your video camera and add them to the Media Pool window.

---

Note: You must have an IEEE-1394/OHCI-compliant video capture card installed to use Video Capture.

---

1. If you have not already done so, connect your video camera to your video capture card using the cable provided with the card.

2. In the Media Pool window, click the Open Video Capture button ( ). The Sonic Foundry Video Capture application starts.

---

Note: If your video camera is properly connected, the Video Preview window in the center of the application area should display “Device connected.”

---

3. Capture your video. For information on capturing video with Sonic Foundry Video Capture, choose Contents and Index from the Help menu within Video Capture to display Video Capture online help.

   Once you have captured your video, Video Capture adds the file(s) to the Media Pool window. If any captured clips go offline, you can recapture the clips using Video Capture. Right-click an offline file in the Media Pool and choose Recapture from the shortcut menu.
Getting images

You can bring images directly into Vegas from your scanner, digital camera, or other TWAIN device. Vegas adds the images to the Media Pool as JPEG image files.

1. Make sure your device (scanner or digital camera) is on and connected to your computer.

2. In the Media Pool window, click the Get Photo button ( ). Vegas starts the software for the device.

3. Use the device software to get an image and send it to Vegas. Once the image has been sent, the Scanned Files dialog appears.
   - Click Rename to give the new image a more meaningful name.
   - Click Delete to cancel the process of adding the image.

4. Click Done. Vegas adds the new JPEG file to the Media Pool.

Extracting audio from a CD

You can extract tracks from a CD and add them to the Media Pool window as WAV files.

1. Insert the audio CD.

2. In the Media Pool window, click the Extract Audio from CD button ( ). The Extract Audio from CD dialog appears.

3. From the Action drop-down list, choose the method you want Vegas to use for extracting the CD audio:
   - Read by track - Use this option to choose the tracks you want to extract from the CD.
   - Read entire disc - Use this option to automatically extract all tracks on the disc. The entire CD is extracted into one new file in the Media Pool.
   - Read by range - Use this option to extract audio from a specified range of time.

4. If you chose either the Read by track or Read by range option, specify the track(s) or range to extract:
   - For Read by track, click the track(s) you want to extract in the Tracks to read list. Use the Ctrl or Shift keys to select more than one track. Each track is extracted into a separate file in the Media Pool.
   - For Read by range, enter a time in the Range start field and either the Range end or Range length fields. The range of audio is extracted into one new file in the Media Pool.

   Note: If you want to extract multiple tracks to a single file, choose Read by track from the Action drop-down list to select your tracks, and then choose Read by range from the Action drop-down list. Vegas will automatically insert the appropriate time range for the tracks you selected and extract the time range to a single file.

5. From the Drive drop-down list, choose the drive containing the audio CD from which you want to extract.
6. From the Speed drop-down list, choose the speed at which you want to extract the audio. If you experience any problems extracting audio, you can try decreasing the selected speed, or you can click Configure to adjust the Audio extract optimization setting.

**Note:** To eject the CD at any time prior to beginning the extraction process, click the Eject button.

7. Click OK. The Save As dialog appears.
8. Select a name and location for the new WAV file.
9. Click Save to begin extracting the audio.

Vegas extracts the track and displays a progress meter to indicate the percent complete. Once extraction is complete, the new WAV file appears in the Media Pool.

Vegas provides the option of automatically naming extracted tracks for you. To enable this option, choose Preferences from the Options menu, and on the CD Settings tab, select the Autoname extracted tracks check box. For more information, see CD Settings tab on page 278.

### Adding a still-image sequence

If you’ve exported a video clip as a still-image sequence using another application (a 3D-rendering application, for example), Vegas can add the sequence to the Media Pool as a single event. Each image in the sequence will be displayed for one frame in the event.

1. Click the Import Media button in the Media Pool window. The Import Media dialog appears.
2. Choose the folder where the sequence you want to open is stored.
3. Select the first image in the sequence (or the image you want to start the event).
4. Select the Open still-image sequence check box.
5. In the Range field, enter the number of the last image you want to open. For example, if you’d selected AnimationOne_00001.tga in step 3, you could enter 120 in this box to create a new event using AnimationOne_00001.tga to AnimationOne_00120.tga.
6. Click Open. Vegas adds the still-image sequence to the Media Pool.
Sorting media with bins
The detailed view of the Media Pool window helps you sort your media files using their attributes, but for more control, you can create bins. Bins are folders within projects that you can use to organize your media files.

Media bins are virtual folders that are saved with your project. They do not affect the way media is saved on your computer.

Creating bins
Right-click the parent bin where you want to create a new bin and choose Create New Bin from the shortcut menu.

Adding media to a bin
1. Browse your existing bins to find the media file you want to move. The All Media Folder contains all media files in your project.
2. Drag a file from the right-hand pane to a bin.

Searching media bins
1. Right-click in the Media Pool window and choose Search Media Bins from the shortcut menu. The Search Media Bins dialog is displayed.
2. Use the drop-down lists in the Search Media Bins dialog to set your search conditions and click the Search button. Vegas will search the selected bin and all sub-bins.
3. Click the Search Results icon to view the matching files.

Hint: Right-click the Search Results icon and choose Save as Bin from the shortcut menu to save the results of your search as a new media bin.

Automatically adding recorded files to a media bin
Select a media bin if you want Vegas to automatically add your recorded audio to a media bin.

Deleting media from a bin
1. Select a media file.
2. Press Delete on your keyboard.
3. If the All Media Folder is selected, the file will be removed from your project.
4. If a media bin is selected, the file is removed from the bin, but remains part of your project. The file is still available in the All Media Folder.

Adding media to the timeline
Media files may be added to your project from the Explorer or Media Pool by double-clicking them or by dragging them. Either method places the media file in an event in its entirety in the timeline.

Dragging a media file to the timeline
You can create a new track by dragging a media file to a blank area on the timeline and dropping it in place. Vegas tracks can contain multiple events, so you can place different events next to each other on a track.

Note: Video and audio events cannot be placed on the same track.
1. Locate a media file in the Explorer or Media Pool.
2. Drag the media file to the timeline.
   An event for the media file appears where you released the mouse.

**Dragging multiple media files to the timeline**

1. Select multiple media files in the Explorer or Media Pool. Select a range of adjacent media files by pressing [Shift] and clicking the first and last files in the range or select files that are not adjacent by pressing [Ctrl] and clicking individual files.
2. Right-click and drag the files to the track view (timeline).
3. When you release the mouse, a shortcut menu appears. Select a placement option from the menu.
   - **Add Across Time**
   - **Add Across Tracks**
   - **Add As Takes**

   You will see one event on the track. The other events are listed at takes “beneath” the topmost event.

   For more information, see Working with takes on page 91.

   - **Video Only** and **Audio Only** allow you to isolate either the video or audio, and add that stream from a multimedia file either across tracks, across time, or as takes.

   **Tip:** A left-click drag-and-drop automatically inserts files across time. However, you can cycle through placement modes by right-clicking (without releasing the left mouse button) while performing the drag-and-drop operation.

**Double-clicking a media file**

This method places the event at the cursor’s position in the selected track. If the selected track is a video track, and you double-click an audio event (or vice versa), Vegas creates a new track for the event. Once an event is placed, you can move it from one track to another or change its position on the timeline.
Inserting a video file with associated audio

Media files with video frequently include associated audio. When you insert a media file into the timeline, the associated audio is automatically inserted into a separate audio track below the video track. The two associated events are grouped together and behave as a single unit when moved or otherwise edited. You can ungroup the events to move them independently. For more information, see Clearing a group on page 128.

Automatically crossfading inserted events

When inserting multiple events across time, the events (both video and audio) may be set to automatically crossfade. Two options must be enabled in order to create crossfades automatically when adding multiple events. First, verify that a check mark appears next to Automatic Crossfades in the Options menu. Second, from the Options menu, choose Preferences, and on the Editing tab, select Automatically overlap multiple selected media when added. For more information, see Using automatic crossfades on page 74.

Working with events

Events are the most basic objects in a project in Vegas. An event is something that happens in time, has a specific duration, and can be video or audio.

Understanding files and events

The objects you work with in Vegas are referred to as media files and events.

- **Files** are objects that are stored on your hard disk. In Vegas, you will work with media files, such as music and video files. Vegas neither operates on nor changes these files. You can access files from the Vegas Explorer window.

- **Events** are periods of time on the timeline in Vegas that act as windows into media files, either whole or in part. When you drag a media file onto the timeline, you automatically create an event that contains that file’s contents. An event can contain video, audio, still images, or generated media. The event window may contain only a small portion of a much larger media file. A single media file can be used repeatedly to create any number of different events, since each event can be trimmed independently.

Audio events are created from audio files on your computer (e.g., WAV, MP3) or can be a part of a video file (e.g., AVI). You can change many characteristics of an audio event, such as speed, volume, and equalization. Audio events can be mixed with other audio events.
Video events are created from video files captured to your computer (typically AVI, MOV, QT) or images (BMP, JPEG, PNG, or TGA). You can change many characteristics of a video event, such as speed, color, and size. Video events can overlay other video events and are visual elements that appear on top of a background video, image, or color.

Moving events along the timeline

You can move events along the timeline individually or as a group. Events may overlap each other or be placed on top of each other. You can crossfade overlapping events automatically or with envelopes.

Moving an event

You can move an event along the timeline within a track or move it to a different track.

1. Drag the event along the timeline.

   If you move the event along the original track's timeline, the event's appearance (color) remains the same.

   ![Original track position]

   However, you may move the event to a different track. When you do, the event appears as a simple outline and you will see its original track and position on the timeline. Once you release the mouse, the event assumes the new timeline position and track color.

   ![New track and position]

2. Release the mouse to place the event.

Moving multiple events

You can move multiple events along the timeline within a track or move them to a different track. Selected events do not need to be within the same track. Use the [Ctrl] key, the [Shift] key, or the Selection Edit Tool ( ) to select multiple events and drag them. To select all events on the track after a given event, right-click the event and choose Select Events to End. For more information, see Selecting multiple events on page 58.

Moving events by small increments

To move an event more precisely, click the event and press 4 or 6 on the numeric keypad to nudge it by small increments. The amount of movement caused by each nudge is determined by how far the timeline is zoomed in or out. You can also click the event and press 1 or 3 on the numeric keypad to nudge the event by frames.

Moving grouped events

Groups allow you to move multiple events within their tracks as a single unit. While you can create your own groups as needed, Vegas automatically creates groups for you when video files with associated audio (e.g., AVI) are added to a project. When you add these video files, the audio portion of the video file is inserted into the timeline as a separate audio event. The video and audio events are grouped and can be moved as a single unit within their respective tracks.

To move grouped events, drag any event in the group to a new position. For more information, see Grouping events on page 127.
Working with tracks

Vegas includes unlimited audio and video tracks. Vegas LE limits you to two video tracks and four audio tracks.

A project consists of multiple audio and video tracks. The track view is the timeline in which all events appear. The track list provides information about the track and contains controls that affect all events in the track.

Using the track view

Vegas provides numerous options for viewing and navigating in track view.

Scrolling and zooming

There are several ways to scroll and zoom in the track view.

- Click the scroll bar arrows or drag the scroll bars to move up and down the tracks or to move forward and back along the timeline.
- Click the Zoom buttons ( ) to reveal more or less of the timeline.
- Drag the edge of the scroll box, found on the scroll bar, to zoom.
- Press  and  to zoom in and out along the timeline.
- Click the Zoom Edit Tool ( ) button or, from the Edit menu, choose Editing Tool and then choose Zoom. In this mode, drag on the timeline to draw a rectangle that defines the zoom region.

Tip: You can also access the Zoom Edit Tool from the lower-right corner of the track view ( )

Vegas also supports mouse wheel control. The default behavior of the wheel is to zoom horizontally.

-  +wheel scrolls horizontally (through time).
-  +wheel scrolls vertically.
-  +  +wheel moves the cursor in small increments.
-  +  + +wheel moves the cursor in one-frame increments.
- Clicking the mouse wheel turns auto-panning on and off.

Zooming directly controls the accuracy of your editing. Each video event has thumbnail representations of the frames within the event. Depending on how far you have zoomed in on a video event, a thumbnail can represent the entire event or a single frame in the event.

Tip: You can choose to display frame numbers, time, or timecode on video event thumbnails. For more information, see Displaying frame numbers on page 263.
Changing track height

You can change the height of individual tracks by dragging their borders in the track list. In the example below, the main video track is fairly large to show the details of the scene while the two tracks above it, which are overlays, have been resized to a shorter height. For more information, see Changing track height on page 104.
Using the track list

This section describes the different controls in the track header of each track. Some controls are specific to either video or audio tracks.

Video track header

<table>
<thead>
<tr>
<th>Button or Control</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make compositing child</td>
<td>Creates a parent/child compositing relationship with the track above. Used when creating masks. For more information, see Understanding the parent/child track relationship on page 190.</td>
<td></td>
</tr>
<tr>
<td>Track number, type, and color</td>
<td>The icon identifies whether this is an audio track or video track. Track numbers and colors help organize a multitrack project. For more information, see Managing tracks on page 101.</td>
<td></td>
</tr>
<tr>
<td>Minimize track height</td>
<td>Minimizes track height. For more information, see Changing track height on page 104.</td>
<td></td>
</tr>
<tr>
<td>Maximize track height</td>
<td>Maximizes track height. For more information, see Changing track height on page 104.</td>
<td></td>
</tr>
<tr>
<td>Restore track height</td>
<td>Restores track height. For more information, see Changing track height on page 104.</td>
<td></td>
</tr>
<tr>
<td>Expand track layers</td>
<td>Displays the A/B roll. For more information, see Understanding track layers on page 206.</td>
<td></td>
</tr>
<tr>
<td>Expand track keyframes</td>
<td>Displays track keyframes on the timeline. For more information, see Working with keyframes in track view on page 212.</td>
<td></td>
</tr>
<tr>
<td>Bypass motion blur</td>
<td>Bypasses motion blur envelope for a track. For more information, see Using video bus tracks on page 115.</td>
<td></td>
</tr>
<tr>
<td>Track motion</td>
<td>Track motion is used to move a video track across a background. Picture-in-picture effects and scrolling title sequences are two simple cases where this tool is important. For more information, see Adding track motion on page 217.</td>
<td></td>
</tr>
<tr>
<td>Track FX</td>
<td>Adds track effects plug-ins. For more information, see Using video effects on page 183.</td>
<td></td>
</tr>
<tr>
<td>Mute</td>
<td>Temporarily suspends playback of the track so that you can focus on other tracks. For more information, see Muting a track on page 108.</td>
<td></td>
</tr>
<tr>
<td>Solo</td>
<td>Isolates a track for playback by muting the other tracks. For more information, see Soloing a track on page 108.</td>
<td></td>
</tr>
<tr>
<td>Track name (scribble strip)</td>
<td>Allows you name a track. To name a track, double-click the scribble strip and type the track’s name. For more information, see Naming or renaming a track on page 103.</td>
<td></td>
</tr>
<tr>
<td>Composite level slider</td>
<td>Determines the opacity/transparency of the video track. Drag the slider to control the transparency or blending of the track. Left is 100% transparent and right is 100% opaque. You can also double-click the label to enter a specific numeric percentage.</td>
<td></td>
</tr>
<tr>
<td>Compositing mode</td>
<td>Determines how the transparency in a video track is generated. For more information, see Selecting compositing modes on page 191.</td>
<td></td>
</tr>
</tbody>
</table>
### Audio track header

<table>
<thead>
<tr>
<th>Button or Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track number, type, and color</td>
<td>The icon identifies whether this is an audio track or video track. Track numbers and colors help organize a multitrack project. For more information, see Managing tracks on page 101.</td>
</tr>
<tr>
<td>Minimize track height</td>
<td>Minimizes track height. For more information, see Changing track height on page 104.</td>
</tr>
<tr>
<td>Maximize track height</td>
<td>Maximizes track height. For more information, see Changing track height on page 104.</td>
</tr>
<tr>
<td>Restore track height</td>
<td>Restores track height. For more information, see Changing track height on page 104.</td>
</tr>
<tr>
<td>Track name (scribble strip)</td>
<td>Allows you name a track. To name a track, double-click the scribble strip and type the track's name. For more information, see Naming or renaming a track on page 103.</td>
</tr>
<tr>
<td>Arm for record</td>
<td>Prepares a track for recording. You may record directly into audio tracks. A track is ready when you see the recording meter appear on it. For more information, see Arming the track for recording on page 147.</td>
</tr>
<tr>
<td>Bus assignment</td>
<td>Assigns an audio track to a specific output bus. This option is available for projects being mixed for multiple stereo busses. For more information, see Assigning audio tracks to busses on page 142.</td>
</tr>
<tr>
<td>Invert Track Phase</td>
<td>Inverts the audio track at its baseline, in effect reversing its polarity. For more information, see Phase inverting a track (audio only) on page 108.</td>
</tr>
<tr>
<td>Track FX</td>
<td>Adds track effects plug-ins. For more information, see Using audio effects on page 129.</td>
</tr>
<tr>
<td>Mute</td>
<td>Temporarily mutes playback of the track so that you can focus on other tracks. For more information, see Muting a track on page 108.</td>
</tr>
<tr>
<td>Solo</td>
<td>Isolates a track for playback by muting the other tracks. For more information, see Soloing a track on page 108.</td>
</tr>
<tr>
<td>Volume fader</td>
<td>Controls the audio track volume relative to the other tracks. Drag the fader left or right to adjust the volume. For more information, see Using the volume fader (audio only) on page 105.</td>
</tr>
<tr>
<td>Multipurpose slider</td>
<td>Controls several features, including track panning, bus send levels, and assignable effects send levels. Select what the slider controls by clicking the label. Each item’s slider position is independent from the others. For more information, see Using the multipurpose slider (audio only) on page 105.</td>
</tr>
</tbody>
</table>
Viewing playbacks and previews

Vegas allows you to play back your project in two ways: directly from the timeline from within Vegas or by mixing the entire project to a preview file.

Using playback in Vegas

The transport bar allows you to play back your entire project or portions of your project based on a time selection or the current cursor position.

If your project includes video, make sure the Video Preview window is displayed for playback: from the View menu, choose Video Preview or press Alt + 6.

Playing an entire project
1. Click the Play From Start button ( ) to begin playback at the beginning of the project.
2. Click the Stop button ( ) to stop playback.

Most of the time, you will only want to preview a small portion of the project to perfect a section. You can do this by creating a time selection.

Playing a time selection
1. Place the mouse pointer above the ruler on the marker bar. The mouse pointer changes to include a left/right arrow cursor ( ).
2. Drag to select the time region. To increase or decrease the time selection, drag its start and end points. The time selection is highlighted and the loop bar appears above the ruler on the timeline.
3. Click the Play button ( ) to begin playback. Only the non-muted tracks and events within the time selection play back.
4. Click the Loop Playback button ( ) to continually play back the events within the time selection. Click the button again to toggle this feature off.
5. Click the Stop button ( ) to stop playback.

By looping the playback, you can repeatedly watch the same section of the project over and over as you make changes to filters and effects in real time. You can define selection areas automatically, depending on what you would like to preview. For more information, see Selecting a time range on page 59 and Time selection commands on page 30.
Playback reference

The following table describes all the transport bar buttons and their keyboard equivalents. You may use these playback functions at any time while working in your project.

**Note:** Vegas also supports the use of many multimedia keyboards for controlling playback.

<table>
<thead>
<tr>
<th>Button</th>
<th>Keyboard</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔴</td>
<td>Ctrl + R</td>
<td>Begin recording into record-enabled tracks</td>
</tr>
<tr>
<td>🎬</td>
<td>Q</td>
<td>Turn on/off loop playback during time selection playback</td>
</tr>
<tr>
<td>🎬</td>
<td>Shift + Space</td>
<td>Begin playback from the start of the project</td>
</tr>
<tr>
<td>🎬</td>
<td>Space</td>
<td>Begin playback from cursor position</td>
</tr>
<tr>
<td>🎬</td>
<td>Enter</td>
<td>Pause playback, cursor stops and holds at pause position</td>
</tr>
<tr>
<td>🎬</td>
<td>Space or Esc</td>
<td>Stop playback, cursor stops and returns to prior cursor position</td>
</tr>
<tr>
<td>🎬</td>
<td>Ctrl + Home</td>
<td>Place cursor at the beginning of project</td>
</tr>
<tr>
<td>🎬</td>
<td>Ctrl + End</td>
<td>Place cursor at the end of the project</td>
</tr>
</tbody>
</table>

**Tip:** You can use the spacebar to stop or pause playback, depending on your preference. From the **Options** menu, choose **Preferences**, and on the **General** tab, select Make spacebar and F12 Play/Pause instead of Play/Stop to change the setting.

Scrubbing

Scrubbing is a type of timeline playback that gives you precise control over the speed and direction of playback. Vegas allows for both linear and logarithmic scale scrubbing. For more information, see **General tab** on page 272.

Vegas supports the use of multimedia controllers for scrubbing. For more information on using Vegas with multimedia controllers, please see the Vegas online help. To access help, choose **Contents and Index** from the **Help** menu.

**Tip:** Choose a setting from the JKL / shuttle speed drop-down list on the Editing tab of the Preferences dialog to control the scrub speed and range when using the keyboard or multimedia controllers.

Vegas provides three methods of scrubbing.

**Scrubbing with the scrub control slider**

The scrub control slider can be dragged back and forth. The farther from the center that the slider is dragged, the faster the playback, both forward and in reverse. Below the slider is a small yellow marker that can be used to set the normal rate playback speed. This is the speed at which the project plays when you click the Play button on the transport bar.
Scrubbing on the timeline

The second way that a project can be scrubbed is by positioning the mouse pointer over the timeline cursor at a location that is not over any events and pressing Ctrl. The cursor changes to a speaker icon. Now, when you left-click, the cursor icon changes again to a pan/scrub icon. Drag the mouse left or right to scrub the timeline.

**Tip:** You can also choose to enable timeline scrubbing when the mouse is positioned over events. From the Options menu, choose Preferences, and select Allow Ctrl+drag cursor style scrub over events on the General tab.

Scrubbing with the keyboard

Vegas uses three letters (JKL) as a keyboard scrub control.

**Note:** Choose a setting from the JKL / shuttle speed drop-down list on the Editing tab of the Preferences dialog to control the scrub speed and range.

Press J for reverse and L for forward playback. Press K to pause playback.

There are several ways to adjust playback speed:

- Adjust the JKL / shuttle speed selection on the Editing tab of the Preferences dialog.
- Press and hold K while pressing J or L to emulate a shuttle knob mode. Press K+J to turn the knob to the left or K+L to turn the knob to the left. Press K again or Space to return to normal mode.

Previewing to media player

Vegas can preview a project in a media player by mixing and rendering the project according to the project’s properties and playing back using the media player associated with the file type you select.

1. From the Tools menu, choose Preview in Player. The Preview dialog appears.
2. Select the file type from the drop-down list.
3. Click OK to begin the mixing and rendering process. A progress dialog appears indicating the percent complete of the new file.

**Note:** You may cancel the preview by clicking the Cancel button on the status bar.

When mixing is completed, the associated media player opens and begins playback.

Prerendering video previews

Playing a project using the transport controls can instantly show how a project is progressing, but it does not actually render your project as it will appear in its final form. The preview you see in the Video Preview window may be different from your final project in a number of ways: frame size, frame rate, and quality. In most cases, the Video Preview is all you need for checking the timing of events in your project. Eventually, however, you may need to output a full-quality preview of a section of your project. To do this, from the Tools menu, choose Selectively Prerender Video. For more information, see Prerendering video on page 225.
Rendering a Vegas project

Rendering refers to the process of creating a new media file from a Vegas project. The project file is not affected (overwritten, deleted, or altered) during the rendering process. You may return to the original project to make edits or adjustments and render it again. The following table describes the formats available for rendering your Vegas project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>.aif</td>
<td>The standard audio file format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>.mpg</td>
<td>Vegas supports MPEG-1 and MPEG-2 file creation through the use of MainConcept MPEG technology.</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>.mp3</td>
<td>Compressed audio format. You may render up to 20 .mp3 files without registering the optional plug-in.</td>
</tr>
<tr>
<td>OggVorbis</td>
<td>.ogg</td>
<td>A patent-free audio encoding and streaming technology.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>.mov</td>
<td>Apple QuickTime multimedia format.</td>
</tr>
<tr>
<td>RealMedia</td>
<td>.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Scott Studios Wave</td>
<td>.wav</td>
<td>Standard audio format used with Scott Studios systems.</td>
</tr>
<tr>
<td>Sonic Foundry AC-3</td>
<td>.ac3</td>
<td>Encoded Dolby Digital surround sound format. This option creates six mono files (WAV or AIFF) that your authoring application can use to create DVD-Video or 5.1-channel music projects.</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity Audio</td>
<td>.pca</td>
<td>A Sonic Foundry proprietary format that is compressed and completely lossless.</td>
</tr>
<tr>
<td>Sonic Foundry Wave64</td>
<td>.w64</td>
<td>A Sonic Foundry proprietary format that allows wave files that are (practically) unrestricted by file size.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>.wmv</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
</tbody>
</table>

More detailed instructions for rendering to a specific format appear later in this manual. For more information, see Saving, Rendering, and Printing Projects on page 237.

Creating a movie

To create a movie, you render the Vegas project into an appropriate media file output. The final output format depends on the destination of the new media file. Some examples are AVI, MOV, and WMV.

1. From the File menu, choose Render As.
2. In the Render As dialog box, choose the appropriate option from the Save as type drop-down list.
3. Click Custom to select custom compression settings. The default compression options are set automatically according to your project’s properties. For more information, see Customizing the rendering process on page 242.
4. Enter a name and browse for a destination for your file.
5. Click OK.
Vegas projects are multitrack compilations of events that occur over time. The events in your project are references (pointers) to source media files. Vegas is a nondestructive editor, so editing events in your project does not alter the source media files in any way.

### Getting around

When editing and playing back the project, the cursor identifies where you are along the project’s timeline.

### Moving the cursor

Use the following keyboard commands to move the cursor in the Vegas timeline.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home or <code>W</code></td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End or <code>E</code></td>
</tr>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Go to</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move left/right to marker(s)</td>
<td>Ctrl+Left/Right Arrow</td>
</tr>
<tr>
<td>Move to marker #</td>
<td>0-9 keys (not numeric keypad)</td>
</tr>
<tr>
<td>Move left/right to event edit points</td>
<td>Ctrl+Alt+Left/Right Arrow</td>
</tr>
<tr>
<td>Nudge cursor on timeline</td>
<td>Left or Right Arrow</td>
</tr>
<tr>
<td>Move left/right one frame</td>
<td>Alt+Left/Right Arrow</td>
</tr>
<tr>
<td>Move left/right one frame</td>
<td>Ctrl+Alt+Shift+Mouse wheel</td>
</tr>
<tr>
<td>Center in view</td>
<td>\</td>
</tr>
</tbody>
</table>

### Changing focus

Focus is used to describe which objects have the attention of a program. For example, when you click a file in the Media Pool, the Media Pool window has focus. To instantly switch the program’s focus to the track view (timeline), press `Alt`+`0` or, from the View menu, choose Focus to Track View.

In Vegas, it matters which track has focus when you perform a task. For example, when you double-click a media file in the Explorer, Vegas inserts it into the track that has focus. You can click a track on its track number to make it the focus track. A blinking white line under the track number and shading in the track list indicates a track has focus.
Making selections

Vegas gives you the flexibility to select one or more events, a time range, or events and a time range. All selection options can apply to a single track or to multiple tracks.

To select an event, click it.

Selecting multiple events

You can select multiple events in your project using several methods.

Tip: Once you have selected multiple events, you can group them together. For more information, see Grouping events on page 127.

Note: You can select multiple video events, multiple audio events, or a combination of both video and audio events. However, you can only use commands and operations that apply to both types of events for selections composed of both audio and video events.

Selecting nonadjacent events

1. Hold the Ctrl key.
2. Select the events by clicking them.
   
   To deselect an event, simply click it again to toggle the event selection on or off.

Selecting a range of events

1. Hold the Shift key.
2. Click the first event that you want to select.
3. Click the last event that you want to select.
   
   All events between the first and last selected events are highlighted and selected.

Selecting a block of events

1. Click the Selection Edit Tool button ( ).
2. Position the cursor in a corner of the area that you want to select.
3. Click and hold the left mouse button.
4. Drag the cursor to the opposite corner of the area you want to select. A rectangle is drawn on the workspace. All events within this rectangle are selected.

Hold the left mouse button and right-click to toggle through the three types of selection boxes: free, vertical, or horizontal.

**Tip:** You may include or exclude events from a selection area by pressing Ctrl and clicking an event. To deselect all events, click anywhere in the workspace outside of the selected events.

---

**Selecting all events to the end of the track**

1. Right-click an event. A shortcut menu appears.

2. From the shortcut menu, choose Select Events to End. All events on the track after the selected event are selected.

**Tip:** To move large blocks of events, you can use Select Events to End with events selected on different tracks. Press Ctrl and click to select events on different tracks, and then right-click to access the shortcut menu.

---

**Selecting all events that refer to a specific media file**

Right-click a file in the Media Pool and choose Select Timeline Events from the shortcut menu. All events that use the selected media file in the active take are selected.

Hold Ctrl or Shift while choosing Select Timeline Events from the shortcut menu to add the events to the current selection.

---

**Selecting a time range**

Time selections are indicated by a shaded box and a bar that appears on the top of the timeline. You can use the time selection bar for playing back a smaller portion of your project or to apply cross-track edits.

**Note:** Unless an event is locked, a selected time range affects all events, or portions of events, that occur within the range.

---

**Dragging to select a time range**

1. Position the mouse pointer above the ruler (on the marker bar). The mouse pointer changes to a left/right arrow cursor (L→).

2. Drag to select a region. All events, or portions of events within the region are highlighted.

3. Drag the yellow handles on either end of the time selection to increase or decrease your time range selection.

**Tip:** You can move the entire selection range by dragging the time selection bar.
Selecting a time range during playback

1. Click the Play (▶) or the Play From Start (▶) button to begin playback.
2. Press [ ] where you want the time selection to begin.
3. Press [ ] where you want the time selection to end.
4. Click the Stop button (■) to stop playback.

Using shortcuts for time selections

These shortcuts can speed up the process of making precise time selections.

<table>
<thead>
<tr>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set time selection duration equal to an event’s duration</td>
<td>Double-click the event</td>
</tr>
<tr>
<td>Extend selection to the end of the currently selected event edge</td>
<td>Ctrl+Shift+Alt+Right Arrow</td>
</tr>
<tr>
<td>Extend selection to the beginning of the currently selected event edge</td>
<td>Ctrl+Shift+Alt+Left Arrow</td>
</tr>
<tr>
<td>Drag a time selection on an event without selecting/deselecting the event</td>
<td>Ctrl+Shift+drag on the event</td>
</tr>
</tbody>
</table>

Tip: Press [Backspace] to recall the last five time selection areas.

Looping playback

If you want to play back the time range, click Play (▶) to play only the events within the time range. Click the Loop Playback button (▶) or press [Q] to toggle loop playback on and off. Vegas continually plays back the portion of the timeline within the time selection when loop playback is toggled on.

Selecting events and a time range

Selecting a time range does not automatically select events. Excluding locked events, all items within the time range play back and are affected by Edit menu commands. However, you may select specific events to edit, and then select a time range.

1. Select the events you wish to edit. For more information, see Selecting multiple events on page 58.
2. Place the mouse pointer above the ruler (on the marker bar). The mouse pointer changes to a left/right arrow cursor (↓→).
3. Drag to select the region. Notice that events that were not initially selected in step 1 remain unselected (not highlighted).
Editing events

Copying events

Vegas allows you to copy events, or portions of events, to the Clipboard and paste them into your project. You may copy a single event or multiple events. Copying preserves the original event information, edits, and other modifications.

1. Select the events to be copied. For more information, see Selecting multiple events on page 58.
2. Select a time range, if applicable.
3. Click the Copy button ( ).

Copying selected events

When copied, selected events are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Event Before Copy" /></td>
<td><img src="#" alt="Clipboard Contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Copying a time selection

Events within the time selection and across all tracks are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Event Before Copy" /></td>
<td><img src="#" alt="Clipboard Contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Copying a time selection and events

Events and portions of selected events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Event Before Copy" /></td>
<td><img src="#" alt="Clipboard Contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>
Cutting events

Cutting events removes them from their respective tracks, but places the cut information (events and time) on the Clipboard. Once on the Clipboard, you may paste the information into your project.

**Tip:** You can apply a ripple edit after cutting. For more information, see Applying post-edit ripples on page 72.

1. Select events or a time range. For more information, see Making selections on page 58.
2. Click the **Cut** button ( )

### Cutting selected events

When cut, selected events are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard. When cutting selected events, ripple edit mode has no effect on later events.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
<th>Events after cut in post-edit ripple mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Events before cut" /></td>
<td><img src="image2" alt="Clipboard contents" /></td>
<td><img src="image3" alt="Events after cut" /></td>
<td><img src="image4" alt="Events after cut in post-edit ripple mode" /></td>
</tr>
</tbody>
</table>

**Cutting a time selection**

Events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard. When cutting a time selection, ripple edit mode affects the position of material on all tracks or affected tracks after the cut.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
<th>Events after cut in post-edit ripple mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Events before cut" /></td>
<td><img src="image2" alt="Clipboard contents" /></td>
<td><img src="image3" alt="Events after cut" /></td>
<td><img src="image4" alt="Events after cut in post-edit ripple mode" /></td>
</tr>
</tbody>
</table>
Cutting a time selection and events

Events and portions of selected events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard. When cutting a combination of time selection and event selection, post-edit ripple mode affects the position of material on all tracks or the tracks of selected events after the cut.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
<th>Events after cut in post-edit ripple mode</th>
</tr>
</thead>
</table>

Pasting events

Once information is copied to the Clipboard, you may choose a variety of ways to paste the Clipboard items. Vegas always pastes from the cursor’s position along the timeline.

When post-edit ripple mode is enabled, Vegas pushes material down the track to make room for pasted material. The exact behavior of the ripple depends on what is being pasted, and the type of ripple edit you chose to perform. If one or more events are pasted, only those tracks where pasted material appears are ripple edited.

Tip: You can apply a ripple edit after pasting. For more information, see Applying post-edit ripples on page 72.

1. Move the cursor to the desired location on the timeline.
2. Click either the track number or within the track where you want to paste the event. This track is the focus track; there can be only one focus track at a time.

   Note: If you are pasting multiple events from different tracks, Vegas automatically creates new tracks as needed.

3. Click the Paste button ( ).

   Clipboard events are pasted at the cursor position on the track. Existing track events can be overlapped with newly pasted information.

Using paste repeat

Use paste repeat to specify how many times Clipboard events are pasted at the cursor position on the selected track and to specify the space between pasted events.

1. Copy a selection to the Clipboard.
2. From the Edit menu, choose Paste Repeat. The Paste Repeat dialog appears.
3. Specify the number of times to paste the Clipboard contents and the space between successive copies.
4. Click OK.
Using paste insert

When using paste insert, Clipboard events are placed at the cursor position on the selected track and existing events on all tracks are moved further down the timeline by the total length of pasted information. This action differs from post-edit ripple mode because pasting in post-edit ripple mode affects only the tracks in which material is pasted, while paste insert affects all tracks in the project.

1. Copy a selection to the Clipboard.
2. From the **Edit** menu, choose **Paste Insert**

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste insert</th>
<th>Events after paste insert</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Clipboard content" /></td>
<td><img src="image2.png" alt="Events before paste insert" /></td>
<td><img src="image3.png" alt="Events after paste insert" /></td>
</tr>
</tbody>
</table>

Events on all tracks (not just tracks with pasted material) are pushed down the timeline.
Punching-in and crossfading events

You can insert events into the middle of (on top of) existing events without altering the timing of the project. When the inserted event ends, the original event continues playing as if it had never stopped.

You can choose the duration of crossfades for punched-in audio events.

1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. Click the Editing tab.
3. Select Quick fade length of audio events. Specify a duration for each transition.

Events that have previously been inserted or punched-in are not affected by this change. The concept of punching in and out only applies when you are inserting an event that is shorter than the event that it is being inserted into. In the following illustration, every frame is numbered so that you can see how the original event continues after the inserted event ends, as if it continued to play underneath the original.

Duplicating events

Duplicating is a combination of copying and pasting in one action. The process is like moving the event to a new position while leaving a copy behind.

1. Press Ctrl.
2. Drag the event you want to duplicate to the place where you want the new event to be positioned.

Inserting empty events and time

You can insert events into the timeline that do not have any contents and are not references to any media files. Empty events are useful as placeholders in the timeline that can be filled with media or recorded into at a later time. In either case, the new media is added to the empty event as a take. For more information, see Working with takes on page 91. To add an empty event to a track, from the Insert menu, choose Empty Event.

You can also make space in a project by inserting a length of time across all tracks. To insert a period of time into the timeline, from the Insert menu, choose Time.
Trimming events

This section describes simple ways to trim events. You can also use the Trimmer window to trim events. For more information, see Using the Trimmer window on page 93.

**Tip:** You can apply a ripple edit after trimming an event. For more information, see Applying post-edit ripples on page 72.

**Trimming an event**

During the trimming process for a video event, both the last thumbnail image on the event and the Video Preview window show the last frame in the event, allowing you to edit events very accurately.

1. Move the cursor over the edge of the event. The cursor changes when properly positioned ( ).
2. Drag the edge of the event to trim it.

Since a multimedia file often has both a video and an audio component, both events are trimmed (or extended) as a group unless you ungroup them or temporarily suspend grouping by clicking the Ignore Event Grouping button ( ). For more information, see Grouping events on page 127.

**Trimming an event beyond its end**

You can trim an event beyond its end, extending it as a result. Once extended, the event loops as a default. A notch indicates where the looped event repeats.

Alternately, you can turn looping off and make the last frame of a video event repeat (a freeze frame) for the remaining duration. A notch appears at the point in the event where the video ends and the freeze frame begins. For more information, see Loop on page 119.

**Trimming adjacent events**

You can trim adjacent events simultaneously. Press **Ctrl+Alt** while dragging the common edge between two adjacent events. The trim adjacent cursor appears ( ).
Trimming a time selection

Trimming events removes all media outside the time selection. The removed information is not placed on the Clipboard. Trimming is different from cutting in that the events within the time selection are preserved.

1. Select a time range. For more information, see Selecting a time range on page 59.
2. Press \texttt{CTRL} + \texttt{T} or, from the \textit{Edit} menu, choose Trim.

The material outside the time selection (across all tracks) is removed from the project. However, the time information (space) between events is not removed.

<table>
<thead>
<tr>
<th>Events before trim</th>
<th>Clipboard contents</th>
<th>Events after trim</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Waveform before trim]</td>
<td>Trimmed information is not placed on the Clipboard.</td>
<td>![Waveform after trim]</td>
</tr>
</tbody>
</table>

Trimming a time and event selection

1. Select the events to be trimmed.
2. Select a time range. For more information, see Selecting events and a time range on page 60.
3. Press \texttt{CTRL} + \texttt{T} or, from the \textit{Edit} menu, choose Trim.

Only the portion of selected events outside the time selection is trimmed. Unselected events remain. The time information (space) between events is not removed.

<table>
<thead>
<tr>
<th>Events before trim</th>
<th>Clipboard contents</th>
<th>Events after trim</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Waveform before trim]</td>
<td>Trimmed information is not placed on the Clipboard.</td>
<td>![Waveform after trim]</td>
</tr>
</tbody>
</table>

Edge trimming events using the keyboard

With this method, you can quickly jump through your project and adjust cuts until they're perfectly synchronized. If you have an external multimedia controller, it's even easier.

1. If you want downstream events to ripple as you trim, click the Auto Ripple button ( ) to turn on Auto Ripple mode.
2. Select the event you want to trim.
3. Press 7 or 9 on the numeric keypad to move the cursor to the event edge you want to trim. 7 selects the beginning of an event or moves to the previous event edge. 9 selects the end of the event or moves to the next event edge. Vegas displays a red bracket to indicate which event edge will be trimmed.

\textbf{Note: You can also perform this step using the [ or ] keys.}
4. Use the 1, 3 and 4, 6 keys on the numeric keypad to trim the current event edge:
   - Press 1 to trim one video frame left, or press 3 to trim one video frame right (or hold \[Ctrl\]+\[Shift\]+\[Alt\] while rolling the mouse wheel).
   - Press 4 to trim one pixel left, or press 6 to trim one pixel right (or hold \[Ctrl\]+\[Shift\] while rolling the mouse wheel). Depending on the current zoom level, the trim duration will vary.

   **Note:** Pressing 5 on the numeric keypad exits edge-trimming mode. If you are not in edge-trimming mode, 1, 3, 4, and 6 on the numeric keypad to nudge events on the timeline by frame (1 and 3) or by pixel (4 and 6).

5. Repeat steps 3 and 4 as necessary.

**Splitting events**

Vegas allows you to create multiple, independently functioning events from a single event by splitting it. Splitting creates a new ending point for the original event and creates a starting point for the newly created event.

Splitting an event does not alter the original media. The original media file's information is there, but is omitted for playback based on where the event's starting or ending point occurs on the timeline.

When split, the two new events are flush against one another. The two events can be moved independently.

**Splitting an event**

1. Select the event(s) to be split. *For more information, see [Making selections on page 58](#).*

2. Place the cursor at the timeline position where the split will occur.

3. From the **Edit** menu, choose **Split**, or press \[5\].

**Splitting all events at the cursor**

All events are split at the cursor's position (unless an event is locked). The split occurs across all tracks (if no events are selected).
**Splitting selected events**

Only the selected events are split at the cursor's position.

**Splitting a time selection**

Unless locked, all events within the time selection are split at the starting and ending points of the time range, meaning that two splits are made. The split occurs across all tracks.

**Splitting a time selection across selected events**

Only selected events within the time selection are split at the starting and ending points of the time range.
Slipping and sliding events

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The window can display the entire media file or a small section. When the window displays only a portion of the media file, you can move either the window or the underlying media to adjust the media that is played by an event:

- When you **slip** an event, your event maintains its place on the timeline, but the media file moves in the direction you drag.
- When you **slide** an event, the media file maintains its place on the timeline, but the event moves in the direction you drag.

---

**Tip:** You can also slip or slide grouped events (at the same time) or slide a crossfade between two events. For more information, see Grouping events on page 127 or Sliding a crossfade on page 75.

---

**Shifting the contents of (slipping) an event**

Press [Alt] while dragging an event. The slip cursor appears ( ).

As you drag the event, the contents of the event shift, but the event does not move. You can use this technique when you want to maintain an event’s length and position, but have the event play a different section of the source media file.

**Slip-trimming an event**

Press [Alt] while dragging the right or left edge of an event. The slip-trim cursor appears ( ).

As you drag the event edge, the media moves with the event edge.
Sliding an event

Press **Ctrl** + **Alt** while dragging an event. The slide cursor appears ( ).

As you drag, the relative position of the media remains fixed on the track, and the event position changes. You can use this technique when you want to maintain an event’s length, but have the event play a different section of the source media file at a different point in your project.

Tip: You can apply a ripple edit after slip-trimming or sliding an event. For more information, see Applying post-edit ripples on page 72.

Deleting events

Deleting an event removes it from its track. Multiple events can be deleted and time selections can be used to modify the process. Ripple editing also applies to delete actions. Deleting operates exactly like a cutting operation, but the removed information is *not* placed on the Clipboard. For more information, see Cutting events on page 62.

1. Select the events to be deleted.
2. Press **Delete**.
Applying post-edit ripples

You can apply a post-edit ripple that affects either the edited track(s), the track(s) and certain project elements, or everything in the timeline. The power lies in the fact that you can apply this post-edit ripple to a wide variety of editing tasks, such as trimming, crossfading, cutting, pasting, and deleting events. You can also choose to apply your ripple edits manually or automatically.

You can ripple the contents of the timeline following an edit after performing these tasks:

- trimming (pg. 66), slip-trimming (pg. 70), and sliding (pg. 71) events
- time compressing/stretching events (pg. 90)
- cutting events (pg. 62)
- pasting events (pg. 63)
- deleting events (pg. 71)

Ripple editing also affects how Vegas adds material from the Trimmer window. For more information, see Using the Trimmer window on page 93.

Vegas also provides a quick and easy method for shuffling a sequence of events on a track. Decide that the third event in a series should really be the second instead? You can drag the event to a new position and instruct Vegas to shuffle the events into their new order.
Applying a post-edit ripple manually

1. Perform one of the edits discussed above. Above the timeline, an arrow indicates where the post-edit ripple will occur and the direction the affected events will move.

2. From the Edit menu, choose Post-Edit Ripple, and choose a command from the submenu:
   - Affected Tracks ripples only the track(s) where you performed the edit.
   - Affected Tracks, Bus Tracks, Markers, and Regions ripples the track(s) where you performed the edit and ripples any keyframes or envelopes on those tracks. This command also ripples any markers, regions, CD layout markers, and command markers in the project.
   - All Tracks, Markers, and Regions ripples all tracks and all keyframes and envelopes on those tracks. This command also ripples any markers, regions, CD layout markers, and command markers in the project.

Vegas ripples the timeline after the edit according to the option you choose.

Tip: You can press F after an edit to ripple the affected tracks, or you can press Ctrl + F to ripple markers, keyframes, and envelopes too. To ripple everything after an edit, press Ctrl + Shift + F.

Applying a post-edit ripple automatically

1. Click the arrow button next to the Auto Ripple button ( ) and choose a ripple type:
   - Affected Tracks ripples only the track(s) where you performed the edit.
   - Affected Tracks, Bus Tracks, Markers, and Regions ripples the track(s) where you performed the edit and ripples any keyframes or envelopes on those tracks. This command also ripples any markers, regions, CD layout markers, and command markers in the project.
   - All Tracks, Markers, and Regions ripples all tracks and all keyframes and envelopes on those tracks. This command also ripples any markers, regions, CD layout markers, and command markers in the project.

2. Perform one of the edits discussed above. Above the timeline, an arrow indicates where the post-edit ripple will occur and the direction the affected events will move.

3. Vegas ripples the timeline after the edit according to the ripple type you choose.
Shuffling events

Vegas provides a quick way to change the order of a sequence of events in a track. Right-click and drag an event to a new location in the track and choose **Shuffle Events** from the shortcut menu that appears. Vegas shuffles the events into the new order.

Crossfading events

Vegas allows you to crossfade between two events on the same track. For audio events, crossfading fades out one audio event’s volume while another event’s volume fades in. For video events, crossfading creates a transition between two events, one fading out while the other fades in. Lines appear indicating how and when the event’s volume or transparency is being affected.

Using automatic crossfades

The automatic crossfade feature turns the overlapping portions of two events into a smooth crossfade. This feature is turned on as a default. Click the **Automatic Crossfades** button or press **Ctrl+Shift+X** to turn automatic crossfades on and off.

Vegas also provides an option for creating automatic crossfades when you add multiple media files to a track. For more information, see **Automatically crossfading inserted events on page 47**.
Manually setting a crossfade

Vegas does not insert an automatic crossfade if a shorter event is placed on top of and within the same time frame of a longer event. In this case, the longer event begins playing, then the shorter event plays, and then the longer event resumes playing at the timeline position. You can manually create a crossfade to fade in and out of the shorter event.

1. Place the mouse pointer on one of the shorter event’s handles. The envelope cursor appears ($\bullet$).
2. Drag the handle to the desired position.

This is a fast and effective method of inserting a voiceover on top of a background music track (although the music fades out completely) or to replace a bad section of audio. For more information, see Punching-in and crossfading events on page 65.

Changing crossfade curves

You can change the crossfade curves that Vegas uses to fade in and out between two events.

1. Right-click anywhere in the crossfade region to display a shortcut menu.
2. From the shortcut menu, choose Fade Type, and choose the desired fade type from the submenu.

Tip: If you use the same crossfade curve frequently, you can set it as a default for all new audio or video crossfades. For more information, see Editing tab on page 277.

Sliding a crossfade

You can slide a crossfade between two events without affecting the total length of the two overlapping events. This process is similar to sliding and slipping events. For more information, see Slipping and sliding events on page 70.

Press [Ctrl] + [Alt] while dragging the overlapping area between two events. The slide crossfade cursor appears ($\bullet$).
As you drag, the relative position of the media remains fixed on the track, and the crossfade position changes, effectively trimming the edge of the event in the direction you drag. You can use this technique when you want to maintain the length of two combined events but want the transition to occur earlier or later.

![Two events with a crossfade.](image)

![Sliding the crossfade to the left...](image)

![...and to the right.](image)

### Using undo and redo

Vegas gives you unlimited undo and redo functionality while working on your project, even to the extent of being able to undo changes made before the last time a project was saved (but not closed). While you are working with a project, Vegas creates an undo history of the changes that you have performed. Each time you undo something, that change is placed in the redo history.

When you close the project or exit Vegas, both the undo and redo histories are cleared.

#### Using undo

Pressing `Ctrl` + `Z` or clicking the Undo button (prominent) reverses the last edit performed. Repeatedly using the keyboard command or toolbar button continues undoing edits in reverse order, from most recent to oldest. In addition, you may undo the last edit by choosing it from the Edit menu.

#### Undoing a series of edits

You can undo a series of edits by using the drop-down list on the Undo button.

1. Click the arrow to the right of the Undo button (prominent).

2. From the drop-down list, choose the edit that you want to undo. Items above it (subsequent edits) are selected automatically. Vegas restores your project to the state prior to those edits.

When you undo an edit or a series of edits, they are added to the redo history. This feature allows you to restore your project to a previous state.

---

**Tip:** From the Edit menu, choose Undo All to undo all edits in the history. All edits are undone and added to the redo history.
Using redo

Pressing \texttt{Ctrl} + \texttt{Shift} + \texttt{Z} or clicking the \texttt{Redo} button (\texttt{R}) redoes the last undo performed. Repeatedly using the keyboard command or toolbar button continues redoing undos in reverse order, from most recent to oldest. In addition, you may redo the last edit by choosing it from the \texttt{Edit} menu.

Redoing a series of edits

You can view the redo history by clicking the arrow on the right side of the \texttt{Redo} button (\texttt{R}). The top item in the list that appears is the most recent undo edit. If you redo a specific edit that appears farther down the list, all subsequent edits above it are redone as well.

When you redo an edit or a series of edits, they are added to the undo history again. The redo history is cleared when a new edit is performed.

Clearing the edit history

You can clear both undo and redo histories without closing your project or exiting Vegas. Once the histories have been cleared, Vegas begins creating a new edit history as you continue working on the project. While clearing the edit history is not usually necessary, it can free up disk space. To clear the edit history, choose \texttt{Clear Edit History} from the \texttt{Edit} menu.

Adding project markers and regions

Vegas provides several types of project markers that identify parts of your project, serve as cues, and provide additional functionality:

- **Markers** are points that you mark along the project's timeline. They are typically used to mark locations in the project for later reference or to mark timing cues.
- **Regions** are ranges of time that you mark along the timeline. Regions identify ranges of time for your reference and can function as permanent time selections.
- **Command markers** are markers that enable metadata in streaming media files. These markers can be used to display headlines or closed captions, link to Web sites, or perform any other function you define. For more information, see Adding closed captioning to Windows Media Video (WMV) files on page 174. In addition, these markers can be used to embed Scott Studios data information, which is used extensively in broadcasting. The Sonic Foundry Web site (http://www.sonicfoundry.com) has a number of metadata examples complete with source code.
- **CD layout markers** are markers that indicate tracks and indices for an audio CD layout. Vegas uses these marks to create tracks and index points when burning an audio CD. For more information, see Understanding tracks and indices on page 249.

Tip: You can use ripple editing to automatically move markers and regions as you edit in the timeline. For more information, see Applying post-edit ripples on page 72.

Working with markers

Markers are useful for identifying and navigating to specific locations in longer projects. As you place markers in your project, Vegas automatically numbers them in the order that they are placed. Markers appear as orange tags above the ruler. You may name them and reposition them along the project's timeline.
Inserting a marker at the cursor
1. Position the cursor where you want to place the marker.
2. From the Insert menu, choose Marker, or press M.
3. Type a name for the marker and press Enter. If you do not want to name the marker, simply press Enter.

Inserting a marker during playback
During playback, press M. The marker appears on the marker bar. You may name the marker after it has been set.

Naming (or renaming) a marker
1. Place the mouse pointer on the marker you want to name or rename. The pointer changes to a hand icon (H). 
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Rename. A text box opens next to the marker.
4. Type the marker name.
5. Press Enter to set the marker’s name.
You can also double-click an existing name or double-click the space just to the right of a marker to rename it.

Moving markers
You can reposition a marker by dragging it on the marker bar.

Navigating to markers
You can jump the cursor to any marker on the timeline by clicking the marker. You can also jump to a marker by pressing the number keys along the top of the keyboard (not the numeric keypad).

Tip: Jump the cursor to the next or previous marker by pressing [Ctrl] + → or [Ctrl] + ←.
Deleting markers

1. Place the mouse pointer on the marker that you want to delete. The pointer changes to a hand (Cursor).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Delete. The marker is removed from your project.

Vegas does not renumber the tags as you remove them. For example, if you have five markers in your project and delete markers 3 and 4, the remaining markers will be listed as 1, 2 and 5. However, as you add markers again, Vegas begins numbering the missing sequence first, in this case 3 and 4, then 6, 7, 8, etc.

Deleting all markers and regions

1. Right-click the marker bar.

2. From the shortcut menu, choose Markers/Regions, and choose Delete All from the submenu.

Working with regions

Regions identify ranges of time and provide a way to subdivide your project. A region is defined as the area between two region markers that share the same number. Regions can function as semi-permanent time selections. You can view region information in the Explorer by clicking the arrow next to the View button (Cursor) and selecting Region View.

Inserting regions

1. Make a time selection. For more information, see Selecting a time range on page 59.

2. From the Insert menu, choose Region, or press [R].

3. Type a name for the region and press [Enter]. If you do not want to name the region, simply press [Enter].

Region markers display at the beginning and end points of a time selection.

Moving regions

Drag a region marker to reposition it. To move both region markers (start and end markers) at once, hold [Alt] while dragging a region marker.
**Naming regions**

1. Place the mouse pointer on the left region marker you want to name or rename. The pointer changes to a hand icon ( ).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose **Rename**. A text box appears next to the region marker.
4. Type the region’s name.
5. Press **Enter** or click anywhere in the track view to set the name.

**Selecting regions**

You may select the events, across all tracks, within the region for editing or playing back.

1. Right-click one of the region markers to display a shortcut menu.
2. From the shortcut menu, choose **Select Region**.

---

**Tip:** You can also select a region by pressing a number on your keyboard (not the numeric keypad) or by double-clicking a region marker.

---

**Navigating to regions**

You can move the cursor to the start or end of a region by clicking either region marker. You may press **Ctrl + →** or **Ctrl + ←** to move the cursor to the next or previous region markers.

Right-click a region marker to display a shortcut menu that allows you to navigate to the beginning (**Go to Start**) or the end (**Go to End**) of a region.

**Deleting regions**

1. Place the mouse pointer on the region marker’s starting or ending point. The pointer changes to a hand icon ( ).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose **Delete**. The region is removed from your project.

Vegas does not renumber the tags as you remove them. For example, if you have five regions in your project and delete region 3 and 4, the remaining regions are listed at 1, 2 and 5. However, as you add regions again, Vegas begins numbering the missing sequence first, in this case 3 and 4, and then 6, 7, 8, etc.

**Deleting all regions and markers**

1. Right-click the marker bar.
2. From the shortcut menu, choose **Markers/Regions**, and choose **Delete All** from the submenu.
Working with command markers

Command markers add interactivity to a multimedia presentation streamed over the Internet by inserting metadata into streaming media files. As your video plays, any number of other actions can be programmed to occur. These commands are a part of the Microsoft Windows Media and RealMedia streaming formats. Most frequently, these actions add text or open a related Web site where the viewer can find more information about the topic at hand. The specific commands available vary depending on the final format of your project.

**Note:** Windows Media Player 9 will ignore metadata commands unless the Run script commands when present check box is selected on the Security tab of the player’s Preferences dialog. Be sure to instruct your audience to select this check box before playing your file.

You can use command markers to add closed captions to your project. For more information, see Adding closed captioning to Windows Media Video (WMV) files on page 174.

Command markers can also indicate when an instruction (function) will occur in a WAV file being used in a radio broadcast environment (Scott Studios data). The following two sections define the markers for both streaming media and Scott Studios files.

**Note:** While streaming media files can be played on any hard drive or CD-ROM, they require a special streaming media server (provided by your Internet service provider) to stream properly across the Internet.
Defining streaming media commands

In a streaming media file, command markers can be used to display headlines, show captions, link to Web sites, or any other function you define. Vegas includes several command types that you may add to a streaming media file. Some command types are exclusive to either the Windows Media (WMV) or the RealMedia (RM) player.

<table>
<thead>
<tr>
<th>Command</th>
<th>Player type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Windows Media</td>
<td>Indicates when an instruction is sent to the user’s internet browser to change the content being displayed. With this command, you enter the URL that displays at a specific time during the rendered project’s playback.</td>
</tr>
<tr>
<td>Text</td>
<td>Windows Media</td>
<td>Displays text in the captioning area of the Windows Media Player located below the video display area. You enter the text that will display during playback.</td>
</tr>
<tr>
<td>WMTextBodyText</td>
<td>Windows Media</td>
<td>Displays the entered text in the text window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextHeadline</td>
<td>Windows Media</td>
<td>Displays the entered text in the headline window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>Author</td>
<td>Windows Media</td>
<td>Displays the entered text (Author’s name) when a user selects About This Presentation from the RealPlayer’s shortcut menu.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Windows Media</td>
<td>Displays the entered copyright information when a user selects About This Presentation from the RealPlayer’s shortcut menu.</td>
</tr>
<tr>
<td>HotSpotPlay*</td>
<td>RealMedia</td>
<td>Displays the RealMedia file specified in the Parameter box when users click the RealPlayer video display.</td>
</tr>
<tr>
<td>HotSpotBrowse*</td>
<td>RealMedia</td>
<td>Displays the Web page specified in the Parameter box when users click the RealPlayer video display.</td>
</tr>
<tr>
<td>HotSpotSeek*</td>
<td>RealMedia</td>
<td>Jumps to the time specified in the Parameter box when users click the RealPlayer video display.</td>
</tr>
</tbody>
</table>

Defining Scott Studios data commands

For WAV files using Scott Studios data, command markers can be used to define information about the WAV file.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCOTT EOM</td>
<td>Calculates when the next queued clip starts playing in a Scott Studios system. For more information, please refer to your Scott Studios documentation.</td>
</tr>
<tr>
<td>SCOTT Cue In</td>
<td>Set the beginning of a file in a Scott Studios System without performing destructive editing. For more information, please refer to your Scott Studios documentation.</td>
</tr>
</tbody>
</table>

Inserting command markers

Command markers appear as blue tags on the command bar, which is above the marker bar.

1. Position the cursor where you want to place the command marker.
2. From the Insert menu, choose Command, or press C.
3. Complete the Command Properties dialog:
   - If desired, choose a custom template from the Template drop-down list. For more information, see Saving command properties as a custom template on page 83.
   - Choose the type of command from the Command drop-down list.
   - In the Parameter box, enter parameters to define the behavior of the command.
   - Enter your own notes or comments in the Comments box.
   - Specify the timing of the command in the Position box. Otherwise, command markers are automatically set to the current cursor position.

4. Click OK. The new command marker appears on the command bar.

**Editing command properties**

Double-click any command marker to open the Command Properties dialog and edit its contents. You can also right-click a command marker and choose Edit from the shortcut menu.

**Saving command properties as a custom template**

If you plan to use a command more than once, you can save command properties as a template. You can then reuse the command properties by choosing the template from the Template drop-down list.

1. Create a command and complete the Command Properties dialog.
2. Enter a name for the template in the Template box.
3. Click the Save Template button ( ).

---

**Note:** Vegas saves your metadata command templates in the cmdtemp.xml file in the Vegas program folder. You can edit this file directly to modify your templates.
Deleting command markers
1. Place the mouse pointer on the command marker. The pointer changes to a hand icon (♀).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The command marker is removed from your project.

Working with CD layout markers
Markers on the CD layout bar indicate the locations of tracks and indices in an audio CD layout project. These markers are discussed in a later chapter. For more information, see Understanding tracks and indices on page 249.

Using an external audio editing program
Vegas is a nondestructive editing environment, which means that the original source files remain unchanged by any editing done in Vegas. Destructive (constructive) edits that modify the actual source media file may be done in a separate application such as Sonic Foundry’s Sound Forge®. By setting up a separate audio editor, you can quickly access the program from Vegas via the Tools menu or by pressing Ctrl+E.

Setting up an audio editing program
If you already have Sound Forge loaded on your computer when you installed Vegas, the installation should have detected it and made it your default audio editing program. However, if you do not have Sound Forge or want to specify a different audio editor, you may do so in the Preferences dialog.

1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. In the Preferences dialog, click the Audio tab.
3. Click the Browse button to the right of the Preferred audio editor box. The Preferred Audio Editor dialog appears.
4. From this dialog, navigate to the application to use for editing audio files.
5. Select the application’s executable icon (.exe) and click Open to set the application as your default audio editor.

The application’s path displays in the Preferred audio editor box.
Opening an audio editor from Vegas

All events in your Vegas project are references to media files on a storage device. When you edit an audio event in an audio editor, you can choose to open the original media file or a copy of the file.

Opening a file in an audio editor

You can directly edit the media file to which an audio event is referenced. Any changes you make and save in the audio editor are permanent and are reflected in the event in your Vegas project.

1. Select the event to be edited.
2. From the Tools menu, choose Audio, and choose Open in Audio Editor from the submenu.

Your selected audio editing application opens the event’s referenced media file. Make the necessary changes and save the file in the audio editor. If you keep the media file’s name and location the same, its event is updated immediately in your Vegas project. However, if you change the media file’s name or location (by using Save As), you must import the edited (new) file into Vegas.

Opening a copy of a file in an audio editor

You can also create a copy of an audio file and open it in an audio editor. Opening a copy of a file has the advantage of preserving the original file unchanged. The modified copy is inserted into the event as a take and is automatically added to the Media Pool.

1. Select the event to be edited.
2. From the Tools menu, choose Audio, and choose Open Copy in Audio Editor from the submenu.

When you are finished editing, save the file. Vegas adds “Take X” to the end of the filename to distinguish it from the original and adds it to the project as a take. If you save it to a new file (by using Save As), you must manually add it as a take into the project. For more information, see Working with takes on page 91.
This chapter builds on the techniques that were introduced in the last chapter. Ripple editing, pitch shifting, and takes are just three of the more advanced editing topics that are covered in this chapter.

Snapping events

Vegas is preset to snap events into place as you drag them. Events can snap to another event's edges, to the cursor position, or to a time selection. Vegas also allows events to snap to grid lines and markers. As you move an event along the timeline, its edge automatically aligns to designated snap points. At the highest level, all features in Vegas can quantize to individual frames.

Turning snapping on and off

You can quickly turn snapping on and off by clicking the Enable Snapping button ( ). Vegas also allows you to selectively turn snapping options on and off in the Options menu:

- **Enable Snapping** controls all snapping behavior except quantizing to frames.
- **Snap To Grid** controls snapping to grid markers. Vegas provides a variety of grid measurements. For more information, see Changing grid spacing on page 265.
- **Snap To Markers** controls snapping to markers. This command applies to markers, regions, command markers, and CD layout markers. For more information, see Adding project markers and regions on page 77.

Quantizing to frames

The Quantize To Frames command in the Options menu takes snapping one step further. With this feature enabled, everything snaps to the starting edge of individual project frames. Quantizing affects how you can move events, place markers, make selections, and position the cursor.

Quantizing to frames means that the position of markers, regions, events, and the cursor are limited to the start of an individual video frame.
Using the event snap offset

Each event in your project has a snap offset flag that can be moved along the length of the event. The flag is the white triangle that is located in the lower-left corner of each event. This flag allows you to designate where snapping occurs. This is useful if you need to align the snap with a beat in the event instead of the edge.

1. Place the mouse pointer on the snap offset triangle. The pointer changes to a hand icon ( Dön ).
2. Drag the snap offset flag to the new position in the event. As the flag moves, a time display appears. This time display indicates where the snap offset flag occurs in time in the event.
3. Release the mouse to set the snap offset flag.

Snapping to the cursor or a selection

You can snap two clips in the same track end-to-end, but how can you snap two events on separate tracks? You can easily snap to specific event boundaries in any track by making a time selection for the event.

1. Double-click the event you want to snap to. The time selection area on the ruler sets to the length of the event.
2. Drag another clip in a different track near the end of the first clip. It snaps into position.

In this example, Vegas snaps the second event to the edge of the time selection. Because events also snap to the cursor, you could accomplish the same task by pressing Ctrl + Alt + → or Ctrl + Alt + ← to position the cursor on the edge of the first event. Once the cursor is on the event edge, you can snap the second event to the cursor.
Pitch shifting audio events

A pitch shift is a way to raise or lower the pitch of an audio event. Vegas provides three ways to pitch shift:

- The **Change Length, Preserve Pitch** method shifts the length without altering the pitch of the event.
- The **Change Pitch, Preserve Length** method shifts the pitch without altering the length of the event.
- The **Change Length and Pitch** method speeds up or slows down the audio and changes the pitch at the same time. You can shorten the event duration and raise the pitch, or lengthen the event duration and lower the pitch.

The semitone range in Vegas is -24 to 24. Twelve semitones equal one octave, so you may increase or decrease the pitch of an event within a two-octave range. Within each semitone is a finer pitch adjustment called cents. There are one hundred cents in one semitone.

1. Right-click an audio event to display a shortcut menu.
2. From the shortcut menu, choose Properties.
3. From the Method list, select Change Length, Preserve Pitch, or Change Pitch, Preserve Length, or Change Length and Pitch.
4. Adjust the pitch shift in the Semitone, Cents, or both by using the arrows or by typing the desired value.
5. Select the desired crossfade mode from the Crossfade dropdown list.
6. Click OK to set the pitch shift for the event.
Time compressing/stretching events

Time compressing/stretching audio while maintaining pitch is only available in the full version of Vegas.

Time stretching and compressing events is the process of using the same amount of source media to fill a shorter or longer event. While this can be done to both video and audio events, the two cases are fundamentally different.

Press [Ctrl] and drag the edge of the event toward the center of the event to compress (shorten) it or drag the edge out away from the center to stretch (lengthen) it.

You can see the results of the time compression or stretching by viewing the properties of the event. Right-click the event and choose Properties from the shortcut menu. Time compressing/stretching an audio event affects the Time stretch/pitch shift settings, while Time compressing/stretching a video event affects the Playback rate setting.

Tip: You can time compress/stretch several events at once by grouping them first. You can also apply a ripple edit after time compressing or stretching events. For more information, see Grouping events on page 127 or Applying post-edit ripples on page 72.

Time compressing/stretching video

Time stretching video allows you to fill a given duration with a set amount of actual video, sometimes called fit-to-fill. For example, if you have a five-second video event and you want this event to fill an eight-second slot, press [Ctrl] and drag the edge of the event to eight seconds. The resulting video is in slow motion, but the contents (footage) remain the same. If you had used a velocity envelope to slow the video to the same rate, the event would also be in slow motion, but its duration would remain unchanged at five seconds. Stretched video has a zigzag line between thumbnails. Video can also be compressed (sped up and shortened in length) by using this method.

When stretching video events or slowing video down, a set number of frames are extended across a period of time. For example, if you take source footage at 30 frames in a second and slow it so that only 15 source frames run during that same second, an additional 15 frames must be created to maintain the project’s 30 fps frame rate. Simply duplicating frames is the easiest way to do this. A more sophisticated method is to resample the frames of an event, allowing Vegas to interpolate and redraw these intervening frames. For more information, see Resample (video only) on page 121 and Resampling video on page 177.
Working with takes

A take is a version of a scene or audio recording, as in “Scene 10, Take 7”, which means the seventh time that scene number ten has been shot. Vegas allows you to include a number of takes in the same location (event) of the project. You can then rapidly switch between these separate takes to see which one fits into the project the best. Although this is what takes are designed for, you can actually use any media files you want as a take, even completely different sounds or scenes. Since an event is just a container of a specific length and at a specific location, the actual content (media file) is easily changed.

Adding takes

You can add multiple media files to the timeline at the same time to a single event as takes. You can also add regions within media files as takes. For more information, see Adding regions as takes on page 96.

Adding media files to the timeline as takes

1. Locate the media files that you want to insert as takes in the Explorer and select them. Select a range by pressing Shift and clicking the first and last file in the range, or select nonadjacent files by pressing Ctrl and clicking the various clips individually.
2. Right-click and drag one of the selected clips in the group to the timeline.
3. From the shortcut menu, choose Add as Takes.

Tip: To add either just the audio or just the video portions of files as takes, choose Video Only: Add Video as Takes or Audio Only: Add Audio as Takes from the shortcut menu.

Adding takes to existing events

You can add media files to existing events as takes.

1. Right-click a media file in the Explorer and drag it to an existing event.
2. From the shortcut menu, choose Add as Takes.

Selecting takes

When you add an event with multiple takes, a single event is inserted into a track. Vegas sets the length of the event according to the last clip that was selected. This last clip is set as the active take.

1. Right-click an event with multiple takes.
2. From the shortcut menu, choose Take, and choose Next Take or Previous Take from the submenu. Alternately, choose the name of the take from the list at the bottom of the submenu.

Tip: Click an event and press T to select the next take or Shift + T to select the previous take.
Previewing and selecting takes

Vegas allows you to preview the takes for a given event.

1. Select an event containing multiple takes.
2. Right-click to display a shortcut menu or, from the Edit menu, choose Take to display a submenu.
3. Choose Choose Active... from the submenu. The Take Chooser dialog appears.
4. Select the take that you want to preview and use the Play ( ) and Stop ( ) buttons within the dialog.
5. To use a take, select it and click OK. The selected take is now the active take.

Deleting takes

You can delete individual takes from an event at any time.

1. Right-click an event with multiple takes.
2. From the shortcut menu, choose Take, and choose Delete Active from the submenu to immediately remove the active take. Alternately, choose Delete to open a dialog with a list of all of the takes contained in this event.

Working with take names

Displaying take names on events

Take names may be displayed on the events in the timeline.

1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. On the General tab, select the Show active take name in events check box.
3. Click OK.

Changing take names

Changing the name of a take does not affect the source media file in any way. Typically, you may want to change an event's name after recording multiple takes into a track or event. For more information, see Working with multiple recorded takes on page 152.

1. Select the take to be renamed. For more information, see Selecting takes on page 91.
2. Right-click the event to display a shortcut menu.
3. From the shortcut menu, choose Properties. The Properties dialog opens.
4. Type the new name in the Active take name box.
5. Click OK to set the new take name.
Using the Trimmer window

The Trimmer allows you to work with and edit one media file at a time. The entire file is opened into the Trimmer, in contrast to events on the timeline that may only contain a portion of the actual source file.

The main function of the Trimmer window is to allow you to trim a media file and place portions of it on a track. You can also add regions and markers to a file, preview the media file, or open it in an external audio editing program.

You can open any number of files in the Trimmer at the same time, selecting the one you currently want to work on from the Trimmer history drop-down list.

From the View menu, choose Trimmer or press \text{Alt} + \text{2} to display the Trimmer window, if it is not already visible. You can dock the Trimmer window in the window docking area or float it over the work area. For more information, see Window docking area on page 22.

Opening a file in the Trimmer

1. Right-click an event. A shortcut menu appears.
2. Choose Open in Trimmer.

You can also drag files to the Trimmer from the Explorer or the Media Pool.

Double-clicking a file to open it in the Trimmer

You can set Vegas to open a file in the Trimmer when you double-click the file in the Media Pool or Explorer windows.

1. From the Options menu, choose Preferences.
2. Click the General tab.
3. Choose Double click on media file loads into Trimmer instead of tracks.
Moving frame-by-frame in the Trimmer window

As you navigate through a video file in the Trimmer, the exact frame that the cursor is over in time is displayed as in a thumbnail image under the cursor. When using the left and right arrow keys, this allows you to edit with frame accuracy. Make sure Animate video frames in Trimmer is selected in the Preferences dialog to use this feature.

Making selections in the Trimmer

After you have opened a media file in the Trimmer, you may select a segment of it and place it in your project. Make a time selection to select a segment in the Trimmer in the same way you do in the project timeline. For more information, see Selecting a time range on page 59.

You can make a selection during playback by using the keyboard. Press  or  to mark the start of the selection, and press  or  to mark the end.

If you know the exact timecode of the point where you want to begin and end a time selection, you can enter it into the boxes at the lower right corner of the Trimmer window.

Tip: Press  to recall the last five time selection areas in the Trimmer.

Adding selections to the timeline

You can use the Trimmer window to do traditional three-point and two-point editing. These editing techniques allow you to add smaller sections of files to the timeline.

Post-edit ripple mode affects how a selection is added to the timeline from the Trimmer. When the Auto Ripple button ( ) is selected, adding a selection from the Trimmer selection affects the position of later events on the track. When Vegas is not in post-edit ripple mode, adding a selection from the Trimmer has no effect on the position of other events. For more information, see Editing events on page 61.
Adding selections at the cursor

1. Open a media file in the Trimmer.
3. Select the track in the timeline where the selection will be added.
4. Position the cursor in the timeline at either the start or end point where you want to add the selection.
5. Add the selection to the timeline in one of the following ways:
   - Click the Add Media from Cursor button ( ) or press \[A\] to insert the event after the cursor.
   - Click the Add Media up to Cursor button ( ) or press \[Shift + A\] to insert the event before the cursor.

Alternately, you can drag the selection from the Trimmer to the timeline.

Note: Post-edit rippling (if enabled) applies to clips inserted from the Trimmer. For more information, see Editing events on page 61.

Filling a time selection on the timeline

You can select a range of time on the project timeline and then fill it with the same length selection from the Trimmer.

1. Create a time selection in the timeline where you want to add the event. This sets the duration and position of the event that you will create.
2. Open the media file you want to use to fill the time selection in the Trimmer window.
3. Right-click the file in the Trimmer window and choose Sync Track View Selection Time from Cursor or Sync Track View Selection Time up to Cursor from the shortcut menu. Vegas creates a time selection in the file in the Trimmer window to match the time selection in the timeline.
4. Adjust the location of the time selection in the Trimmer as needed by dragging the time selection (the area between the yellow triangles) on the Trimmer marker bar.
5. Drag the event from the Trimmer to the timeline and allow it to snap into place within the time selection.

Adding selections from a media file with audio and video

You can open a file in the Trimmer that has both audio and video streams (e.g., AVI). When you add a selection from this type of file to the timeline, both streams are added:

- If you select a video track before adding the selection, Vegas adds the video to the selected track and adds the associated audio to the track below it.
- If you select an audio track before adding the selection, Vegas adds the audio to the selected track and adds the associated video to the track above it.

Vegas creates new tracks for the added media if necessary.
Adding and saving regions and markers to a media file

The Trimmer allows you to add markers and regions to a media file in the same way that you add them to your project. Media file markers and regions are different from project markers and regions. The difference between the two is that project markers and regions affect a project, while media file markers and regions are embedded in, and saved with, a media file. For more information, see Adding project markers and regions on page 77.

The markers and regions you add in the Trimmer are only temporary. You must save them by clicking the Save button ( ) in the Trimmer window if you want to use them again after you close the project. After the markers and regions are added and saved to the media file, they are available when you open the media file in an audio editor program or in the Trimmer.

Note: You cannot save markers to read-only media files. Change a file's properties to make the file writable before saving markers.

Automatically saving Trimmer markers and regions with media files

1. From the Options menu, choose Preferences.
2. On the General tab, select Automatically save trimmer markers and regions with media file.

Adding regions as takes

Once regions are saved with a media file, either in the Trimmer window or in another application, you can add the regions as takes to the timeline from the Explorer window. In the Explorer window, click the arrow next to the View button and select Region View from the drop-down list. A single media file may contain a number of separate regions. You can select these regions individually or as groups and insert them as takes into the timeline. This is especially useful when loop-recording numerous takes to a single file. For more information, see Working with takes on page 91.
Viewing media markers and regions in events

From the View menu, choose Event Media Markers to toggle the display markers and regions that are saved in a media file. These markers are displayed in the timeline in events that refer to the media file.

Media markers and regions cannot be edited within the event. However, when you edit the markers in markers and regions in the Trimmer window or in an external audio editor, the event will reflect your changes.

Media markers in Trimmer

Tip: When media markers are displayed, you can use them as snap points for positioning the cursor and for edge-trimming if Snap to Markers is selected on the Options menu. If a media file’s frame rate does not match your project frame rate, frame quantization will occur after the snap if Quantize to Frames is selected on the Options menu.

Opening a file in an external audio editor from the Trimmer

The Trimmer allows you to open your selected audio editing application (e.g., Sound Forge) to perform permanent edits to the media file. After you make the necessary changes and save the file in the audio editor, Vegas automatically updates the event. Make sure that the media file’s name and location remain the same. For more information, see Using an external audio editing program on page 84.

To open the audio editor from the Trimmer, click the Open in Audio Editor button ( ).

Using the Edit Details window

The Edit Details window displays a database for all of the media in your project. It shows information about how the files are being used and allows you to modify many of those properties. You may sort, add or change information, rearrange columns, and edit items in the project.

This window provides an alternate method for working with events, audio CD track list items, command markers, markers, and regions after they are placed in your project.

You can dock the Edit Details window in the window docking area or float it on the workspace. For more information, see Window docking area on page 22.
Viewing the Edit Details window

To view the Edit Details window, choose Edit Details from the View menu or press Alt + 4. The Show dropdown list allows you to view categorized project information. You can edit most entries by double-clicking them or by right-clicking them to display a shortcut menu.

Audio CD track list

The Audio CD track list category displays information about the track and index markers placed on the CD layout bar. Vegas uses this information to burn audio CDs. For more information, see Understanding tracks and indices on page 249.

Commands

The Commands category displays information about commands that are placed along the project's timeline. This category displays four columns: the command's position along the timeline, the command type, its parameters, and any comments that were entered when the command marker was placed in your project. Right-click a command entry to display a shortcut menu. For more information, see Working with command markers on page 81.
Events

The Events category displays information about all of the events in your project. You may sort any of the information by clicking a column's header. The number of columns in the Events category requires that you use the scroll bar to view them all.

The following table explains each column in the Events category and describes its function.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Edit function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Displays the track number where the event is located.</td>
<td>Move the event to a different location by entering a different track number (pg. 48).</td>
</tr>
<tr>
<td>Start</td>
<td>Displays when on the timeline the event starts playback.</td>
<td>Enter a different value to cause the event to begin playback sooner or later in the project (pg. 48).</td>
</tr>
<tr>
<td>End</td>
<td>Displays when on the timeline the event ends playback.</td>
<td>Enter a different value to cause the event to end playback sooner or later in the project (pg. 48).</td>
</tr>
<tr>
<td>Length</td>
<td>Displays the total length of the event.</td>
<td>Enter a different value to increase or decrease the event's playback time.</td>
</tr>
<tr>
<td>Number of Takes</td>
<td>Displays the amount of recorded takes contained in the event.</td>
<td>Cannot be edited (display only).</td>
</tr>
<tr>
<td>Active Take Name</td>
<td>Displays the event's current take name.</td>
<td>Enter a different name for the current take (pg. 92).</td>
</tr>
<tr>
<td>Take Start</td>
<td>Displays the offset into the source media file when the placed event begins playback.</td>
<td>Enter a different value to cause the take to playback sooner or later from the source media file.</td>
</tr>
<tr>
<td>Timecode In</td>
<td>Displays the media file timecode at the start of the event.</td>
<td>Display only (cannot be edited).</td>
</tr>
<tr>
<td>Timecode Out</td>
<td>Displays the media file timecode at the end of the event.</td>
<td>Display only (cannot be edited).</td>
</tr>
<tr>
<td>File Path</td>
<td>Displays the path of the event's media file.</td>
<td>Enter a new media file reference path for the event to use.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>Displays the name of the source media tape name.</td>
<td>Change the tape name here or in the properties dialog for the media file (pg. 181).</td>
</tr>
<tr>
<td>Select</td>
<td>Displays whether the event is selected in the project.</td>
<td>Toggle the event's selection by clicking the check box. A check mark in the box indicates that the event is selected (pg. 58).</td>
</tr>
<tr>
<td>Mute</td>
<td>Displays whether the event is muted.</td>
<td>Toggle the event's mute switch by clicking the check box. A check mark in the box indicates that the event is muted (pg. 119).</td>
</tr>
<tr>
<td>Loop</td>
<td>Displays whether the event is looped for playback.</td>
<td>Toggle the event's loop switch by clicking the check box. A check mark in the box indicates that the event is looped for playback (pg. 119).</td>
</tr>
<tr>
<td>Lock</td>
<td>Displays whether the event is locked.</td>
<td>Toggle the event's lock switch by clicking the check box. A check mark in the box indicates that the event is locked (pg. 119).</td>
</tr>
<tr>
<td>Normalize</td>
<td>Displays whether the event is normalized.</td>
<td>Toggle the event's normalize switch by clicking the check box. A check mark in the box indicates that the event is normalized (pg. 120).</td>
</tr>
<tr>
<td>Snap Offset</td>
<td>Displays when in the event the snap offset is positioned.</td>
<td>Enter a different value to change the snap offset position in the event (pg. 88).</td>
</tr>
</tbody>
</table>

Markers

The Markers category displays information about markers on the project’s timeline. This category displays two columns: the marker’s position on the timeline and the marker’s name. For more information, see Working with markers on page 77.

Regions

The Regions category displays information about regions on the project’s timeline. This category displays four columns: the region’s start position, end position, length, and name. For more information, see Working with regions on page 79.

Selected Events

The Selected Events category is visually identical to the Events category except that the Edit Details window only displays information about events that are selected in your project.
Customizing the Edit Details window

You may arrange and delete columns from each category and save the changes to a personal template. Vegas has one template from which you may create your own display options.

1. From the Show drop-down list, choose the category that you want to customize.

2. Drag a column’s header to the new position. The cursor changes to a column icon ( ) as you move the column. If you want to remove the column from the display, drag the icon off the Edit Details window. Release the mouse to drop the column in its new position.

3. The Template drop-down name changes to “Untitled.” Enter a new name in the Template drop-down.

4. Click the Save button ( ) on the Edit Details window to save the custom display.

Tip: You can delete a custom display by selecting it from the template drop-down list and clicking the Delete button ( ).
Tracks contain the media events on the timeline of a project. There are two types of tracks: video and audio. Each type of track has its own features and controls. While tracks can be organized and mixed in any order, track hierarchy can be important in determining the final output for video. Because tracks are containers for events, effects that are applied to a track apply to every event in that track.

Vegas provides unlimited audio and video tracks and fourteen compositing modes. Vegas LE limits you to four audio tracks, two video tracks, and source alpha compositing.

Managing tracks

Once you have added a track to your project, you may perform basic editing tasks on it such as duplicating, deleting, and renaming.

Inserting an empty track

Vegas creates tracks for you when you drag events to empty spaces in the timeline. You can also add empty (eventless) tracks to a project. You can record into these tracks or use them as placeholders for specific media that you will add later. For example, you may want to create an empty track and then record a voiceover directly into a project.

1. Right-click in either the track view or the track list to display a shortcut menu.

2. Choose Insert Audio Track or Insert Video Track.

You may also add an empty track from the Insert menu by choosing Audio Track or Video Track. Vegas adds an empty track at the bottom of the track list.

Duplicating a track

You can duplicate a track in your project including all of the events contained on it. When you duplicate a track, the duplicate is placed directly below the original track. You can duplicate one track or select multiple tracks to duplicate.
1. Click the track that you want to duplicate. To select multiple tracks, click each one while pressing Shift to select adjacent tracks or Ctrl to select nonadjacent tracks.

2. Right-click and choose Duplicate Track from the shortcut menu.
Deleting a track

You can delete a track from your project and all of the events contained on it. You can delete one track or select multiple tracks to delete.

1. Select the track that you want to delete. To select multiple tracks, click each one while pressing \( \text{Shift} \) to select a range of adjacent tracks or \( \text{Ctrl} \) to select discontinuous tracks.

2. From the Edit menu, choose Delete.

Tip: You can also delete a track by selecting it and pressing \( \text{Delete} \).

Naming or renaming a track

Every track in your project has a scribble strip where you can type a name for the track. The track name may be up to 255 characters long. If the scribble strip is not visible, you may need to increase the height or width of the track by dragging the track's edge to reveal it. For more information, see Changing track height on page 104.

1. Double-click the scribble strip. Any existing name is highlighted on the strip.
2. Type the new track name.
3. Press \( \text{Enter} \) to save the track's name.

Organizing tracks

Vegas is flexible in how tracks can be organized. You can arrange and resize tracks to fit your particular needs.

Reordering tracks

When you create tracks, Vegas arranges them in the order that they were added. It is a simple process to reorder tracks to fit your needs. You may reorder one or more tracks at a time.

Note: Track hierarchy can be critical in video compositing. For more information, see Compositing on page 190.

1. In the track list, place the mouse pointer on the track that you want to move.
2. Drag the track to the new position in the track list.

Tip: When moving a track, you may want to place the mouse pointer on the track number when dragging. This helps avoid accidental modifications to other track list controls.
Changing track color

When you add a track, Vegas automatically assigns it a color. This color is easily changed. This feature is useful if you want to use color to organize similar tracks.

1. In the track list, right-click a track to display a shortcut menu.
2. From the shortcut menu, choose Track Display Color, and choose a color from the submenu.

Changing track height

You can control track height by dragging the bottom edge of a track in the track list. You can also change track height by clicking the buttons on the track list.

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Resulting Track height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize Track Height</td>
<td>![Button Image]</td>
<td>![Track Height Minimized]</td>
</tr>
<tr>
<td>Restore Track Height</td>
<td>![Button Image]</td>
<td>![Track Height Restored]</td>
</tr>
<tr>
<td>Maximize Track Height</td>
<td>![Button Image]</td>
<td>![Track Height Maximized]</td>
</tr>
</tbody>
</table>

You can also use several different keyboard shortcuts to change all track heights at once:

- Press Ctrl+Shift+ to change the height of all tracks in your project at once.
- Press to minimize all tracks. Press the key again to restore the tracks to their previous height.
- Press Shift+ to make all tracks a uniform height slightly shorter than the default.
- Press Ctrl+ to make all tracks the default height.

Resizing a track

You can resize a track by dragging its bottom or the right border. Place the mouse pointer at the bottom of the track. The cursor turns into an up/down arrow ( ). Drag up or down and release the mouse to set the desired track size. You can resize the width of the track list in a similar way.
Using the track list

Each track in your project has its own controls, faders, and sliders that are contained in the track list on the left side of the track. You can work with these controls to affect the events on the track.

Using the volume fader (audio only)

This fader controls the volume of the events on a particular audio track. The fader's range is \(-\inf\) to 12 dB. To adjust the fader, drag it to the desired volume level. As you drag the fader, the volume level displays to the left of the fader. Double-click the fader to set it to 0.0 dB, or double-click the current volume value to enter a specific number.

Tip: Press Ctrl while dragging or use the mouse wheel for finer control of the fader. You can also move the fader by using the right or left arrow keys.

Volume envelopes allow you to automate track volume changes. For more information, see Working with track envelopes on page 109.

Using the multipurpose slider (audio only)

This slider controls several features, including panning, bus send levels, and assignable effects send levels. The options for the multipurpose slider depend on what your project contains (e.g., busses, assignable effects, etc.). You can select what the slider controls by clicking the slider label. Each item's slider position is independent from the others.

Tip: If you do not see this slider on a track, increase the track height. For more information, see Resizing a track on page 104.

You can move the slider by pressing Shift+the right or left arrow keys.
Adjusting stereo panning

When you click the slider label and choose Pan from the menu, the slider controls the position of a track in the stereo field. Vegas audio tracks are preset to center the signal. Move the slider to adjust the signal’s output left or right. As you move the slider, Vegas displays the signal’s percentage going to either the left or right channel. For example, moving the slider to 60%L means that sixty percent of the signal is mixed to the left channel, while forty percent is mixed to the right.

You can further control the panning by right-clicking the multipurpose slider and selecting an option from the shortcut menu:

- The Add Channels panning model is most useful for panning stereo source material. This model makes the stereo image appear to move as a unit between the speakers. As the fader is moved from the center to a side, more and more of the signal from the opposite side is folded into the side you are panning towards, until at the extreme, both channels are fed at full intensity into a single channel. This panning model uses a linear panning curve.
- The Balance panning model is most useful for adjusting the relative signal levels of the right and left channels in stereo source material. In this model, moving from the center to a side, the opposite side starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no signal level. The signal in the side you are panning towards starts at the base dB level (either 0 dB, -3 dB, or -6 dB) and increases to 0 dB. This panning model uses a linear panning curve.
- The Constant Power panning model is most useful for panning mono source material. As you move the fader from side to side, this model creates the illusion of the source moving around the listener from one side to the other in a semi-circle. This model uses a constant-power panning curve.

You can add a pan envelope to automate panning changes. For more information, see Working with track envelopes on page 109.

Adjusting bus levels and assignable effects send levels

If you add a bus or an assignable effects chain to your project, you can control the level of tracks sent to these mixer controls using the multipurpose slider. Bus and assignable effects send levels are preset to -inf. dB (mute) for playback. Click the slider label and choose the mixer control from the menu, then move the slider to adjust the send level. For more information, see Adjusting a bus send level on page 142 or Assigning audio tracks to assignable effects chains on page 143.

Note: Multiple busses and assignable effects are only available in the full version of Vegas.

Using the composite level slider (video only)

This slider determines the opacity of the video track. Drag the slider to control the transparency or blending of each track. Left is 100% transparent and right is 100% opaque. You can also double-click the percent to enter a specific value.

Bypassing motion blur envelopes (video only)

If you applied a motion blur envelope to your video bus track (available only in the full version of Vegas), this envelope affects all tracks. You can select specific tracks to bypass this envelope by clicking a track’s Bypass Motion Blur button ( ). For more information on motion blur envelopes, see Adding a motion blur envelope on page 115.
Using track motion (video only)

Use the Track Motion button ( ) to move a video track over another track (i.e., picture-in-picture). For more information on adding track motion, see Adding track motion on page 217.
Phase inverting a track (audio only)

The Invert Track Phase button ( ) inverts the audio track at its baseline, in effect reversing its polarity. Inverting a track, while creating little audible difference, is occasionally useful for matching transitions when mixing audio on separate tracks or fine-tuning a crossfade.

You can also phase invert an audio event. If an event on a track is inverted and you invert the track, the event is doubly-inverted (restored to its original state). For more information, see Invert phase (audio only) on page 120.

Muting a track

The Mute button ( ) in the track list temporarily suspends playback of the track so that you can focus on another track. When a track is muted, it appears grayed out on the track view. You can mute more than one track at a time.

To mute a track, click the Mute button. To mute several tracks, select the tracks and click the Mute button on any of the selected tracks. Click the Mute button again to restore the track(s).

Tip: Press Ctrl and click the Mute button to mute only the selected track (and restore any other muted tracks). If the selected track is already muted, press Ctrl and click the Mute button to restore all tracks.

Muting all audio or video tracks

You may mute either all audio or all video tracks in a project. From the Options menu, choose Mute All Audio or Mute All Video.

Soloing a track

The Solo button ( ) in the track list isolates a track’s events for playback and mutes the other non-soloed tracks. This allows you to focus on a track’s contents without the distraction of other tracks. You can solo more than one track at a time.

To solo a track, click the Solo button on that track. To solo several tracks, select the tracks and click the Solo button on any of the selected tracks. Click the Solo button again to restore the track(s) for playback.

Tip: Press Ctrl and click the Solo button to solo only the selected track (and restore any other soloed tracks). If the selected track is already soloed, press Ctrl and click the Solo button to restore all tracks.
Setting default track properties

You can use the settings of a selected track to determine the default settings for all new tracks in your project. Properties that can be set appear in the Set Default Track Properties dialog.

1. Set up a track in your project with the properties to use as default settings for new tracks.

2. Right-click the track number and choose Set Default Track Properties. The Set Default Track Properties dialog appears.

3. Select the check boxes that you want to set as defaults.

4. Click OK.

Vegas creates any new tracks in the project with these defaults. To return to the original settings for new tracks, select the Restore original defaults check box in the Set Default Track Properties dialog.

Working with track envelopes

Track envelopes allow you to control and automate volume, audio panning, opacity, and fade to color effects of a particular track over time.

<table>
<thead>
<tr>
<th>Track Type</th>
<th>Envelope type</th>
<th>Description</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Volume</td>
<td>Controls track volume.</td>
<td>Blue</td>
</tr>
<tr>
<td>Audio</td>
<td>Bus send volume</td>
<td>Controls track level sent to bus.</td>
<td>Lilac</td>
</tr>
<tr>
<td>Audio</td>
<td>Assignable effects send volume</td>
<td>Controls track level sent to assignable effects control.</td>
<td>Green</td>
</tr>
<tr>
<td>Audio</td>
<td>Pan</td>
<td>Controls the position of a track in the stereo field (pan).</td>
<td>Red</td>
</tr>
<tr>
<td>Video</td>
<td>Composite level</td>
<td>Controls track opacity/transparency.</td>
<td>Blue</td>
</tr>
<tr>
<td>Video</td>
<td>Fade to color</td>
<td>Controls fading of a track to color. Designate a top and bottom color by right-clicking the track, choosing Fade Colors from the shortcut menu, and choosing Top or Bottom from the submenu.</td>
<td>Red</td>
</tr>
</tbody>
</table>

Composite Level envelopes and Fade to Color envelopes are only available in the full version of Vegas.

Adding track envelopes

You may add any type of envelope by following the same basic steps.

1. Select the track(s) where you want to add the track envelope.

2. From the Insert menu, choose either Audio Envelopes or Video Envelopes, and choose the type of envelope you want to add from the submenu.

Tip: You can also right-click an empty area of a track, choose Insert/Remove Envelope from the shortcut menu,
Adding bus envelopes

A bus envelope controls the level of a track sent to a particular bus. Before you can add a bus envelope, you must add busses to the project. For more information, see Adding busses to a project on page 139.

1. Select the track to which you want to add the bus envelope. You may select multiple tracks, if desired.

2. Add the envelope to the selected track(s) in one of the following ways:
   - From the Insert menu, choose Envelopes, and choose the bus for which you want to add an envelope from the submenu.
   - Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose the appropriate bus from the submenu.
   A purple line representing the envelope appears across the track(s).

Adding effect automation envelopes

If a plug-in supports automation, you can use envelopes to adjust effect parameters over time. The appearance of the plug-in in the Plug-In Chooser window indicates whether the plug-in supports automation. Plug-ins with this icon ( ) support automation, while plug-ins with this icon ( ) do not. In addition, you can quickly locate plug-ins that support automation in the Automatable subfolder.

1. Click the Track FX button ( ) on a track to open the Audio Plug-In window.
   If no track effects exist, clicking the Track FX button displays the Plug-In Chooser. Use the Plug-In Chooser to create an effect chain including an automatable plug-in.

2. Click the FX Automation button ( ) to display the FX Automation Chooser.

3. Click a plug-in at the top of the FX Automation Chooser. A list of the effect’s automatable parameters appears.

4. Select the check box for each parameter that you want to control with an envelope. You can use the Select All and Select None buttons to quickly change your selections to all or none of the parameters.

5. Click OK to close the FX Automation Chooser.

   Envelopes display on the track for parameters that you selected in the FX Automation Chooser. To control which effect parameter envelope displays on the track, click the arrow adjacent to the Track FX button ( ) and choose an envelope from the menu.

   Press E to toggle through the display of all effect parameter automation envelopes.
Adding envelope points

Once you add an envelope to a track, you may add points to it. These points are used to edit the envelope line in order to automate the control.

1. Place the mouse pointer on the envelope’s line. The pointer changes to a hand icon (/gif).
2. Right-click and choose Add Point from the shortcut menu or double-click to add an envelope point. A square point appears on the envelope line.

Tip: You can use ripple editing to automatically move envelope points as you edit in the timeline. For more information, see Applying post-edit ripples on page 72.

Deleting envelope points

You can delete a point by right-clicking it and choosing Delete from the shortcut menu. If you want to delete all envelope points, right-click a point and choose Reset All from the shortcut menu.

Moving envelope points

Once you have added envelope points, you can raise and lower them to different levels along the timeline, or you can adjust the envelope’s location along the timeline by dragging it right or left. You can move one point at a time, even during playback and check the results in real time. If snapping is enabled, the envelope point snaps to time divisions as you drag. Hold Shift while dragging to override snapping.

Tip: You can move multiple envelope points at once using the Envelope Edit tool. For more information, see Using the Envelope Edit tool on page 112.

1. Place the mouse pointer on an envelope point. The pointer changes to a hand icon (/gif).
2. Drag the point to the desired position. As you move an envelope point, a ToolTip displays both the point’s location on the timeline and its decibel level/percent pan.
3. Click the Play (/gif) or Play From Start (/gif) button to play the project and check the timing of the envelope.

Tip: You can also set the value of the point by right-clicking an envelope point and choosing a setting from the shortcut menu.
Changing envelope fade curves

You can set the type of fade curve Vegas uses after each envelope point: linear, fast, slow, smooth, or sharp. You can select either a point or a portion of the envelope to set the fade curve. If you select a portion of the envelope, Vegas applies the fade curve to that envelope segment. If you select a point, Vegas applies the fade curve to the segment of the envelope after the selected point.

1. Right-click a point or a portion of the envelope to display a shortcut menu.
2. From the shortcut menu, choose the curve type.

Tip: If you use the same fade curve frequently, you can set it as a default all new audio or video envelopes. For more information, see Editing tab on page 277.

Hiding track envelopes

After you have set your envelopes on the tracks, you can hide them from the track view. Hiding track envelopes does not affect playback. The points that you set still automate the controls, even though the envelopes are not visible.

1. From the View menu, choose either Audio Envelopes or Video Envelopes. A submenu appears. Envelopes that are currently displayed are selected in the submenu.
2. From the submenu, choose an envelope name. All envelopes in your project of that type no longer appear in the track view.

Removing track envelopes

When an envelope is removed, the events on the track no longer have automated control and the envelope line no longer displays.

1. Select the track(s) from which you want to remove envelopes.
2. From the Insert menu, choose either Audio Envelopes or Video Envelopes. A submenu appears. Envelopes that are currently displayed are selected.
3. From the submenu, click an envelope name. The envelope of that type is removed from the selected track.

Alternately, right-click an empty area of a track, choose Insert/Remove Envelope from the shortcut menu, and choose an envelope type from the submenu to remove that envelope.

Note: When you remove a track envelope from a track and then add it again, all points are reset.

Using the Envelope Edit tool

You can also edit envelope points using the Envelope Edit tool. To use this tool, click the Envelope Edit Tool button ( ). The advantage of switching to this tool to edit envelopes is that events cannot be moved when this tool is selected, thereby protecting them from changes. This effectively locks all of the events and effects in a project while you modify envelopes.
Selecting and adjusting envelope points
1. Select the Envelope Edit Tool button ( ).
2. Click within a track to select it.
3. Drag along the timeline to select envelope points.
4. Drag the selected envelope points to a new position.
To deselect envelope points, click anywhere in the event that is not part of the envelope.

Cutting, copying, and pasting envelope points
1. Select the Envelope Edit Tool button ( ).
2. Click within a track to select it.
3. Drag along the timeline to select envelope points.
4. From the Edit menu, choose Cut or Copy.
5. Click to position the cursor where you want to paste envelope points. Click within a different track if you want to paste envelope points to another track.
6. From the Edit menu, choose Paste. The envelope points are pasted in the new position.

Copying an envelope to another track
1. Select the Envelope Edit Tool button ( ). The Envelope Edit tool is active.
2. Click within a track to select it.
3. From the Edit menu, choose Select All.
4. From the Edit menu, choose Copy.
5. Click within a track to select it.
6. Click Go to Start ( ) if you want the envelope to appear exactly as it was in the original track, or click to position the cursor where you want the envelope to start.
7. From the Edit menu, choose Paste. The envelope is pasted on the track.
Working with Track Envelopes

Locking envelopes to events

Track envelopes extend for the length of a track and are independent of the events on the track. This means that the envelope remains in place when you move the events in the track. However, track envelopes can be set to move with the underlying events, thus preserving the timing of envelope points in relation to events.

To lock all of the envelopes in a project to the events in which they occur, click the Lock Envelopes to Events button ( ) or, from the Options menu, choose Lock Envelopes to Events. You can turn this feature off by clicking the button again.

Using audio bus tracks

Audio bus tracks are only available in the full version of Vegas.

From the View menu, choose Audio Bus Tracks to toggle the display of audio bus tracks at the bottom of the track view. An audio bus track exists for each bus or assignable effects chain in your project and serves as a timeline representation of each bus or assignable effects chain.

You can use bus tracks to automate volume, panning, and effect parameters using envelopes. If a bus track has envelopes applied, its icon will include a fader ( ) in the bus track and in the Mixer window.

The selected bus track displays a flashing cursor in its icon.

Adding envelopes to an audio bus track

Adding volume, panning, and effect automation envelopes to a bus track is just like adding an envelope to a standard track. For information on adding envelopes, see Working with track envelopes on page 109.

Adding effects to audio bus tracks

Click the Bus FX button ( ) in the bus track header to add or edit bus effects. If there are no effects on the bus, clicking this button displays the Plug-In Chooser. If an audio bus already has effects assigned, clicking this button displays the Audio Plug-In window.

Clicking this button has the same effect as clicking the button on a bus control in the Mixer window or the Video Preview window.

If the bus effects chain includes plug-ins with automatable parameters, the Bus FX button is displayed as a .

Muting or soloing an audio bus track

Click the Mute ( ) or Solo ( ) button in the bus track header to mute or solo a bus.

Clicking these buttons on a bus track has the same effect as clicking the buttons on a bus control in the Mixer window.
Resizing audio bus tracks

You can drag the horizontal splitter between the track list and bus tracks to increase or decrease the space allocated to bus tracks. Perform any of the following actions to resize individual bus tracks:

- Drag a bus track’s bottom border to set its height.
- Click Minimize ( ) to minimize a track vertically.
- Click Maximize ( ) to zoom in vertically so a bus track fills the lower portion of the timeline.
- After minimizing or maximizing a bus track, click Restore ( ) to return a bus track to its previous height.
- Press [Ctrl]+[Shift]+[A] when the bus track area has focus to resize all bus tracks at once.

Using video bus tracks

Video bus tracks are only available in the full version of Vegas.

From the View menu, choose Video Bus Tracks to toggle the display of the video bus track at the bottom of the track view. A single bus track exists as a timeline representation of the main video output.

You can use bus tracks to animate video output effects using keyframes, add motion blur envelopes, or video supersampling envelopes.

Adding keyframes to the video bus track

Adding keyframes to the video bus track is just like working with any other video track. Use video bus track keyframes to animate video output effects. For information on adding keyframes, see Using keyframe animation on page 209.

Adding a fade-to-color envelope

You can add fade-to-color, motion blur amount, and video supersampling envelopes to the video bus track to affect your video output.

Adding and editing a fade-to-color envelope is just like adding an envelope on a standard video track, but it affects all tracks. For more information on adding envelopes, see Working with track envelopes on page 109.

Adding a motion blur envelope

Motion blur can help you make computer-generated animation look more realistic. For example, if you use track motion or event pan/crop to move a clip across the frame, each frame is displayed clearly when no motion blur is applied. Turning on motion blur adds a motion-dependent blur to each frame to create the appearance of smooth motion in the same way a fast-moving subject is blurred when you take a photograph with a slow shutter speed.

**Note:** Motion blur significantly increases your rendering time. Adjust the envelope to apply motion blur only where necessary.

1. Right-click the video bus track, choose Insert/Remove Envelope from the shortcut menu, and then choose Motion Blur Amount from the submenu.

2. Add and adjust envelope points as necessary to set the time interval that will be used for blurring. Increasing the value emphasizes the blur effect. For example, setting the envelope to 0 means no blurring will occur; setting the envelope to 1 second means that each frame will be blurred for one-half second before and after the frame.
3. The motion blur envelope affects all tracks. To bypass motion blur for a track, select the Bypass Motion Blur button ( ) in the track header.

4. To change blur type, choose a setting from the Motion blur type drop-down list on the Video tab in the Project Properties dialog. This setting determines the shape of the blur and the opacity of the frames.

Adding a video supersampling envelope

Video supersampling can improve the appearance of computer-generated animation by calculating intermediate frames between the project’s frame rate, allowing you to create smoother motion blurring or motion from sources such as track motion, event pan/crop, transitions, or keyframable effects.

Note: The effect of video supersampling is less apparent with video that contains fast motion, and supersampling cannot improve the appearance of existing video.

1. Right-click the video bus track, choose Insert/Remove Envelope from the shortcut menu, and then choose Motion Blur Subsampling from the submenu.

2. Add and adjust envelope points as necessary to indicate how many frames will be calculated between frames (using the project’s frame rate) to create the blur.

Note: Video supersampling significantly increases your rendering time. For example, when you set the video supersampling envelope to 2, Vegas renders twice as many frames as it would without supersampling. Adjust the envelope to apply supersampling only where necessary.

Adding effects to video bus tracks

Click the Video Output FX button ( ) in the bus track header to add or edit video output effects. If there are no video output effects, clicking this button displays the Plug-In Chooser. If you’ve already set up video output effects, clicking the button displays the Video Output FX window.

Muting the video output

Click the Mute button ( ) in the bus track header to mute all video output.

Bypassing video effects and envelopes

Click the Bypass FX and Envelopes button ( ) in the bus track header to bypass all video output effects and bus track envelopes.

Resizing video bus tracks

You can drag the horizontal splitter between the track list and bus tracks to increase or decrease the space allocated to bus tracks. Perform any of the following actions to resize individual bus tracks:

- Drag a bus track’s bottom border to set its height.
- Click Minimize ( ) to minimize a track vertically.
- Click Maximize ( ) to zoom in vertically so a bus track fills the lower portion of the timeline.
- After minimizing or maximizing a bus track, click Restore ( ) to return a bus track to its previous height.
- Press Ctrl + Shift + I when the bus track area has focus to resize all bus tracks at once.
Rendering to a new track

Rendering to a new track is only available in the full version of Vegas.

Rendering or mixing multiple tracks to a single track can be a good method of decreasing the complexity of a project and speeding up future renders. The original tracks and their events are unaffected when you render (mix) to a single track.

Typically, you would use this feature when you are finished refining a few tracks and want to combine them. When you render multiple tracks, any envelope or track effects that you have applied are rendered into the new track. The original source files remain unaffected and the new track(s) are saved to a new file.

When working with DV files, select a DV template to avoid any loss of quality. For more information, see Working in DV format on page 178.

Note: Every video render that uses compression results in a loss of quality from the original source material. To minimize loss of quality, minimize the number of video renders that use compression.

1. Select the tracks that you want to combine. To mix specific events, make a time selection.

2. From the Tools menu, choose Render to New Track or press Ctrl + M. The Render to New Track dialog appears.

3. Complete the dialog as follows:
   - From the Save in drop-down list, select the drive or folder to save the new media file.
   - Type a file name in the File name box.
   - From the Save as type drop-down list, choose the file format (e.g., .wav for audio or .avi for video).
   - From the Template drop-down list, choose a format from the template list. Alternately, click Custom to set custom rendering settings. For more information, see Customizing the rendering process on page 242.
   - Select Render loop region only if you only want to render the time selection area.
   - Select Stretch video to fill output frame size (do not letterbox) to adjust the aspect ratio so the output frame is filled on all edges. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterboxing).

4. Click Save to render to a new track.

As the tracks are being rendered (mixed down), a small dialog appears displaying the progress of the render. A status bar also appears in the lower-left portion of Vegas.

Tip: You can cancel the rendering process by clicking the Cancel button on the status bar.

After Vegas renders the new track, it appears at the top of the track view. If you render the entire project, you may delete (or mute) the other tracks from the project, since they are all contained on the new track.
Events are windows into media files in a project and are the most basic unit of editing in Vegas. Media files that are inserted into the timeline are automatically contained within an event. Trimming and editing an event does not affect the source media file in any way.

**Setting event switches**

Event switches are important functions that are used to determine the basic behavior of events in Vegas. You can set switches for a single event or multiple events at the same time.

1. Right-click an event.
2. From the shortcut menu, choose **Switches**, and choose the desired switch from the submenu.

   Active switches have a check mark next to them. Choose an active switch on the menu to remove the check mark and turn it off.

   **Tip:** You can also set switches in the **Edit** menu, in the **Edit Details** window, or by right-clicking an event and choosing **Properties**.

**Mute**

Use the Mute switch to mute an event. This prevents the event from playing back.

**Lock**

The Lock switch locks an event to prevent it from being moved or edited.

**Loop**

You can loop an event so that you can extend it along the timeline by dragging the right edge of the event. Notches appear in the top of the event to mark where the media in the event ends and then repeats.
For video events, turning off the Loop switch makes the last frame repeat for the duration of the event beyond its original length, creating a freeze frame effect (as in the middle example below). The Loop switch is enabled for the event in the last example below.

Invert phase (audio only)

This switch inverts the audio event at its baseline, in effect reversing its polarity. Inverting an event, while creating no audible difference, is occasionally useful for matching transitions when mixing audio on separate tracks or fine-tuning a crossfade. You can also phase invert a track. If a track is inverted and you invert an event on the track, the event is doubly-inverted (restored to its original state). For more information, see Phase inverting a track (audio only) on page 108.

Normalize (audio only)

You may normalize an event to maximize its volume, based on the waveform’s highest peak, without clipping the event during playback.

Recalculating the normalization

When you normalize an event, Vegas analyzes the event and raises the volume based on the waveform’s highest peak and then adjusts the rest of the event accordingly. If you have adjusted the edge of an event to exclude the (formerly) highest waveform peak, you may want to recalculate the event’s normalization.

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Properties dialog opens.
3. Click Re-calculate to normalize the event again.

**Tip:** You can set the maximum decibel level used by Vegas to calculate the event during normalization. For more information, see Audio tab on page 268.

### Maintain aspect ratio (video only)

Video and image files of various sizes and formats can be included in a single project. The project itself may have a different frame size aspect ratio from the source media files. This is not a problem, but you must specify how Vegas handles these differences. If the length-to-width ratio of the source media and the project’s frame size are the same (e.g., source media at 320x240 and project frame size of 640x480), no aspect ratio distortion occurs. If the ratios are not the same, the source material may become distorted (stretched or compressed). By maintaining the aspect ratio of the original, Vegas keeps the video from becoming distorted by letterboxing or pillarboxing around the edges. This is the default setting.

The BMP media file in this example is 320x100, while the project is set to 320x240.

### Reduce interlace flicker (video only)

This switch can be useful in cases where the source material didn’t originate as video and contains extremely high spatial or temporal frequencies. When you watch the rendered (interlaced) output on video of this sort of media, you may see flickering or crawling edges if this switch is not applied.

### Resample (video only)

Resampling allows Vegas to interpolate frames in an event when the frame rate of a media file is significantly different from the project’s frame rate. Resampling may solve some interlacing problems and other jittery output problems. For more information, see Resampling video on page 177.

Vegas provides three options for event-level resampling:

- **Smart resample:** Vegas only resamples the event when the event frame rate does not match the project output frame rate. This can occur either because the event has a velocity envelope or because the frame rate of the original media is different than the project frame rate. **Smart resample** is the standard setting.
- **Force resample:** Vegas always resamples the event, regardless of its frame rate or the project’s frame rate.
- **Disable resample:** Vegas does not resample the event.
Accessing event properties

Vegas automatically determines the properties of an event based on the properties of the source media file. In addition to the event switches (mute, loop, etc.) described in the previous section, event properties include playback and undersample rates for video and pitch shifting for audio.

1. Right-click an event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Properties dialog appears.

The first tab in the dialog, either Audio Event or Video Event, contains the properties that are exclusively Vegas-related. The second tab, the Media tab, contains many properties that are an inherent part of the media file itself.

In addition to the event switches discussed in this chapter, event properties include the following:

- **Playback rate** box sets the rate of playback. For example, a playback rate of 1 plays at normal speed, while a playback rate of 0.5 plays at half speed. For more information, see Time compressing/stretching events on page 90.
- **Undersample rate** box allows you to simulate a lower frame rate. For example, an undersample rate of 0.5 plays the event at half its original frame rate. Each frame plays twice as long as in the original media file, creating a strobe effect.
- **Time stretch/pitch shift** section of the dialog allows you to change the pitch, duration, or both pitch and duration of an audio event. For more information, see Pitch shifting audio events on page 89.

---

**Pitch shifting while preserving length and time stretching while preserving pitch are only available in the full version of Vegas.**

Adjusting audio channels

A stereo audio event has two channels: right and left. You can adjust how Vegas plays these channels by right-clicking an event, choosing Channels from the shortcut menu and choosing one of the following commands from the submenu:

- **Both** plays both channels in stereo. This is the default setting.
- **Left Only** plays only the left channel. Playback is mono and is centered between the two channels.
- **Right Only** plays only the right channel. Playback is mono and centered.
- **Combine** adds the two channels into a single channel and divides the level in half to prevent clipping. Playback is mono and is centered between the two channels.
- **Swap** exchanges the right and left channels (stereo playback).

You can also pan from one channel to the other using either the multipurpose slider or a pan envelope. For more information, see Adjusting stereo panning on page 106.
Copying and pasting event attributes

You’ve set up one event exactly the way you want it, and now you want to apply the same attributes to another event. Vegas provides a quick way to copy the attributes of one event and paste them onto another.

You can copy and paste multiple event attributes, including:

- Properties (pg. 122), including audio pitch shift (pg. 89) and video playback rate (pg. 90)
- Switches (pg. 119)
- Video event plug-ins (pg. 183)
- Cropping (pg. 167)

1. Click the event with the attributes you wish to copy and click the Copy button ( ).

2. To paste the event attributes to multiple events, select the events. For more information, see Selecting multiple events on page 58.

3. Right-click an event and choose Paste Event Attributes from the shortcut menu. Vegas pastes the attributes onto the selected event(s).

Using audio event envelopes (ASR)

You may apply envelopes to individual events. Envelopes, also known as ASRs (attack, sustain, and release), give you the ability to control an audio event's fade-in, fade-out, and overall volume level.

---

**Note:** Event envelopes only affect an event. Track envelopes affect the entire track. For more information, see Working with track envelopes on page 109.

---

When you add an event to your project, Vegas adds handles that are used to set the envelope. As you use these handles on audio events, a volume envelope appears indicating how the event is being affected.

Setting an audio event’s volume

When you place the mouse pointer at the top of the event, the pointer changes to a hand cursor ( ) that you can use to lower the event’s overall volume.

1. Place the mouse pointer at the top of the event.

2. When you see the envelope cursor ( ), drag the volume envelope to the desired level. As you drag, Vegas displays the event’s decibel level.
Setting an event’s fade in and out

The event handles allow you to change an audio event’s fade in and out volume. You can also change the type of curve that the event uses to control the volume’s fade in or out.

1. Place the mouse pointer on a handle (upper corners of the event). The pointer changes to the envelope cursor ( ).

2. As you drag, the volume envelope appears. Vegas displays both the time in the event and the decibel level.

Changing an event’s fade curve

You can set the shape of the fade curve (fast, linear, slow, sharp, or smooth) that an event uses to raise or lower the volume over time. To access the different fade curves, right-click anywhere in the event’s fade-in or fade-out region and choose Fade Type from the shortcut menu.

Tip: If you use the same fade curve frequently, you can set it as a default for all new audio event envelopes. For more information, see Editing tab on page 277.

Using video event envelopes

Velocity envelopes are only available in the full version of Vegas.

Video envelopes allow you to control an event’s opacity or velocity over time. Envelopes appear as lines on an event. With a velocity envelope, you have the added control of being able to create and edit envelope points.

Note: Event envelopes only affect an event. Track envelopes affect the entire track. For more information, see Working with track envelopes on page 109.
Using opacity envelopes

Opacity envelopes set the overall opacity and allow you to fade video events in and out. This affects the transparency of the event in relation to background events on lower tracks. These background events can be other video events or background colors. For more information, see Using generated media on page 189.

**Setting a video event’s opacity**

When you place the mouse pointer at the top of the event, the pointer changes to a hand cursor ((strcmpi) that you can use to lower the event’s overall opacity.

1. Place the mouse pointer at the top of the event.
2. When you see the envelope cursor (strcmpi), drag the opacity envelope to the desired level. As you drag, Vegas displays the event’s opacity level.

**Setting an event’s fade in and out**

The event handles allow you to change a video event’s fade in and out. You can also change the type of curve that the event uses to control the fade in or out.

1. Place the mouse pointer on a handle (upper corners of the event). The pointer changes to the envelope cursor (strcmpi).
2. As you drag the cursor, the opacity envelope appears. Vegas displays both the time in the event and the opacity level as you drag.

**Changing an event’s fade curve**

You can set the shape of the fade curve (fast, linear, slow, sharp, or smooth) that an event uses to increase or decrease the opacity over time. To access the different fade curves, right-click anywhere in the event’s fade-in or -out region and choose Fade Type from the shortcut menu.

---

**Tip:** If you use the same fade curve frequently, you can set it as a default for all new video event envelopes. For more information, see Editing tab on page 277.

---

Using velocity envelopes

Velocity envelopes are only available in the full version of Vegas.

You can use velocity envelopes to change the speed of a video event over time. To view a velocity envelope, right-click the event and choose Insert/Remove Velocity Envelope.

1. Right-click an event and choose Insert/Remove Velocity Envelope. The velocity envelope appears on the event as a blue line.
2. To increase the speed, drag the envelope up. To slow the video down, drag the envelope down.

**Adding velocity envelope points**

When combined with points, envelopes can be used to animate velocity changes.
1. Double-click the envelope where you want to add a point.

2. Drag the point to adjust it. Vegas displays the time and velocity level of the point as you drag.

3. Right-click the envelope between two points to choose a fade type (linear, fast, slow, smooth, or sharp) to set the shape of the curve.

   Tip: To delete a point, right-click the point and choose Delete.

Making a video play at twice its normal speed makes the duration of the video half as long. Likewise, slowing a video down makes it longer (with 0% being an infinite freeze frame). For example, if you decrease the speed of a ten-second video event by 50%, only five seconds of video play (played over the course of the ten-second event), meaning that only half as much actual footage from the original event plays. On the other hand, if the speed is increased 200%, the ten seconds of content play in only five seconds. The remaining five seconds of the event are filled either with a freeze of the last frame or with ten additional seconds of video content from the longer file.

You may want to resample the frame rate of an event that has been significantly slowed. To resample an event, right-click the event and choose Properties. Then, on the Video Event tab, select the Resample check box. For more information, see Resampling video on page 177.

Using the Envelope Edit Tool

While you can edit envelopes using the Normal Edit tool ( ), you can limit your editing to envelopes only by clicking the Envelope Edit Tool button ( ). You cannot move, trim, or otherwise modify events with this tool, which allows you to edit envelope points without making any other unwanted changes. For more information, see Using the Envelope Edit tool on page 112.

Reversing a video event

Setting the velocity to a negative value reverses the video, working backwards from the point where the negative value occurs. An event that has been reversed plays backwards until it gets to the first frame and then holds that frame for the duration of the event.

1. Right-click an event and choose Insert/Remove Velocity Envelope.

2. Trim the beginning of the video event to the place where you want the reversal to begin (e.g., the last frame in the media file that you want to play if it were playing forward).
3. Drag the velocity down to -100% for a normal speed reversal.

Removing a velocity envelope

To remove a velocity envelope and all of its settings, right-click the event and choose Insert/Remove Velocity Envelope from the shortcut menu.

Grouping events

Vegas allows you to group events together within tracks or across separate tracks. Once you create a group, you can move all the events in the group within their tracks as a unit and apply event-specific edits at the same time.

You can still edit properties of individual events within a group without affecting the other events in a group.

Creating a new group

Grouping is useful when you want to preserve timing of events and move events together along the timeline.

1. Select the events you want to group. For more information, see Selecting multiple events on page 58.
2. From the Edit menu, choose Group, and choose Create New from the submenu.
Adding an event to an existing group

1. Right-click an event in the existing group, choose Group from the shortcut menu, and choose Select All from the submenu to select all of the members of the group.

2. Press [Ctrl] and click the event to be added to the group.

3. Right-click the event, choose Group from the shortcut menu, and choose Create New from the submenu.

---

Note: Events can only be in one group at a time. Adding an event to an existing group essentially clears the old group and creates a new one that includes all of the selected events.

---

Removing events from a group

You can remove individual events from a group without affecting the other members of the group. An event you remove from the group is not deleted from the project and remains on the timeline.

1. Right-click the event you want to remove from the group.

2. From the shortcut menu, choose Group, and choose Remove From from the submenu. The event is removed from the group. The rest of the grouped events remain intact.

Clearing a group

You may ungroup all events by clearing the entire group. Clearing a group does not remove events from your project.

1. Right-click one of the members of the group.

2. From the shortcut menu, choose Group, and choose Clear from the submenu.

Selecting all members of a group

While grouped events move together within their tracks, selecting one member of a group does not automatically select every member of that group.

1. Right-click one of the members of the group.

2. From the shortcut menu, choose Group, and choose Select All from the submenu.

With all events in a group selected, you can move the group to other tracks, or cut and paste the group to a new location.

Suspending grouping temporarily

You can temporarily suspend the grouping behavior of all groups (including video media files with included audio streams) in Vegas by clicking the Ignore Event Grouping button.
You can use audio effects, or plug-ins, to improve the quality of the audio in a production or to create special artistic effects. In addition to the DirectX plug-in effects included with Vegas, you can also use other Sonic Foundry plug-ins and third-party plug-ins.

Using audio effects

Vegas contains the complete set of audio effects plug-ins, while Vegas LE contains a subset. Multiple audio busses and assignable effects chains are only available in the full version of Vegas.

There are three ways to use audio plug-ins in Vegas: track effects, bus effects, and assignable effects. You can access these plug-ins by clicking the Track FX, Bus FX or Assignable FX buttons ( ). The combination of these various methods of applying audio effects is important to the final mix of a project. For more information, see Audio signal flow on page 35.

- **Track effects** are applied to all events in a single track.
- **Bus effects** are applied to a bus (including the Master bus). When you add plug-ins to a bus, the tracks that are assigned to the bus are processed by the plug-in(s). Since multiple tracks can be assigned to a single bus, using bus-level audio effects is an efficient method of applying carefully customized chains of audio effects to multiple tracks. If plug-ins are assigned at the track level, the track’s signal flows through the track’s plug-in(s) before the bus plug-ins. For more information, see Using busses on page 139.
- **Assignable effects** allow you to send various levels of multiple tracks to a single effect chain. Like busses, these controls reside in the Mixer window and support plug-in chains. In addition, assignable effects outputs can be routed to busses. Click the Insert Assignable FX button ( ) in the Mixer window to add an assignable effect chain to your project. For more information, see Using assignable effects chains on page 142.
Using plug-in chains

A plug-in chain is a sequence of plug-ins to be applied to tracks, busses, or assignable effects. A plug-in chain can contain one or more plug-ins. The same plug-in can be added to a chain more than once.

After the plug-in chain is created, the audio is processed by each plug-in in order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the desired effect.

Creating a plug-in chain

Audio tracks have a built-in plug-in chain with three default plug-ins applied as a default. For bus effects and assignable effects, however, you must first create a plug-in chain.

Creating a bus effects plug-in chain

1. Click the Bus FX button ( ) on a bus in the Mixer window. The Plug-In Chooser dialog appears.
2. Select a plug-in and click OK. The Audio Plug-In window displays with your selected plug-in as the first in the new plug-in chain.
3. Adjust the settings for the plug-in to create the desired effect and click the Close button ( ) in the upper-right corner to close the window.

Creating an assignable effects plug-in chain

1. Click the Insert Assignable FX button ( ) on the Mixer window. The Plug-In Chooser dialog appears.
2. Select a plug-in and click OK. The Audio Plug-In window displays with your selected plug-in as the first in the new plug-in chain.
3. Adjust the settings for the plug-in to create the desired effect and click the Close button ( ) in the upper-right corner to close the window. The new assignable effect control appears in the Mixer window.

Adding plug-ins to a plug-in chain

There are two ways to add plug-ins to a chain: via the Plug-In Chooser dialog and via the Audio Plug-In window.

Adding plug-ins via the Plug-In Chooser dialog

You can access the Plug-In Chooser dialog from the track, bus, or assignable effects chain to which you are adding the plug-in.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track FX) appears.
2. Click the Plug-In Chain button ( ) on the window. The Plug-In Chooser dialog appears. Plug-ins already in the chain appear at the top of the dialog.

3. Select a plug-in and click Add.

4. Repeat step three to add as many plug-ins as you need to create the desired effect.

5. Click OK to close the Plug-in Chooser dialog. The plug-in chain appears just below the title bar in the appropriate FX window (Audio Plug-In or Video Track FX).

Adding plug-ins via the Plug-Ins window

The Plug-Ins window is a dockable window that allows you to view and choose plug-ins to be added to a track, bus, or assignable effects chain.

1. If the Plug-Ins window is not displayed, press Ctrl + Alt + 1.
2. In the Plug-Ins window, navigate to the Audio folder and select the FX folder.

3. Drag a plug-in to a track, bus, or assignable effects chain.

   **Tip:** You can select multiple plug-ins and add them at the same time by dragging them to the desired location.

4. Confirm that the plug-ins were added by clicking the Track FX, Bus FX or Assignable FX button ( ) to view the appropriate FX window (Audio Plug-In or Video Track FX). You can customize the settings for the effects at this time.
Saving customized plug-in presets

Each plug-in has a number of presets that you can use to set the behavior of the plug-in. However, you can also adjust the controls for the plug-in manually to create custom settings. You can then save the effect settings as a new preset.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track FX) appears.
2. In the plug-in chain at the top of the window, click the plug-in you want to customize.
3. Adjust the settings for the effect.
4. Enter a preset name in the Preset box.
5. Click the Save button ( ) to save the preset.

---

Tip: You can delete a saved preset by selecting it from the list and clicking the Delete button ( ).

---

Arranging the order of plug-ins

Plug-ins are cumulative during playback. Because of this cumulative effect, you may need to arrange plug-ins in a certain order so that one plug-in’s processing does not adversely affect the next plug-in on the chain. There is no right or wrong way to order plug-ins, but some plug-ins work better when arranged in a particular order.

You can arrange the order of plug-ins in a chain in either the appropriate FX window or the Plug-In Chooser dialog.

Arranging the plug-in order in the FX window

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track FX) appears.
2. On the plug-in that you want to move, right-click and choose Move Left or Move Right from the shortcut menu. Alternately, drag a plug-in to a new position.
3. Once the chain’s plug-ins are in the order that you want, click the Close button ( ) in the upper-right corner to close the window.
Arranging the plug-in order from the Plug-In Chooser dialog

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track FX) appears.
2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top.
3. Drag a plug-in to a new location in the chain, or select a plug-in and click either the Shift Plug-In Left ( ) or Shift Plug-In Right ( ) button.
4. Click OK to close the Plug-In Chooser dialog.

Bypassing plug-ins on the chain

You can bypass plug-ins on the chain by clearing the check box on a specific plug-in or by right-clicking the plug-in and choosing Bypass from the shortcut menu. The plug-in remains bypassed until you enable it again. Bypassing a plug-in prevents it from being processed on the mixer, track or bus.

Removing plug-ins from a chain

You can remove plug-ins from a chain in either the appropriate FX window or the Plug-In Chooser dialog.

Removing a plug-in from the chain in the FX window

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track FX) appears.
2. Select the plug-in that you want to remove.
3. Click the Remove Selected Plug-In button ( ).

Removing a plug-in from the chain in the Plug-In Chooser dialog

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Audio Plug-In or Video Track FX) appears.
2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top.
3. Select the plug-in that you want to remove and click Remove to remove it from the chain.
4. Click OK to close the Plug-In Chooser dialog.
Adding audio effects

Saving plug-in chains

You can save and edit the plug-in chains that you add to tracks or busses or create as assignable effects chains. Saved chains retain the order of plug-ins and the settings that you have applied. Vegas stores these chains as effect packages for use in future projects. If you use the same plug-in chains regularly, saving them as packages is faster and more consistent than recreating the chain manually.

Once you save a chain as a package, you can use it as either a track, bus or assignable effects plug-in chain. Saved plug-in chain packages appear in the Plug-In Chooser dialog.

1. Click the Track FX, Bus FX or Assignable FX button. The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.

2. Click the Plug-In Chain button. The Plug-In Chooser dialog appears with the plug-in chain displayed at the top.

3. Click Save As. The Save Plug-in Package dialog appears.

4. Enter a name for the package.

5. Click OK or press Enter to save the package.

Editing saved plug-in chains

You can add, delete, or rearrange plug-ins in a saved package at any time. You can then save your changes to the package, or enter a new name to save the chain as a new package.

1. Click the Track FX, Bus FX or Assignable FX button. The appropriate FX window (Audio Plug-In or Video Track FX) appears.

2. Click the Plug-In Chain button. The Plug-In Chooser dialog appears with the package in the chain area.

3. Add, delete, rearrange, or change the settings of plug-ins in the package chain.

4. In the Plug-In Chooser dialog, click Save As to save the modified package.

5. To save the package with a new name, enter a name in the Name box. To save the changes to the existing package, choose the name of the package from the Name drop-down list.

6. Click OK or press Enter to save the new settings.
Organizing your plug-ins

Within the Plug-in Chooser dialog, you can create folders to organize the plug-ins. This can help you organize large numbers of plug-ins on your system. You can create folders and then drag plug-ins to the folders.

Applying non-real-time event effects

Non-real-time event effects are a different method of applying audio effects in Vegas. In all other cases, event editing in Vegas is nondestructive, meaning that edits and effects are applied to events in real time and not to the source media files, which remain unaltered. There may be times, however, when you want to create a permanent file using an effect or effects. This may be useful in a very complicated project or when a slower computer cannot process the effects quickly enough for a real-time preview.

By applying non-real-time event effects, you can make a new copy of a media file with the effects applied to it. Vegas saves this new media file and adds it to the project as a take. For more information, see Working with takes on page 91.

1. Select an audio event.
2. From the Tools menu, choose Audio, and choose Apply Non-Real-Time Event FX from the submenu.
3. In the Plug-In Chooser dialog, add plug-ins to create a plug-in chain. For more information, see Adding plug-ins via the Plug-Ins window on page 131.
4. Click OK.
5. In the Take window, adjust the settings for the plug-in(s) to create the desired effect.
6. Preview the effect by clicking the Preview button ( ) in the Non-Real-Time Event FX window.
7. Click OK.
8. In the Take dialog, click Save to save the newly processed media file.

The new media file is saved and added to the project as a take.
Bypassing all audio effects

From the **Options** menu, choose **Bypass All Audio FX** to omit all audio effects (track, bus, and assignable effects) during playback.

Bypassing effects allows you to quickly compare your project with and without effects and conserve processing power to avoid playback problems.

When effects are bypassed, you can choose whether bypassed effects remain open. When the **Keep bypassed FX running** check box on the **General** tab of the Preferences dialog is selected, effects remain open so you can bypass/enable effects with no pause for A/B testing. When the check box is cleared, effects are fully bypassed, conserving processing power.
The Mixer window is where you control the project’s busses and assignable effects chains. *Multiple audio busses and assignable effects chains are only available in the full version of Vegas.*

**Using the Mixer window**

The Mixer is a dockable window where you can control audio busses and assignable effects chains within your project and adjust the outgoing signal’s volume and routing.

**Viewing the Mixer window**

The Mixer window appears in the window docking area by default when you first start Vegas. However, you can drag the Mixer within the workspace at any time to float it. *For more information, see Window docking area on page 22.*

To hide/view the Mixer window, choose **Mixer** from the **View** menu or press **Alt + 3**.

---

![Mixer window](image)

**Float handle**
Using the Mixer toolbar

The Mixer’s toolbar allows you to access project properties, add busses, and add assignable effects chains to the Mixer.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Project Audio Properties" /></td>
<td>The Project Audio Properties button accesses the project properties dialog (pg. 268).</td>
</tr>
<tr>
<td><img src="image" alt="Dim Output" /></td>
<td>The Dim Output button attenuates the volume of all busses that are routed to hardware outputs by 20 dB. Click again to restore original volume.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Assignable FX" /></td>
<td>The Insert Assignable FX button adds an assignable effects chain to your project. You can route tracks to the assignable effects chain (pg. 143).</td>
</tr>
<tr>
<td><img src="image" alt="Insert Bus" /></td>
<td>The Insert Bus button adds a bus to your project. You can route tracks or assignable effects chains to the bus (pg. 142).</td>
</tr>
</tbody>
</table>

Using the Mixer Preview fader

The Preview fader allows you to adjust the volume and monitor output levels of media files when you preview them from the Explorer window or Media Pool, or play them back from the Trimmer window. The Preview fader also controls the metronome volume. For more information, see Using the metronome on page 148.

Viewing/hiding the Preview fader

The Preview fader is hidden as a default to make more room for other busses and assignable effects chains. To view or hide the Preview fader, simply right-click anywhere within the Mixer and choose Show Preview fader from the shortcut menu.

Adjusting the Preview fader

You can adjust the Preview fader while you are previewing a media file from the Explorer window. Drag the fader up or down, or press [Ctrl] while dragging to move in smaller increments. Double-click the fader to reset it.

You can select a preferred meter resolution at which the Preview fader displays the media file’s volume level. For more information, see Changing bus meter resolution on page 141. You can also adjust the Preview fader to correct clipping in the same way you adjust a bus. For more information, see Adjusting a bus for clipping on page 141.
Using busses

Multiple audio busses are only available in the full version of Vegas.

A bus is a master control for the audio-signal mix of one or more tracks. You can assign tracks to play back on a specific bus. For more information, see Assigning audio tracks to busses on page 142.

However, to assign a track to a bus, you must have more than one bus in your project. Each project has a Master bus as a default, but you may add up to 25 additional busses to the Mixer window. A bus is the last stage in the signal's flow through Vegas. For more information, see Audio signal flow on page 35.

You can configure each bus to use a specific hardware output. For more information, see Audio tab on page 275.

Adding busses to a project

You can add up to 25 busses at any time during the development of your project.

Adding a bus

Click the Insert Bus button ( ) on the Mixer window.

Adding multiple busses

1. Click the Audio Properties button ( ) on the Mixer window. The Project Properties dialog appears with the Audio tab displaying.

2. In the Number of stereo busses box, enter the desired number of busses (up to 25) to appear in the Mixer window.

3. Click OK to add the specified number of busses and close the Project Properties dialog.

The new busses appear in the Mixer window.
Deleting busses from a project

You can remove busses from your project at any time. When you remove a bus from a project, any tracks assigned to it are reassigned to the Master bus.

Deleting a bus

Right-click the bus to be deleted in the Mixer window and choose Delete from the shortcut menu.

Deleting multiple busses

1. Click the Audio Properties button ( ) on the Mixer window. The Project Properties dialog appears with the Audio tab displaying.
2. In the Number of stereo busses box, enter the desired number of busses to appear in the Mixer window.
3. Click OK. All tracks assigned to a deleted bus are reassigned to the Master bus in the Mixer window.

Routing busses to hardware

You can assign busses to use specific hardware for output. When you installed Vegas, it automatically detected the hardware available for output on your computer. For more information, see Audio tab on page 275.

1. From the Options menu, choose Preferences and click the Audio device tab.
2. From the Audio device type drop-down list, choose Windows Classic Wave Driver.

Note: If you select Microsoft Sound Mapper in the Audio device type drop-down list on the Audio tab, you will not be able to assign the bus to a different device.

3. Click OK to close the Preferences dialog.
4. In the Mixer window, click the Playback Device button ( ) on the bus you want to route.
5. Choose a hardware device from the menu.

Note: You can map multiple busses to a single sound card.

Working with busses

Busses in the Mixer window are fully independent and may be adjusted separately. You can adjust the bus volume, change the bus meter resolution, and adjust the bus fader to eliminate clipping.

Adjusting bus volume

You can adjust a bus's volume during project playback by dragging the fader. The fader on a stereo bus is split so that you can adjust the levels of the two stereo channels independently.

The faders are locked (ganged) so that the left and right channels of stereo files move together. Click the Lock/Unlock Fader Channels button ( ) to unlock or lock the faders. You can also press Shift while dragging a fader to temporarily override a fader's locked or unlocked state.

Tip: Double-click a fader to reset it to 0.0 dB. If you have set each channel independently, double-click either the left or right fader to have the other fader match the other's volume setting.
You can adjust the volume of several busses simultaneously by selecting the busses and adjusting any of their faders. If you select an assignable effect along with the busses, the output fader of the assignable effect moves along with the bus volume faders.

**Changing bus meter resolution**

You can select a meter resolution at which a bus displays the signal levels that are being mixed. When you change the meter resolution on this control, the other meters (assignable effects and preview) automatically change to match.

To change bus meter resolution, right-click a meter and choose a meter resolution from the shortcut menu.

**Adjusting a bus for clipping**

If the volume level is set too high, it may cause clipping. The clipping displays in red at the top of the meter with the clipping value displayed in decibels (dB). Adjust the fader and click the red clipping value to reset the meter. Continue to adjust the fader and reset the meter until you eliminate the clipping.

You can set the meter to remember and display the highest and lowest levels by right-clicking and selecting **Hold Peaks** and **Hold Valleys**.

**Muting a bus**

Muting allows you to temporarily suspend playback of the bus. When a bus is muted, the word **Muted** appears at the bottom of the meter. You can mute more than one bus at a time.

To mute the bus, click the Mute button ( ). Click the button again to restore bus playback.

**Soloing a bus**

Soloing isolates a bus’s playback and mutes the other busses so that you can focus on a specific output. You can solo more than one bus at a time. To solo the bus, click the Solo button ( ). Click the button again to turn off soloing.

**Naming or renaming a bus**

Every bus in the Mixer window has an editable name.

1. Double-click the bus name.
2. Type a new name.
3. Press **Enter** to save the name.
Assigning audio tracks to busses

If your project contains multiple busses, you can assign a track to a specific bus.

Multiple audio busses are only available in the full version of Vegas.

1. Click the Bus button ( ) in the track list to display a drop-down list of available busses. This button appears only if the project contains multiple busses. For more information, see Adding busses to a project on page 139.

2. From the drop-down list, choose the bus for the track’s output.

Adjusting a bus send level

You can adjust the level of a track sent to a bus by using the multipurpose slider in the track list. Each bus send level is preset to \(-\infty\) dB (mute) by default.

1. Click the label on the multipurpose slider and choose a bus from the menu.

2. Drag the slider to adjust the level of the track sent to the bus.

Note: Bus sends are pre-volume by default. To change to post-volume, right-click the multipurpose slider and choose Post Volume from the shortcut menu.

Using assignable effects chains

Assignable effects are only available in the full version of Vegas.

Assignable effects allow you to send various levels of multiple tracks to a single audio effect chain. Like busses, these controls reside in the Mixer window and support plug-in chains. In addition, you can route assignable effects outputs to project busses.

Click the Insert Assignable FX button ( ) in the Mixer window to add an assignable effects chain to your project. For more information, see Adding Audio Effects on page 129.

<table>
<thead>
<tr>
<th>Number/Name</th>
<th>Number and name of assignable effects. Double-click the name to edit it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute</td>
<td>Prevents the assignable effects chain from processing the track’s signal.</td>
</tr>
<tr>
<td>Solo</td>
<td>Plays only the output of that assignable effects chain.</td>
</tr>
<tr>
<td>Assignable FX</td>
<td>Displays the Assignable FX window and allows you to adjust the plug-in settings.</td>
</tr>
<tr>
<td>Bus assignment</td>
<td>Allows you to assign the assignable effects chain to a bus.</td>
</tr>
<tr>
<td>Input Fader</td>
<td>Adjusts the input volume.</td>
</tr>
<tr>
<td>Output Fader</td>
<td>Adjusts the output volume.</td>
</tr>
<tr>
<td>Meter</td>
<td>Displays the incoming and outgoing signal level to the assignable effects chain.</td>
</tr>
<tr>
<td>Lock/Unlock Fader Channels</td>
<td>Locks the faders so the left and right channels of stereo files always move together. Click again to unlock the faders.</td>
</tr>
</tbody>
</table>
Tip: To use the output fader to control the wet/dry mix of the assignable effects chain, set each plug-in to 100% wet. Use the output (effects return) fader to balance the dry track signal with the wet plug-in signal.

You can work with assignable effects controls in much the same way you work with busses. Use the same methods described earlier in this chapter for adjusting volume, adjusting for clipping, muting, soloing, and renaming. For more information, see Working with busses on page 140.

Assigning audio tracks to assignable effects chains

Assignable effects are only available in the full version of Vegas.

Assignable effects chains are made up of one or more plug-ins that are used to add audio effects to a track's signal. You can adjust the level of a track that is sent to an assignable effects chain using the multipurpose slider in the track list.

1. Click the label on the multipurpose slider to display a drop-down list.
2. Choose the assignable effects chain that the track will use.
3. Drag the slider to adjust the level of the track sent to the assignable effects chain.

Note: Assignable effect sends are pre-volume by default. To change to post-volume, right-click the multipurpose slider and choose Post Volume from the shortcut menu.

Routing assignable effects chains to busses

When you add assignable effects to your project, you can assign them to a specific bus for output. The bus mixes the assignable effects chain's plug-ins along with any tracks that may be routed to the same bus. For more information, see Audio signal flow on page 35.

This option is only available if the project contains multiple busses. For more information, see Adding busses to a project on page 139.

1. Click the Bus button ( ) on the assignable effect control. A menu displays all the busses in your project.
2. Choose the bus to which you want to route the assignable effects chain.

The assignable effects chain displays the letter of the bus to which it is routed.

Automating busses and assignable effects

You can automate busses and assignable effect chains in the track view. Vegas allows you to view each of these controls on bus tracks at the bottom of the track view and to add envelopes to automate functions such as volume, pan, and assignable effect chain input/output levels. You can also add envelopes to automate effect parameters for plug-ins that support automation. For more information, see Adding effect automation envelopes on page 110.
Viewing bus tracks

From the **View** menu, choose **Show Bus Tracks** or press **U**. The bus tracks appear at the bottom of the track view. A bus track appears for each bus or assignable effect chain in your project.

Adding track envelopes

Right-click the track header in the track list, choose **Insert/Remove Envelope** from the shortcut menu, and choose the appropriate envelope type from the submenu.

You can identify which busses or assignable effect chains have envelopes by looking at each control’s letter or number. An automated bus or assignable effect chain has a small fader icon on its letter or number in the Mixer window.

Modifying track envelopes

You can modify a track envelope for a bus or assignable effect in the same way you do with any other track. *For more information, see Working with track envelopes on page 109.*
Vegas can record audio into multiple mono or stereo audio tracks while simultaneously playing back existing audio and video tracks. You are limited only by the performance of your computer system and audio hardware. Vegas records audio to a media file on your computer and into an event on the timeline. You may record into an empty track, a time selection, an event, or a combination of time and event selection. Audio output from your computer during recording is not necessarily recorded with the new audio.

Recording in Vegas does not alter any of the source media files in your project. Even when recording into an existing event, you are not overwriting the data in that event. Instead, the data is recorded into a new take for that event and saved to a media file on your hard drive.

Setting up your equipment

There are numerous ways to connect your equipment to your system. Refer to your equipment’s documentation for specific setup instructions. The following are some possible general configurations.

Basic setup

This setup includes a simple microphone and speaker that are connected to the computer’s sound card. With a more sophisticated microphone, you would typically want to use a preamplifier for input to the sound card.
Setup with mixer

This setup includes a mixer where the speaker and microphone connect. The mixer is then connected to the computer's sound card. Mixers usually have pre-amps built into them. This diagram does not show you an instrument or a physical preamplifier, such as a rack-mounted component. The reason for this omission is because these types of setups vary widely based on your mixer, instrument, and pre-amp type. Refer to your components’ documentation for specific setup configurations.

Setup with digital multitrack

This setup includes a digital multitrack recorder with an optional MIDI synchronization component. Usually you would have a mixer, a microphone, etc. connected to these components. Your particular setup will vary depending on your equipment. Refer to your components’ documentation for specific setup configurations.

Synchronizing MIDI timecode

Vegas can generate (output) MIDI timecode to synchronize external devices with project playback or can be triggered by MIDI timecode generated by an external device. To output MIDI, from the Options menu, choose Timecode, and choose Generate MIDI Timecode from the submenu. To allow Vegas to be triggered by an external MIDI device, choose Trigger from MIDI Timecode from the same submenu. For more information, see Triggering from MIDI timecode on page 151 and Sync tab on page 278.
Preparing to record

Before you record, you must arm the tracks into which you will record the new audio. You must also select the recording settings for the tracks. You have the additional options of using a metronome or turning off playback during recording.

Arming the track for recording

Whether recording into an existing track, an empty track, a selected event, or a time selection, you must prepare a track for recording. You can arm multiple tracks prior to recording.

1. Click the Arm for Record button ( ) in the track list.

The first time you arm a track to record in a project, the Project Recorded Files Folder dialog displays.

2. Browse to the location where you want Vegas to save your recorded audio files.

3. Click OK.

Tip: You can change the location where Vegas saves recorded files at any time. For more information, see Specifying where recordings are stored on page 152.

Once a track is armed, a record meter appears in the track list. Depending on your hardware, a record gain fader may also appear.

In addition, one of two Record Device Selector buttons appears: ( ) or ( ). The button that appears is based on the Audio device type selected in the Audio tab of the Preferences dialog. For more information, see Audio tab on page 275.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Stereo" /></td>
<td>This button appears when Use Microsoft Sound Mapper has been selected as the audio device type on the Preferences Audio tab. The Sound Mapper allows you to choose how the signal will be recorded: stereo or mono. Click this button to view a menu with Stereo, Left, or Right.</td>
</tr>
<tr>
<td><img src="image" alt="Mono left" /></td>
<td>This button appears when Windows Classic Wave Driver has been selected as the audio device type on the Preferences Audio tab. When you choose this option, you can specify which device (e.g., sound card) you will record from on any given track prior to recording. Click this button to view a menu with Stereo or Mono, and a submenu with all available devices for either option.</td>
</tr>
<tr>
<td><img src="image" alt="Mono right" /></td>
<td></td>
</tr>
</tbody>
</table>

---

CHP. 9 RECORDING AUDIO
Selecting recording settings

After the track has been armed for recording, select whether the track records the signal in stereo, in mono from the left channel, or in mono from the right channel. If you are using the Windows Classic Wave Driver, you also must select the device from which the track will record.

Selecting recording settings for Sound Mapper

1. Click the Record Device Selector button ( ). A menu appears.
2. From the menu, choose the recording method (Stereo, Left, or Right).

Selecting recording settings for Windows Classic Wave Driver

1. Click the Record Device Selector button ( ). A menu appears.
2. Choose either Stereo or Mono from the menu.
3. From the submenu, choose the input device

Using the metronome

Vegas has a built-in metronome that marks time to help with the timing and tempo when recording a performance. The metronome’s sound is not mixed in the final rendering of the project. Use the Preview fader in the Mixer window to control the metronome volume. For more information, see Using the Mixer Preview fader on page 138.

To use the metronome, from the Options menu, choose Metronome.

Tip: You can customize the sound of the metronome in the Audio tab of the Preferences dialog. For more information, see Audio tab on page 275.
Recording

You may record into an empty track, a time selection, an event, or a combination of time and event selection. Vegas adds the recording to the timeline as new take and saves it to a media file on your hard drive.

Vegas also supports triggering recording from MIDI timecode.

Recording into an empty track

1. Select a track. Alternately, to record to a new track, choose Audio Track from the Insert menu.
2. Place the cursor on the timeline where you want to begin recording.
3. Arm the track by clicking the Arm for Record button ( ) on the track.
   If this is the first time you arm a track for recording in this project, Vegas prompts you to identify the location where the new audio files will be saved. For more information, see Arming the track for recording on page 147.
4. Start recording by clicking the Record button ( ) on the transport bar.
   Depending on the recording selection, a waveform is created along the timeline as you record into the armed track(s).
5. Stop recording by clicking the Record button ( ) again or the Stop button ( ) on the transport bar.
6. A small dialog opens displaying the name and location of the file or files that were just created. Click Done to return to the main workspace.

Note: The Recorded Files dialog does not appear if you are triggering from MIDI timecode, as this would interrupt the synchronizing. Instead, files are automatically named and saved according to your preferences.
Recording into a time selection

By making a time selection, you specify where along the timeline to record. The time selection also determines how long Vegas records. Any selected events that occur within the time selection are split and the recorded data is placed into the time selection. For more information, see Recording into an event with a time selection on page 151.

Vegas displays the event’s waveform as it is recorded and automatically stops recording when the cursor reaches the end of the time selection.

Recording into an event

By recording into an event, you automatically create a new take containing the recorded material that is the same duration as the selected event. The edges of the selected event serve as the punch-in and -out points that Vegas uses for recording. Recording into an event allows you to establish a pre-roll before recording, which gives you time to prepare before recording starts.

Because Vegas saves the entire recording to the media file (not just the material between the edges of the take), you are not limited to the recorded material contained in the length of the new take. You can adjust the edges of the event or slip the contents of the event if necessary. For more information, see Shifting the contents of (slipping) an event on page 70.

The existing event that you record into is not affected or deleted. Instead, the event now contains two media files, each listed as a separate take in the event. For more information, see Working with multiple recorded takes on page 152.

1. Place the cursor before the event to allow for pre-roll.
2. Press Ctrl and click the event to select it.

Tip: You can record into multiple events by pressing Ctrl and making selections.

3. Click the Arm for Record button ( ) on the event’s track. When recording into multiple selected events, arm their respective tracks at this time.
4. Click the Record button ( ) on the transport bar to begin recording.
5. Click the Record button ( ) again or the Stop button ( ) on the transport bar to stop recording.
Recording into an event with a time selection

Recording into a time selection allows for a pre- and post-roll during recording. The time selection is adjustable to increase or decrease the pre- and post-roll duration. During recording, the selected event’s edges serve as the punch-in and -out points. You can create multiple punch-in and -out points by selecting more events within the time selection.

You may need to split an existing event into three pieces so that you can select a smaller portion of the event to record into. For more information, see Splitting events on page 68.

1. Click the Arm for Record button ( ) on the desired track(s).
2. Select the event to record into.

   **Tip:** You may record into multiple events by pressing Ctrl and making your selections.

3. On the marker bar, drag a time selection. You may adjust the time selection by dragging the selection bar’s starting and ending points. Make the time selection start before the event for a pre-roll.
4. Click the Record button ( ) on the transport bar to begin recording.

Using a pre-roll

The previous technique allows you to define the playback region with a time selection and sets the punch-in and punch-out points in the recording to the event boundaries. When you click the Record button, playback begins at the beginning of the time selection. Vegas then fills the event with the newly recorded material. The audio file that is recorded to your hard disk is the full duration of the time selection. The event only contains a portion of the full recorded performance and can therefore be trimmed (both shorter and longer) and repositioned within the event.

Triggering from MIDI timecode

Recording can be triggered and synchronized in Vegas by an external MIDI device that outputs (generates) MIDI timecode (MTC). When triggering from MIDI timecode, you should have your audio devices connected together via a master digital word clock. The word clock keeps the audio hardware locked together, eliminating the need for the software to constantly vary its playback rate to stay synchronized. The incoming timecode is only used for an absolute time reference. For more information, see Sync tab on page 278.

1. From the Options menu, choose Preferences and go to the Sync tab.
2. From the Trigger from MIDI Timecode settings drop-down list, select the device that you want to trigger Vegas.
3. Click OK. The Preferences dialog closes.
4. Click the Arm for Record button ( ) on the desired track(s).
5. Right-click the time display and choose **MIDI Timecode In**. The time display now shows the timecode being generated from your MIDI device. The top of the display reads **MTC Input Waiting**.

6. Begin generating MTC from your MIDI device. The top of the time display now reads **MTC Input Locked**, the time updates from the MIDI device, and Vegas automatically begins recording. Typically, there is a short delay between when you begin generating MTC and synchronization.

**Working with multiple recorded takes**

Clicking the **Loop Playback** button ( ) on the transport bar enables you to continually create takes during recording. Takes are different versions of a recorded event that you can quickly switch between to choose the best one. Each take within an event references a different source media file.

During recording with loop playback enabled, Vegas continually repeats the time selection and starts recording a new take until you stop recording. You can preview, select, rename, and delete takes. For more information, see *Working with takes* on page 91.

**Specifying where recordings are stored**

When you record in Vegas, the event appears on the timeline while its media source file is written to your hard drive. The first time you arm a track to record in a project, Vegas prompts you to identify the location where the recordings will be stored.

**Changing where recorded files are stored when arming a track**

1. Press **Shift** and click the **Arm for Record** button ( ) on a track. The Project Recorded Files Folder dialog appears.
2. Browse for the location where you want Vegas to save recorded files.
3. Click **OK**.

**Changing where recorded files are stored when starting to record**

1. Press **Shift** and click the **Record** button ( ) on the transport bar. The Project Recorded Files Folder dialog appears.

   **Tip:** You can also press **Ctrl + Shift + R** to specify the location for recorded files when starting to record.

2. Browse for the location where you want Vegas to save recorded files.
3. Click **OK**.
Changing where recorded files are stored in the Project Properties dialog

1. From the File menu, choose Properties. The Project Properties dialog appears.

2. Click the Audio tab to display the project’s audio properties.

3. Click Browse. The Recorded Files Folder dialog appears.

4. Browse for the location where you want Vegas to save recorded files.

5. Click OK.

Tip: You can select Start all new projects with these settings in the Project Properties dialog to store recorded media source files to the same location in every new project.

Monitoring audio levels

While you’re recording, Vegas provides a responsive meter in the track header to monitor the incoming signal level of the selected recording device. It is important that you record with the highest signal possible without clipping.

A reading of 0 dB is the maximum for a digital signal. Clipping occurs when the incoming signal is too high to be represented as a digital value. The result is distortion in the recording. A clipped signal will be indicated by a red Clip warning at the top of the meters.

Right-click the meters and choose a command from the shortcut menu to adjust the display of the meters.
Monitoring recording input with track effects

If you want to hear your recording signal with real-time track effects, you can turn on input monitoring.

*Input monitoring is only available in the full version of Vegas.*

Click the Record Device Selector button ( or ) and choose Input Monitor from the menu. During recording, your signal will be played back with the current track effects chain, but a dry (unprocessed) signal is recorded.

**Note:** Your ability to monitor effects in real time is dependent on your computer’s performance. Effect automation envelopes are bypassed during record monitoring.

Using input monitoring to record an affected signal

If your sound card includes a mixer application, you can use input monitoring to record a processed signal.

1. Route the track you are recording to a bus. *For more information, see Assigning audio tracks to busses on page 142.*

2. Route that bus to an unused output channel on your sound card. *For more information, see Routing busses to hardware on page 140.*

3. Arm a new track for recording.

4. On the new track, click the Record Device Selector button ( or ) and choose the output channels where you routed the bus in step 2.

5. When you start recording, the first track will record a dry (unaffected) signal, and the second track will record the wet (processed) signal.

6. Drag the Vol and Pan faders in the track header to control the level and panning of your input monitor signal.
Working with 5.1 Surround

Vegas allows you to create 5.1-channel mixes to prepare audio for DVD-Video.

**Note:** Vegas plays and mixes uncompressed 5.1-channel audio. Authoring software such as the Sonic Foundry 5.1 Surround Plug-In Pack is required to encode 5.1-channel audio to AC-3 for use in DVD authoring.

What is 5.1 surround?

5.1 surround is a standard format consisting of three speakers across the front and two speakers in the rear. The “.1” is a sixth channel called low frequency effects (LFE) that enhances the bass levels in the mix.

5.1 surround includes five main channels... ...and a sixth channel for low frequency effects.

The LFE channel is commonly used in motion pictures to enhance low audio frequencies for effects such as explosions or crashes. Audio in this channel is commonly limited to a range from about 25 Hz to 120 Hz. Unlike the five primary channels, the LFE channel adds no directional information. Depending on the speaker setup and audio levels, the sound assigned to the LFE channel may be routed among the five main speakers or to an additional subwoofer.

Setting up surround hardware

Before you create surround projects in Vegas, you should set up your system to provide 5.1 surround playback. To play a 5.1 surround project, you must have an appropriate speaker setup such as:

- Six powered speakers
- Six passive speakers with a six-channel amplifier
Your system must also have an appropriate sound card setup such as:

- 5.1-compatible sound card
- Sound card with three stereo outputs
- Three stereo sound cards

There are several ways to set up your system, depending on the sound card and speaker setup you are using.

### Setting up surround projects

You can configure a Vegas project to use 5.1 surround in the Project Properties dialog. You can also choose to apply a low-pass filter for the LFE channel. Applying a low-pass filter approximates the bass-management system in a 5.1 decoder and ensures that you're sending only low-frequency audio to the LFE channel.

1. From the **File** menu, choose **Properties**.
2. Click the **Audio** tab.
3. From the **Master bus mode** drop-down list, choose **5.1 surround**.
4. To limit the audio sent to the LFE channel, do the following:

   - Select the **Enable low-pass filter on LFE** check box and enter a value in the **Cutoff frequency for low-pass filter** box. The low-pass filter isolates the audio sent to the LFE channel by limiting it to frequencies lower than the value entered in the Cutoff frequency for low-pass filter box.
   - Choose a setting from the **Low-pass filter quality** drop-down list to determine the sharpness of the filter's rolloff curve. **Best** produces the sharpest curve.

**Note:** Before rendering your surround project, check your surround authoring application's documentation to determine its required audio format. Some encoders require a specific cutoff frequency and rolloff, while other encoders require that no filter be applied before encoding.

5. Click **OK**.

The track list and Mixer window switch to 5.1 surround mode. The Master bus becomes the Surround Master bus, which contains faders for each of the six surround channels. Surround panners appear on tracks and mixer controls. Tracks routed to mixer controls (busses or assignable effects) do not have surround panners; panning for these tracks takes place on the mixer control.
Routing to hardware in the mixer

You must route the surround audio to the correct output in the mixer.

1. From the **Options** menu, choose **Preferences**.

2. Click the **Audio** tab.

3. From the **Audio device type** drop-down list, choose an audio device type other than **Microsoft Sound Mapper** (such as **Windows Classic Wave Driver**).

4. Choose the playback devices for the six surround channels:
   - From the Default Stereo and Front playback device drop-down list, choose the appropriate device for the front left and right surround channels.
   - From the Default Rear playback device drop-down list, choose the appropriate device for the rear left and right surround channels.
   - From the Default Center and LFE playback device drop-down list, choose the appropriate device for the center and LFE surround channels.

5. Click **OK**.

Overriding the default device routing

By setting up the device routing in the **Audio** tab of the Preferences dialog, you have set the defaults for surround routing in Vegas. However, you can override the default device routing at any time using the Surround Master bus in the Mixer window.

1. In the Mixer window, click the Audio Device Selector button ( ) on the Surround Master bus. A menu of surround channels (Front L/R, Rear L/R, and Center/LFE) appears.

2. In the submenu, match a surround pair with the appropriate output.

3. Repeat steps one and two to match each surround pair to the appropriate output.
Assigning audio to the LFE channel

Once the project is in 5.1 surround mode, you must decide whether a track will provide the “5” (surround panning) or the “1” (LFE channel) in 5.1 surround. Initially, all tracks in a surround project are set to provide surround panning, but you can assign a track to the LFE channel instead.

You can assign an individual track to the LFE channel or you can route the track to a mixer control (bus or assignable effect chain) and assign the mixer control to the LFE channel.

To assign audio to the LFE channel, right-click the surround panner on the track header or mixer control and choose LFE Only from the shortcut menu. The track or mixer control is assigned to the LFE channel.

Right-click the surround panner and choose LFE Only... ...to assign the track or mixer control to the LFE channel.

To change a track or mixer control back to surround panning, right-click the LFE indicator and choose Surround Pan from the shortcut menu.

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine its required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 156.

Panning audio

You can pan audio in a 5.1 surround project in two ways:

- Pan tracks individually using the Surround Panner window.
- Route tracks to mixer controls (busses, assignable effect chains) and pan the mixer controls using the Surround Panner window.

Panning tracks

1. Double-click the surround panner on the track you wish to pan. The Surround Panner window appears.
2. Adjust the panning settings. *For more information, see Using the Surround Panner window on page 160.*

3. Close the Surround Panner window.

**Tip:** You can also use the surround panner in the track header to pan your track.

### Panning mixer controls

You may choose to route tracks to busses or other mixer controls (such as assignable effect chains) and pan them as a group rather than panning each track individually.

**Note:** When you route a track to a bus, Vegas sends stereo (two-channel) output to the mixer control and the mixer control sends 5.1 (six-channel) output to the Surround Master bus.

1. Add a bus or assignable effect chain to the project. *For more information, see Using the Mixer on page 137.*

2. Route tracks to the bus or assignable effect chain. *For more information, see Using the Mixer on page 137.*

3. Double-click the surround panner on the mixer control to display the Surround Panner window.

4. Adjust the panning settings. *For more information, see Using the Surround Panner window on page 160.*

5. Close the Surround Panner window.

**Tip:** You can also use the surround panner on the mixer control to pan your track.
Using the Surround Panner window

Whether you’re adjusting track panning or mixer control panning, you use the same controls in the Surround Panner window.

View the Surround Panner window by double-clicking a surround panner on a track header or mixer control. Once the Surround Panner window is open, you can dock it in the Vegas workspace. For more information, see Window docking area on page 22.

Tip: You can also choose Surround Panner from the View menu to display the Surround Panner window. Once the Surround Panner window is displayed, double-click the surround panner for a track or mixer control to view its pan settings.

1. Click the speaker icons to mute or include channels.
   Muting a channel ensures that no audio bleeds through a channel. For example, you might want to mute all but the center channel when you’re panning dialogue to the center channel.

   Tip: **Ctrl** + click a speaker icon to solo the channel.

2. Drag the pan point to position the sound within the sound field. For more information, see Moving the pan point on page 161.

3. Click the center speaker icon to include the center channel and drag the Center fader to apply a gain to the center channel.
   Applying a gain to the center channel may make dialogue more present in the mix.

   Note: When automating panning using keyframes, you cannot automate the gain applied using the Center fader. For more information, see Automating panning on page 162.

4. Drag the Smoothness slider to adjust the smoothness of the interpolation path between panning keyframes. The smoothness setting appears only when you are automating panning using keyframes. For more information, see Adjusting the Smoothness slider on page 164.
Moving the pan point

Vegas provides a variety of methods to help you position the pan point in the Surround Panner window.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Click to toggle through three options for constraining pan point motion as you drag: Move Freely ( ), Move Left/Right Only ( ), and Move Front/Back Only ( ).</td>
</tr>
<tr>
<td>Double-click</td>
<td>Double-clicking the pan point resets it to the center front of the surround panner. Double-clicking in the Surround Panner window moves the pan point to the double-click location.</td>
</tr>
<tr>
<td>Ctrl+drag</td>
<td>Makes fine adjustments.</td>
</tr>
<tr>
<td>Shift+drag</td>
<td>Constrains motion to vertical, horizontal, or diagonal motion at 45 degree increments.</td>
</tr>
<tr>
<td>Alt+drag</td>
<td>Constrains motion to a constant radius from the center of the surround panner.</td>
</tr>
<tr>
<td>Shift+Alt+drag</td>
<td>Constrains motion to the maximally inscribed circle (a constant radius at the greatest possible distance from the center of the surround panner).</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Moves front/back/left/right.</td>
</tr>
<tr>
<td>Ctrl+Arrow keys</td>
<td>Makes fine adjustments.</td>
</tr>
<tr>
<td>Page Up/Page Down</td>
<td>Moves front/back.</td>
</tr>
<tr>
<td>Shift+Page Up/Page Down</td>
<td>Moves left/right.</td>
</tr>
<tr>
<td>Numeric keypad 1-9</td>
<td>Jumps to a corner, edge, or center of the surround panner.</td>
</tr>
<tr>
<td>Ctrl+Numeric keypad 1,3,7,9</td>
<td>Jumps to a location on the maximally inscribed circle (a constant radius at the greatest possible distance from the center of the surround panner).</td>
</tr>
<tr>
<td>Mouse wheel</td>
<td>Moves front/back.</td>
</tr>
<tr>
<td>Shift+mouse wheel</td>
<td>Moves left/right.</td>
</tr>
<tr>
<td>Ctrl+mouse wheel</td>
<td>Makes fine front/back adjustments.</td>
</tr>
<tr>
<td>Ctrl+Shift+mouse wheel</td>
<td>Makes fine left/right adjustments.</td>
</tr>
</tbody>
</table>

Choosing pan types

When you pan a track or mixer control, you can choose among several pan types to determine how Vegas pans the audio. The current pan type appears at the bottom of the Surround Panner window.

Right-click the Surround Panner window and choose a pan type from the shortcut menu.

- **The Add Channels** pan type makes the audio appear to move as a unit among the surround channels. As you move the pan point toward a channel (speaker icon), more and more of the signal from the other channels are folded into the channel you are panning towards, until at the extreme, all channels are fed at full intensity into a single channel. This pan type uses a linear panning curve.

- **The Balance** pan type is most useful for adjusting the relative signal levels of the channels. In this pan type, as you move the pan point from the center to a channel, the signal in the channel you are panning towards starts at the base dB level (either 0 dB, -3 dB, or -6 dB) and increases to 0 dB. The signal in the channel you are panning away from starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no signal level. For example, when you pan fully to the right, only the right channel is audible. This pan type uses a linear panning curve.

- **The Constant Power** pan type maintains a constant volume as you move the pan point from channel to channel. This pan type, which uses the constant-power panning curve, is most useful for panning monaural source media.
Using the grid to monitor panning

The grid in the Surround Panner window helps you to visualize how your panning will sound. The grid's spacing changes to match the current pan type.

The vertical lines represent the points where the left-to-right signal ratio is 6 dB, 0 dB, and -6 dB respectively: at the far-left line, the left channel is 6.0 dB louder than the right channel.

The horizontal lines represent the points where the front-to-rear signal ratio is 6 dB, 0 dB, and -6 dB respectively. As you adjust the Center fader, the lines move forward or backward to compensate for the center-channel gain.

---

**Note:** The grid assumes that you’re using a correctly set-up surround system (matched speakers and ideal positioning). Variations in your monitoring system will cause inconsistencies between the graph and perceived output.

---

Automating panning

You can automate panning on a track or mixer control by adding keyframes. Keyframes are similar to envelope points in that they specify a settings state at a point in time. However, unlike envelope points, keyframes appear just below the track to which they apply.

To add panning keyframes to a mixer control, you must first view the mixer control in track view. From the View menu, choose Show Bus Tracks to view the bus track at the bottom of the track view. For more information, see Viewing bus tracks on page 144.

Turning on panning keyframes

Before adding individual keyframes, you must first turn on the panning keyframes for the track or bus track.

1. Select the track or bus track for which you want to automate panning.
2. From the Insert menu, choose Audio Envelopes, and choose Surround Pan Keyframes from the submenu.

An additional row appears below the track with a single keyframe positioned at the beginning of the project. This single keyframe represents the current panning settings for the track.

---

Adding panning keyframes

With panning keyframes turned on, you can add keyframes at any location along the track or bus track.

1. Position the cursor where you want to begin panning the track.
2. Double-click the surround panner to display the Surround Panner window.
3. Adjust the panning settings. For more information, see Using the Surround Panner window on page 160.

---

**Note:** You cannot automate muting/including channels or the gain applied to the center channel using the Center fader.
4. Close the Surround Panner window.

A keyframe with the pan settings you created appears below the track at the cursor position.

Note: You can also add keyframes by double-clicking the keyframe row or by right-clicking the row and choosing Add Point from the shortcut menu. Once you’ve added the keyframe, double-click it to adjust panning settings in the Surround Panner window.

As you add keyframes to a track or bus track, the Surround Panner window shows the path of the panning keyframes. The Smoothness slider controls the smoothness of the interpolation path between the keyframes. For more information, see Adjusting the Smoothness slider on page 164.

---

**Working with keyframes**

After you add keyframes, you can work with them in much the same way as envelope points. For more information, see Working with track envelopes on page 109.

**Moving keyframes**

Drag a keyframe to a new position below its track.

**Duplicating keyframes**

Hold [Ctrl] and drag a keyframe to a new position below its track.

**Editing keyframes**

1. Double-click a keyframe to open the Surround Panner window.
2. Adjust the panning settings as desired and close the window.
Changing keyframe interpolation curves

To control how the pan is interpolated between keyframes, right-click a keyframe and choose an interpolation curve type from the shortcut menu. Keyframe interpolation curves control how the pan occurs over time. The keyframe color changes according to the interpolation curve you have chosen.

<table>
<thead>
<tr>
<th>Keyframe</th>
<th>Interpolation curve</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✹</td>
<td>Hold</td>
<td>No interpolation takes place. The keyframe’s settings are maintained until the next keyframe.</td>
</tr>
<tr>
<td></td>
<td>Linear</td>
<td>Panning is interpolated in a linear path.</td>
</tr>
<tr>
<td></td>
<td>Fast</td>
<td>Panning is interpolated in a fast logarithmic path.</td>
</tr>
<tr>
<td></td>
<td>Slow</td>
<td>Panning is interpolated in a slow logarithmic path.</td>
</tr>
<tr>
<td></td>
<td>Smooth</td>
<td>Panning is interpolated along a smooth, natural curve.</td>
</tr>
</tbody>
</table>

Adjusting the Smoothness slider

The Smoothness slider controls the perceived motion of sound within the sound field among three or more keyframes. When you drag the Smoothness slider to 0, Vegas interpolates the changes between keyframes along a linear path. As you increase the smoothness value, the path between keyframes grows more curved and smooth.

1. Double-click a keyframe. The Surround Panner window appears.

2. Drag the Smoothness slider to adjust the smoothness of the spatial interpolation path leading up to this keyframe.

Looking keyframes to events

If you want keyframes to move with an event when it is moved along the timeline, choose Lock Envelopes to Events from the Options menu.
Hiding keyframes

1. Select the track for which you want to hide keyframes.
2. From the View menu, choose Show Audio Envelopes, and choose Surround Pan Keyframes from the submenu.

Deleting keyframes

Right-click a keyframe and choose Delete from the shortcut menu.

Rendering surround projects

Vegas renders 5.1 surround projects to produce six monaural files (AIFF, WAV, W64, or PCA), or a single 5.1-channel file (AC-3, WMA, and WMV). You can then use an authoring application to create the final DVD-Video or 5.1-channel music project from the rendered files.

**Note:** Before rendering your surround project, check your surround authoring application’s documentation to determine its required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 156.

1. From the File menu, choose Render As. The Render As dialog appears.
2. From the Save in drop-down list, choose the drive and folder where the file will be saved.
3. Enter a new name for the project in the File name box.
4. From the Save as type drop-down list, choose the desired file format.
5. Choose 44,100 Hz, 16 Bit, Mono, PCM from the Template drop-down list if you want to render six monaural files, or choose an appropriate 5.1-channel template if the selected file type supports it.
6. If necessary, click Custom to customize the rendering settings. For more information, see Customizing the rendering process on page 242.
7. Select the Render loop region only check box if you want to save only the portion of the project that is contained within the loop region. Loop Playback does not need to be selected on the Vegas workspace for this option to work.
8. If the selected file type supports it, you can select the Save project markers with media file check box to include markers, regions, and command markers in the rendered media file. If Vegas cannot save the information in your media file, it will create an .sfl file (using the same base name as your media file).
9. Click Save.

Rendering the surround project SampleProject.wav...

...results in six WAV files.

Note: You can use an application such as the Sonic Foundry 5.1 Surround Plug-In Pack to encode 5.1-channel audio to AC-3 for use in DVD authoring.

Creating a DVD with DVD Architect

If you have Sonic Foundry DVD Architect™, you can create menu-based DVDs, music compilations, picture slide shows, or a single-movie DVD that will play back automatically in your DVD player.

DVD Architect includes support for many file types and can convert your media to the formats required for DVD as needed. However, for best performance (decreased disc preparation time and recompression), render your files in the appropriate format in Vegas.

MPEG-2 video files rendered with the DVD NTSC or DVD PAL templates will not need to be recompressed. Audio will not need to be recompressed if rendered as stereo or surround AC-3 files with a bitrate of less than 448 kbps or as stereo, 48-kHz, 16-bit, WAV (PCM) files.

Note: AC-3 audio may not play back on some PAL DVD players. To ensure compatibility with PAL DVD players, use 48-kHz, 16-bit, WAV (PCM) files for audio.
CHAPTER 167

Using Advanced Video Features

While simple to learn, Vegas is a powerful application with many advanced features. This chapter covers some of the advanced video features of this powerful tool.

Cropping video

With the Event/Pan Crop window, you can resize media in a video event or selectively crop media without resizing. The Stretch to fill frame check box allows you to resize the media to fill the output frame (when selected), or to crop out a portion of the media without resizing (when cleared).

When keyframes are added, you can use this window to create scrolling, panning, or zooming effects. For more information, see Using keyframe animation on page 209.

Tip: If you apply plug-ins to a event with panning or cropping, you can choose whether Vegas processes the plug-ins before or after the panning or cropping. For more information, see Processing plug-ins on events with panning or cropping on page 187.
Open the Event Pan/Crop window by clicking the Event Pan/Crop button on the event.

![Event Pan/Crop window](image)

**Note:** If any controls shown in the figure above are not visible, enlarge the Event Pan/Crop window by dragging the lower right corner until all controls are revealed.

The Smoothness control and the keyframe controller are used when adding keyframe animation to create panning, zooming, or scrolling effects. For more information, see Animating event panning and cropping on page 213.

**Cropping**

Cropping is the process of removing the outside edges from an image or video, thereby re-framing the subject. In the following example, the Event Pan/Crop window on the left has been used to create a selection area around the subject, removing extraneous information from the outside of the video. This creates a zoom effect that is similar to zooming in with a camcorder. The Video Preview window on the right displays the event after cropping.
1. Click the Event Pan/Crop button ( ) on the event.

2. Drag the handles (small boxes) located around the perimeter of the selection area to change the size.

3. Move the mouse to middle of the selection area until the cursor changes to a move icon ( ). Drag the selection area to reposition it.

Be aware of the following as you crop a video event:

- To keep the selection area centered as you resize, select the Size About Center button ( )
- To maintain the proportion of the selection area, select the Lock Aspect Ratio button ( )
- To prevent distortion of the source media file, ensure that Maintain aspect ratio is selected.
- To restore the selection area to full frame, right-click the image and choose Restore from the shortcut menu.
- To set the selection area to a standard aspect ratio proportion, choose a preset from the Preset drop-down list.
- When using photographs or other media that is not the same frame aspect as your video, you’ll see black bars on the sides or above and below the image. To create a crop rectangle that matches the project frame aspect, right-click the image and choose Match Output Aspect from the shortcut menu.

The cropping occurs instantly and the results are updated in the Video Preview window. Cropping applies to the entire event and can be animated with keyframes. For more information, see Using keyframe animation on page 209.

**Rotating**

You can also rotate the selection area in the Event Pan/Crop window. If you rotate the entire frame, the background behind the video shows through. Position, size, and rotation can all be animated with keyframes. For more information, see Using keyframe animation on page 209.

1. Click the Event Pan/Crop button ( ) on the event.

2. Resize and move the selection area as desired. For more information, see Cropping on page 168.

3. Move the mouse outside the selection area until it becomes a rotate icon ( ). Drag to rotate the selection area. Alternately, you may enter precise rotation values in the Angle (degrees) box.

**Understanding the rotation clock**

As you drag to rotate the selection area, the rotation clock displays. The rotation clock works like an altimeter on an airplane. The larger hand represents the degree of rotation relative to 0°, which is straight up. The smaller hand shows the number of times the crop area has been rotated through 360°.
Adding animation

Keyframe animation dramatically increases the variety of panning, zooming, and rotating effects you can create using the Event Pan/Crop window. A later chapter provides examples of zooming in on a still image and using pan-and-scan techniques. *For more information, see Animating event panning and cropping on page 213.*

Working with still images

You can use still images in Vegas for a number of purposes including slide shows, overlay graphics, and titles. You can insert still images into projects just like any other media files. The default length for a still image event when it is first added to a track is five seconds (this is an adjustable preference), but this duration can be modified by dragging the edges to create a still image event of any length. Images cannot be looped, but share many characteristics with video files, including transparency. In addition, you can use many of the same tools on image events that you can on video events, such as track motion, panning and cropping, and video effects plug-ins. *For more information, see Zooming in on a still image on page 213.*

Creating still images for use in Vegas

Many image formats can be imported into Vegas: BMP, GIF, JPG, PNG, TIFF (requires QuickTime), PSD (flattened), and TGA. If you have the option to create PNG files in your graphics software, this is the recommended file type. PNG files use lossless compression and can also include alpha channel information, which is one of the cleanest methods of creating transparency for overlays. Vegas can automatically detect an alpha channel, if present, in PNG files.

---

**Note:** Vegas may not automatically detect the alpha channel in TGA images. Right-click a TGA image in the Media Pool or an event on the timeline and choose Properties. Then, in the Media Properties dialog, select the type of alpha channel from the list.

---

If you know your media file has an alpha channel and Vegas is not detecting it properly, right-click the media file in the Media Pool or an event on the timeline and choose Properties from the shortcut menu. Then, in the Media tab, select the appropriate alpha channel type from the Alpha channel drop-down list. **Premultiplied** is the recommended setting. You can save this setting so that Vegas will properly detect the alpha channel on other media files with the same properties. *For more information, see Setting custom stream properties on page 182.*
Correcting images for DV pixel aspect ratios

For best results when importing still images into Vegas, create images that account for the pixel aspect ratio of your desired output format. Vegas does a good job stretching images to fit the output format, but some distortion occurs if the pixel aspect ratio for the source format does not match the destination format.

To calculate pixel aspect ratio correction, use this formula:

\[
\text{Output frame pixel width} \times \text{Output format pixel aspect ratio} = \text{Still image pixel width}
\]

For example, this is the formula for NTSC DV format:

\[
720 \text{ (DV screen frame pixel width)} \times .9091 \text{ (DV pixel aspect ratio)} = 655 \text{ (pixel width)}
\]

Use these figures as a guide when creating images:

- Full frame, pixel-aspect-corrected still images for use in NTSC DV projects are 655x480.
- Full frame, pixel-aspect-corrected still images for use in PAL DV projects are 787x576.

Capturing a timeline snapshot

You can create still images of a single frame of your project. Once saved, the snapshot can be used just like any other still image.

1. Position the cursor on the frame of the project you wish to capture as a still image.
2. Click the Save Snapshot to File button on the Video Preview window. The Image Filename dialog appears.
3. Select a file format (JPEG or PNG) and enter a name for the new still image file.
4. Click Save. The image is added to the Media Pool.
Creating a slide show

A slide show composed of still images and an accompanying soundtrack can be an excellent way to show off your pictures. You can insert multiple images to instantly create a slide show, complete with crossfades.

Importing high-resolution still images and using panning, cropping, and track motion tools can add interest to an otherwise static slide show. For more information, see Cropping video on page 167 and Adding track motion on page 217.

1. In the Options menu, verify that Automatic Crossfades is selected.

2. From the Options menu, choose Preferences. Adjust the following settings on the Editing tab:
   - Enter the length for the still images in the New still image length box.
   - Select Automatically overlap multiple selected media when added.
   - Enter the length of the automatic overlap in the Amount box in the Cut-to-overlap conversion section of the dialog.

3. Click OK. The Preferences dialog closes.

4. Select all of the images you want to use in the Explorer.

5. Right-click and drag these files to the timeline.

6. From the shortcut menu, choose Add Across Time.

If you want, you can replace the crossfades between images by dragging transitions to the crossfade regions at a later time. For more information, see Using transition effects on page 203.

Note: When using photographs or other media that is not the same frame aspect as your video, you’ll see black bars on the sides or above and below the image. To create a crop rectangle that matches the project frame aspect, right-click the image and choose Match Output Aspect from the shortcut menu.

Creating titles

Most video projects include titles and credits. There are two ways to add text to your project. You can use the Vegas titling engine (text generator) or you can use an external image-editing program to create titles. For more information, see Using generated media on page 189.
Creating titles from images

While every software application is slightly different, the general procedure for creating titles with a transparent background is as follows.

1. Start your image-editing application.

2. From the File menu, choose New. Set the dimensions of the new image to be the same as the frame size for the project. For more information, see Correcting images for DV pixel aspect ratios on page 171. Make the default canvas (background) color a solid color. The background will be transparent in the final image, so any solid color works.

3. Select the Text tool and enter the text for your title.

   Note: Size and position your titles carefully to fit within the Title Safe Area or the titles may extend beyond the edges of your television. For more information, see Identifying safe areas on page 228.

4. From the File menu, choose Save As.

5. From the Save as type drop-down list, choose TGA, PNG, PSD or BMP (PNG is recommended). Make sure that you save the alpha channel information (for TGA and PNG), which is used for transparency.

6. Enter a name and click Save.

7. In Vegas, insert the image in a track just above the one with the video that will be in the background.

8. Click the Compositing Mode button ( ) on the title track and choose Source Alpha (default) if your image has an alpha channel associated with it. If it does not, you may need to add a Chromakey filter to the image and key out the background. For more information, see Chromakeying on page 200.

   The alpha channel is saved as a selection area in some programs. If you cannot save the alpha channel, use a black background and Vegas will create a mask from the background. The alpha channel of TGA images may not be detected automatically. For more information, see Modifying media file properties on page 181.
Fading titles

Another common technique is to fade a still title in and out. You can create this effect by using an opacity envelope on a title event. For more information, see Using opacity envelopes on page 125.

You can also create multiple title images and then use crossfades or custom transitions between them. For more information, see Using transition effects on page 203.

Adding closed captioning to Windows Media Video (WMV) files

Closed captioning makes your final video accessible to a wider audience. You can use text commands to add captions line-by-line to a Windows Media Video (WMV) file, or for longer projects, you can add captioning from a script.

Adding closed captioning line-by-line

1. Position the cursor where you want the closed captioning text to appear.
2. From the Insert menu, choose Command. The Command Properties dialog appears.
3. From the Command drop-down list, choose Text.
4. In the Parameter box, enter the closed captioning text you want to display.
5. Click OK.
6. Repeat steps 1-5 for each line of closed captioning text you want to add.
7. Render your file in Windows Media Video format. For more information, see Rendering a project on page 239.

Tip: Take steps to ensure that the closed captioning displays when the video is played. For more information, see Displaying closed captioning on page 176.

Adding closed captioning from a script

Using a script to generate closed captioning involves several steps. First, you must copy and paste the lines from the script into a spreadsheet. You can create the spreadsheet from scratch (using the steps that follow) or use the sample shell (Vegas Captioning Shell.txt) provided in the Samples folder on the Vegas CD. You can open this tab-delimited shell with a spreadsheet application or, in the absence of a spreadsheet application, any text editor.

Once the spreadsheet is complete, you can copy and paste the lines into the Edit Details window. You can set the position for each line of closed captioning during playback in Vegas.
Creating a script spreadsheet

1. Create a four-column, tab-delimited spreadsheet.

2. In the first column, enter 00:00:00:00 in each of the cells as a placeholder. You will set the actual position of each line during playback in Vegas.

3. In the second column, enter TEXT in each of the cells to specify the command type.

4. In the third column, enter the text that you want to display as a closed caption. Enter each line in its own cell.

   **Tip:** If you have a script, you can copy and paste individual lines into the cells.

5. In the fourth column, enter a label to identify your captions. An entry such as Line 001 can help you sort the captions once you paste them into Vegas.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>But, soft! What light through yonder window breaks? Line 001</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>It is the east, and Juliet is the sun Line 002</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Arise, fair sun, and kill the envious moon, Line 003</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Who is already sick and pale with grief, Line 004</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>That thou hast made art far more fatal than she: Line 005</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>She is not married, since she is arraign'd, Line 006</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Her wealth is but sick and green Line 007</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>And none but fools do wear it, cast it off Line 008</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>O, it is my lady, O, it is my love! Line 009</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>O, that she knew she were! Line 010</td>
<td></td>
</tr>
<tr>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Line 011</td>
<td></td>
</tr>
</tbody>
</table>

   **Note:** The final caption displays in the Windows Media Player until the end of the video. To clear the final caption sooner, add a final command with no text (as shown above).
Copying and pasting captions into Vegas

1. Select the cells in the spreadsheet and copy them.
2. Switch to Vegas and choose Edit Details from the View menu. The Edit Details window appears.
3. From the Show drop-down list, choose Commands.
4. Right-click the gray box in the upper-left corner and choose Paste from the shortcut menu. Vegas pastes the spreadsheet data into the Edit Details window.
5. Click the column header for the Comments column. This sorts the captions by line number.

Setting closed captioning timing

1. Position the cursor shortly before where you want the first caption to occur.
2. Select the row for the first caption in the Edit Details window.
3. Click the Play button (►) to start playback.
4. When playback reaches the place where the first caption should occur, press \[Ctrl]+K. Vegas inserts the first caption at the cursor position, updates the Position setting in the Edit Details window, and selects the next caption.
5. Press \[Ctrl]+K to insert each subsequent caption.
6. Render your file in Windows Media Video format. For more information, see Rendering a project on page 239.

Displaying closed captioning

You may use one of two methods for displaying the closed captioning when the video is played:

- Instruct your audience to turn on captioning. In Windows Media Player 7 and 8, choose Now Playing Tools from the View menu and choose Captions from the submenu.
- Create an HTML page with the Windows Media player embedded in it. See Vegas online help for a sample HTML page.
Resampling video

Resampling allows Vegas to interpolate frames in an event when the frame rate of a media file is lower than the project’s frame rate. With resampling, the intervening frames are interpolated from the source frames, much like a crossfade between the original frames.

You can instruct Vegas to resample the video of a single video event or to resample the entire project at the time of final rendering:

- To resample an event, right-click a video event and choose Properties from the shortcut menu. In the Video Event tab of the Properties dialog, choose the Smart resample, Force resample, or Disable resample radio button. For more information, see Accessing event properties on page 122.
- To resample the project, choose Render As from the File menu. In the Render As dialog, click the Custom button to access custom rendering settings. Select the Resample the frame rate of all video check box. For more information, see Customizing the rendering process on page 242.

Resampling at either the event or project level perform the same function. There are few cases where resampling may be particularly important:

- When the frame rate of the source media for an event is slower than the project’s frame rate. For example, when you are using a source media file that has a 10 fps rate in a 29.97 fps rate project, resampling is recommended.
- When changing the speed of a video event. For example, when slowing a clip to 30% using a velocity envelope, resampling is recommended.
- When creating vertically scrolling titles.
When any of the above situations are true, there are only ten frames of source material for every second of project time. When the project is rendered, there must be roughly thirty frames in each second. Vegas must create the frames between the source media frames, sometimes known as padding. The easiest way to do this is to simply duplicate the previous frame. This can result in less than smooth video playback. Resampling allows Vegas to interpolate the intervening frames more smoothly.

**Using Edit Decision Lists (EDL)**

Vegas Edit Decision Lists (EDL) are text lists of all of the media files used, where they are placed, and how they are trimmed. As such, Vegas EDLs are not the same as EDLs used in traditional linear edit suites. These simple text lists can be used as a printed summary of your project, can be used to open a Vegas project in another compatible application, or can be used to convert a project from another application into a Vegas project. There are some necessary limitations to this conversion process because of the great disparities between video editing applications.

**Creating an EDL**

1. From the **File** menu, choose **Save As**. The Save As dialog appears.
2. From the **Save as type** list choose **EDL Text File (.txt)**.
3. Enter a name for the file and browse for a destination.
4. Click **Save**.

You can open EDLs created in another application in Vegas in order to work with a rough copy of a project. For example, you could create an EDL from a project in a third-party editing application and then import the project into Vegas via the EDL. For best results, save the EDL file and source media files in a single folder before opening the EDL in Vegas.

**Opening an EDL**

1. From the **File** menu, choose **Open**.
2. Locate the EDL file, select it, and click the **Open** button. If you are working on another project, Vegas prompts you to save your work before it opens a the new project.

   **Note:** EDLs do not contain any information about the location of source media. Therefore, the EDL file should be saved in the same directory as the source media. If it is not, or if media is stored in a number of different locations, Vegas prompts you to relink these files when the EDL is imported.

Because of the significant differences between editing applications, third-party (e.g., CMX and Sony) EDL files may not bring all of the project data into Vegas. Among other differences, events are inserted into the timeline on a single track, all transition effects are replaced with crossfades, and only four audio tracks can be imported.

**Working in DV format**

Vegas is optimized for DV editing. If your project is destined for tape or television, the DV format is an excellent choice. The Sonic Foundry DV codec provides video with excellent image quality, even over multiple generations, and provides audio that is better than CD-quality. If you start with well-shot DV footage and stay within the DV format throughout the editing process, you can output broadcast-quality video programs from Vegas. This section provides guidelines for working in the DV format in Vegas.
Selecting source media

Wherever possible, use DV source video clips. You can capture video from DV cameras and decks using an IEEE-1394 card with no quality loss. You can also convert analog footage to DV using a device like the Canopus ADVC-100 (a good choice for NTSC or PAL).

Setting project properties

Set your project to match the DV format of your final output. This provides a true WYSIWYG view of the project when you use an external monitor for previewing. This also prevents you from stretching output or changing field order unnecessarily. You can match the project settings to a DV source file by using the Match Media Settings button ( ) in the Project Properties dialog. For more information, see Setting video properties based on a media file on page 38 and Modifying project video properties on page 180.

Selecting templates

Always select a DV template when performing any of the following tasks in a DV project:

- prerendering video (pg. 225)
- rendering to a new track (pg. 117)
- printing video to tape from the timeline (pg. 246)
- rendering a project (pg. 239)

Rendering to a new track and printing video to tape from the timeline are only available in the full version of Vegas.

When prerendering video or rendering to a new track, a DV template not only optimizes playback performance, but also helps you avoid needless recompression of DV footage. Vegas recompresses DV material only when necessary. Cuts-only DV sequences are not recompressed when you output the project to DV from the timeline or in Video Capture.

The DV templates are designed to provide high quality, pixel aspect-correct, DV-compliant renders when rendering a project or printing to tape from the timeline. Do not select an uncompressed setting when choosing rendering or print-to-tape options. An uncompressed setting produces a large file that will not print back to DV tape from Video Capture or from the timeline.

Eliminating out-of-range colors

The DV format allows color values to exceed broadcast NTSC and PAL color level standards. If you have a scene whose colors are too hot, or if you want to be sure that your video stays within legal broadcast levels, apply the Broadcast Colors effect to specific events or the entire project.

Be aware that applying the Broadcast Colors effect results in recompression of the video. As a result, render times can increase significantly when the effect is applied to the entire project.
Modifying video properties

Modifying project video properties

You can access project video properties by clicking the File menu and choosing Properties or by clicking the Project Video Properties button ( ) on the Video Preview window. Many of these settings are identical to the settings found on the Project tab of the Custom Template dialog. Final render properties set up in the Custom Template dialog override the following Project Properties settings. For more information, see Video tab on page 243.

These properties control all of the default settings for your project. Without making any changes, these are also the settings that are used to create a final rendered movie file.

- Select a preset template from the Template drop-down list to automatically configure the remaining video controls in this dialog. Many popular formats are included, but you should consult your hardware manuals if you have any questions. You can also save your own custom template.
- Click the Match Media Settings button ( ) to set your project properties to match the properties of a media file of your choosing.
- The values in the Width and Height boxes set the frame size of your final movie.
- Choose an option from the Field Order drop-down list to set the field order. Choose None (Progressive) for video to be viewed on a computer monitor. For DV output, choose Lower Field First. If the output is jittery or shaky, or your hardware’s manual specifies it, choose Upper Field First. For more information, see Interlacing and field order on page 285.
- Choose the pixel aspect ratio for the final movie’s destination from the Pixel aspect ratio drop-down list. For more information, see Pixel Aspect Ratio on page 297.
- Choose a frame rate for the final movies destination from the Frame rate drop-down list. For more information, see Frame Rate (Video) on page 295.
- Choose a rendering quality level from the Full resolution rendering quality drop-down list. For most projects, Good is the recommended setting. If you have critical material where nothing but the highest quality rendering will do, select Best. Please note that rendering time may increase dramatically as large amounts of extra processing is required for the Best setting.
- Some effects and transitions can involve motion or animation. The Motion blur type drop-down list allows you to select whether the frames are blurred slightly to create the illusion of motion on individual frames. This can make computer generated animation appear more smooth and natural. Gaussian is the best choice in most situations where blurring is required.
- The Deinterlace method drop-down list provides several options relating to interlacing. Source video from a television is interlaced. When Vegas renders effects, it needs to deinterlace the two fields that make up a frame. You can choose the exact method Vegas uses in this list. If you choose the None option, Vegas leaves the fields interlaced. If you choose the Blend option, Vegas uses contents from both fields, which is a good choice for high-detail, low-motion material. If you choose the Interpolate option, Vegas uses a single field at a time, which is good for low-detail, high-motion material.
- Choose the location for Vegas to save prerendered preview files in the Prerendered files folder box. For more information, see Prerendering video on page 225.
- Select the Start all new projects with these settings check box to always use these settings for new projects.
Modifying media file properties

Vegas tries to automatically detect the properties of your media files. In most cases, these properties do not need to be modified, but there are times when you may need manual control over some of these attributes, depending on the type of file and your specific hardware configuration.

1. Right-click a file in the Media Pool or an event on the timeline and, from the shortcut menu, choose Properties.

2. Modify the parameters on the Media tab as needed. See Setting general media properties on page 181 and Setting custom stream properties on page 182.

3. Click OK.

Setting general media properties

The following general properties appear in the top of the Media tab:

- The File name box displays the file name (cannot be edited).
- The Tape name box displays the name of the tape for media files captured in Video Capture. You can edit the name here or in the corresponding column in the Edit Details window.

Setting timecode media properties

These properties appear in the Timecode section of the Media tab:

- The Use timecode in file radio button is the default setting, where Vegas uses the media file's timecode.
- The Use custom timecode radio button allows you to set the media file's timecode manually.
- If you have selected the Use Custom timecode radio button, a drop-down list contains the available timecode formats. SMPTE Drop (29.97 fps, Video) for example, is the timecode format for NTSC DV. Changing the timecode format does not change the source media file in any way. It merely changes how the file is measured in time. For more information, see Timecode on page 287.
Setting custom stream properties

Vegas opens media files with a set of default values based on the media file type. When you change any of the values for a media file, these changes are saved for that file in the current project only. If you want to change the default settings for a particular type of video file whenever that type of file is used in Vegas, click the Save settings to video profiles for future auto-detection button ( ) to the right of the Stream list. This adds an entry to a file called vegas video profiles.ini that can be referenced for future use.

The following properties appear in the Stream properties section of the Media tab:

- If the file has more than one stream of the given type, you can choose the particular stream to work with from the Stream drop-down list.
- The Attributes, Format, and Frame rate boxes display basic information about the file.
- Choose an option from the Field order drop-down list to control how the video field order is handled on a television monitor. Choose None (Progressive) for video to be viewed on a computer monitor. For DV output, choose Lower Field First. If the output is jittery or shaky, or your hardware’s manual specifies it, choose Upper Field First. For more information, see Interlacing and field order on page 285.
- While you can choose a different value from the Pixel aspect ratio drop-down list, this value should always match the source video’s properties.
- The option selected in the Alpha channel drop-down list determines how transparency is handled in a file. The default alpha channel setting for most video files is None. PNG image files can have an alpha channel that is automatically detected by Vegas. The options in this drop-down list are described below.

<table>
<thead>
<tr>
<th>Alpha channel option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined</td>
<td>Because the image format provides no alpha channel information, this setting ignores any alpha channel information in the file.</td>
</tr>
<tr>
<td>None</td>
<td>Either there is no alpha channel or there is an alpha channel but it’s completely opaque (solid).</td>
</tr>
<tr>
<td>Straight (unmatted)</td>
<td>Transparency information is maintained in only the alpha channel. Alpha information must be applied to the RGB channels before compositing.</td>
</tr>
<tr>
<td>Premultiplied</td>
<td>The standard method of handling alpha information. Transparency information is maintained in the alpha and RGB channels, and the image is ready for compositing. No RGB component exceeds the alpha value.</td>
</tr>
<tr>
<td>Premultiplied (dirty)</td>
<td>Similar to Premultiplied, but RGB components may exceed the alpha value. This option is used mainly for images created by 3D applications involving compositing of 3D images over a non-solid color image background.</td>
</tr>
</tbody>
</table>

Modifying output properties

You can adjust final output properties when you render your movie. For more information, see Creating custom rendering settings for AVI files on page 243.

Using Video FX, Compositing, and Masks

Video plug-ins in Vegas include effects and generators. Effects cover a broad range of electronic modifications that can be used to improve substandard video or artistically enhance a production. Generators can be used to create custom video events such as credit rolls or gradient overlays.

Vegas provides a variety of options in compositing video and using masks. Compositing involves mixing visual elements together into a final output. Vegas provides multiple compositing modes from which to choose. Masks, which are used extensively in television and movies, are an important part of creating overlays. Together, these professional tools can help you polish your productions.

Vegas provides multiple compositing modes and parent/child video track grouping (for masks), while Vegas LE limits you to source alpha compositing.

Using video effects

Vegas provides a great variety of video effects plug-ins that are ready for you to drag-and-drop onto your projects, media files, tracks, and events. Previews of the different effect presets appear in the Video FX window. In addition to the presets, each plug-in has individual controls that allow you to customize the effects in precise detail. You can also animate video effects using keyframes. For more information, see Using keyframe animation on page 209.

The mix of video effects applied at different levels (to events, tracks, files, etc.) is important to the final mix of a project. For more information, see Video signal flow on page 36.

In general, effects are applied in the following order:

- to files in the Media Pool
- to events
- to tracks
- to the project (video output effects)
Adding a video effects plug-in

You can apply video effects to events, tracks, files in the Media Pool, or to an entire project. You can add a plug-in by selecting it in the Plug-In Chooser dialog, or you can drag-and-drop the plug-in from the Video FX or Plug-Ins windows.

Adding a plug-in using the Plug-In Chooser

1. Click the Video FX button ( ) in one of the following locations (see the illustration):
   - Media FX are applied before a media file is inserted into an event on the timeline. Every occurrence of this media file in a project has the effect applied to it.
   - Event FX are applied to events on the timeline.
   - Track FX are applied to the output of a particular track.
   - Video Output FX are applied to the final output and affect every event in a project.

2. In the Plug-In Chooser dialog, select the effect that you would like to apply and click OK.
3. Modify the effect in the Video FX window and close the window when you are finished. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.
Adding a plug-in from the Video FX or Plug-Ins window

1. If the Video FX or Plug-Ins window is not currently visible, choose either Video FX or Plug-Ins from the View menu to view the appropriate window.

2. Drag and drop a plug-in from the window onto one of the following locations. The mouse cursor changes ( ) to indicate when you can drop the plug-in:
   - file in the Media Pool
   - event
   - track list or empty section of a track
   - Video Preview window (video output effects)

3. Modify the effect in the Video FX window and close the window when you are finished. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.
Working with video effects plug-in chains

You can apply plug-ins in chains of two or more for even greater flexibility. A plug-in chain is a sequence of all of the plug-ins to be applied to a media file, event, track, or project. The same plug-in can be added to a chain more than once. Use the same steps to add additional plug-ins to a chain as you use to add a single plug-in. For more information, see Adding a video effects plug-in on page 184.

After you apply a plug-in chain, the video is processed by each plug-in in order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the desired effect.

To view and work with a plug-in chain, click the Video FX button ( ) for the event, track, Media Pool file, or Video Preview window to open the Video FX window.

Bypassing plug-ins

Video effects plug-ins can also be temporarily bypassed (turned off) by deselecting them (clearing the check box on the plug-in). Since the effects are rendered very quickly in the Video Preview window, turning a plug-in on and off allows you to see the results of the plug-in on your project.

Changing the plug-in order

Vegas applies video effects plug-ins in the order that they appear in the chain. You can change this order by dragging a plug-in to a new location in the chain. Alternately, you can click the Plug-In Chain button ( ) in the Video FX window and reorder the plug-ins in the Plug-In Chooser dialog.

In the following illustration, you can see how the order of plug-ins is important.
The goal of the above example is to use video effects plug-ins to create a very high-contrast mask out of a video clip of fire. In the image on the left, a Brightness and Contrast plug-in is applied first and then a Black and White plug-in. In the image on the right, the Black and White plug-in was applied first, removing the color, and then the Brightness and Contrast plug-in was applied. The mask created by the second example is much cleaner, even though all of the settings of the two plug-ins are identical.

Processing plug-ins on events with panning or cropping

When you add a plug-in to a video event that has panning or cropping applied to it, you have the choice of processing the plug-in before or after the pan/crop. For example, you might want to apply a Radial Blur plug-in before Vegas crops the video and then apply a Noise plug-in after the cropping is complete.

You can choose whether an effect is applied pre- or post-pan/crop in the keyframe controller at the bottom of the Video FX window. Click the Before/After Pan/Crop button to the left of the effect name to determine whether the effect is processed before (↑) or after (↓) Vegas pans or crops the event.

Removing a plug-in

1. Click the FX button (•) on the event, track, Media Pool file, or Video Preview window that has the plug-in applied to it. The Video FX window appears.
2. Click the plug-in that you want to remove.
3. Click the Remove Selected Plug-In button.
Modifying a video effects plug-in

Video effects plug-ins are highly customizable. You can select from a variety of presets or adjust the settings for custom effects. You can also save custom settings to be used again as a new preset.

1. Click the FX button ( ) on the event, track, Media Pool file, or Video Preview window that has the plug-in applied to it. The Video FX window appears.
2. Select a preset from the Preset drop-down list or adjust the parameters as needed. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Changes you make are automatically updated in the Video Preview window, using the current cursor position as the example. To see the effect as applied to the video in motion, create a time selection (looped region) and preview in loop playback.

Saving custom plug-in settings as a preset

1. Click the Preset text box. The name of the current preset is highlighted.
2. Type a new name for the preset and click the Save button ( ).

Tip: To use a saved custom preset, simply choose it from the drop-down list.

Using keyframe animation with plug-ins

You can use keyframe animation to control a plug-in over time. Keyframes are added to the keyframe controller at the bottom of the Video FX window. Since a number of plug-ins can be added to a single event, track or project, click the plug-in's button in the chain and modify the particular attributes and keyframe controller for that plug-in. For more information, see Using keyframe animation on page 209 and Animating video effects plug-ins on page 215.
Using generated media

Generated media plug-ins are a special class of plug-in that creates virtual media files contained in events on the timeline. These virtual files are stored in the Media Pool, where their properties can be viewed and modified.

Generated media provide an easy way to add text, backgrounds, or test patterns to your project. You can view the generators by choosing Media Generators from the View menu to display the Media Generators window.

Generated media events can be animated using keyframes. For more information, see Using keyframe animation on page 209 and Animating generated text on page 216.

<table>
<thead>
<tr>
<th>Generated media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkerboard</td>
<td>Creates checked and striped patterns.</td>
</tr>
<tr>
<td>Color gradient</td>
<td>Creates gradient colored events to be used behind overlays, as masks, or for fades.</td>
</tr>
<tr>
<td>Credit roll</td>
<td>Creates events that format your text into credits. Text can be formatted within the Video Event FX dialog in Vegas, or pasted into this dialog from a word processing program.</td>
</tr>
<tr>
<td>Noise texture</td>
<td>Creates realistic-looking textures.</td>
</tr>
<tr>
<td>Solid color</td>
<td>Creates solid colored events to be used behind overlays or for fades.</td>
</tr>
<tr>
<td>Test pattern</td>
<td>Creates standard test patterns that can be used to calibrate your video output stream. Many studios and broadcast facilities require a color bar pattern at the beginning of your video so that engineers can calibrate their equipment.</td>
</tr>
<tr>
<td>Text</td>
<td>Creates events containing text for titles or simple credits. Text can be formatted with color, shadows, and other effects.</td>
</tr>
</tbody>
</table>

Adding a generated media event

You can add a generated media event by choosing Generated Media from the Insert menu. This adds the event at the cursor position in the selected track. However, perhaps the simplest way to add generated media is through drag-and-drop.

1. From the View menu, choose Media Generators. The Media Generators window displays.

2. Drag a generator from the Media Generators window to the project. The mouse cursor changes ( ) to indicate when you can drop the generator.

3. Modify the generator in the Video FX window and close the window when you are finished. To modify settings at a later time, click the Generated Media button ( ) on the event. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Tip: A generated media event is ten seconds long as a default. However, you can trim the event to any length. For more information, see Trimming an event on page 66.
Duplicating a generated media event

Once you have added a generated media event and modified its settings, you can duplicate it. For more information, see Duplicating events on page 65.

When you duplicate a generated media event, you have two options:

- Select the Create a new copy of the source media radio button if you want the new event to be modified on its own. The new event is completely independent of the original event.
- Select the Create a reference to the original media radio button to keep the new event linked to the original generated media event. Any change to either event is mirrored in the other.

Compositing

Compositing is the process of mixing visual elements together into a final output. In Vegas, this means mixing tracks together vertically. Masks, generated text, and chromakeying all involve compositing. Understanding how compositing works in Vegas is important to understanding these and many other video track mixing techniques.

Vegas provides multiple compositing modes and parent/child video track grouping (for masks), while Vegas LE limits you to source alpha compositing.

Understanding the parent/child track relationship

The key to understanding overlays, masks, transparency, and compositing is to understand the parent/child relationship between tracks. In general terms, the parent track is the highest track in a group of tracks (often only two) and the behavior of the child tracks (i.e., how they are composited together) is determined by the parent track.

The following three examples demonstrate different compositing relationships.

The first example shows two independent tracks. The top track contains a generated text event that has a transparent background. The second track therefore shows through the transparent areas in the Video Preview window. Since the second track does not have any transparent areas, any tracks below it would be completely obscured.
In the second example, track two is the child track of track one (the parent track). This parent/child relationship was set up by clicking the Make Compositing Child button ( ) in the track list for track two. This makes the text in track one act as a mask over track two, allowing the fire to show through the mask (i.e., the text). The region outside of the text is still transparent, but there is nothing below these tracks, so it appears black.

Parent/child video track grouping using the Make Compositing Child button is only available in the full version of Vegas.

In the third example, a generated media event was added to the track below the first two tracks, which are already paired in a parent/child relationship. The color gradient event in track three shows through the transparent area of the top two paired tracks.

Selecting compositing modes

Vegas provides multiple compositing modes, while Vegas LE limits you to source alpha compositing.

The Compositing Mode button ( ) determines how the transparency in a video track is generated. Since lower tracks show through higher tracks, it is the compositing mode of the higher track that determines how much of the lower track shows through.

Note: The compositing mode of the lowest video track is a special case. Selecting a mode for the lowest track affects its transparency against a black background.

To select a compositing mode, click the Compositing Mode button and choose a mode from the menu that appears.
The sample below uses a generated text event that is partially transparent. For more information, see Using generated media on page 189.

The following table shows how these two sample tracks are blended using each of the compositing modes.

<table>
<thead>
<tr>
<th>Compositing mode</th>
<th>Sample</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td><img src="image1.png" alt="Sample Image" /></td>
<td>Adds the overlay color values to the background.</td>
</tr>
<tr>
<td>Subtract</td>
<td><img src="image2.png" alt="Sample Image" /></td>
<td>Subtracts the overlay color values from the background.</td>
</tr>
<tr>
<td>Multiply (Mask)</td>
<td><img src="image3.png" alt="Sample Image" /></td>
<td>Multiplies the overlay color values by the background color values. This makes overlay colors stronger and more present and results in a darker video image. The opposite of this mode is Screen.</td>
</tr>
<tr>
<td>Source Alpha</td>
<td><img src="image4.png" alt="Sample Image" /></td>
<td>Uses the alpha channel to determine transparency in the overlay. This compositing mode is based on the alpha channel characteristics of an event or media file. If no alpha channel is present in the overlay, the Source Alpha compositing mode has no effect.</td>
</tr>
<tr>
<td>Cut</td>
<td><img src="image5.png" alt="Sample Image" /></td>
<td>Cuts out the overlay color values from the background.</td>
</tr>
<tr>
<td>Screen</td>
<td><img src="image6.png" alt="Sample Image" /></td>
<td>Multiplies the inverse of the overlay color values with the background color values. This makes overlay colors weaker and less present and results in a lighter video image. The opposite of this mode is Multiply.</td>
</tr>
</tbody>
</table>
Adjusting opacity with the composite level slider

You can precisely control the transparency or blending of the overlay with the composite level slider. Left is transparent and right is 100% opaque. You can also double-click the current value to enter a specific numeric percentage.
Changing the overlay mode for a parent track

By default, the multiply compositing mode is used for parent tracks. Click the Parent Overlay Mode () and choose Custom from the menu to use plug-ins to control how the parent track modifies the tracks in its composite group.

The included Displacement Map, Height Map, and Bump Map plug-ins can create interesting lens, mirror, water, fire, and other light-bending effects. These plug-ins are explained below:

- **Displacement Map**: Uses the parent image as a guide to offset the pixels in the composited child tracks along the horizontal and vertical axes. The X and Y offsets are independently encoded in the image color channels.
- **Height Map**: Uses the parent image as a guide to offset the pixels in the composited child tracks. The gradient of the image in the parent track is used to determine the amount of offset for the image displayed at that location, much like how light bends through a lens.
- **Bump Map**: Uses the parent image as a guide to add texture and lighting to the composited child tracks. The texture of the bump map is applied to the composited child tracks: light sections of the map represent high areas, and dark sections represent low areas.

Creating masks

Masks are used to create overlays, limit the effects of a filter, and to create transparent titles. In their simplest form, masks work by making a particular color in an image or video transparent. More complex effects can be created with gradients (smoothly blending transparent areas together) and by altering the sensitivity of the mask.

*Parent/child video track grouping using the Make Compositing Child button is only available in the full version of Vegas.*

Creating image masks

You can use Vegas generated media to create simple masks. You can also create masks from just about any image file.

1. Create an image of a solid white circle on a black background in any paint program. This will be the mask.
2. Add the mask image file as an event into the top-most track on the timeline.
3. Insert a video event just below the mask track. This is the background video behind the mask and is the event that is masked.
4. Click the Make Compositing Child button () located in the track list of the background video (lower) track. This makes the lower track the child of the mask track (the parent track).
In the following example, the white circle is a BMP image file. Black is 100% opaque and white is completely transparent.

Masks can also be partially transparent. By using gradients and grayscale images, you can achieve smooth blending. Black is still 100% transparent and white is opaque, but the grays in between are only partially opaque.

The effects of the masks are very clear in these examples, but this is not how they would actually be used in a real production. Masks are commonly used to isolate a portion of the video from an effect. Masks do not need to be black and white, or grayscale, nor do they need to be still images.

**Tip:** It is best to use images that are the same size as your project’s frame size. You may also need to change the pixel aspect ratio of an image file to get it to display correctly. For more information, see Correcting images for DV pixel aspect ratios on page 171 and Modifying media file properties on page 181.
Creating video masks

You can also use video files to create masks, although the process can be more complicated than using an image as a mask. The key to any mask is contrast. You can increase the difference between the light and dark areas of a video file using video effects plug-ins.

1. Insert the video that you want to use as a mask into a video track.

2. Drag a Black and White plug-in from the Video FX window to the event to remove the color. For more information, see Adding a video effects plug-in on page 184.

3. Drag a Brightness and Contrast plug-in from the Video FX window to the event.

4. Adjust the Brightness and Contrast to create the mask. Watch the Video Preview window for a real-time preview of the mask. Adjust the effect so that parts of the video are completely black (opaque) and other parts are completely white (transparent). This can often mean increasing the contrast while decreasing the brightness.

5. If necessary, mask areas can be inverted (reversing the black and white areas) with an Invert plug-in or by selecting the Invert check box in the Mask Generator window. For more information, see Using the Mask Generator on page 198.

After you have created the mask, place it in the highest track. Add another video event to another track below the mask and click the Make Compositing Child button ( ) on that track. Any video that appears in a lower track below the Parent mask track and its Child shows through the areas outside of the mask. The entire setup is pictured in the following illustration.
Fine-tuning masks

Depending on the source material, creating a clean mask can be a tricky exercise. There are a few tools and tricks you can use to fine tune a mask.

- **Solo the track**: Click the Solo button ( ) in the track list to mute all of the other video tracks in a project. This allows you to concentrate exclusively on the mask.
- **Toggle effects**: Turn individual plug-ins on and off to isolate effects in a plug-in chain. Keep in mind that the order of the plug-ins in the chain is important in determining the final composited output.
- **Isolate channels**: Isolate individual color channels in the Video Preview window by clicking the Overlays button ( ). Click the arrow on the button to select the specific channel to be isolated and whether to display this channel in grayscale only. Then click the main button to toggle the channel display on and off. The **Alpha as Grayscale** option isolates the alpha channel mask and displays it in grayscale. *For more information, see Understanding the Video Preview window on page 223.*
Using the Mask Generator

The Mask Generator is a plug-in that controls the transparency of events to be used as masks. Apply the plug-in to an event (or a track) in the same way as any other plug-in: just drag-and-drop. The Mask Generator plug-in can be found in the Video FX window (from the View menu, choose Video FX).

The Mask Generator and parent/child video track grouping is only available in the full version of Vegas.

The Mask Generator is also an automatic part of the compositing process between parent and child tracks. To open the Mask Generator window, click the Mask FX button on any track that is the parent of another. For more information, see Compositing on page 190.
How the Mask Generator works

The following illustration demonstrates some of the effects of the Mask Generator. The background image is the original mask. There are five ellipses on the mask: white, red, green, blue and an invisible alpha channel. Note especially the dashed-line ellipse in the lower left of the mask; this is the alpha channel. You can base the alpha channel on a color or define the alpha channel in a graphics program that supports alpha channel creation. Masks with alpha channels must be saved in a format that supports this method of transparency, such as PNG or TGA. As in this example, the alpha channel may be invisible in the actual mask.

The top-right example uses luminance to determine the transparency in the mask. The white area is completely transparent. Since white is made up of 100% values of red, green, and blue (255, 255, and 255), those three colors are all 33% transparent as well. In the lower-right example, blue is the selected transparent index. The blue area is 100% transparent and so are all areas that have a value of 255 for blue (0, 0, 255), including white (255, 255, 255).
Chromakeying

Chromakeying or blue screening is a special case of overlay transparency. A color key is a specific color or a range of similar colors in an image that are made transparent, allowing a background video to show through. The idea is to take a video subject and film it against a solid, uniform background color. It is critical that the color be smooth and uniformly lit with no shadows, and that the color chosen for the background not be used in the subject.

The most important factors in successful blue screening happen during shooting, well before the footage is imported into Vegas. Compression of the source video is also an important consideration. While almost all video is compressed in some way, highly compressed video does not key well because colors can be smeared together and edges tend to not be very sharp.

If your source footage is good and the captured video file is also of high quality, color keying is an easy process.

1. Insert a video with a blue (or any solid colored) background into a track. This is the overlay video.
2. Insert the background video that will show through the blue areas into the next lower track.

**Note:** You do not need to set the lower track as a child track when using the Chroma Keyer plug-in as you would with a mask.

3. Click the overlay video (foreground, higher track) to select it.
4. Drag a Chroma Keyer plug-in from the Video FX window onto the overlay video. The Video Event FX window displays.
5. Click the down arrow to the left of the Split Screen View button ( ) on the Video Preview window and choose FX Bypassed. This will bypass the effect of the Chroma Keyer plug-in until you are ready to view the effect.
6. In the Video Event FX window, click the Eyedropper button ( ). The cursor changes to an eyedropper icon.

7. Draw (click and drag) a small rectangular selection area around the color(s) to key out. Although you can select the color range from just about anywhere, the Video Preview window is the best location.

   **Note:** Other effects that can change the color of the event should be bypassed when using the Eyedropper tool.

8. Click the Split Screen View button ( ) on the Video Preview window to restore the video effects. The Video Preview window shows the result of the Chroma Keyer plug-in.

When a subject is filmed against a solid colored background in a studio, you can key out the background color using the Mask Generator or the Chroma Keyer plug-in. You can select a wider range of colors using the Chroma Keyer plug-in, making it the perfect tool for less-than-perfect blue screens.

This procedure selects a small range of colors to use as a key. In the example above, the blue sky around the dome is far from uniform and it would be difficult to key it out with a traditional blue screen key. The color is uniform enough however, that a range of blues can be selected directly from the preview image in Vegas. Use the controls at the bottom of the dialog box to determine the sensitivity of the colors selected. Since the filter selects a range of colors, it is a good idea to try to select a relatively small range of similar colors. Drawing a color selection area that spans both blue and red colors would make very large sections of an overlay transparent.

   **Tip:** It is possible to use multiple Chroma Keyer plug-ins on a single event, keying out the blues with one and the reds with the other, without keying out any colors between blue and red.
Adding Video Transitions and Motion

Want something other than a cut or crossfade between video events? Vegas provides a wide variety of transitions you can add to your project. This chapter also covers track motion and keyframe animation, which allows you to automate video effects, media generators, cropping, panning, and more.

Transitions are customizable in Vegas. Vegas LE provides standard presets only.

Understanding basic transitions

Transitions occur between two video events. Most professional productions, on television or on the big screen, use only two types of transitions. The first is a simple cut, where one scene immediately cuts to the other without delay or effects. The other is a fade, otherwise known as a crossfade or a dissolve.

Cuts

A cut is actually not a transition. Instead, the last frame from an event is immediately followed by the first frame of the next event. This is what happens with two adjacent events on the Vegas timeline, either in the same track or in different tracks. This can also happen when an event is punched into another (with fade edge edits turned off).

Crossfades

You can fade one event out and fade into the next event by simply overlapping the two. The duration of the transition is determined by the amount of overlap. For more information, see Crossfading events on page 74.

Using transition effects

Transition effects are more complex than a simple cut or crossfade. You can replace a crossfade with a transition and then customize the transition to meet your needs.
Adding a transition

1. Insert a video event onto the timeline.

2. Insert another event so that it overlaps the first to create an automatic crossfade.

3. In the Transitions window, browse for a transition effect. If the Transitions window is not visible, choose Transitions from the View menu.

4. Drag the effect onto the crossfade between the two events.

Note: The duration of a transition is automatically determined by the amount of overlap between the two events. As with other events in Vegas, you can control the precise duration of a transition by dragging the edges in and out. You can also slide a transition for more precise control. For more information, see Sliding a crossfade on page 75.

Tip: Some transitions also have their own shortcut keys. On the numeric keypad, press  to insert a crossfade,  to insert a dissolve, and  to insert a linear wipe. Holding Ctrl while pressing any of these keys converts the transition to a cut at the cursor position.

Adding a transition to the end of an event

Typically, a transition occurs between two events on a track, but you can also use transitions to fade to and from the background, whether that is an underlying image, video, or background color. For example, you can drag a Clock Wipe transition to the end of a video event and have the wipe go from the video event to black.
Adding a transition to all selected events

If you tend to use the same transitions often, you can save yourself some time by adding a transition to all selected events at once.

1. Select the events where you want to add the transition.

2. From the View menu, choose Transitions to display the Transitions window.

3. Select a transition from the list on the left side of the window. The thumbnail images on the right side of the window represent each of the existing presets for the selected transition. Hover your cursor over a preset to see an animated example.

4. After you've found the setting that you want to use, drag it to the position where you want it to occur on the timeline.

5. The Video Event FX dialog is displayed to allow you to edit the transitions settings, and a icon is displayed in the timeline to show you where the transition takes place. You can also click this icon to edit the transition's settings.

Dropping on existing cuts, crossfades, or transitions

- If you drop the preset on an existing transition, only transitions within the selection will be changed. Cuts and crossfades are preserved.
- If you drop the preset on an existing crossfade, only crossfades and transitions within the selection will be changed. Cuts are preserved.
- If you drop the preset on an existing cut, all cuts, crossfades, and transitions within the selection will be changed.

Dropping on event edges

- If you drop the preset on a transition that is at the beginning or end of an event (but does not span two events), only single-event transitions that occur on the same end of the event within the selection will be changed.
- If you drop the preset on an event fade-in or -out, event fade-ins/outs and single-event transitions that occur on the same end of the event within the selection will be changed.
- If you drop the preset on an event edge with no fade, all other event edges, event fade-ins/outs, and single-event transitions that occur on the same end of the event within the selection will be changed.

Note: To change the length of the transition for cuts that are converted to transitions, use the Cut-to-overlap conversion settings on the Editing tab of the Preferences dialog.
Understanding track layers

If you want, you can view and modify transitions in an A/B roll mode. Click the Expand Track Layers button to expand the track to reveal three layers within the main track. These layers are called the A roll, the B roll, and the transition roll.

The concept of an A/B roll is fundamentally different from the Vegas multitrack philosophy. Every track is in some way mixed (composited) into the final output in a multitrack system, but events are not mixed on the A/B roll. Instead, either the A roll or the B roll is playing, with the two trading places during a transition. You could mix the two for as long as you want with a transition, but they do not blend without an intervening transition. Transitions move from one roll and into the other. This could be from A to B or from B to A. The direction of the transition is automatically set by Vegas. The small arrows on the side of the transition event indicate this direction.

As the sequence at the right shows, the video output can shift from the A to the B and back to A many times during a production, but there is only one video output from any particular roll at a time. This means that the A and B rolls are not composited.

Converting a cut to a transition

The transition between two events that are adjacent to each other on the same track is instantaneous and is called a cut. However, if the first event is trimmed back from the end and the second event is trimmed back from the beginning (in other words, both have enough media to overlap), you can transform the cut into a transition effect using this extra media.

1. Right-click the line between two adjacent events at the cut position.
2. From the shortcut menu, choose Transition and then choose the transition that you want to insert (e.g., Insert Sonic Foundry Iris).

You can also drag a transition to the cut from the Transitions window.

The duration of the newly inserted transition event is determined by the Cut-to-overlap conversion time set in the Editing tab of the Preferences dialog. To access this dialog, choose Preferences from the Options menu.
Note: There must be enough media in the respective events to cover the transition (e.g., the end of the first event must not be the end of the media file).

Tip: You can also convert cuts between audio events to crossfades. Click the cut and press [7] on the numeric keypad to create a crossfade. There must be enough media on either side of the cut to create the crossfade.

Converting a crossfade or transition to a cut

1. Click to position the cursor within the transition.
2. Hold [CTRL] while pressing the / key on your numeric keypad.

Vegas will convert the transition to a cut, using the Cut-to-overlap conversion settings on the Editing tab of the Preferences dialog to determine where the cut occurs.

Previewing a transition

The easiest way to preview a transition is to set the loop region to the duration of the transition and then loop the playback. This allows you to adjust the transition while it is playing and make changes in real time.

1. Double-click the transition. This automatically creates a time selection equal to the length of the transition.
2. Click the Loop Playback button ( ) to turn loop playback on. The selection area bar is dark blue when loop playback is turned on.
3. Click the Play button ( ).

To preview complicated transitions, you may want to build a dynamic RAM preview or prerender the effect. For more information, see Building dynamic RAM previews on page 226 or Prerendering video on page 225.
Modifying a transition

Transitions are customizable in Vegas. Vegas LE provides standard presets only.

All of the transitions in Vegas include several presets that create standard transitions. If a preset doesn’t meet your needs, you can customize a transition to suit your taste.

Tip: You can also animate the parameters of a transition with keyframes. For more information, see Using keyframe animation on page 209.

1. Click the Transition Properties button ( ) on the transition or right-click the transition and choose Transition Properties from the shortcut menu. The Video Event FX window appears.

2. Change the parameters. Changes update in real time in the Video Preview window. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Saving custom settings as a preset

After you modify a transition, you can save your settings as a preset for use at a later time. You can apply presets by choosing them from the Preset drop-down list.

1. Modify the settings in the window to create your desired transition effect. For help on the different controls in the window, click the Plug-In Help button ( ) to access online help.

2. Click the name in the Preset drop-down list. The current text is highlighted.

3. Enter a name for the new preset.

4. Click the Save Preset button ( ).

You can save any additional changes to the custom preset by clicking the Save Preset button.
Using keyframe animation

Keyframe animation is a technique that computer artists use to quickly make complex animated sequences. Instead of drawing every frame of a title scrolling in from top to bottom by hand, an animator simply has to set a starting and ending position for the animation and let the computer interpolate the intermediate frames. The animation pictured on the right has three keyframes: a starting, middle, and ending keyframe. More complex animations use more keyframes.

While keyframing motion may be the most obvious use for keyframe animations, just about any parameter of an effect can be animated with keyframes. Vegas uses keyframe animation techniques in many areas, including transition effects, video effects, event panning and cropping, generated media, and track motion. You can animate color, brightness, transparency, motion, size, perspective, and many other parameters with keyframes.

Understanding the keyframe controller

The keyframe controller appears at the bottom of the Video FX window (used for transitions, effects, and generated media), the Track Motion window, and the Event Pan/Crop window.

The cursor position is marked by a flashing line on the controller. This position can also be automatically updated on the timeline, with the Video Preview window also updating in real time to reflect changes. Click the Sync Cursor button ( ) on the keyframe controller to sync the keyframe cursor with the timeline cursor.
Adding keyframes

Every effect has a starting keyframe at the beginning (left side) of the keyframe controller. This sets the initial parameters for the effect. In order to animate the effect, you must add another keyframe to the effect and change some of the parameters. When you first add a new keyframe, it has the same settings (for the transition, effect, pan/crop, etc.) as the first keyframe. You can then modify the settings of the new keyframe to create the animation from the first keyframe settings to the second.

1. Click the keyframe controller timeline to move the cursor where you want to add a keyframe. The current position is marked by a blinking cursor.
2. Click the Create Keyframe button ( ).
3. Modify the settings in the window for the new keyframe as desired.

Tip: You can also add a new keyframe by positioning the cursor in the keyframe controller and changing any parameters in the window. Vegas adds a keyframe with the new settings at the cursor position.

Deleting keyframes

1. Select a keyframe in the keyframe controller.
2. Click the Delete Keyframe button ( ).

Navigating in the keyframe controller

Use the keyframe navigation buttons (First, Previous, Next, and Last) to quickly jump to a keyframe. Alternately, press Ctrl+← or Ctrl+→ to move to the previous or next keyframe.

Modifying keyframes

After you create your keyframes, you can move them, copy and paste them, and change the interpolation curves between them.

Moving keyframes

You can move a keyframe within the keyframe controller by dragging it to a new position. For track-level keyframes, you can also move the keyframes in the track view. For more information, see Working with keyframes in track view on page 212.

Copying and pasting keyframes

Keyframes on the controller can be copied, pasted, and duplicated.

1. Right-click a keyframe.
2. From the shortcut menu, choose Copy.
3. Right-click the keyframe controller at the position where you want to paste the keyframe.
4. From the shortcut menu, choose Paste.

Duplicating keyframes

1. Right-click and drag a keyframe to a new position.
2. From the shortcut menu, choose Copy. A duplicate keyframe is created at the new position.

You can also duplicate a keyframe by holding the Ctrl key while dragging it.
Changing the interpolation curve

The interpolation curve determines the rate at which Vegas animates between two keyframe settings. You can right-click a keyframe to choose a different shape for the interpolation curve. The shortcut menu provides five options: Hold, Linear, Fast, Slow, and Smooth. Selecting Hold from the shortcut menu prevents any animation from being interpolated between two keyframes. The color of the keyframe indicates which interpolation curve is being used.

Changing the relative spacing of keyframes

You can change the relative positions of the keyframes as a group. This can be useful if you need to change the overall length of an animated sequence or if you need to copy a set of keyframes to another event that has a different duration than the original.

1. Click on the first keyframe, hold the Shift key, and click on the last keyframe in the sequence to select all of the keyframes.

2. Hold Alt and drag the first or last keyframe to scale the keyframes.

When copying keyframes from longer events to shorter events, you must temporarily lengthen the duration of the shorter event so that all of the keyframes appear on the keyframe controller. Once you have pasted the keyframes, you can rescale the keyframes using the above procedure, and then resize the event to its original length.
Working with keyframes in track view

You can move and modify track keyframes in track view. These keyframes are used in the following three track-level effects:

- Track effects plug-in (pg. 184)
- Track motion (pg. 217)
- Mask generator plug-in on a parent compositing track (pg. 198)

Viewing and moving track keyframes

Once you have added keyframes to one of these track-level effects, the track keyframes appear at the bottom of the track on the timeline. Click the Expand Track Keyframes button ( ) to view the keyframes.

You can drag a keyframe on the track in the same way you would in the keyframe controller. To move several keyframes at once, use the Envelope Edit tool ( ) to select and drag multiple keyframes.

Tip: You can use ripple editing to automatically move track keyframes as you edit in the timeline. For more information, see Applying post-edit ripples on page 72.

Adding new track keyframes

You can add new track keyframes to an existing track-level effect by double-clicking the track keyframe area.

Editing track keyframes

Double-click a track keyframe to open the associated window and adjust the settings. To change a keyframe interpolation curve, right-click the keyframe and choose a curve type from the shortcut menu.

Locking track keyframes

When track keyframes are locked, you can move events along the track and the keyframes move along with them. Only keyframes that occur within the selected events move.

Select the Lock Envelopes to Events button ( ) to lock track keyframes to the events on the track.

Hiding track keyframes

If track view becomes too cluttered, you can hide track keyframes from view. From the View menu, choose Show Video Envelopes, and choose Track Keyframes from the submenu to hide track keyframes.
Sample uses for keyframe animation

The following section provides several examples of how keyframe animation can be used with features such as event panning and cropping, video effects plug-ins, and generated text events.

Animating event panning and cropping

You can combine event panning and cropping tools with keyframe animation to create several special effects. For more information, see Cropping video on page 167.

Zooming in on a still image

By using keyframe animation in the Event Pan/Crop window, you can zoom in and out on a still image. In this example, four keyframes are used to zoom in on faces in an old photograph and zoom back out again. A generated color gradient event masks the edges of the image during the zoom to enhance the effect. For more information, see Using generated media on page 189.

1. Click the Event Pan/Crop button ( ) on the still image event.
2. Click the keyframe controller to position the cursor for the second keyframe.
3. Click the Add Keyframe button ( ). Resize and move the selection area to zoom in on a portion of the image.
4. Click the keyframe controller to position the cursor for the third keyframe.
5. Click the Add Keyframe button ( ). Resize and move the selection area to zoom in on a different portion of the image.
6. Click in the keyframe controller near the end of the event to place the final keyframe.
7. Click the Add Keyframe button ( ).
8. Right-click in the selection area and choose Restore from the shortcut menu. The selection area is zoomed out to include the full image for the last keyframe.
9. Preview the event in the Video Preview window. Adjust the settings in the Event Pan/Crop window as you preview the zoom effect.

Using pan-and-scan

Another way to use keyframe animation in the Event Pan/Crop window is panning, or pan-and-scan. Pan-and-scan is a technique commonly used when film is converted for television. Movie screens and film are usually wider (~2.35:1) than television (~1.33:1). When you transfer the film to video, you have four choices: (1) squash the film horizontally to fit, distorting it in the process; (2) crop it, possibly losing information on the sides; (3) letter box it so the top and bottom have black areas and the picture is shorter overall; and (4) pan-and-scan. Pan-and-scan is a variation of cropping, where someone goes through the movie and moves the crop area back and forth to follow the action or subject.

1. Click the Event Pan/Crop button ( ) on the event. The Event Pan/Crop window appears.
2. Confirm that the Stretch to fill frame check box is selected.
3. Right-click the selection area and choose Match Output Aspect from the shortcut menu.
4. Select a starting position, size, and angle of rotation for the crop rectangle. This is the start position (first keyframe).
5. Click in the keyframe controller and press [Ctrl]+[End]. This moves the cursor to the end of the event.
6. Click the Create Keyframe button ( ). A new keyframe appears in the keyframe controller at the end of the event.
7. Change the position, size, and angle of rotation. This is the final position (last keyframe).
8. Preview the event. Add and adjust keyframes as needed to create the desired effect. You can adjust both temporal and spatial interpolation for each keyframe.
- **Temporal interpolation** (how the pan occurs over time) is controlled by the keyframe interpolation curve type. Experiment with temporal interpolation by right-clicking a keyframe to change the interpolation curve type (hold, linear, fast, slow, smooth) and previewing the result. For more information, see **Changing the interpolation curve** on page 211.

- **Spatial interpolation** (how the pan occurs within the video image) is controlled by the Smoothness setting of each keyframe. If you have three or more keyframes, the blue arc in the window shows the path of the center of the frame during the panning. A smoothness value of 0 makes the movement linear from one keyframe to the next. A higher smoothness value makes the path of the pan more curved. Select a keyframe and change the Smoothness value to adjust spatial interpolation.

---

### Animating video effects plug-ins

You can use keyframe animation to smoothly and gradually apply an effect to an event. This example uses the Add Noise plug-in. The Add Noise plug-in adds static or noise to a video sequence. When added to a simple solid-colored background with a monochrome setting and animated, a pattern is produced that is similar to a television that is not tuned to any station.

1. **Add an Add Noise plug-in to an event.** For more information, see **Adding a video effects plug-in** on page 184.

   The Video FX window appears with the keyframe controller at the bottom of the window.
2. Add two keyframes to the event for a total of three including the one at the beginning. New keyframe attributes are copied from the previous keyframe.

3. Click the first keyframe to select it. Drag the Noise level slider to 0.

4. Click the last keyframe to select it. Drag the Noise level slider to 0.

5. Click the second keyframe to select it. From the Preset drop-down list, select Grainy.

6. Hold [Ctrl] and drag the second keyframe to duplicate it. Position this new keyframe between the second and final keyframes.

The effect is off at the first keyframe and smoothly transitions to a grainy effect at the second keyframe, at which point the effect remains constant until the third keyframe. Then the effect gradually fades out until it reaches a minimum value at the last keyframe.

### Animating generated text

You can add a generated text event to a project by dragging a text generator from the Media Generator window. For more information, see Using generated media on page 189. You can then animate the text by adding keyframes.

Not all attributes of generated text media can be animated using keyframes, however. You cannot, for example, morph one text message into a different one. Some aspects can be easily and smoothly animated using the keyframe controller, such as text, color, transparency, leading, tracking, and position.

Other aspects of generated text do not allow interpolated keyframe animation. For example, if you set the text to “One” initially and then at five seconds change it to “Two”, the text will suddenly jump to the new value at the five second keyframe. This behavior is different from the behavior of other keyframe animation techniques.

In this example, keyframes are used to make a title appear one letter at a time across the screen.

1. Drag a text generator from the Media Generator window to the timeline.

2. Right-click the new event and choose Edit Generated Media.

3. Enter the first letter of the title, for example “T”.

4. Click the keyframe controller at the 1.000 second mark and enter the second letter, for example “y”. The title now reads “Ty”. A new keyframe appears in the keyframe controller at the 1.000 second mark.

5. Proceed down the keyframe controller to 2.000 and enter the letter “p”.

6. Proceed down the keyframe controller repeating this process until the title is finished: “Typing”.

The results of gradually transitioning into an effect using keyframe animation.
7. Preview the event in the Video Preview window. The word “Typing” appears one letter per second until finished.

Adding track motion

The Track Motion window (accessible by clicking the Track Motion button on any video track) is used to move a video track across a background. This background can be a solid color, another video event, or an image. Picture-in-picture effects and scrolling title sequences are two simple cases where this tool is important.

The gray area in the center of the window (covered by the blue/gray rectangle) represents the actual screen or area that is visible in the movie. The area outside of the main screen, which is filled with dotted lines, is the general workspace. The video you are moving can be positioned off of the visible screen and then animated onto and across the screen. The dots are markers to help position the video window. If snapping is enabled, these serve as snapping points.
The main window allows you to control the placement, size, and orientation of the overlay video through time. The blue and gray rectangular overlay in the middle represents the video on the track. The large “F” is used to represent the orientation of the track and is especially useful in indicating a track that has been flipped.

You can also create blue guide lines to help you align objects by moving to the edge of the ruler and dragging towards the center of the workspace to create a new line. Existing guides can be repositioned by dragging. Guidelines can also be used to snap the video window.

Using the track motion shortcut menu

When you right-click anywhere in the Track Motion window, a shortcut menu appears:

- **Restore** returns the overlay to its original state.
- **Center** moves the overlay to the center of the frame.
- **Flip Horizontal** flips the overlay backwards or left to right.
- **Flip Vertical** flips the overlay upside-down.
- **Match Output Aspect** sets the aspect ratio to the frame value.
- **Match Source Aspect** sets the x,y ratio to the overlay value.
- **Background** sets the color of the overlay window.

Controlling the track motion workspace

The track motion workspace allows you to position the video within the project frame. As you move the mouse around the workspace, it changes shape to indicate when you can move ( ), resize ( ), or rotate ( ) the overlay. When the mouse cursor changes to a hand ( ), you can click and drag to move around the workspace.

Select the **Zoom Edit Tool** to zoom using the mouse. Click the workspace to zoom in or right-click the workspace to zoom out. You can also use a mouse wheel to zoom in and out on the workspace.
Using keyframes in track motion

Keyframes are what create the motion in the track motion feature. You can create, modify, and remove keyframes in the keyframe controller in the same way as with any other Vegas feature that uses keyframes. For more information, see Using keyframe animation on page 209.

The keyframe controller in the Track Motion window has three attributes that can be animated: position, shadow, and glow. Each effect can be animated independently. The shadow and glow effects can be turned on and off. Each effect has its own set of controls that appear on the left-hand side of the window. You can access these controls by clicking the respective item on the keyframe controller.

Tip: If any controls described in this section are not visible on the screen, enlarge the Track Motion window by dragging the lower right corner until all controls are revealed.

**Position**

You can control the position of the overlay in the main window by dragging the blue/gray overlay. However, the position controls in the window are invaluable when you need precision in resizing, moving, or rotating the overlay.

The Smoothness box allows you to modify the smoothness of the interpolation curve among three or more keyframes.

You can enter a value in the Magnify View box to shrink or expand the video overlay. The Grid Density box controls the ruler settings and snap to points.

**Shadow**

This creates a simple drop shadow that appears under the entire window or only under the opaque (nontransparent) parts of the overlay. You can control the size and offset of the shadow as well as the shadow color. A shadow is especially effective under a picture-in-picture window or to emphasize text and titles. Use the Eyedropper tool to select a specific color from anywhere on the screen.

**Glow**

Glow is a bright haze surrounding an overlay. In general, light colors are used for glow effects, but you can emphasize bright text on complex backgrounds by using a very small black glow, with little or no feathering, and 100% intensity.
Creating a picture-in-picture effect

Picture-in-picture is an easy effect to reproduce using track motion.

1. Insert the background video into a track.
2. Insert the overlay video into another track just above the background video track.
3. Click the Track Motion button ( ) on the upper overlay track.
4. In the Track Motion window, position and resize the track area.

The illustration below shows some of the relevant parts of this procedure. Note the shadow cast by the overlay video. This is added by selecting the Shadow check box on the keyframe controller. The Video Preview window displays the results.

Tip: While overlay picture-in-picture windows are often completely opaque, you can fade them in and out using opacity envelopes. For more information, see Using opacity envelopes on page 125.

Animating the overlay

You can animate many aspects of an overlay using the keyframes at the bottom of the Track Motion window.

1. Insert a video event onto the timeline.
2. Click the Track Motion button ( ) in the track list.
3. In the Track Motion window, resize the overlay by dragging the handles at the edges of the overlay.
4. Drag the middle of the overlay to position it. This will be the size and position for the start of the animation.
5. Click the timeline of the keyframe controller at a later time to move the cursor to that position.

**Tip:** With the Sync Cursor button enabled, you can also navigate to a new position on the main timeline. Vegas automatically moves the cursor on the keyframe controller to the same location.

6. Reposition the overlay. A new keyframe is automatically added to the keyframe controller at the new cursor position.

**Tip:** You can constrain your movement as you reposition the overlay by clicking the Move Freely button until it changes to Move in X only or Move in Y only.

When you preview the video, Vegas interpolates the position of the overlay between the two keyframes with a smooth animation.

**Rotating the overlay**

You can also rotate the overlay. To rotate the overlay by a precise number, enter a value in the Angle box. Alternatively, you can use the mouse for freehand rotation.

1. Move the cursor outside of the track area box. The cursor changes to a rotate icon.
2. Drag to rotate. The clock icon in the track area shows the orientation of the track and the exact angle displays in a small ToolTip below the cursor.
3. To change the center of rotation, drag the clock icon to a new location.
Flipping the overlay

You can flip the overlay horizontally or vertically to further augment a track motion effect.

1. Right-click the overlay. A shortcut menu appears.
2. Choose either Flip Horizontal or Flip Vertical. The overlay flips and the Video Preview window shows the effect.

![Original](image1) ![Flip Horizontal](image2) ![Flip Vertical](image3) ![Flip Horizontal and Vertical](image4)
As you work in Vegas, you can preview your video by using the Video Preview window or by connecting to an external monitor. You can optimize previews by adjusting preview quality, prerendering video, or building a dynamic RAM preview. The Video Preview window also provides features such as safe area overlays, grid overlays, and isolated color channel displays to further enhance your productivity.

Dynamic RAM previews are only available in the full version of Vegas.

Understanding the Video Preview window

The workspace for editing video can get quite crowded, so the Video Preview window can be configured in a number of ways to make it more useful. The Video Preview window can be used on a separate monitor (if your video hardware supports this feature), docked at the bottom of the workspace, or floated freely on the screen.
Using the Video Preview window shortcut menu

Right-click the Video Preview window to adjust the following options:

- Choose **Default Background**, **Black Background**, or **White Background** to set the background color for the window.
- **Simulate Device Aspect Ratio** displays the output in square pixels. This can prevent distortion of the preview when using sources with rectangular pixels. This does not affect the final render.
- **Show Toolbar** toggles the toolbar at the top of the window.
- **Show Status Bar** toggles the information display at the bottom of the window.
Optimizing the Video Preview window

Timing and synchronization are critical aspects of any multimedia production. Because complex multimedia projects are challenging for any computer, Vegas provides a number of tools to maintain real-time playback even though the computer may not be able to process the data quickly enough.

Reducing preview quality

You can adjust the resolution of the Video Preview window and the quality of the preview rendering in order to improve playback. Lower-resolution previews are less clear but allow Vegas to display more frames per second. This may be particularly important with projects that use overlays, transitions, and effects. Click the Preview Quality button to choose different preview resolutions.

Note: To view the effects of the deinterlacing method you chose in your project properties, you will need to use the Good or Best quality preview mode. The Draft and Preview quality preview modes do not deinterlace.

Prerendering video

There are times where nothing but a full, high-quality preview will do. In these cases, Vegas can take the time necessary to selectively render only the portions of your project that need extra processing. Vegas prerenders these sections and creates short files to use for previews. The prerendering can take anywhere from a few seconds to a few minutes, depending on the length and complexity of the video.

Once these temporary files have been created, Vegas uses them whenever it plays back those sections of the project, increasing playback quality and performance. As long as no changes are made to the events in the prerendered sections, Vegas continues to use the newly created files for previews, even if changes are made to other sections of the project.

1. To prerender a portion of the project, create a selection containing the portion you want to prerender.
2. From the Tools menu, choose Selectively Prerender Video. The Prerender Video dialog appears.
3. Select the type of prerender file to create in the Prerender as drop-down list. Click Custom to configure any custom compression options.
4. To preview just a portion of the project, verify that Render loop region only is selected. To create a prerender of the entire project, clear this check box.
5. Click OK. A progress bar displays the progress of the render.
When prerendering is complete, green bars appear at the top of the timeline indicating the sections that have been prerendered.

As a default, Vegas saves these preview files when a project is closed. To delete these files when you close the project, from the Options menu, choose Preferences and, on the General tab, clear the Save active previews on project close check box.

You can set the location of these preview files by clicking the Properties button ( ) and choosing a Prerendered files folder in the Project Properties dialog. Ideally, this folder should be on a different physical drive from where Windows is installed. You can delete prerendered preview files from your hard disk by choosing Clean Up Prerendered Video from the Tools menu.

Note: Each prerendered section will consist of no more than 10 seconds (approximately 40 megabytes). Because selective prerendering creates multiple files, minor editing on the timeline will not invalidate all of your prerendered video—only the sections you modify will need to be rerendered.

Building dynamic RAM previews

Dynamic RAM previews are only available in the full version of Vegas.

Vegas automatically drops video frames when previewing if the computer can’t keep up with processing demands. This means that you may not be seeing all video frames as you preview your project. If you prefer not to prerender your project, there is another option for improving previews of selected portions of a project. Vegas dedicates a portion of your RAM to cache video frames that Vegas cannot render in real time.

Vegas automatically maintains a cache of 16 MB for dynamic RAM previews. To change the cache amount, choose Preferences from the Options menu and change the Dynamic RAM Preview Max value on the Video tab.

Note: Although not all frames appear in previews of a project, all frames are included when you render a file. For more information, see Rendering a project on page 239.

You can make a time selection and add each frame in the selection to the cache. Once the frames are cached, Vegas can display all video frames in a selection.

1. Select a region containing the frames you want to cache.
2. From the Tools menu, choose Build Dynamic RAM Preview.

Vegas plays through the time selection and builds the cache frame by frame.
Using split-screen previewing

Click the Split-Screen View button ( ) in the Video Preview window to turn split-screen previews on or off. Split-screen previews allow you to split the Video Preview window so you can see your affected and unaffected video or your video and the contents of the clipboard at the same time. Use split-screen previews to fine-tune video effects or to match colors for color correction.

**Note:** The Video Preview window temporarily enters split-screen preview mode when you slip-trim a video event. This temporary split-screen mode allows you to see the event’s first and last frame as you trim. You can toggle this preview mode by selecting or clearing the Show video event edge frames in Video Preview window during edits check box on the General tab of the Preferences dialog.

Previewing affected and unprocessed video

1. Click the down arrow next to the Split-Screen View button ( ) and choose FX Bypassed from the menu.
2. Select the Split-Screen View button ( ). The cursor is displayed as a .
3. Choose a preset selection or drag in the Video Preview section to create a selection. This selection will display the unprocessed video. In the following example, the Add Noise plug-in was applied to the event, and the selection displays the original video.

**Tip:** Double-click in the Video Preview window to select the full window, or drag again to replace the existing selection.
Showing the video at the cursor position and the contents of the clipboard

1. Position the cursor on the timeline and click the Copy Snapshot button ( ) in the Video Preview window to copy a frame to the clipboard.

2. Position the cursor at another point on the timeline.

3. Click the down arrow next to the Split-Screen View button ( ) and choose Clipboard from the menu.

4. Select the Split-Screen View button ( ).

5. Choose a preset selection or drag in the Video Preview section to create a selection. This selection will display the contents of the clipboard.

   **Tip:** Double-click in the Video Preview window to select the full window, or drag again to replace the existing selection.

Changing the selection for displaying split-screen views

Click the down arrow next to the Split-Screen View button ( ) and choose Select Right Half, Select Left Half, or Select All to indicate which portion of the Video Preview window you want to use to display unprocessed video or the contents of the clipboard.

When the Split-Screen View button ( ) is selected, the cursor is displayed as a . Drag a rectangle in the Video Preview window to create a custom selection.

Identifying safe areas

The Video Preview window in Vegas displays the entire video frame data. However, most television monitors do not display all of this data. Previewing the video on a television monitor is the only way to verify what frame information will display. You should also note that individual television monitors vary in what they display. While there is no substitute for previewing on a television, safe areas are a good method of estimating the extent of the masking.

1. Click the down arrow next to the Overlays button ( ) and choose Safe Areas.

2. Click the Overlays button to toggle the safe areas display on or off. The display shows two areas:
   - The safe action area is the frame area that is visible on a television screen.
   - The safe title area is a suggested area to limit the extent of titles. It is always smaller than the safe action area.

   **Tip:** To customize safe area sizes, choose Preferences on the Options menu, and on the Video tab, enter the Action safe area and Title safe area values as a percent of the frame size. For more information, see Video tab on page 267.
Viewing the grid

The Video Preview window can display vertical and horizontal lines over your video. You can use the grid to help you align objects. To view the grid, click the down arrow next to the Overlays button ( ) and choose Grid.

Set the grid spacing using the Horizontal grid divisions and Vertical grid divisions settings on the Video tab in the Preferences dialog.

Isolating color channels

The Video Preview window allows you to select a specific channel to be isolated and whether the channel should be displayed in grayscale only. To display a channel, click the down arrow next to the Overlays button ( ) and choose a color channel.

Note: Use the Alpha as Grayscale setting to isolate the Alpha channel mask and display it in grayscale.

Monitoring video with scopes

Video scopes are only available in the full version of Vegas.

From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.

Broadcast video uses a narrower range of color than the RGB you see on your computer. When you broadcast a project that contains out-of-range colors, you can introduce image problems or even noise into the audio stream.

Use the scopes to analyze your video and adjust accordingly with the Brightness and Contrast, Broadcast Colors, Color Corrector, Color Corrector (Secondary), and Levels plug-ins before rendering.

Choose a setting from the drop-down list to choose which scope you want to display.

Note: If your video hardware will add a 7.5 IRE setup, click the Settings button ( ) and select the 7.5 IRE Setup check box in the Video Scopes Settings dialog. Black will be displayed as 7.5 in the waveform monitor. If your video hardware does not add a 7.5 setup, clear the check box, and
black will be displayed as 0.

Displaying chominance using the vectorscope monitor

The vectorscope monitor in the Video Scopes window allows you to monitor the chominance (color content) of your video signal. The monitor plots hue and saturation on a color wheel.

The vectorscope displays targets for broadcast-legal saturations of red (R), magenta (Mg), blue (B), cyan (Cy), green (G), and yellow (Yl). Individual colors in your video signal are displayed as dots in the vectorscope. A dot's distance from the center of the scope represents its saturation, and the angle of the line from the dot to the center of the scope represents its hue.

For example, if an image has a blue cast, the distribution of dots in the vectorscope will be concentrated toward the blue portion of the color wheel. If the image includes out-of-range blue values, vectorscope display will extend beyond the blue target.

You can use the vectorscope to calibrate color between scenes. Without calibration, you may see noticeable color differences between scenes from multicamera shoots.

1. From the **View** menu, choose **Video Scopes** to toggle the display of the Video Scopes window.
2. Choose **Vectorscope** from the drop-down list.
3. Position the cursor in the frame you want to analyze. If the **Update Scopes While Playing** button ( ) is selected, you can monitor your video during playback.
4. The vectorscope monitor displays the chominance of the video signal:

   1. Hover over a portion of the monitor to display the chroma value at the pointer position:
Displaying luminance using the waveform monitor

The waveform monitor in the Video Scopes window allows you to monitor the luminance (brightness or Y component) of your video signal. The monitor plots luminance on the vertical axis and the width of the current frame on the horizontal axis.

If you want to include chroma (color or C component) information in the waveform monitor, choose Composite from the drop-down list at the top of the monitor window. When you choose Luminance, chroma information is omitted.

1. From the View menu, choose Video Scopes to toggle the display of the Video Scopes window.
2. Choose Waveform from the drop-down list.
3. Position the cursor in the frame you want to analyze. If the Update Scopes While Playing button ( ) is selected, you can monitor the waveform during playback.
4. The waveform monitor displays the luminance of the video signal:

5. Hover over a portion of the monitor to display the luma value at the pointer position:

Displaying color levels and contrast using the histogram monitor

The histogram monitor in the Video Scopes window allows you to monitor color levels and contrast of your video. Use the histogram before rendering your project to find and correct out-of-range values that could cause problems on the destination playback device.

The bar graph plots the number of pixels that exist for each color intensity. For example, when using the Blue setting, the vertical axis represents the number of pixels, and the horizontal axis represents the RGB color range from 0,0,0 to 0,0,255.
To get acquainted with the histogram, use an external monitor to preview your video and watch the video output and histogram as you use plug-ins to modify the colors.

1. From the **View** menu, choose **Video Scopes** to toggle the display of the Video Scopes window.
2. Choose **Histogram** from the drop-down list.
3. Choose a histogram type from the menu:
   - **Luminance**: charts the luminance or brightness of colors in your video.
   - **Red**: charts the red tones in your video.
   - **Green**: charts the green tones in your video.
   - **Blue**: charts the blue tones in your video.
   - **Alpha**: charts the alpha channel (transparency) in your video.
   - **Luminance/R/G/B**: stacks luminance and RGB charts.
4. Position the cursor in the frame you want to analyze. If the **Update Scopes While Playing** button ( ) is selected, you can monitor your video during playback.
5. Use the histogram to evaluate the colors in your video. The **Mean** value indicates the average intensity of all pixels in the graph, and the **Standard Deviation** value indicates the average percentage by which pixels in the graph vary from the **Mean** value.
6. Use plug-ins such as Brightness and Contrast, Broadcast Colors, and Levels to adjust the color. *For more information, see Using video effects on page 183.*

**Displaying RGB components with RGB parade monitor**

The RGB parade monitor in the Video Scopes window displays waveforms for the red, green, and blue components of your video signal. The monitor plots RGB values from 0-255 on the vertical axis and three times on the horizontal axis.

The parade monitor helps you determine whether the individual RGB components of your video signal are within limits and whether the total video signal is clipping.

1. From the **View** menu, choose **Video Scopes** to toggle the display of the Video Scopes window.
2. Choose **RGB Parade** from the drop-down list.
3. Position the cursor in the frame you want to analyze. If the **Update Scopes While Playing** button ( ) is selected, you can monitor your video during playback.
4. The waveform monitor displays the RGB values of the video signal. Hover over the monitor to display the RGB value at the pointer position:

![RGB value](image)

**Previewing in a player**

You can create a full-quality preview that automatically plays in the appropriate media player. You can preview the entire project or select a portion.

1. To preview a portion of the project, create a selection containing the portion you want to preview.

2. From the **Tools** menu, choose **Preview in Player**.

3. Select the type of preview file to create. Select a template or click **Custom** to configure any compression options.

4. To preview just a portion of the project, verify that **Render loop region only** is selected. To create a preview of the entire project, clear this check box.

5. Click **OK**.

A progress bar displays the progress of the render. When finished, the file automatically plays in the appropriate media player.
Using an external monitor

Vegas allows you to feed video directly from the timeline to a television monitor. With this feature, you can make your final editing decisions on a broadcast monitor (which differs significantly from a computer monitor) before printing the project to tape. To use an external monitor, you must have:

- OHCI-compliant IEEE-1394 DV card
- DV camcorder or DV-to-analog converter box

While configuring your computer for DV external monitor previewing is not difficult, the setup may require some troubleshooting. The Sonic Foundry Vegas Forum is a good resource for peer-to-peer system troubleshooting:

http://www.sonicfoundry.com/forums

Setting up an external monitor

The diagram below shows the preferred setup for sending video from the Vegas timeline to an external television monitor.

Vegas conforms the video to DV format and feeds it through the 1394 card to the DV device (camcorder or DV-to-analog media converter). The DV device sends analog output to the television monitor.

Note: The DV device must support pass-through in order to use an external monitor. Some PAL camcorders do not support this feature.

Previewing audio

External monitor previewing differs in one respect from printing to tape from the timeline: no audio is sent through the 1394 card. As shown in the illustration above, Vegas routes the audio to the sound card and then on to the mixer (if present) and speakers. This allows you to mix your audio on better speakers than are typically found in television monitors.

Before printing to tape, you may wish to preview the audio through the television monitor speakers to ensure a good TV mix. You can use the print-to-tape feature to send the full video and audio to the external monitor. Follow the steps for printing to tape from the timeline (pg. 247) but do not set the camcorder to record. Vegas sends both the video and audio through the 1394 card to the external monitor.
Optimizing preview quality

Keep in mind that complex effects and/or transitions may not play back in real time from the timeline. What effects can and cannot be played back depends on the speed of your computer. You may want to prerender more complex portions of a project. *For more information, see Prerendering video on page 225.*

---

**Note:** The compression settings used to create the prerendered video must be identical to your captured files for timeline playback to work.

---

Configuring an external monitor

1. Connect your camera to the IEEE-1394 card and turn it on in VTR mode.
2. Run Vegas.
3. From the Options menu, choose Preferences.
4. Click the Video Device tab.
5. Select your device from the Device list (e.g., OHCI Compliant IEEE-1394/DV).

Vegas directs the output to the camcorder through the IEEE-1394 card. You can preview this output on the camcorder’s LCD screen or connect the camera to a television monitor to preview the output there. Once you have verified that the external monitor settings are working correctly, you can use it to preview your project.

Verifying the external monitor configuration

1. Click the Preview on External Monitor button ( ) on the Video Preview window.
2. Open a properly formatted AVI (e.g., a DV AVI) file in the Trimmer window in Vegas.
3. Click the Play button ( ) in the Trimmer window to test the output.

This can be a complex hardware issue. You can find more detailed information at the Sonic Foundry Website (http://www.sonicfoundry.com).

*For more information, see Video device tab on page 274.*
Vegas allows you to save and render projects into many different multimedia formats. When you render your Vegas project, the project itself is not altered, but rather can be rendered in any number of different formats.

This chapter explains saving a project and using the Save As and Render As functions. In addition, you will find reference information for the rendering options available in Vegas. This chapter also describes the different options for delivering your projects, such as printing to DV tape, burning a Video CD, or burning a multimedia CD.

Using custom settings to render to streaming media formats is available only in the full version of Vegas. Printing to tape from the timeline and CD burning are only available in the full version of Vegas.

**Saving a project**

A project in Vegas is saved as a small VEG file. This file contains all of the information Vegas needs to recreate your project: source file locations, trimming, track and bus plug-ins, volume and panning envelopes, bus assignments, assignable effects settings, etc. This is not the same as creating a final media file, which is done with the Render As command.

**Note:** Vegas also provides the option of saving a project as an Edit Decision List (EDL). For more information, see Creating an EDL on page 178.

1. Click the Save button ( ). The first time a project is saved, the Save As dialog appears.

   In subsequent saves, the Save As dialog is bypassed, your existing file name is retained, and your project is updated to include any changes.

2. Select Vegas Project File (.veg) from the Save as type list (default).

3. Select the drive and folder where you want to store the project.

4. Type the project name in the File name box.

5. Click Save.
Creating a copy of a project (using Save As...)

After you have been working with your project, you can use the Save As command in the File menu to create a copy of the small project file with a different name. Since multimedia projects can be very complex, and since Vegas project files are so small, saving a number of different versions of a project is a low-risk way to try new techniques.

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and folder where you want to store the project.
3. Type a new name in the File name box.
4. Click the Save button on the Save As dialog.

Saving a project with media

Vegas also provides the option of saving both the project file (VEG) and the media files to a common location. You can choose to save all media files along with the project file or allow Vegas to consolidate and trim the media for you. With this second option, Vegas optimizes media storage by saving only those portions of files that are used in the project and by eliminating unused takes.

The option to consolidate and trim media when saving is only available in the full version of Vegas.

Note: Peak files (.sfk) and audio proxy files (.sfap0) are not saved with the project when Copy and trim media with project is selected. Because Vegas can regenerate these files as needed, they do not need to be archived. For more information, see Peak File (.sfk) on page 297 or Audio proxy files (.sfap0) on page 285.

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and folder where you want to store the project.
3. Type the project name in the File name box.
4. Select the Copy and trim media with project check box.
5. Click Save. The Copy Media Options dialog appears.
6. Select the appropriate option:
   - Select the Copy all media radio button to copy all media files to the same location as the Vegas project file.
   - Select the Create trimmed copies of source media radio button to optimize media storage by saving only those portions of media files used in events and discarding unused takes. Vegas saves audio media as Wave64 files (.w64) and saves DV video media as AVI files. Non-DV video files are copied in full.

   Enter an Extra Head and Tail (seconds) value to indicate how much time Vegas should include before and after the trimmed media. For example, if the project contains a 2-minute media file, but the event on the timeline for that file lasts only from 1:00 to 1:20, you could enter 5 seconds in the Extra Head and Tail box to have Vegas save the media file from 0:55 to 1:25 (5 seconds added to the head and tail of the event). Including this extra material allows space for future edits.

7. Click OK. Vegas saves the project file and the related media files to the location you specified.
Autosaving a project

Vegas automatically saves a backup copy of your project every five minutes. If your system crashes, Vegas prompts you to open the backup file the next time you start the program.

Backup files are saved in the location specified in the Temporary files folder box on the General tab of the Preferences dialog. Files are saved with the .autosave.veg extension and are deleted when you close Vegas.

If you prefer not to autosave your project, you can clear the Enable autosave check box on the General tab of the Preferences dialog.

Vegas also creates .veg-bak files in your project folder when you save a project to allow you to return to the project’s last-saved state. Creation of .veg-bak files is independent of autosaving.

Rendering a project

Rendering refers to the process of converting the Vegas project into a single new multimedia file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, video tape, etc. The project file is not overwritten, deleted, or altered during the rendering process. You can return to the original project to make edits or adjustments and render it again later.

Rendering a video file can take quite a bit of time, depending on the complexity of your project, the speed of your CPU, and the final format you have selected. For longer projects, you might want to plan to render your movie overnight or when you are not using your computer.

The process for rendering a project is essentially the same, regardless of the final format of the rendered file.

---

**Note:** For specific information on 5.1 surround projects, see Rendering surround projects on page 165.

---

Using custom settings to render to streaming media formats is only available in the full version of Vegas. Vegas LE requires you to select from several predefined templates.

1. From the **File** menu, choose **Render As**. The Render As dialog appears.
2. Select the drive and folder where you want to save the rendered file.
3. Type a new name in the **File name** box, if necessary.
4. In the **Save as type** drop-down list, choose the appropriate format. For more information, see Selecting a file format on page 240.
5. In the **Template** drop-down list, select the appropriate template.

**Tip:** If your source media is in DV format, select a DV template. For more information, see Working in DV format on page 178.

You can customize the rendering settings by clicking **Custom**. For more information, see Customizing the rendering process on page 242.
6. Select any check boxes as needed:

- Select the Render loop region only check box to render only the portion of your project within the loop selection.
- Select the Stretch video to fill output frame size (do not letterbox) check box to adjust the aspect ratio so the output frame is filled on all edges. Clear the check box to maintain the current aspect ratio and add black borders to fill the extra frame area (letterbox). This option is useful when the desired output format does not match the frame aspect ratio of your project.
- Select the Save project markers in media file check box to save any regions and markers in your project to the final rendered file.

7. Click Save. A small dialog box appears, displaying the progress of the render. You can cancel the rendering process by clicking the Cancel button in the dialog box. You can also view the progress of the render or cancel the render using the status bar in the lower-left corner of the Vegas window.

Selecting a file format

The following table describes the formats available for rendering your Vegas project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>.aif</td>
<td>The standard audio file format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>.mpg</td>
<td>Some versions of Vegas also support MPEG-1 and MPEG-2 file creation through the use of MainConcept MPEG technology (see notes following table).</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>.mp3</td>
<td>Compressed audio format. You may render up to 20 .mp3 files without registering the optional plug-in.</td>
</tr>
<tr>
<td>OggVorbis</td>
<td>.ogg</td>
<td>A patent-free audio encoding and streaming technology.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>.mov</td>
<td>Apple QuickTime multimedia format.</td>
</tr>
<tr>
<td>RealMedia</td>
<td>.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity Audio</td>
<td>.pca</td>
<td>A Sonic Foundry proprietary format that is compressed and completely lossless (see notes following table).</td>
</tr>
<tr>
<td>Sonic Foundry Wave64</td>
<td>.w64</td>
<td>A Sonic Foundry proprietary format that allows wave files that are (practically) unrestricted by file size (see notes following table).</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Wave (Scott Studios)</td>
<td>.wav</td>
<td>Standard audio format used with Scott Studios systems.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>.wmv</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
</tbody>
</table>

More about the MPEG format

MPEG renders can sometimes take more time than renders with some other formats. MPEG video files can be played back on most computer systems. MPEG video files can also be burned to CDs or DVDs for playback in standalone VCD, SCVD, and DVD players. Sonic Foundry cannot guarantee the compatibility of MPEG files with VCD/DVD authoring software or VCD, SCVD, and DVD standalone players. Consult your specific authoring software’s documentation for information on what constitutes a valid file and then customize the MPEG rendering properties to match.

Note: For information on preparing files for Sonic Foundry DVD Architect™, please see the DVD Architect documentation.
More about the Wave64 and Perfect Clarity Audio formats

The Wave64 (.w64) and Perfect Clarity Audio (.pca) formats are proprietary formats developed by Sonic Foundry to work around some limitations inherent in other formats. Currently, neither is compatible with many other applications and may not be playable in other media players, but both are excellent choices for Sonic Foundry projects.

- **Wave64** files work around the maximum file size limitation inherent in the WAV format. The Wave64 format has no maximum file size and is useful in long format productions.
- **Perfect Clarity Audio** is a compressed format that is completely lossless. Unlike MP3 and other highly compressed formats which are lossy, 100% of the quality of your audio is maintained by using the PCA format.

More about video formats

When you create a final movie, you will find that there are dozens of formats to choose from, each having many customization options. The destination of your final movie is the most important factor in selecting a format. Movies created for broadcast television must be of the highest quality, but for many other destinations, such as a CD-ROM or the Internet, you may have to sacrifice some quality when you render the file. Heavy compression may create visible artifacts in the video, such as when you create streaming video for the Internet. Every case is different and it is necessary to experiment to obtain the best results.

**VCR or television**

If you are creating a movie that you want to send back out to a television, a VCR or a camcorder, there is only one choice: use the same settings as the original video.

There is no way to improve upon the quality of your original video (as far as compression is concerned). If you have captured your video at 640X480, at 24 fps in an MJPEG codec, then that is how you should set up your final movie. This is the only way to maintain 100% quality. For more information, see Working in DV format on page 178.

**Computer**

This can be the most complicated case because you have to decide exactly which computer it is going to be played back on, how fast it is, what software is installed, and how you are going to get it there (e.g., burn to a CD). Your biggest concern with creating a video file is compatibility. When you create a movie, you must select a specific codec to compress the video. That same codec must then be used to view the movie. This is not a problem if you are viewing the movie on your own computer, since the appropriate codec is already installed. To ensure that your audience has the appropriate software, you should use a fairly universal codec. Intel Indeo, Cinepak, and QuickTime (which is not a codec, but installs with a number of different codecs) are all widely available.

**Internet**

When video on the Internet is discussed, people almost always mean streaming. There are two streaming media formats that come with Vegas: RealMedia and Windows Media Format. There is nothing particularly magical about streaming video, and the three rules of creating video files for the Internet are as follows: compress, compress, and compress. The smaller the file size the better, and this inevitably results in a loss of quality. There are two main places where you can save space: frame dimensions and frame rate. Typical Internet video files should be about 160X120 and should rarely exceed 320X240. This is not very big, and video with lots of detail does not translate well to this frame size. The frame rate should also be as low as possible, with 15 fps being a good maximum. Fast action, pans, and moving backgrounds (e.g., tree leaves or ocean waves) do not compress well. Streaming media files must be placed on a special Internet server in order to stream properly.
Customizing the rendering process

Using custom settings to render to streaming media formats is only available in the full version of Vegas. Vegas LE requires you to select from several predefined templates.

Every media file format has different variables and controls. You can use a Vegas template to automatically configure a particular format for a particular destination.

You can also choose to create custom settings for your render by clicking Custom. Once you have customized the settings, you can create your own template so that you can reuse the custom settings at a later time.

Customizing the Render As settings

1. From the **File** menu, choose **Render As**.
2. In the Render As dialog, choose the format [e.g., Video for Windows (.avi)].
3. Click **Custom**. The Custom Template dialog appears.
4. Adjust the settings in each of the tabs as desired.
5. Click **OK** to close the Custom Template dialog.
6. Enter a name and location for the new file and click **Save**.

Saving custom settings as a template

You can save customized rendering settings for future use. One of the most important reasons to save a new template is to save the specific compression codec used to create the final media file, since this is not predetermined by the project properties.

1. Modify the parameters in the Custom Template dialog.
2. In the **Template** drop-down list, enter a name for the new template.
3. Click the **Save Template** button ( ).

To use the new template in the future, choose it from the **Template** list in the Save As dialog.

Tip: To delete a template, select it from the drop-down list and click the Delete button ( ).
Creating custom rendering settings for AVI files

The options that appear in the Custom Template dialog depend on which format you choose for your rendered file. This section provides descriptions of the Custom Template options for creating a Video for Windows (AVI) file. For descriptions of the options used to customize other formats, use the What’s This button ( ) in the specific Custom Template dialog for that format. For more information, see What’s This? help on page 18.

Some of the rendering settings are identical to your Project Properties and can be saved as a part of a project template. Final render settings override Project Properties settings. For more information, see Modifying project video properties on page 180.

The Custom Template dialog for rendering to an AVI file has three tabs: Project, Video, and Audio.

**Project tab**

**Video rendering quality**
Higher quality settings result in longer rendering times. Good is the default.

**Video tab**

**Include video**
Select this check box to include the video stream and enable the remaining fields on the dialog. If you do not want to include the video stream, clear this check box.

**Frame size**
Frame size contributes to quality and file size. The appropriate frame size is determined by the final destination of the movie. See your video capture card’s documentation for more information. The final frame size of the movie can be different from the project’s default settings.

**Frame rate**
Frame rate is important in determining the quality and size of the final media file. The appropriate frame rate is determined by the final destination of the movie. See your video capture card’s manual for more information. The final rendered multimedia file can have a different frame rate from the project itself.

**Field order**
Video that is displayed on a television monitor is interlaced. This means that every frame of video is actually composed of two fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in alternate lines, but which of the two fields is displayed first can be important. Choose None (progressive scan) to ignore interlacing for video to be displayed on a computer. For video on a television, most hardware supports Lower Field First. If the output is jittery or shaky on a television, or your hardware’s manual specifies it, choose Upper Field First.

**Pixel aspect ratio**
A pixel is a single picture element or dot on a television or computer screen. Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.909, 0.899, or anything other than square. Using the wrong pixel aspect ratio can result in distortions or stretching of the video. Select the aspect ratio for the final movie’s destination. Consult your hardware manual if you are in doubt about the appropriate ratio. The pixel aspect ratio and frame size determine the frame’s aspect ratio.
Video format

Codec, which stands for COmpressor/DECompressor, is the mathematical algorithm used to compress a media file. The codec directly determines the size and quality of the movie, as well as its compatibility with various playback devices. The final destination for the movie dictates the choice of codec. Many of the codecs used for specific rendering formats are updated periodically by their creators. For information about specific codecs, contact the codec’s manufacturer.

Each codec is a small program that may have additional custom controls used to fine tune the output. Click Configure to adjust these parameters manually.

Quality slider

If the codec you choose in the Video format drop-down list supports it, use this slider to adjust the quality of the compression applied by the codec.

Interleave every

This control allows you to specify how often the audio and video streams are interleaved. Interleaving relates directly to how the data is saved in the file. For example, during the rendering process, the audio data is written in between the video data based on the frame setting that you specified. Interleaving allows for optimal playback of the AVI file.

Keyframe every

If the codec you choose in the Video format drop-down list supports compression keyframes, select this option to set compression keyframes to adjust the quality of the compression. More keyframes typically produce higher quality video, but a larger file size (and thus a higher data rate).

Data rate

If the codec you choose in the Video format drop-down list supports a data rate ceiling, select this option and enter a maximum data rate for the final file.

Render alpha channel

If the codec you choose in the Video format drop-down list supports alpha channel transparency, select this option to save this information with the file.

Create an OpenDML (AVI version 2.0) compatible file

Select this check box if you want to save your file as an OpenDML file. OpenDML files allow you to create files that are limited in size only by the format of your hard disk: 2GB using FAT32 or 4GB using NTFS.

Audio tab

Include audio

Select this check box to include the audio stream and enable the remaining fields on the dialog. If you do not want to include the audio stream, clear this check box.

Audio format

This lists the audio rendering codecs that are available.

Attributes

If the codec you choose in the Audio format drop-down list supports it, select the appropriate attributes for the codec from this list.
Sample rate

The sample rate directly affects the audio's quality. The sample rate is defined as the number of times a second that data is sampled in an audio file. It is similar to the concept of resolution in an image file. The higher the setting you choose, the better the quality, but the larger the file size.

Bit depth

The bit depth directly affects the audio's quality. The bit depth is defined as how much data is used to save each sample. The higher the setting you choose, the better the quality, but the larger the file size.

Channels

You can render a project in either stereo or mono.

Printing with Video Capture

Once you have rendered your project, you can use Sonic Foundry's Video Capture application (installed with Vegas) to print your finished video onto DV tape in your video camera or VTR.

Note: You must have an IEEE-1394/OHCI-compliant video capture card installed to use Video Capture.

1. If you have not already done so, connect your video camera to your video capture card using the cable provided with the card.

2. In the Media Pool window, click the Capture Video button ( ). The Sonic Foundry Video Capture application starts.

Note: If your video camera is properly connected, the Video Preview window in the center of the application area should display “Device connected.”

3. Follow the instructions for printing to tape provided in the Video Capture online help. To access online help, click the Help menu within the Video Capture application, and choose Contents and Index. The Video Capture online help file displays.
Printing to DV tape

Print to tape from the timeline is only available in the full version of Vegas.

You can print either a portion of your project or the entire video right from the project timeline. Vegas examines your project, prerenders any complex portions, and then prints to DV tape all in one action. For more information, see Prerendering video on page 225.

---

Note: Printing to tape from the timeline can require significant drive space for temporary prerendered files. Set the Prerendered files folder on the Video tab of the Project Properties dialog to an A/V-capable drive with sufficient space. Prerendering a DV project uses approximately 228 MB/minute, so plan accordingly.

---

To print to DV tape, you must first establish a connection to the video camera or VTR to which you will print. For more information, see Video device tab on page 274.

Establishing a connection to the recording device

1. On the Tools menu, choose Preferences. The Preferences dialog appears.
2. Click the Video Device tab.
3. In the Device drop-down list, select OHCI Compliant IEEE 1394/DV.
4. Click OK. The Preferences dialog closes.
Printing to DV tape from the timeline

1. To print just a portion of your project, make a time selection in the timeline.

2. From the **Tools** menu, choose **Print Video to DV Tape**. The Conform Timeline to DV Format dialog appears. Complete the following information:
   - In the **DV Template** drop-down list, choose the appropriate template for rendering your video or click **Custom** to select custom settings. **For more information, see Customizing the rendering process on page 242.**

   **Note:** If you are working with a 24p progressive-scan project or you have the Allow pulldown removal when opening 24p DV check box selected on the General tab of the Preferences dialog, you will need to insert pulldown by choosing the appropriate 24p DV template from the list. To use the video footage in Vegas later, choose the NTSC DV 24p (inserting 2-3-3-2 pulldown) template.
   If you are not working with a 24p progressive-scan project and you cleared the Allow pulldown removal when opening 24p DV check box on the General tab of the Preferences dialog, you can use any DV template.
   - To print just a portion of your project, select the **Render loop region only** check box.

3. Click **Next**. The Leader and Trailer dialog appears. Complete the following information:
   - In the **Leader** section, choose a test pattern, and indicate the test pattern and black duration that will precede the video. To print without a test pattern or black leader, enter 0 for the **Duration** value. Select the **Play 1 kHz tone with test pattern** check box to include a tone in the leader.
   - In the **Trailer** section, indicate the duration of the black to follow the video. To print without a trailer, enter 0 for the **Duration** value.

   ![Leader and Trailer dialog](image)

4. Click **Next**. The Device Setup dialog appears. Choose the device control mode:
   - Choose the **Manual** radio button to cue the device manually and set it to record.
   - Choose the **Use device control** radio button to cue the device automatically based on a timecode value. Enter the timecode for recording to begin in the Device timecode box. The device must support OHCI 1394-DV device control to use this option.
5. Click Finish. Vegas begins printing the selected video to the device. A progress meter appears indicating the percent completed.

Note: The tone that you can include in the leader is fixed at -20 dB. If you need a different tone level (to match your audio mix), create a test pattern and tone clip that is calibrated to your record deck.
You created your project in Vegas, and now you are ready to write the project to a CD. With the CD-burning capabilities of Vegas, you can place and arrange audio files to produce professional audio CDs. You can burn CDs for multiple- or single-track projects and build audio CD layouts automatically or manually. Vegas also allows you to create video CDs that can be played in many home DVD players and on computers with a CD-ROM drive and VCD player software, and multimedia CDs that can be played in any computer with the appropriate player.

CD burning is only available in the full version of Vegas.

Understanding track-at-once and disc-at-once

Vegas provides two ways of recording audio to a CD-R disc: track-at-once and disc-at-once.

Track-at-once

Track-at-once writing records individual tracks to the disc and results in a partially recorded disc. However, the CD-R disc remains unplayable on most systems until you close the disc. The advantage of track-at-once writing is that you can record tracks onto the disc as you finish them versus waiting until you have finished your whole album. Track-at-once writing burns the entire Vegas project as a single track.

Disc-at-once (Single Session or Red Book)

Disc-at-once writing is the most common burning method in the music industry. This writing mode is used when creating a master disc to be sent to a disc manufacturer for mass replication. Disc-at-once works just as it sounds. Multiple tracks of audio are written to the CD in one recording session.

Understanding tracks and indices

You are ready to burn a CD. If you plan to use track-at-once to record a single track, you can proceed right on to writing the entire project to a CD. However, you are more likely to set up tracks—and perhaps indices—within your project and burn several tracks at once.

**Tracks** distinguish songs in the project and have a starting and ending point. Tracks are used to indicate to the CD-R device where to mark the beginning and ending of a track during the writing process.

**Indices** are single markers that subdivide a track. Indices are useful for navigating to specific areas within a track. For example, a sound effects CD may have one track of breaking glass. The track is then indexed to allow navigation to a specific glass-breaking effect within the track. However, be aware that not all CD players allow navigation to indices.

Tracks and indices are identified in a **track list**, which is a chronological text list of all tracks and indices defined in the audio CD project.
Setting up to burn audio CDs

CD burning is only available in the full version of Vegas.

You can set the project properties and adjust Vegas preferences to better accommodate writing audio CDs. Vegas sets up the ruler and time display for you automatically.

Viewing the ruler and time display

Vegas automatically changes the ruler and time display to audio CD time for you when you mark CD tracks in a project.

Audio CD time formats are as follows:

<table>
<thead>
<tr>
<th>Display</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler</td>
<td>hh:mm:ss (hours:minutes:seconds) or \n</td>
</tr>
<tr>
<td>Time display</td>
<td>tt+mm:ss:ff (track number +/- minutes:seconds:frames, with fps=75)</td>
</tr>
</tbody>
</table>

Setting project properties

Click the Properties button ( ) to access project properties. On the Audio CD tab, you can set the Universal Product Code/Media Catalog Number (UPC/MCN) or set the number for the first track on the CD. For more information, see Audio CD tab on page 269.

Setting preferences

From the Options menu, choose Preferences to access the Preferences dialog. On the CD Settings tab, you can select the CD drive or set the speed at which you will burn the CD. For more information, see CD Settings tab on page 278.

You can also enter the number of seconds Vegas adds between tracks when adding Media Pool files as CD tracks. In the same Preferences dialog, click the Editing tab, and enter a value in the Default time between CD tracks box.

Finally, you may want to turn off the Quantize to Frames command in the Options menu. When quantizing to frames is active, your edits are limited to the starting edge of frame boundaries. In a CD layout project, you can turn this feature off to allow greater precision in editing and track placement. For more information, see Quantizing to frames on page 87.

Importing CD Architect files

You can use Vegas to open projects created in Sonic Foundry CD Architect version 4.0.

1. From the File menu, choose Open. The Open dialog appears.
2. Browse to the location of the project file.
3. In the Files of type drop-down list, select CD Architect Project Files (.cdp).
4. Select the file.
5. Click Open.
Creating audio CD layout projects

Vegas provides several ways to create an audio CD layout project. If you have a set of audio files you wish to burn to a CD, you can add the files as tracks to a new audio CD layout project. Or, if you want to burn an audio CD from an existing project, you can mark the tracks in your project either automatically or manually.

Adding media as CD tracks to a new project

You have a collection of completed audio files that you want to write to a CD. Vegas can quickly assemble an audio CD layout project from sound files in the Media Pool. You can add the tracks one at a time, or use the Media Pool to sort them into track order and add them all at once.

1. Create a new project in Vegas.
2. Add all the media to be included in the project to the Media Pool. For more information, see Adding media to the Media Pool on page 42.
3. To add all tracks at once, use the following steps to sort the files into track order:
   - In the Media Pool, click the arrow on the Views button ( ) and choose Details from the menu. The Media Pool changes to Details view.
   - In the Comments column, enter the track number for each media file (01, 02, etc.).
   - Click the Comments column header to sort the list into track order.
   - Select the sorted files in the Media Pool.
4. Right-click a media file (or the selected media files) and choose Add as CD Track from the shortcut menu.

Vegas adds the files to a new track and marks the audio CD tracks on the CD layout bar. Vegas uses the name of the media file to name each track. If necessary, you can edit the information for the new audio CD tracks using the markers on the CD layout bar or using the Edit Details window. For more information, see Working with tracks and indices on page 253.

Right-click files in the Media Pool to add them as CD tracks to a audio CD layout project.
Marking tracks in an existing project

Once you have laid out your audio project with the appropriate pauses, you can mark tracks and indices either automatically or manually.

Note: In DAO CD burning, Vegas burns from the beginning of the timeline to the last track marker, regardless of the location of the first track marker. Material before the first marker is included as a hidden track on the disc (if your drive supports burning this material).

Adding pauses

Each audio CD track in your project should have a two-second pause following it. This default setting is based on the Red Book specification for audio CDs. The exception to this standard is a continuous recording, such as a live concert CD. For a continuous recording, you can omit the pauses after tracks for continuous playback. For more information, see Red Book specification on page 299.

Note: The Red Book specification also requires a two-second pause at the beginning of an audio CD. If the first track in your project begins before the two-second mark, Vegas adds a ruler offset to ensure the project begins with the required two-second pause.

If you use the Add as CD Track command to add tracks from the Media Pool, Vegas adds the appropriate pauses automatically. However, if you are laying out your project manually, you must create these pauses between audio CD tracks.

1. Position the cursor where you want to insert the pause.
2. From the Insert menu, choose Time. The Insert Time dialog appears.
3. Enter two seconds in the Amount of time to insert box.
4. Click OK. Two seconds are inserted in the timeline at the cursor position.

Marking tracks automatically

Vegas can examine the events in your project and mark the audio CD tracks for you. Once Vegas marks the tracks, you can adjust them manually if necessary. For more information, see Moving track and index markers on page 253.

1. Lay out your project with two-second pauses between tracks.
2. From the Tools menu, choose Lay Out Audio CD from Events.

The new audio CD track markers appear on the CD layout bar above the timeline. Vegas uses the name of the media file for each event to name the tracks.
Marking tracks manually
You can make a time selection and then mark that selection as an audio CD track.

1. Make a time selection that includes the audio for the new track.
2. From the **Insert** menu, choose **Audio CD Track Region**. The markers for the new audio CD track appear on the CD layout bar.

Marking indices
You can create an index marker in much the same way as you create track markers.

1. Position the cursor where you want the index mark to appear.
2. From the **Insert** menu, choose **Audio CD Track Index**. The new index marker appears on the CD layout bar.

Working with tracks and indices
Once you have marked your tracks and indices, you can edit, move, rename, or delete them as needed.

Navigating to and selecting tracks and indices
Vegas provides several shortcuts for navigating to and selecting audio CD tracks on the CD layout bar.
- Double-click a track marker to select the track.
- Press . (period) to jump the cursor to the next track or index marker.
- Press , (comma) to jump the cursor to the previous track or index marker.
- Press **Ctrl** + . (period) to jump the cursor to the next track marker (index markers are skipped).
- Press **Ctrl** + , (comma) to jump the cursor to the previous track marker (index markers are skipped).
- Add **Shift** to any of these keystrokes to select rather than jump. For example, press **Ctrl** + **Shift** + . (period) to select from the cursor position to the next track marker.

The shortcut keystrokes can be used to jump the cursor while working on a project or during playback.

Moving track and index markers
Track and index markers function just like markers and regions in Vegas (pg. 77). You can drag a track or index marker to move it along the CD layout bar. Alternately, you can use the Edit Details window to make precise adjustments.

**Tip:** Move both the starting and ending markers for a track by pressing **Alt** and dragging either of the markers.

Renaming track and index markers
1. Right-click a marker and choose **Rename** from the shortcut menu that appears.
2. Type a new name for the marker and press **Enter**.

Deleting track and index markers
You can delete a single track or index marker by right-clicking it and choosing **Delete** from the shortcut menu. To delete all markers at once, right-click the CD layout bar and choose **Delete All** from the shortcut menu.
Editing markers using the Edit Details window

The Edit Details window provides a way to adjust the settings for a track or index.

1. From the View menu, choose Edit Details. The Edit Details window displays.

2. From the Show drop-down list, choose Audio CD Track List. The track settings display.

3. Double-click a setting to edit it:
   - In the Position column, adjust the track starting position or index position.
   - In the End column, adjust the track ending position.
   - In the Length column, adjust the track length.
   - In the Name column, enter the name of the track or index.
   - In the Prot column, select the check box to apply copy protection to the track.
   - In the Emph column, select the check box to enable a simple noise reduction process that is implemented by a CD player. For more information, see Emphasis on page 294.
   - In the ISRC column, enter the ISRC number for the track (if used).

Copying a track list from the Edit Details window

You can use the Edit Details window to copy your track list and paste it into another application.

1. Click the gray box in the upper-left corner of the Edit Details window to select all the cells.

2. Press Ctrl+C to copy the cells.

3. Switch to another application and paste the information into a document or spreadsheet.

Burning audio CDs

CD burning is only available in the full version of Vegas.

You can burn either single tracks (track-at-once) or the entire disc (disc-at-once).

Burning single tracks (track-at-once)

You can burn your Vegas project as a single track (track-at-once). Once you have burned all your tracks to the CD, you must close the disc before it can be played.

Burning a track-at-once CD

1. From the Tools menu, choose Burn CD, and choose Track-at-Once Audio CD from the submenu. The Burn Track-at-Once Audio CD dialog displays the length of the current file and the amount of time remaining on the disc in your CD recorder.

2. Choose a setting from the Action drop-down list:
   - Burn audio begins recording audio to your CD when you click the Start button. You will need to close the disc before it can be played in an audio CD player.
   - Test, then burn audio performs a test to determine whether your files can be written to the CD recorder without encountering buffer underruns. Recording begins after the test if it is successful.
   - Test only performs a test to determine whether your files can be written to the CD without encountering buffer underruns. No audio is recorded to the CD.
   - Close disc closes your disc without adding any audio when you click the Start button. Closing a disc allows your files to be played on an audio CD player.
   - Erase RW disc erases your rewritable CD when you click the Start button.
3. Select your burning options:
   - Erase RW disc before burning: If you’re using a rewritable CD, select this check box to erase the CD before you begin burning.
   - Close disc when done burning: Select this check box to close the CD after burning. Closing a disc allows your files to be played on an audio CD player.
   - Eject disc when done: Select this check box to eject the CD automatically when burning has completed.
   - Burn loop region only: Select this check box to burn only the audio within the loop region.

4. From the Drive drop-down list, choose the CD drive that you want to use to burn your CD.

5. From the Speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest possible speed; decrease the setting if you have difficulty burning.

6. Click the Start button.

   **Warning:** Clicking the Cancel button after the disc-writing process has begun will render your disc unusable.

7. When the writing process is complete, a confirmation message displays. Click OK to clear the message.

Closing a track-at-once CD

1. From the Tools menu, choose Burn CD, and choose Track-at-Once Audio CD from the submenu. The Create CD dialog appears.

2. Click the Close Disc button.

3. When the disc is closed, a confirmation message displays. Click OK to clear the message.

Burning a disc (disc-at-once)

1. From the Tools menu, choose Burn CD, and choose Disc-at-Once Audio CD from the submenu. The Burn Disc-at-Once Audio CD dialog appears.

2. From the Drive drop-down list, use the CD drive that you want to use to burn your CD.

3. From the Speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest possible speed; decrease the setting to prevent the possibility of buffer underruns.

4. Select the Buffer underrun protection check box if your CD recorder supports buffer underrun protection. Buffer underrun protection allows a CD recorder to stop and resume burning.

   **Note:** Buffer underrun protection can create a disc that can be played in CD players, but may contain a bit error where burning stopped and restarted. Consider clearing this check box when creating a premaster disc.

5. Choose a radio button in the Burn mode box:
   - Burn CDs begins recording audio to your CD immediately.
   - Test first, then burn CDs performs a test to determine whether your files can be written to the CD recorder without encountering buffer underruns. No audio is recorded to the CD during the test, and recording begins after the test if it is successful.
   - Test only (do not burn CDs) performs a test to determine whether your files can be written to the CD recorder without encountering buffer underruns. No audio is recorded to the CD.
6. Select the Render temporary image before burning check box if you want to render your CD project to a temporary file before recording. Prerendering can prevent buffer underruns if you have a complex project that cannot be rendered and burned in real time.

**Note:** The rendered temporary file will remain until you modify your project or exit Vegas. If an image file exists when you Open the Burn Disc-at-Once Audio CD dialog, the check box is displayed as Use existing rendered temporary image.

7. Select the Automatically erase rewritable discs check box if you’re burning to rewritable media and want to erase the disc before burning.

8. Select the Eject when done check box if you want Vegas to eject the CD automatically when burning has completed.

9. Click OK to start burning.

**Burning video CDs**

CD burning is only available in the full version of Vegas.

Video CDs can be played in many home DVD players and on computers with a CD-ROM drive and VCD player software.

1. From the Tools menu, choose Burn CD and choose Video CD from the submenu. The Burn Video CD dialog is displayed.

2. Choose the movie file you want to use:

   • If you want to render the current project, select the Render format radio button.
     
     a. Edit the contents of the File path box to specify the name and location of your rendered file.
     
     b. Choose a template from the Template drop-down list to specify the parameters that should be used for rendering your file, or click the Custom button to create a new template.
     
     c. Select the Render loop region only check box if you want to use only a portion of your project. If the check box is cleared, the entire project will be rendered and saved to the Video CD.
     
     d. Select the Stretch video to fill output frame check box if you want Vegas to reformat your video so it fills the output frame size listed in the Description box. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterbox). This option is useful when the desired output format does not match the frame aspect ratio of your project.
     
     **Note:** Clear the Fast video resizing check box if you see unacceptable artifacts in the rendered video.
Turning off this option can correct the artifacts, but your rendering times will increase significantly.

- If you want to use an already-rendered MPEG file, select the Use an existing file radio button, and enter the path to the file in the File path box (or click the Browse button to locate the file).

3. Select recording options for your CD-recordable drive:

   a. Choose a burn mode:

      - **Burn CDs** begins recording audio to your CD immediately.
      - **Test first, then burn CDs** performs a test to determine whether your files can be written to the CD recorder without encountering buffer underruns. No audio is recorded to the CD during the test, and recording begins after the test if it is successful.
      - **Test only (do not burn CDs)** performs a test to determine whether your files can be written to the CD recorder without encountering buffer underruns. No audio is recorded to the CD.

   b. From the Burn speed drop-down list, choose the speed at which you want to record. **Max** will record using the fastest speed possible with your drive; decrease the speed if you have difficulty recording.

4. Vegas records your movie to the CD. When recording is finished, you can select the Save movie file check box to keep the MPEG file that was rendered, or you can clear the check box to delete the file.

5. Click **Finish**.

### Creating a multimedia CD

*CD burning is only available in the full version of Vegas.*

From the **Tools** menu, choose **Burn CD** and choose **Multimedia CD** from the submenu to render your project and burn it to a data CD. The rendered project can be played in any computer with the appropriate player.

1. From the **Tools** menu, choose **Burn CD**, and choose **Multimedia CD** from the submenu. The **Burn Multimedia CD** dialog appears.
2. Select the options for burning the multimedia CD:

- Choose the appropriate format and template for rendering the project from the Format and Template drop-down lists.
- Select the Render loop region only check box to burn only a portion of your project.
- Select the Stretch video to fill output frame check box to have Vegas reformat your video so that it fills the output frame size listed in the Description box. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterboxing).
- Clear the Fast video resizing check box if you see unacceptable artifacts in the rendered video. Turning off this option can correct the artifacts, but it increases rendering time significantly.
- Select the Play movie inside web page check box to create an HTML page and embed the finished video in it.
- Select the Include movie player installer check box to include a media player installer on the CD. Click the Browse button to locate the installer file.
- From the Speed drop-down list, choose the speed at which you want to record. The Max option records using the fastest speed possible with your drive. Decrease the speed if you have difficulty recording.

3. Click OK.
Using the scripting features, Vegas becomes an even more powerful and flexible tool. You can use scripting to streamline repetitive tasks, integrate with external applications, and implement customized features.

To use scripting in Vegas, you'll need to install the Microsoft .NET Framework. This component is available from the Windows Update site. (Choose Windows Update from the menu.)

![Scripting is only available in the full version of Vegas.](image)

### Running a script

1. From the **Tools** menu, choose **Scripting**, and then choose **Run Script** from the submenu. The Run Script dialog is displayed.

![Run Script dialog](image)

2. Browse to the script file (.vb or .js) you want to run.
3. Select the file and click the **Open** button. Vegas runs the script.
Creating shortcuts for frequently used scripts

The Scripting submenu allows you to store ten of your favorite scripts for easy access.

Storing a script

1. From the Tools menu, choose Scripting, and then choose Set Script X (1-10) from the submenu. The Set Script dialog is displayed.

   To replace an existing script, press [Ctrl]+[Shift]+[the number of the script you want to replace].

2. Browse to the script file (.vb or .js) you want to run.

3. Select the file and click the Open button. Vegas adds the script to the Scripting submenu, and the name of the command is updated to reflect the name of the script.

Recalling a stored script

From the Tools menu, choose Scripting, and then choose the script you want to run, or press [Ctrl]+[the number where you stored the script].

---

**Note:** There are toolbar buttons for each script that you can choose to add to your toolbar display for easy access. For more information on customizing your toolbar, see Adding buttons to the toolbar on page 270.

---

Creating a script

Vegas uses the Microsoft .NET framework for scripting. You can write scripts in JScript or Visual Basic .NET.


Editing an existing script

All you need to edit a script is a simple text editor (and a working knowledge of JScript or Visual Basic .NET scripting). The scripts that are included with Vegas are fully commented to help you find and edit the parameters you need.

1. Create a copy of the script (.vb or .js) file you want to edit, assigning a descriptive name to the copy.
2. Open the new copy of the script in your text editor.
3. Edit the script as needed. The comments in the script will help you find the parameters you need to edit.
   Comments are indicated with double forward slashes: //.
   For example, the AddEffectToAllMedia.js script includes the following lines:

   // This is the full name of the effect plug-in you want to add.
   var plugInName = "Sonic Foundry Timecode";

   // This is the name of the preset you want. Set this to null if you
   // want the default preset.
   var presetName = "SMPTE Drop (29.97 fps)";

   The default script applies the Sonic Foundry Timecode plug-in to all video media in your project using the SMPTE Drop (29.97 fps) preset. If you wanted to apply the Broadcast Colors plug-in's Extremely Conservative - 7.5 Setup preset to all audio media, you could edit the script as follows (changes appear in red):

   // This is the full name of the effect plug-in you want to add.
   var plugInName = "Sonic Foundry Broadcast Colors";

   // This is the name of the preset you want. Set this to null if you
   // want the default preset.
   var presetName = "Extremely Conservative - 7.5 Setup";

   The plugInName variable should use the plug-in name that is displayed in the Plug-In Chooser. The presetName variable should use the preset name that is displayed in the Preset box in the FX window.
4. Save the script.
Customizing Vegas

You can customize Vegas to suit your project needs and working preferences. Many of the settings depend on your equipment or studio setup. Vegas can be set to work with the components that you use in your studio.

In this chapter, you will find information about functions that allow you to customize the appearance of Vegas, set a project’s properties, and set the application’s preferences.

Displaying frame numbers

You can display frame numbers on video events. Once you have enabled frame numbering, a small box appears at the bottom of the event thumbnail with the frame offset, time or timecode. The small black arrow marks the exact position of that frame in time.

When the workspace is zoomed in far enough, each thumbnail represents a single numbered frame in the source video file. At intermediate zoom levels, marks between the frame numbers show the location of intermediate frames. These frame marks are not visible at lower magnifications.

1. From the Options menu, choose Preferences.
2. Click the Video tab.
3. Choose an option from the Show source frame numbers on event thumbnails as drop-down list.
4. Click OK.

Changing the ruler format

You can customize the ruler in Vegas to display a number of different standard formats. The format that you select affects how the ruler and time display window display time units. For more information, see Timecode in Vegas on page 288.

To change the ruler’s format, right-click the ruler and choose the desired time format from the shortcut menu or, from the Options menu, choose Ruler Format and choose the desired time unit. You can also change ruler settings on the Project Properties dialog’s Ruler tab. For more information, see Ruler tab on page 268.
The following are the different time units available in Vegas (hh=hours, mm=minutes, ss=seconds, and ff=frames):

<table>
<thead>
<tr>
<th>Time format name</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>numbered (starting with zero)</td>
</tr>
<tr>
<td>Time</td>
<td>hh:mm:ss.sss</td>
</tr>
<tr>
<td>Seconds</td>
<td>sssss.sss (to three decimal places)</td>
</tr>
<tr>
<td>Time &amp; Frames</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>Absolute Frames</td>
<td>frames are numbered starting with 0</td>
</tr>
<tr>
<td>Measures &amp; Beats</td>
<td>measures.beats.ticks, where 64 ticks = 1 beat</td>
</tr>
<tr>
<td>Feet &amp; Frames 16mm (40 fps)</td>
<td>feet+frames, where 40 frames = 1 foot</td>
</tr>
<tr>
<td>Feet &amp; Frames 35mm (16 fps)</td>
<td>feet+frames, where 16 frames = 1 foot</td>
</tr>
<tr>
<td>SMPTE Film Sync (24 fps)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE EBU (25 fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Non-Drop (29.97 fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Drop (29.97 fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE 30 (30 fps, Audio)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>Audio CD Time</td>
<td>hh:mm:ss or hh:mm:ss:ff when zoomed in tightly</td>
</tr>
</tbody>
</table>

### Editing the ruler offset

The ruler doesn’t necessarily need to start with zero at the far left side. You can enter an offset to change the orientation of the ruler in a project. One use of this is to create a lead-in into a project. A five-second offset would mean that the ruler would start at -5 seconds and would be at 0 five seconds into the project.

**Note:** You cannot create a ruler offset in an audio CD layout project.

1. Position the cursor at the desired location along the timeline.
2. Right-click the ruler and choose **Set Time at Cursor** from the shortcut menu. The current ruler value is highlighted.
3. Enter a time value.
4. Press **Enter** to set the ruler’s time. The value that you enter at the cursor’s position affects the entire ruler.
Changing grid spacing

Grid spacing is different from the ruler and provides an alternate method of subdividing a project's time. This can be useful if you want the ruler to display SMPTE video timecode, but you need to create your music in terms of beats and measures. You can display the grid spacing in time, frame, measure, or note units. The grid can also be set to match the ruler's time format. The grid appears across all tracks in your project and the grid's lines can be used as snap points.

To change grid spacing, choose Grid Spacing from the Options menu, and choose the desired time unit from the submenu. The grid spacing changes to reflect your selection.

Note: In some cases, the grid lines and the ruler do not match. This is because they are two independent functions.

Using the Time Display window

The Time Display window reflects the cursor's position on the timeline and the end point of a time selection. You can customize the time display's settings, including what time the window displays and what colors it uses.

You can move the Time Display window from its docked position above the track list to float on the Vegas workspace. In addition, you can dock the time display in the window docking area. For more information, see Window docking area on page 22.

Changing the time display settings

The time display always reflects the ruler settings that are selected. You can change the ruler settings via the time display or vice versa. For more information, see Changing the ruler format on page 263.

1. Right-click the time display. A shortcut menu appears.
2. From the shortcut menu, choose Time Format, and choose the desired time format from the submenu.

Both the time display and ruler display the chosen time format.
Changing the time display colors

You can change the background color and text color used in the time display.

1. Right-click the time display to display the shortcut menu.
2. From the shortcut menu, choose Text Color or Background Color and then choose Custom. The Time Display Color dialog appears.
3. Choose the color setting that you want.
4. Click OK to set the text or background color or click Cancel to keep the existing color settings and close the dialog.

Tip: To return the time display’s text or background color to its default settings, choose either Text Color or Background Color from the shortcut menu, and choose Default from the submenu.

Setting the time display to monitor MIDI timecode

You can use the time display to monitor the status of incoming or outgoing MIDI timecode. Vegas can monitor MIDI timecode being generated from an external device or monitor MIDI timecode and MIDI clock information generated by Vegas. From within Vegas, the time display settings work in conjunction with your project’s properties and MIDI setup options. For more information, see Sync tab on page 278.

1. Right-click the time display.
2. From the shortcut menu, choose the type of MIDI monitoring for Vegas to display.

Once you have made your selection, the time display displays both the MIDI timecode being input or output and a status message.
Working with project properties

Vegas supports a large range of formats and various types of media files. Some settings in a project’s properties are simply informational details about the project, while others control how Vegas handles your project and its output. If you have multiple projects, Vegas stores the settings used for each project. These settings can be saved as templates for future use.

To view and modify project properties, choose Properties from the File menu. The Project Properties dialog has five tabs: Video, Audio, Ruler, Summary, and Audio CD. An overview of each tab and its settings follows.

Video tab

This tab allows you to set different characteristics the project uses to handle the video. Also, this tab displays information about the video contained in your project. For more information, see Modifying project video properties on page 180.
Audio tab

This tab allows you to set different characteristics the project uses to handle the audio. This page also displays the available drive space where Vegas stores recorded audio.

Multiple audio busses are only available in the full version of Vegas. Sample rates are limited in Vegas LE to 48,000 Hz, while Vegas allows up to 96,000 Hz.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master bus mode</td>
<td>Choose Stereo to create a two-channel stereo project.</td>
</tr>
<tr>
<td></td>
<td>Choose 5.1 Surround if you want to perform advanced 5.1-channel mixing.</td>
</tr>
<tr>
<td>Number of stereo busses</td>
<td>Enter the number of stereo busses that you want in your project. You may add up to 25 additional busses. The busses appear in the Mixer.</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a sample rate from the drop-down list or enter your own rate. The sample rate range is 2,000 Hz to 96,000 Hz for the full version of Vegas, or 2,000 Hz to 48,000 Hz for Vegas LE. Higher sample rates result in better quality sound, but also mean larger audio files.</td>
</tr>
<tr>
<td>Bit depth</td>
<td>Choose a bit depth from the drop-down list. A higher bit depth results in better quality sound, but also means larger audio files.</td>
</tr>
<tr>
<td>Resample quality</td>
<td>Choose Preview, Good, or Best resample quality.</td>
</tr>
<tr>
<td>Enable low-pass filter on LFE</td>
<td>Applies a low-pass filter to each track in a 5.1 surround project that is assigned to the LFE channel.</td>
</tr>
<tr>
<td>Cutoff frequency for low-pass filter (Hz)</td>
<td>Choose a frequency to set the frequency above which audio will be ignored by the LFE channel.</td>
</tr>
<tr>
<td>Low-pass filter quality</td>
<td>Choose Preview, Good, or Best to determine the sharpness of the filter's rolloff curve. Best produces the sharpest curve.</td>
</tr>
<tr>
<td>Recorded files folder</td>
<td>Displays the path where recorded audio is stored. The Browse button allows you to select a new location to store recordings.</td>
</tr>
<tr>
<td>Free storage space in selected folder</td>
<td>Displays the available disk space where recorded audio is stored.</td>
</tr>
<tr>
<td>Start all new projects with these settings</td>
<td>Use the project properties that you have specified whenever a new project is created.</td>
</tr>
</tbody>
</table>

Ruler tab

This tab allows you to change ruler settings used in your project. You can also change ruler settings in track view. For more information, see Changing the ruler format on page 263.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler time format</td>
<td>Choose a ruler time format from the drop-down list.</td>
</tr>
<tr>
<td>Ruler start time</td>
<td>Enter a value that the ruler will use at the beginning of your project. This feature is useful for synchronization purposes.</td>
</tr>
<tr>
<td>Beats per minute (tempo)</td>
<td>Enter the desired number of beats per minute for the project.</td>
</tr>
<tr>
<td>Beats per measure</td>
<td>Enter the desired number of beats to occur per measure for the project.</td>
</tr>
<tr>
<td>Note that gets one beat</td>
<td>The value entered will determine the time signature used by the ruler when its format is set to Measures and Beats. For example, if the entered value is 4, then a quarter note gets one beat.</td>
</tr>
<tr>
<td>Start all new projects with these settings</td>
<td>Use the project properties that you have specified whenever a new project is created.</td>
</tr>
</tbody>
</table>
Summary tab

This tab allows you to enter information about the project. You can leave the boxes on this tab blank or, if information exists, you can change it at any time.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the name or title of the open project.</td>
</tr>
<tr>
<td>Artist</td>
<td>Enter the name of the narrator, band, or artist(s) being recorded into the project.</td>
</tr>
<tr>
<td>Engineer</td>
<td>Enter the name(s) of the people who mixed and edited the project.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Enter the date and ownership rights of the project.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter information that identifies and describes the project.</td>
</tr>
<tr>
<td>Start all new projects with these settings</td>
<td>Use the project properties that you have specified whenever a new project is created.</td>
</tr>
</tbody>
</table>

Audio CD tab

This tab allows you to enter information used when burning audio CDs in Vegas.

CD burning is only available in the full version of Vegas.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Product Code/Media</td>
<td>If your CD-R device supports writing UPC/MCN codes, you may specify the value in this field. If you leave the field blank, no UPC/MCN value will be written to the CD. Otherwise, the value consists of 13 digits.</td>
</tr>
<tr>
<td>Catalog Number</td>
<td></td>
</tr>
<tr>
<td>First track number on disc</td>
<td>This sets the number for the first track on the disc.</td>
</tr>
</tbody>
</table>

Using the toolbar

Vegas automatically displays the main toolbar below the menu bar. However, you may hide and customize the toolbar to suit your preferences. The settings that you apply to the toolbar remain set until you change them again.

Hiding and displaying the toolbar

If you prefer to use shortcut keys when working with your project, you may hide the toolbar to create more workspace. Choose Toolbar from the View menu to hide it. The check mark next to the command is removed and the toolbar disappears. The toolbar remains hidden until you choose Toolbar from the View menu to display it again.

Reordering toolbar buttons

Vegas allows you to change the main toolbar’s button order to suit your preferences. You may either reorder the buttons directly on the workspace or via the Customize Toolbar dialog.

Reordering buttons on the Vegas workspace

1. Hold Shift and drag the button that you want to move to the new location on the toolbar. A hand icon ( liberté ) within an outline of the button indicates that you are moving the button.
2. Release the mouse to drop the button in its new location.

Note: If you drag the button off the toolbar, the button is removed.
Reordering buttons in the Customize Toolbar dialog

The Customize Toolbar dialog allows you to control the order and functionality available on the main toolbar. You may return the toolbar to its default settings by clicking the Reset button.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. In the Current toolbar buttons list, select the button that you want to move and click Move Up or Move Down.

3. Click Close to save the toolbar changes and close the dialog.

Adding buttons to the toolbar

Vegas includes a series of buttons that you may add to the main toolbar. These buttons are listed in the Customize Toolbar dialog. You may also add separators on the toolbar to organize the buttons to suit your preferences.

You may return the toolbar to its default settings by clicking the Reset button on the dialog.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. In the Available toolbar buttons list, use the scroll bars to locate the button that you want to add, and then select it.

3. On the Current toolbar buttons pane, select the button that you want the newly added button to proceed in order.

For example, if you want to add the Record button and want it to precede the Enable Snapping button, select the Enable Snapping button in the Current toolbar buttons list.

4. Click Add. The new button is added above the selected button in the Current toolbar buttons list.

**Note:** You may also double-click a button to add it to the toolbar.

5. Click Close to save the toolbar settings and close the dialog.
Removing buttons from the toolbar

You may remove buttons and separators from the main toolbar. If you have added buttons to the toolbar, removing unused or unwanted buttons allows you to maximize the toolbar's space. You may remove toolbar buttons either directly on the workspace or via the Customize Toolbar dialog.

Removing buttons on the Vegas workspace

1. Hold \textit{Shift} and drag the button that you want to remove off the toolbar. A hand icon (\textit{\[\text{\textsuperscript{\textsuperscript{\textsuperscript{\textsuperscript{Hand icon}}}}\]}) within an outline of the button indicates that you are removing the button.

2. Release the mouse to remove the button.

Removing buttons in the Customize Toolbar dialog

You may return the toolbar to its default settings by clicking the \textit{Reset} button on this dialog.

1. From the \textbf{Options} menu, choose \textit{Customize Toolbar}. The Customize Toolbar dialog appears.

2. On the \textit{Current toolbar buttons} pane, select the button that you want to remove.

3. Click \textit{Remove}. The button is removed from the \textit{Current toolbar buttons} pane and will not appear on the toolbar.

\textbf{Note: You may also double-click a button to remove it.}

4. Click \textit{Close} to save the toolbar settings and exit the dialog.
### Setting Vegas preferences

The preferences options are different from project properties. Project properties are unique to each project, while preferences affect how Vegas functions. Any changes that you make to the preferences remain set until you change them again or reset Vegas to use the default presets.

You can access the Preferences dialog by choosing Preferences from the Options menu. This dialog contains eight tabbed pages: General, Video, Video Device, Audio, Audio Device, Editing, CD Settings, and Sync. The following sections explain the settings on each tab.

#### General tab

The General tab includes a variety of settings. The following is a list of these preferences and their meaning.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically open last project on startup</td>
<td>When Vegas is run, the last project saved automatically opens.</td>
</tr>
<tr>
<td>Show logo splash screen on startup</td>
<td>Briefly shows the Vegas logo while the program is loading. The logo does not increase loading time.</td>
</tr>
<tr>
<td>Show active take name in events</td>
<td>Displays the name of the take that is active in an event.</td>
</tr>
<tr>
<td>Draw waveforms and frames in events</td>
<td>Draws a graphical representation of an audio file's waveform and thumbnail images of a video file's frames.</td>
</tr>
<tr>
<td>Show video event buttons</td>
<td>Shows/hides the Event FX, Pan/Crop, and Generated Media buttons on video events.</td>
</tr>
<tr>
<td>Animate video frames in Trimmer</td>
<td>Animates the thumbnail representations of frames in a media file opened in the Trimmer. This can visually aid trimming.</td>
</tr>
<tr>
<td>Prompt to keep files after recording</td>
<td>Opens a dialog where you can enter a name and select a location where audio will be saved after recording into a track.</td>
</tr>
<tr>
<td>Create undos for FX parameter changes</td>
<td>Allows you to undo changes made in the FX, Transition, Event Pan/Crop and Track Motion windows.</td>
</tr>
<tr>
<td>Confirm media file deletion when still in use</td>
<td>When deleting media in the Explorer or Media Pool, Vegas warns you if any events in the project are using these files.</td>
</tr>
<tr>
<td>Double-click on media file loads into Trimmer instead of tracks</td>
<td>The default Explorer double-click behavior is to insert an event at the cursor position on the timeline. Select this option to open the media file in the Trimmer instead.</td>
</tr>
<tr>
<td>Show Trimmer history with file name first, then folder</td>
<td>The Trimmer history drop-down list displays the media file's name first, followed by the folder it is in. Select this to reverse the names.</td>
</tr>
<tr>
<td>Automatically save Trimmer markers and regions with media file</td>
<td>Markers and regions created at the media file level in the Trimmer can be saved to the file.</td>
</tr>
<tr>
<td>Show progress in Video Preview window while rendering</td>
<td>Frames can be displayed in the Video Preview during a render. This will slow a render somewhat.</td>
</tr>
<tr>
<td>Save active prerenders on project close</td>
<td>Full quality preview renders are cleaned up and deleted when a project is closed. Select this if you want these prerendered files to be available later.</td>
</tr>
<tr>
<td>Close media files when not the active application</td>
<td>This allows media files to be edited in external editors (audio, image, etc.) while they are contained in events in Vegas.</td>
</tr>
<tr>
<td>Close audio and MIDI ports when Vegas is not the active application</td>
<td>Select this check box if you want Vegas to close audio and MIDI ports when you switch to another application.</td>
</tr>
<tr>
<td>Enable multimedia keyboard support</td>
<td>This allows you to use a multimedia keyboard to control playback of a project.</td>
</tr>
<tr>
<td>Render large Wave files as Wave64</td>
<td>The WAV format is limited by a maximum file size of ~2GB. You can choose to render larger files as Sonic Foundry Wave64 files.</td>
</tr>
<tr>
<td>Automatically name regions and markers if not playing</td>
<td>When regions and markers are added, this option automatically prompts you for a name. This does not happen when adding markers on-the-fly during playback.</td>
</tr>
<tr>
<td>Ignore third party DV codecs</td>
<td>Clear this check box to enable third-party DV codecs.</td>
</tr>
<tr>
<td>Use Microsoft DV codec</td>
<td>Vegas uses the Sonic Foundry DV codec (which offers improved DV video quality over the Microsoft codec) as a default. Select this option to have Vegas use the Microsoft codec to read DV files instead.</td>
</tr>
<tr>
<td>Preference</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Strictly conform to AVI2 specification</td>
<td>Select this option to create 100% AVI2 compliant files. While these files conform to the standards, not all applications follow these specifications and some programs may not be able to read them.</td>
</tr>
<tr>
<td>Disable multi-processor AVI rendering</td>
<td>Suspends dual processor rendering for AVI files. Selecting this option does not affect other dual processor operations.</td>
</tr>
<tr>
<td>Allow pulldown removal when opening 24p DV</td>
<td>Select this option to have Vegas remove pulldown on DV video files in 24 fps progressive-scan (24p) format. When this check box is cleared, Vegas will open 24p files as 29.97 fps interlaced video (60i).</td>
</tr>
<tr>
<td>Create project file backups (.veg-bak)</td>
<td>Automatically create backups of your project files.</td>
</tr>
<tr>
<td>Use Net Notify to stay informed about Sonic Foundry products</td>
<td>Select this option to have Vegas periodically display information from Sonic Foundry at startup.</td>
</tr>
<tr>
<td>Enable autosave</td>
<td>Creates a temporary project file that can aid in crash recovery. When enabled, autosave occurs every five minutes. The autosave process does not overwrite the original project file.</td>
</tr>
<tr>
<td>Use linear scrub range</td>
<td>When this check box is selected, the scrub control uses a linear range. When this check box is cleared, the scrub control uses a logarithmic range.</td>
</tr>
<tr>
<td>Allow Ctrl+drag cursor style scrub over events</td>
<td>Vegas allows scrubbing on empty sections of the timeline using Ctrl+drag on the cursor. Select this option to enable timeline scrubbing over events as well.</td>
</tr>
<tr>
<td>Make spacebar and F12 Play/ Pause instead of Play/Stop</td>
<td>Changes the spacebar and F12 keys to start and pause playback rather than start and stop.</td>
</tr>
<tr>
<td>Always draw marker lines</td>
<td>Select this check box if you want Vegas to extend marker and region lines across tracks in the timeline. When the check box is cleared, marker lines are drawn only when Enable Snapping is turned on.</td>
</tr>
<tr>
<td>Build 8-bit peak files</td>
<td>Vegas builds 16-bit peak files as a default. Select this option to build 8-bit peak files instead.</td>
</tr>
<tr>
<td>Disable pop-up animations</td>
<td>Turns off the animation applied to windows such as Video FX, Event Pan/Crop, and Track Motion when these windows are opened.</td>
</tr>
<tr>
<td>Automatically hide docking area</td>
<td>Select this check box if you want the window docking area to hide automatically. Hover over the bottom of the Vegas window to show the window docking area.</td>
</tr>
<tr>
<td>Show video event edge frames in Video Preview window during edits</td>
<td>Select this check box if you want Vegas to show the frame at the edge of a video event when you perform edge trimming. For example, when you drag the edge of a video event with this check box selected, the Video Preview window will update to draw the last frame in the event as you drag. When the check box is cleared, Vegas will display a static frame.</td>
</tr>
<tr>
<td>Build peaks for visible events only</td>
<td>Select this check box if you want Vegas to build peak files as needed. Vegas will not build a peak file until a file is visible in the timeline. You can open your projects more quickly, but there may be occasional pauses as Vegas builds peaks. Clear the check box if you want Vegas to build all necessary peak files when you open your project. Opening a project can take longer, but after peak files are built, you can scroll through and view your project.</td>
</tr>
<tr>
<td>Keep bypassed FX running (to avoid pause on bypass/enable)</td>
<td>Select this check box if you want effects to remain open so you can bypass/enable effects with no pause for A/B testing. When the check box is cleared, effects are fully bypassed, conserving processing power.</td>
</tr>
<tr>
<td>Enable joystick support</td>
<td>Select this checkbox if you want to have joystick control for editing in Vegas.</td>
</tr>
<tr>
<td>Recently used project list</td>
<td>Select the number of files to be listed at the bottom of the File menu.</td>
</tr>
<tr>
<td>Temporary files folder</td>
<td>Select a location for all temporary files.</td>
</tr>
<tr>
<td>Free storage space in selected folder</td>
<td>Displays the available disk space in the folder specified in the Temporary files folder box.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all general preferences to the default settings.</td>
</tr>
</tbody>
</table>
**Video tab**

The Video tab in the Preferences dialog controls the display of video media, video events and video tracks in Vegas.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic RAM Preview max</td>
<td>Determines the size of the RAM cache for building dynamic RAM previews in the Video Preview window. Dynamic RAM previews are only available in the full version of Vegas. For more information, see Building dynamic RAM previews on page 226.</td>
</tr>
<tr>
<td>Show source frame numbers on event thumbnails as</td>
<td>Display frame, time, or timecode numbering on video event thumbnails.</td>
</tr>
<tr>
<td>Preferred video capture application</td>
<td>Browse for the application to be launched when you click the Open Video Capture button ( ).</td>
</tr>
<tr>
<td>Action Safe Area and Title Safe Area</td>
<td>Sets the reference overlay safe areas in the Video Preview window. For more information, see Identifying safe areas on page 228.</td>
</tr>
<tr>
<td>Horizontal Grid Divisions and Vertical Grid Divisions</td>
<td>Sets the spacing of the grid overlay in the Video Preview window used in aligning visual elements in a project. For more information, see Changing grid spacing on page 265.</td>
</tr>
<tr>
<td>Display at project size</td>
<td>Sets the Video Preview window to always display the video at full project size.</td>
</tr>
<tr>
<td>Simulate device aspect ratio</td>
<td>Determines how the video is displayed in the Video Preview window. In short, televisions display rectangular pixels and computer monitors display square pixels. This can result in a distorted preview, although the source media and rendered video is unaffected.</td>
</tr>
<tr>
<td>Background color</td>
<td>Sets the background color of the Video Preview window (black by default) that shows either when there is no visual content or when using a transparent overlay with no background visual content.</td>
</tr>
<tr>
<td>Default track fade colors</td>
<td>Sets the default top and bottom colors when adding a Fade to Color envelope to a video track. For more information, see Working with track envelopes on page 109.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all video preferences to the default settings.</td>
</tr>
</tbody>
</table>

**Video device tab**

This tab allows you to identify an external video device for Vegas to communicate with. The selected video device is used to display previews on an external monitor or to print directly from the timeline to DV tape. For more information, see Printing to DV tape on page 246.

The connection between Vegas and the video device works with OHCI compliant IEEE-1394 DV capture cards and some MJPEG capture cards. There are two cases where Vegas can play back to an external monitor. One is when you have special hardware that has both computer and television monitor outputs. The other is for (OHCI compliant) DV capture cards where DV data can be previewed out through your DV camcorder to an external monitor. For more information, see Using an external monitor on page 234.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Choose a device from the drop-down list.</td>
</tr>
<tr>
<td>Details</td>
<td>Displays information regarding the capture card specified in the Device drop-down list.</td>
</tr>
<tr>
<td>If project is invalid for DV output, conform to the following</td>
<td>If your source media does not conform to DV standards, choose a setting from the drop-down list to adjust the video to display properly on your external monitor.</td>
</tr>
<tr>
<td>Sync offset (frames)</td>
<td>If audio and video do not play back in synchronization on your external monitor, drag this slider to specify a frame offset to restore synchronization. Note: This setting affects synchronization on an external monitor only. Audio and video synchronization in your Vegas project is unaffected.</td>
</tr>
</tbody>
</table>
Audio tab

The Audio tab allows you to set preferences to optimize how Vegas uses your computer’s components to handle resource-intensive audio. This tab also allows you to configure Vegas to the equipment that is connected to your computer.

Multiple audio busses are only available in the full version of Vegas.

Audio Device tab

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio device type</td>
<td>Choose a driver type from the drop-down list. The Microsoft Sound Mapper is the default setting. If you want to activate specific sound cards, choose Windows Classic Wave Driver or ASIO and choose a device from the Default Stereo and Front playback device drop-down list. ASIO audio drivers are only supported in the full version of Vegas. For more information, see Routing busses to hardware on page 140.</td>
</tr>
<tr>
<td>Default Stereo and Front playback device</td>
<td>Choose the device that you want to use for playing stereo sound data and the front-left and -right channels of a 5.1 surround project. Selecting the Microsoft Sound Mapper allows Windows to select an appropriate device to use for the current sound data. <strong>Note:</strong> If you have selected Microsoft Sound Mapper, you will not be able to assign busses to different devices.</td>
</tr>
<tr>
<td>Default Rear playback device</td>
<td>Choose the device that you want to use for playing the rear channels of a 5.1 surround project.</td>
</tr>
<tr>
<td>Default Center and LFE playback device</td>
<td>Choose the device that you want to use for playing the center and low-frequency effect channels of a 5.1 surround project.</td>
</tr>
<tr>
<td>Playback buffering (seconds)</td>
<td>Sets the amount of memory Vegas uses during project playback. For more information, see Adjusting the playback buffering slider on page 276.</td>
</tr>
<tr>
<td>Default audio recording device</td>
<td>Sets the default device for recording into a track.</td>
</tr>
<tr>
<td>Automatically detect and offset for hardware recording latency</td>
<td>Select the check box to automatically compensate for offset between the time you initiate recording and when your sound card starts recording. Clear the check box and drag the User recording latency offset (ms) slider to specify an offset value.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all audio device preferences to the default settings.</td>
</tr>
</tbody>
</table>
Advanced audio preferences

You can access advanced settings by clicking the Advanced button on the Audio Device tab. The Advanced Audio Configuration dialog displays all of the audio devices that are installed on your computer and allows you to set the controls for each device.

### Preference Description

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio devices</td>
<td>This list contains all of the audio devices that are installed in your computer. Selecting one from the list allows you to set the options below for that device.</td>
</tr>
<tr>
<td>Interpolate position</td>
<td>During project playback, you may notice that the cursor position is different than what you are hearing. This problem stems from inaccuracies in some audio devices. Select this control's check box to have Vegas attempt to compensate for the inaccuracies by interpolating the cursor's correct position during playback or recording.</td>
</tr>
<tr>
<td>Position bias</td>
<td>The position bias control gives you additional cursor control when it is inaccurately displayed during project playback and recording. If you have enabled the Interpolate position control and are still experiencing cursor position inaccuracies, move the Position bias control forward or backward to compensate for the inaccuracies of the audio device.</td>
</tr>
<tr>
<td>Do not pre-roll buffers before starting playback</td>
<td>When this option is not selected, Vegas begins storing (buffering) project audio information prior to playback. This storing is very fast and unnoticeable in most cases. However, some audio devices stutter when you begin playback as a result of the buffering process. If your audio stutters when you start playback, select this check box to prevent Vegas from buffering audio information prior to playback.</td>
</tr>
<tr>
<td>Audio buffers</td>
<td>Drag the slider to set the number of audio buffers that will be used. Adjusting this setting can help you synchronize the input and output for record input monitoring. Record input monitoring is only available in the full version of Vegas.</td>
</tr>
<tr>
<td>Buffer size (samples)</td>
<td>Choose a setting from the drop-down list to indicate the buffer size you want to use. Choose MME to use the Playback buffering setting on the Audio Device tab in the Preferences dialog.</td>
</tr>
<tr>
<td>Priority</td>
<td>Choose a setting from the drop-down list to set the priority that is assigned to your audio buffers. Increasing the buffers' priority can help you attain smoother playback, but it can also adversely affect other processes.</td>
</tr>
<tr>
<td>Enable input monitoring</td>
<td>Select this check box to enable the monitoring of your recording input through Vegas while you are recording.</td>
</tr>
</tbody>
</table>

### Adjusting the playback buffering slider

The playback buffer controls how much memory Vegas uses when playing back your project. This preference is useful, but must be carefully adjusted. If you set the buffer size too high, you may experience gapping during playback. Conversely, if you set the buffer size too low, you may experience gapping as well because Vegas has too little memory to work with during playback.

The playback buffer slider should be set to balance RAM usage and playback buffering. The rule is to set this slider as low as possible without introducing gapping.

1. Open a project that has multiple events.
2. On the Audio device tab, move the Playback buffering (seconds) slider to 0.25.
   
   ![Playback buffering slider](image)

3. Start playing back the project.
4. If the playback still gaps, increase the Playback buffering (seconds) slightly.
You may have to experiment to find the correct settings. If you continue to experience gapping, you can try the following to control the gapping within Vegas:

- Decrease the number of events you are trying to play back. This may mean muting tracks or soloing a couple of tracks. RAM is mostly affected by the number of unique events that are playing back simultaneously.
- Use the **Render to New Track** command (on the **Tools** menu) to combine all the events into one event. For more information, see **Rendering to a new track** on page 117.

### Editing tab

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable looping on events by default</td>
<td>Sets events that are trimmed longer than their source media to automatically loop. When this option is not selected, extended events repeat the final frame of a video file.</td>
</tr>
<tr>
<td>Preserve pitch when stretching audio events</td>
<td>Prevents pitch shifting when you stretch an audio event.</td>
</tr>
<tr>
<td>Collapse loop region when no time selection is present</td>
<td>When selected, a loop region does not persist when there is no time selection. This means that when you click the timeline and move the cursor (destroying the any previous time selection), the loop region is also reset to zero. By default, this option is not selected and loop regions persist until modified or until a new time selection is created.</td>
</tr>
<tr>
<td>JKL/shuttle speed</td>
<td>Choose a setting from the drop-down list to set the speed that will be used for scrubbing the timeline with the JKL keys or with a multimedia controller.</td>
</tr>
<tr>
<td>Quick fade length for audio events (ms)</td>
<td>Sets a fast fade on the edges of audio events (10ms by default) to soften potentially harsh beginnings and endings.</td>
</tr>
<tr>
<td>New still image length (seconds)</td>
<td>Sets the default duration of inserted still image files (e.g., BMP, PNG).</td>
</tr>
<tr>
<td>Default time between CD tracks</td>
<td>Sets the default time Vegas creates between CD tracks when using the <strong>Add Media as CD Tracks</strong> command in the Media Pool window. For more information, see <strong>Adding media as CD tracks to a new project</strong> on page 251.</td>
</tr>
<tr>
<td>Cursor preview duration (seconds)</td>
<td>Enter a value in the edit box to specify the length of the time Vegas will preview when you preview the cursor. To preview the cursor, press the 0 key on the numeric keypad. Vegas creates a temporary selection (centered over the cursor) and begins playback automatically. Cursor preview will loop if the Loop Playback mode is enabled.</td>
</tr>
<tr>
<td>Automatically overlap multiple selected media when added</td>
<td>Creates automatic crossfades between events when multiple media files are added to the same track across time. When this check box is not selected, multiple media files are added end-to-end across time with no overlap. For more information, see <strong>Creating a slide show</strong> on page 172.</td>
</tr>
<tr>
<td>Cut to overlap conversion</td>
<td>Sets the behavior of the cut-to-overlap feature. The cut-to-overlap feature allows you to transform a cut from one event to another into a transition. The <strong>Amount</strong> field sets the duration of the extended overlap. The <strong>Alignment</strong> value determines the direction of the extension. For more information, see <strong>Converting a cut to a transition</strong> on page 206.</td>
</tr>
<tr>
<td>Envelope fade types</td>
<td>Sets the default fade curves for event, track, and bus track envelopes. You can choose separate fade types for audio and video envelopes. For more information, see <strong>Changing an event’s fade curve</strong> on page 124.</td>
</tr>
<tr>
<td>Envelope Colors</td>
<td>Choose an envelope type from the Envelope color preference for drop-down list and click the color swatch to display a color picker, where you can choose a new color for the selected envelope type.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all editing preferences to the default settings.</td>
</tr>
</tbody>
</table>
CD Settings tab

The CD Settings tab allows you to set preferences for burning CDs and extracting audio from CDs in Vegas. **CD burning is only available in the full version of Vegas.**

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burn drive</td>
<td>Sets the device where you burn CD-R discs.</td>
</tr>
<tr>
<td>Burn speed</td>
<td>Sets the speed at which the device burns the CD-R disc.</td>
</tr>
<tr>
<td>Extract optimization</td>
<td>Sets the amount of buffering and restitching done to recover audio from older CD drives. Adjust this setting if your extracted CD audio has occasional gaps or glitches.</td>
</tr>
<tr>
<td>Autoname extracted tracks</td>
<td>Automatically names extracted CD tracks based on the ISRC number, the track number, and the number of times the track has been extracted.</td>
</tr>
<tr>
<td>Use strict Red Book specification for DAO validation</td>
<td>Select this check box if you want to be notified prior to burning a disc-at-once CD if anything about your CD project is against strict Red Book standards. These warnings are not critical, and in most cases you will not write an unreadable disc if you proceed. Clearing this check box will not suppress critical warnings that will result in an unreadable disc.</td>
</tr>
<tr>
<td>Include wide SCSI devices when searching for drives</td>
<td>Select this check box if you want Vegas to scan for wide SCSI CD drives when you attempt to extract data from or burn CDs. When the check box is cleared, Vegas will not scan for wide SCSI devices, which can increase compatibility with some USB device drivers that incorrectly identify themselves as wide SCSI.</td>
</tr>
<tr>
<td>Skip drive database; autodetect drive capabilities on startup</td>
<td>When the check box is cleared, Vegas will use an internal configuration file to determine your drive's capabilities. If you encounter problems burning CDs, select this check box, and Vegas will test your drive to determine its capabilities.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all CD preferences to the default settings.</td>
</tr>
</tbody>
</table>

Sync tab

These preferences are used to set up Vegas to generate or trigger from MIDI timecode from external MIDI devices. For more information, see Synchronizing MIDI timecode on page 146.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate MIDI Timecode settings</td>
<td>Sets the output device and frame rate that Vegas uses when generating MIDI timecode.</td>
</tr>
<tr>
<td>Generate MIDI Clock settings</td>
<td>Sets the output device that Vegas uses when generating MIDI Clock information. You can choose the same device that you chose for Generate MIDI Timecode settings.</td>
</tr>
<tr>
<td>Trigger from MIDI Timecode settings</td>
<td>Sets the input software or device and frame rate that Vegas uses when triggering from MIDI timecode.</td>
</tr>
</tbody>
</table>

**Note:** When Sync is active (Vegas is triggering from MTC), media files are not closed (i.e., cannot be edited outside of Vegas) while Vegas is not the active application. You will also not be prompted to rename or delete recorded takes as this may interrupt the synchronization.

Setting advanced Sync preferences

From the Sync tab, you can access advanced settings by clicking Advanced. The Advanced Sync Preferences dialog has three tabs: MTC Input, MTC Output, and MIDI Clock Output. The display of these tabs is dependent on your selections in the Sync tab. See the following sections on each tab for more information.
CHP. 18 CUSTOMIZING VEGAS

MTC Input

This tab displays only if you choose a device in the Trigger from MIDI Timecodes settings drop-down list on the Sync tab.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free-wheel for timecode loss</td>
<td>When selected, Vegas continues to play for a specified period of time without chasing if timecode is lost. Enabling this option can compensate for infrequent losses in timecode monitoring. If losses in timecode are frequent, troubleshooting should be done on your hardware to find the cause of the problem.</td>
</tr>
<tr>
<td>Free-wheel slack time (seconds)</td>
<td>Specifies the amount of time that timecode can be lost before the Free-wheel playback time starts. A longer time is more tolerant of losses in the incoming timecode.</td>
</tr>
<tr>
<td>Free-wheel playback time (seconds)</td>
<td>Specifies the amount of time that Vegas plays back after the Free-wheel slack time has been exceeded.</td>
</tr>
<tr>
<td>Synchronization delay time (seconds)</td>
<td>Specifies the amount of time required for Vegas to synchronize itself to incoming timecode. On slower computers, this time should be set to around two seconds. On faster computers, it may be set lower.</td>
</tr>
<tr>
<td>Offset adjust (quarter frames)</td>
<td>If Vegas is consistently behind or ahead of the MTC generator, enter a value to adjust a synchronization offset with quarter-frame accuracy.</td>
</tr>
<tr>
<td></td>
<td>If Vegas is behind the MTC generator, enter a negative number such as -4. If Vegas is ahead of the MTC generator, enter a positive number such as 4.</td>
</tr>
</tbody>
</table>

MTC Output

This tab displays only if you choose a device in the Generate MIDI Timecode settings drop-down list on the Sync tab.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use internal timer for MTC generation</td>
<td>When selected, the MIDI timecode that Vegas generates is based off of your computer’s internal clock. Otherwise, Vegas generates MTC based on the sound card’s clock.</td>
</tr>
<tr>
<td>Internal timer resolution</td>
<td>Allows you to control MTC resolution.</td>
</tr>
<tr>
<td>Full-frame message generation</td>
<td>Specifies when Vegas sends full-frame timecode messages. Full-frame messages are used by some external audio synchronizers to seek a proper location prior to synchronization. For example, tape-based recorders benefit from seeking to full-frame messages because of the time required to move the transport to the proper location. However, full-frame messages are ignored by some devices and may actually cause unexpected behavior in other devices. Check your hardware documentation to find out if it supports full-frame messages.</td>
</tr>
</tbody>
</table>

MIDI Clock Output

This tab displays only if you choose a device in the Generate MIDI Clock Settings drop-down list on the Sync tab.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Start instead of Continue when beginning playback</td>
<td>When selected, Vegas sends a Start command rather than a Continue command. Normally, Vegas sends a Continue command to allow the chasing device to start at a specific time. However, some older MIDI sequencers do not support the Continue command and must start from the beginning every time.</td>
</tr>
<tr>
<td>Song Position Pointer generation</td>
<td>Specifies when Vegas sends Song Position Pointer messages. Song Position Pointer messages are used by MIDI applications and devices to seek to a proper location prior to starting the synchronization process.</td>
</tr>
</tbody>
</table>
Troubleshooting

Troubleshooting resources

Visit the Sonic Foundry Web site to access product updates, look for answers in the knowledge base, contact customer support, or participate in an online forum:

http://www.sonicfoundry.com

Common questions

Why are some of my DirectX plug-ins not working correctly?

Vegas is a nondestructive time-based editor. As a result, there are certain types of DirectX plug-ins that perform poorly in Vegas. These types of plug-ins are roughly classified as any plug-ins that output a different amount of time than what goes in. This includes all plug-ins such as time compress/expand, gapper/snipper and pitch shift without preserving duration. However, these types of effects plug-ins may perform suitably as bus effects, but only if just one bus is used in the project. Plug-ins that require a lot of pre-buffering (such as Sonic Foundry Acoustic Mirror when using long impulse files) may also perform poorly.

Also, make certain that the plug-ins you use in Vegas are DirectX plug-ins and not DXi plug-ins. DXi plug-ins are not supported in Vegas and do not perform properly.

Why do I hear gaps in my audio playback?

Check to see if any Vegas updates have been posted on the Sonic Foundry Web site:

http://www.sonicfoundry.com/download

Click Updates to access the Updates page. Any updates to Vegas are posted at this location.

If software updates do not address the playback problem, check these other reasons that your audio playback can gap:

- Playing back too many tracks simultaneously can overload your hard drives.
- Not enough physical RAM can cause Windows to use virtual memory, which is slower.
- Your CPU may not be able to process a complex mix of plug-ins.
- Problematic video card settings. For more information, see Trouble-free video: hardware solutions on page 283.

The following are some things you can check and do to make sure your system is optimized to prevent gapping.
RAM usage
You could be gapping because Windows virtual memory is being used. Virtual memory is a method used by Windows to write information to your hard drive to make room in physical RAM. This process uses a lot of your computer's resources. Try the following to optimize RAM usage:

- Exit all background applications not in use.
- Adjust the playback buffering slider on the Audio tab in the Preferences dialog. Adjust this slider as low as possible. However, be aware that setting it too low may cause gaps as well. For more information, see Adjusting the playback buffering slider on page 276.
- Mute/solo some of the events or tracks in the mix.
- Add more RAM to your computer.

Disk usage
You may experience gapping when data is not being read off the hard drive fast enough. Try the following to optimize disk usage:

- Fully defragment your audio hard drives regularly.
- Split audio usage between different physical hard drives, not just different partitions of the same drive.
- Run fewer events simultaneously. It is not how many tracks you have in the project, but how many different events are playing simultaneously that matters.
- Make sure that you trim out any silent sections of events to minimize the wasted disk access.
- Use hard drives with fast seek times and spindle speeds of 7200 RPM or greater. SCSI drives usually have better prolonged data transfer performance than IDE drives. Under Windows XP and 2000, Vegas can take advantage of SCSI asynchronous reads, which can be a big performance advantage.

CPU usage
If you have checked your RAM usage and disk usage and you are still experiencing gapping, you can try to adjust how Vegas utilizes the central processing unit (CPU). Try the following to optimize CPU usage:

- Zoom out (Ctrl + Shift + F) fully on the track view while playing so that the screen does not have to scroll to keep the cursor on it.
- Run fewer DirectX plug-ins.
- Make sure that the peak files are built for all of the audio data in the project before playing. Peaks are only built for those files on screen. If all peak files are not build, you can encounter gapping when the screen scrolls as it plays and Vegas must build peaks on the fly. Press F5 before playback to rebuild peaks for all of the events, on or off of the screen.

Why do mono events increase 6 dB when panning a track hard?
In Vegas, all audio events are treated as stereo. A mono audio event is interpreted as a stereo event with the same data in both channels. If you’re using the add channels panning mode, this duplication doubles the amplitude and results in a 6 dB increase in volume when you pan a track hard left or right. Try using the constant power panning mode instead. Right-click the multipurpose slider and choose Constant Power from the shortcut menu. For more information, see Adjusting stereo panning on page 106.

Why do buffer underruns occur during a test or real write to a CD?
Buffer underruns occur when data transferred to the CD-R is too slow. This may be caused by a variety of factors relating to optimizing your system. Try writing the CD at a slower speed or prerendering the audio. For more information, see Burning a disc (disc-at-once) on page 255.

Why can’t I work with footage captured using an MJPEG card?
Vegas requires that you have the MJPEG codec (for the MJPEG card used to capture the video) installed locally on your workstation. Check to make sure that the appropriate MJPEG codec is installed on your PC.
Trouble-free video: software solutions

There are literally dozens of possible configurations of hardware for editing video on a PC. While it is impossible to go into detail for each and every system, the following explains some of the concepts behind the various settings in Vegas. Editing and playing back full-frame, 30 fps video is one of the most demanding activities for any computer. The hardware you use is an important part of the equation, but there are a number of things you can do to optimize your PC for video. The following list is arranged from the most to the least important.

- Close all other applications. When capturing video or playing it back, it is critical that no other applications interrupt this process. Close any applications that are not vital. This includes screen savers, task schedulers, and even virus-detection software. You can ensure that you have closed all unnecessary applications by pressing **Ctrl** + **Alt** + **Delete**, selecting the individual applications, and clicking the **End Task** button to close them. Certain processes are required and should not (cannot) be terminated (for example, Explorer).
- Check your virtual memory. Windows uses virtual memory when RAM is low. This is a method for Windows to use the hard disk to create more memory and is sometimes called a swap disk. If Windows tries to write to the swap disk during playback or capture, this can interrupt the video software and cause problems. Make sure that Windows is using a different disk drive for virtual memory other than the one from which you are capturing or playing your video. If you have enough space, force Windows to use C:\ for virtual memory and use a physically distinct drive for capturing and playing back video.
- Make sure you have the latest drivers for your video card and capture card and the latest updates and patches to all relevant software. One caveat to this is that you should not try to fix a program that is working correctly. Many times patches and updates fix relatively minor bugs that only affect a small number of users. If you are not experiencing any problems, it is probably best not to upgrade unless the manufacturer recommends it.
- Uncompressed video may be high quality, but it results in very large files with very high data rates. Selecting a more appropriate compression scheme (codec) will definitely improve the situation. If you are creating movies that need maximum quality, however, this may not be an option.

Trouble-free video: hardware solutions

Even with a fast computer, video is still a hardware challenge. On the other hand, it is definitely possible to properly configure a 400 MHz Pentium to work with large video files. There are three parts of your PC that are important and the speed of your CPU is not necessarily the most critical. The following list is arranged from the most to the least important.

**Video subsystem**

Many graphics cards (video boards, primary display cards) on a PC cannot handle full-screen, full-frame rate video. While this leads to jerky, hesitating playback, it may not actually be a serious problem. A common video configuration is to have a separate video capture card and a primary display card. In this case, the playback using the primary display on the computer may be jerky, but when you finally output the video to tape and view it on your television monitor there may not be any problems. If you are not creating movies to go back to the television or VCR and you are experiencing stuttering playback, you should consider using a smaller frame size (320X240) and frame rate (15 fps).
The second most common problem is slow hard disks. Until recently, fast, expensive SCSI AV hard disks were required to properly capture and play back video on a PC. Slow hard disk problems also manifest themselves with jerky video playback, although the stutters are less frequent and of longer duration than if the video subsystem is the problem. Slower hard disks (e.g., 5400 RPM IDE) can cause an occasional dropped frame. DV enthusiasts have fewer problems due to the low data rate (~3.6 MB/sec.) of that format. The following section outlines some recommendations arranged in order of importance.

- **Buy a dedicated video drive.** This is easily the most important piece of hardware advice. A dedicated, physically distinct hard drive is almost a requirement for any type of serious video work. This means that you have one primary C:\ drive (or wherever Windows is installed) and a separate drive for video. You can use your dedicated drive for other purposes, especially storage, but it is a good idea not to run any applications from it and to keep Windows virtual memory off of it. It is very important that the drive only be used for video when playing and capturing, and that other programs (including Windows) are not trying to access it. Since video files are so large, a dedicated drive is not an unreasonable item even if digital video is just a hobby. You can never have too much hard disk space.

- **Buy a faster hard drive.** Older 5400 RPM hard drives may not be fast enough for capturing and playing back video for any length of time, while newer 7200 RPM drives are almost always adequate. Be careful: manufacturers are usually talking about burst transfer rates when they talk about the speed of a drive. A drive that can transfer data at 80MB/sec is worthless for video if it cannot sustain a much slower rate of 8MB/sec for thirty minutes (or more) without dropping a frame. Look to other computer video enthusiasts for additional advice. Again, the RPMs are a very good indicator, because 7200 RPM IDE drives are usually newer (c.1998) and older 7200 RPM drives are usually SCSI, which are already higher quality drives to begin with.

- **IDE vs. SCSI.** While this was a big issue just a few years ago, it has fortunately faded in importance. Hard drives can be hooked up to your computer in a number of ways, with the two largest divisions being IDE and SCSI. This interface simply determines how much data can be transferred to and from the drive in a second. The interface almost always far outstrips the performance of even the best hard disks and even the slower interfaces exceed the transfer requirements of video data. SCSI hard disks are usually more expensive and require a special controller, and while SCSI-2 promises 80MB/sec transfer rates, this is overkill for most people. Newer IDE hard disks with designations of EIDE, DMA, Ultra-DMA, ATA-33, and ATA-66 (and newer drives that came out after this writing) can all handle most sustained video requirements.

### CPU and RAM (memory)

While the CPU and the RAM are probably the most important overall aspects of a PC's speed and performance, these factors are only third on the list for video. For the most part, these critical components do not affect the capture or playback of video. This does not mean that a faster CPU or more RAM will not help, because bigger and faster is always better: CPU and RAM definitely impact rendering speeds. Creating a final AVI file, especially in a movie project that uses a lot of effects and transitions, can take a long time. A thirty-minute movie could easily take six or more hours to render, depending on the format and effects used. CPU speed is also important for more advanced compression codecs, such as MPEG and newer streaming formats.
Audio proxy files (.sfap0)

Working with certain types of media files with particular audio compression schemes can be inefficient and slow. To compensate for this, Vegas creates audio proxy files for formats that are known to dramatically impact performance. There are two cases where this occurs.

Multimedia video files often contain both video and audio information. In certain formats, these two streams can be packed together in such a way as to make editing slow and inefficient. Vegas therefore takes the audio stream from these files (e.g., type-1 DV, QuickTime 4) and saves it to a separate and more manageable audio proxy file.

QuickTime 4 audio-only files can also be compressed in a way that makes editing slower. Vegas also uses audio proxy files in this situation as well. While audio proxy files may be large (because they are uncompressed), the performance increase is significant.

The file is saved as a proprietary .sfap0 file, with the same name as the original media file and has the same characteristics as the original audio stream. So movie.avi yields a movie.avi.sfap0 audio proxy. Additional audio streams in the same file are saved as movie.avi.sfap1, movie.avi.sfap2, etc. This is a one-time process that greatly speeds up editing. The conversion happens automatically and does not result in a loss of quality or synchronization. The original source file remains unchanged (the entire process is nondestructive). Audio proxy files can be safely deleted at any time since Vegas recreates these files as needed.

Note: Vegas saves audio proxy files to the same folder as the source media. If the source media folder is read-only (e.g., CD-ROM), the files are saved to a temporary directory.

Interlacing and field order

Field order in interlaced video is an important parameter that can severely impact the quality of video on a television monitor. While the concept is easy enough to understand, the lack of standards in both technology and terminology clouds the issue.

The path of the electron gun across the screen is fundamentally different between television monitors and computer monitors. Computer monitors scan every line in order, from left to right and top to bottom. This is known as progressive scanning. On a standard television monitor, the electron gun scans every other line from top to bottom, twice for every picture or frame. For example, the first scan from top to bottom might scan all of the odd numbered lines first, then jump back to the top of the screen and, in the second scan, draw all of the remaining even numbered lines, completing the frame. The two fields are said to be interlaced together to form a single frame.

The illustration that follows shows how two frames in a video are actually composed of two fields each, for a total of four fields. These fields can be referred to as field one (F1) and field two (F2). Obviously, it is critical that these two fields are paired together to create a whole frame. What may not be so obvious is that the actual order of these two fields is not particularly important. In other words, F1 could be scanned first and then F2, or F2 could be scanned first and then F1. Both situations would create a perfectly valid, error-free frame of video. While that may sound like good news, in reality this is the source of all of the problems associated with field order. Since both methods are technically correct, both methods have been used. It is important to use the correct order when rendering video files for your particular hardware (capture card).
The next illustration shows the effects of incorrectly interlacing a frame of video. In this case, F2 from frame one is combined with F1 from frame two. Remember that there is nothing inherently right or wrong with a field order of F2/F1; it just happens to be wrong in this case. At a minimum, this can create slightly blurry or hazy video. In most situations, the video is jumpy or jittery and is unwatchable. Interlacing problems can be especially noticeable when two adjacent frames are significantly different; for example, at a cut or in video with fast moving action. It can also manifest itself in certain computer-generated special effects; for example, in slow-motion sequences.

The basic problem is that there is no standard correct field order. Some capture cards use F1/F2 and some use F2/F1. If this were the extent of our troubles, we could check out our hardware manual, look up the correct field order and that would be that. Unfortunately (if this information is even available) the terminology used can be equally baffling. F1 may be called the odd, upper, or A field, or (more rarely) it may be called the even, lower, or B field. Add into the mix the fact that the first scan line might be numbered 0 or 1 (which changes whether the field is considered odd or even), and that cropping may change which line is ultimately scanned first, and you can see that this is not a very clear-cut problem. The remainder of this section deals with how to sort this out in Vegas. Fortunately, you only have to determine the correct settings once for any particular hardware setup.

**Identifying problems**

Vegas refers to the two fields as upper field first and lower field first. These are probably the most common terms used to distinguish the two fields, and you may find a page in your hardware’s manual that says something like “Use a field order of lower first.” In many cases (but not all or even most), Upper=Odd=A and Lower=Even=B.
In Vegas, you can select the field order of a project by choosing Properties from the File menu and clicking the Video tab. The pre-configured templates should work for almost everyone (e.g., if you are editing and outputting DV video in the US, select the NTSC DV template). If you have problems, you can manually select a different field order on the Video tab. You can also override the project settings and set the field order when you render a video file. From the File menu, choose Render As. Then, click the Custom button and choose an option from the field order drop-down list on the Video tab. You can also set field order at the level of the media file or event. Right-click a media file in the Media Pool or an event on the timeline and choose Properties. The field order drop-down list appears on the Media tab.

Interlacing problems only manifest themselves on television monitors. Video that is going to be played back on a computer does not need to be interlaced, and you can select None (progressive scan) for the field order. Rendered video must be displayed on a television monitor to identify any problems. The only way to see interlacing problems is to record (print) a rendered video file out to tape and play back the tape on a television. Problems are most apparent in video that has a lot of motion or that has been modified in some way; for example, a slow-motion effect. (Some codecs force the correct field order during a render, making it difficult or impossible to create video with the wrong field order.)

**Solving interlacing problems in Vegas**

If your hardware’s documentation does not contain any information about the proper field order, you must determine this information for yourself. It is not a difficult process, and involves rendering one video file with an upper first field order and another with a lower first field order. Source material that dramatically and clearly demonstrates the improperly interlaced video is important: use a media file with a lot of motion in it and then slow the event down with a velocity envelope or by time-stretching the event.

**Timecode**

Timecode is a method of labelling frames with a unique and searchable identifier. It is primarily important for synchronizing video (in frames per second) with time in the real world and, in the case of Vegas, with other media in a project.

Changing the timecode used to measure a video file does not alter the contents of the file. For example, no frames are ever dropped or removed when using SMPTE 29.97 drop frame timecode. Instead, specific frame numbers are periodically dropped to compensate for differences between timecode and time in the real world. Confusion between using drop versus non-drop timecode can cause synchronization problems between video and audio. For very short periods of time, the error would be unnoticeable. After about a half an hour, you might notice that mouths and words do not quite match in shots of people speaking. Longer stretches of time show larger discrepancies in synchronization.

Changing the timecode displayed on an event is not equivalent to converting a video to another format. You cannot convert NTSC video at 29.97 fps to PAL video at 25 fps by simply changing the timecode. To convert NTSC video to PAL video in Vegas, you need to re-render the video in the new format. In this situation, the conversion process necessarily results in some frames of video actually being removed from the original sequence.

**SMPTE timecode types**

The following are descriptions of each of the Society of Motion Picture and Television Engineers (SMPTE) timecode types.

**SMPTE 25 EBU (25 fps, Video)**

SMPTE 25 EBU timecode runs at 25 fps, and matches the frame rate used by European Broadcasting Union (EBU) television systems.

Use SMPTE 25 EBU format for PAL DV/D1 projects.
SMPTE Drop Frame (29.97 fps, Video)

SMPTE Drop Frame timecode runs at 29.97 fps, and matches the frame rate used by NTSC television systems (North America, Japan).

Use SMPTE Drop Frame format for NTSC DV/D1 projects.

Both SMPTE Drop and SMPTE Non-Drop run at 29.97 fps. In both formats, the actual frames are not discarded, but they are numbered differently. SMPTE Drop removes certain frame numbers from the counting system to keep the SMPTE clock from drifting from real time. The time is adjusted forward by two frames on every minute boundary except 0, 10, 20, 30, 40, and 50. For example, when SMPTE Drop time increments from 00:00:59.29, the next value is 00:01:00.02.

SMPTE Non-Drop Frame (29.97 fps, Video)

SMPTE Non-Drop Frame timecode runs at a rate of 29.97 fps. This leads to a discrepancy between real time and the SMPTE time, because there is no compensation in the counting system as there is in SMPTE Drop Frame.

Use SMPTE Non-Drop format for NTSC D1 projects that are recorded on master tapes striped with Non-Drop timecode.

SMPTE 30 (30 fps, Audio)

SMPTE 30 is an audio-only format and runs at exactly 30 fps. SMPTE 30 is commonly used when synchronizing audio applications such as multitrack recorders or MIDI sequencers. This format should not be used when working with video.

SMPTE Film Sync (24 fps)

The SMPTE Film Sync time format runs at 24 fps (frames per second). This frame rate matches the standard crystal-sync 16/33 mm film rate of 24 fps.

Timecode in Vegas

Video timecode crops up fairly frequently in Vegas. Being a multimedia production tool, time in Vegas can be measured in real-world time (hours, minutes, seconds), in video timecode (involving frames of video), or in musical time (measures and beats).

Ruler format and timecode

The ruler in Vegas can be set to measure time in any way that is convenient. This setting does not change how the final file is rendered, but controls the grid lines and how snapping behaves. Right-click the ruler and choose a time format from the shortcut list. For more information, see Changing the ruler format on page 263.

Preferences dialog timecode settings

From the Options menu, choose Preferences and click the Video tab to adjust the Show source frame numbers on event thumbnails as drop-down list. These settings take precedence over those found in the source media Properties dialog (see the next topic) and are displayed on events inserted into the timeline. None means that no numbers are displayed on events, Frame Numbers marks frames in the media file starting with 0, Time displays the time in seconds, and Timecode allows the source media's timecode to be detected or selected.
Source media timecode format

Right-click an event, choose Properties, and click the Media tab to view these properties. By default, Use timecode in file is selected.

Note: You can override these settings by choosing different settings on the Video tab of the Preferences dialog. Select Timecode from the Source frame numbering list to allow event-level specification.

Render media file format

The timecode of a final rendered media file is determined by the specified format. The frame rate of the project ultimately determines the timecode and is often constrained by the type of media file being rendered or the codec being used for compression. For example, NTSC DV is typically limited to a frame rate of 29.97 fps and uses SMPTE drop frame timecode.

Time formats in Vegas

Vegas provides a variety of time formats. For more information, see Changing the ruler format on page 263.

Troubleshooting DV hardware issues

Vegas is designed to integrate seamlessly with OHCI compliant IEEE-1394 DV video capture hardware and DV camcorders. While most people never have any problems, the vast number of hardware configuration possibilities makes this a potentially complex issue. Although Sonic Foundry is exclusively a software company, there are a number of resources at Sonic Foundry’s Web site that may be able to assist you.

More detailed information is available at:
http://www.sonicfoundry.com/Support/Productinfo/OHCI.asp

You can also visit the Vegas updates Web page to access a troubleshooting document for OHCI-compliant devices. From the Sonic Foundry home page, go to the Download page and click Updates. Click the Vegas update link to access the update page.
Glossary

A-Law
A companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit PCM signals into a nonlinear 8-bit format. The algorithm is commonly used in United States telecommunications. A-Law is very similar to µ-Law, however, each uses a slightly different coder and decoder.

Adaptive Delta Pulse Code Modulation (ADPCM)
A method of compressing audio data. Although the theory for compression using ADPCM is standard, there are many different algorithms employed. For example, Microsoft’s ADPCM algorithm is not compatible with the International Multimedia Association’s (IMA) approved ADPCM.

Aliasing
A type of distortion that occurs when digitally recording high frequencies with a low sample rate. For example, in a motion picture, when a car’s wheels appear to slowly spin backward while the car is quickly moving forward, you are seeing the effects of aliasing. Similarly, when you try to record a frequency greater than one-half of the sampling rate (the Nyquist Frequency), instead of hearing a high pitch, you may hear alias frequencies in the low end of the spectrum.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the sound has been recorded, aliasing distortion is impossible to remove without also removing other frequencies from the sound. This same anti-aliasing filter must be applied when resampling to a lower sample rate.

Amplitude Modulation (AM)
A process whereby the amplitude (loudness) of a sound is varied over time. When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies are created which can strongly alter the timbre of a sound.

Analog
When discussing audio, this term refers to a method of reproducing a sound wave with voltage fluctuations that are analogous to the pressure fluctuations of the sound wave. This is different from digital recording in that these fluctuations are infinitely varying rather than discrete changes at sample time (see Quantization).

ASIO
ASIO (Audio Stream In/Out) is a low-latency driver model developed by Steinberg Media Technologies AG.

ASIO audio drivers are only supported in the full version of Vegas.

Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, guitar plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a slow attack.
Attenuation
A decrease in the level of an audio signal.

Audio Compression Manager (ACM)
The Audio Compression Manager, from Microsoft, is a standard interface for audio compression and signal processing for Windows. The ACM can be used by Windows programs to compress and decompress WAV files.

AVI
A file format of digital Video for Windows. Vegas allows you to open, edit and create new AVI files.

Bandwidth
Refers to the EQ plug-in that is built in. Each frequency band has a width associated with it that determines the range of frequencies that are affected by the EQ. An EQ band with a wide bandwidth affects a wider range of frequencies than one with a narrow bandwidth.

Bandwidth can also refers to the amount of data that can be transferred via a connection, such as a network or modem. For example, streaming media must be compressed due to the limited bandwidth of most Internet connections.

Beats Per Measure
In music theory, the time signature of a piece of music contains two pieces of information: the number of beats in each measure of music, and which note value gets one beat. Vegas uses this notion to determine the number of ticks to put on the ruler above the track view, and to determine the spacing when the ruler displays in measures and beats format.

Beats Per Minute (BPM)
In music theory, the tempo of a piece of music can be written as a number of beats in one minute. If the tempo is 60 BPM, a single beat occurs once every second. Lower BPM's equal slower tempo, and vice versa.

Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an example, the 8-bit binary number 10011010 represents the unsigned value of 154 in the decimal system. In digital sampling (specifically the PCM format), a binary number is used to store individual sound levels, called samples.

Bit Depth
The number of bits used to represent a single sample. Vegas uses either 8, 16, or 24-bit samples. Higher values increase the quality of the playback and any recordings that you make. While 8-bit samples take up less memory (and hard disk space), they are inherently noisier than 16 or 24-bit samples.

Bus
A virtual pathway where signals from tracks and effects are mixed. A bus's output can be a physical audio device in the computer from which the signal is heard.

Byte
Refers to a set of 8 bits. An 8-bit sample requires one byte of memory to store, while a 16-bit sample takes two bytes of memory to store.
Clipboard

The Clipboard is where data that you have cut or copied in Vegas is stored. You can then paste the data back into Vegas at a different location, or paste it into other applications. Some data, such as audio, cannot be pasted into applications such as Microsoft Word or Notepad, but the text data from the Edit Details window can be pasted. This allows you to then print or format the data. The Video Preview window also lets you capture still frames to the Clipboard for use in any image editing program. For more information, see Understanding the Video Preview window on page 223.

Clipping

Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16-bit data. Clipping causes sound to distort.

Codec

An acronym for COmpressor/DECompressor. A codec is an computer algorithm that is used to compress video and audio data, shrinking file sizes and data rates.

Compositing

Compositing is the term used to describe the way separate video sources are mixed together. Overlay titles are composited onto a background video sequence.

Crossfade

Mixing two pieces of overlapping audio or video by fading one out as the other fades in.

Cutoff frequency

The cutoff frequency of a filter is the frequency at which the filter changes its response. For example, in a low-pass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than the cutoff frequency are not affected.

DC Offset

DC Offset occurs when hardware, such as a sound card, adds DC current to a recorded audio signal. This current causes the audio signal to alternate around a point above or below the normal -infinity dB (center) line in the sound file. To see if you have a DC offset present, you can zoom all the way into a sound file and see if it appears to be floating over the center line.

Decibel (dB)

A unit used to represent a ratio between two numbers using a logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 6 dB from? Engineers use the equation dB = 20 x log (V1/V2) when comparing two instantaneous values. Decibels are commonly used when dealing with sound because the ear perceives loudness in a logarithmic scale.

In Vegas, most measurements are given in decibels. For example, if you want to double the amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be referred to as having a value of -6 dB.

Device Driver

A program that enables Windows to connect different hardware and software. For example, a sound card device driver is used by Windows software to control sound card recording and playback.
Digital Signal Processing (DSP)

A general term describing anything that alters digital data. Signal processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a combination of programming and mathematical techniques. DSP techniques are used to perform many effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your computer's processor and specialized DSP chips can be used to perform any DSP operation. The difference is that DSP chips are optimized specifically for mathematical functions while your computer's microprocessor is not. This results in a difference in processing speed.

DirectX

A set of Application Program Interfaces designed by Microsoft for multimedia development. A DirectX plug-in, such as the Sonic Foundry Noise Reduction DirectX Plug-In, uses the DirectX Media Streaming Services (DMSS) API. Because DMSS is a standard API, a DirectX plug-in can be used in any application that supports DMSS.

Dithering

The practice of adding noise to a signal to mask quantization noise (see also Noise Shaping).

Drag and Drop

A quick way to perform certain operations using the mouse in Vegas. To drag and drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and move the mouse) and drop it (let go of the mouse button) at another position on the screen.

Dynamic Range

The difference between the maximum and minimum signal levels. It can refer to a musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before distortion vs. noise floor). For example, orchestral music has a wide dynamic range, while thrash metal has a very small (always loud) range.

Emphasis

A rudimentary noise reduction process that involves a boost in the high frequencies during the recording of the CD and a complimentary cut in the same frequencies during the playback of the CD. The result reduces high frequency noise without disrupting the natural frequency response of the source material. If the emphasis flag is set for a track, any CD player that has a de-emphasis circuit will impart the high frequency cut on the track. Be aware that Vegas cannot impart the pre-emphasis boost on a track; it can only set the emphasis flag.

Endian (Little and Big)

Little and Big Endian describe the ordering of multi-byte data that is used by a computer's microprocessor. Little Endian specifies that data is stored in a low to high-byte format; this ordering is used by the Intel microprocessors. Big Endian specifies that data is stored in a high to low-byte format; this ordering is used by the Motorola microprocessors.

Envelopes (Audio and Video)

Envelopes, as used by Vegas, are a way of automating the change of a certain parameter over time. In the case of volume, you can create a fade out (which requires a change over time) by adding an envelope and creating an extra point to the line that indicates where the fade starts. Next, you pull the end point of the envelope down to -inf. For more information, see Working with track envelopes on page 109.
Equalization (EQ)
The process by which certain frequency bands are raised or lowered in level. EQ has various uses. The most common use in Vegas is to simply adjust the subjective timbral qualities of a sound.

Event
Media files that have been dragged onto the timeline in Vegas are referred to as events. An event is actually a window into a media file and is a reference, or pointer, to the file. It can display all or part of a media file and can be edited without altering the source media (nondestructive).

Field Order
Video that is displayed on a television is interlaced. This means that every frame of video is actually composed of two fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in alternate lines, but which of the two fields is displayed first (the field order) can be important. You can set the field order for video in the Project Properties dialog or, when rendering a project, in the Custom Template dialog. For more information, see Interlacing and field order on page 285.

File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows for example, the most common audio file format is the Microsoft WAV format. However, Vegas can read and write to many other file formats so you can maintain compatibility with other software and hardware configurations.

Frame Rate (Audio)
Audio uses frame rates only for the purposes of synching to video or other audio.

Frame Rate (Video)
The speed at which individual images in the video are displayed on the screen. A faster frame rate results in smoother motion in the video. However, more times than not, frame rate is associated with SMPTE standard frame rates for video: 29.97 for NTSC (used in US, North and Central America, parts of South America, and Japan), 25 for PAL (used in many parts of the world, including Europe and much of Asia), or 24 for film.

Frequency Spectrum
The frequency spectrum of a signal refers to its range of frequencies. In audio, the frequency range is basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200 Hz) of the spectrum.

Hertz (Hz)
The unit of measurement for frequency or cycles per second (CPS).

Insertion Point
The insertion point (also referred to as the cursor position) is analogous to the cursor in a word processor. It is where pasted data is placed or other data is inserted, depending on the operation. The insertion point appears as a vertical flashing black line and can be moved by clicking the left mouse button anywhere in the timeline.

Inverse telecine
Telecine is the process of converting 24 fps (cinema) source to 30 fps video (television) by adding pulldown fields. Inverse telecine, then, is the process of converting 30 fps (television) video to 24 fps (cinema) by removing pulldown.
Markers
Saved locations in the sound file. Markers can be displayed in the Trimmer window for sound files that contain them, but more often, markers and regions are used at the project level to mark locations or sections in the project.

Media Control Interface (MCI)
A standard way for Windows programs to communicate with multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can easily be controlled by most multimedia Windows software.

Media File
A media file, or multimedia file, is any image, audio or video file on a computer. In Vegas, you can browse for these files in the Explorer window. You can drag media files to the timeline or insert them into the Media Pool. Media files that have been dragged to the timeline are referred to as events.

Media Player
A Microsoft Windows program that can play digital sounds or videos using MCI devices. Media Player is useful for testing your sound card setup. For example, if you can’t hear sound when using Vegas, try using Media Player. If you can’t play sound using Media Player, check the sound card’s manual.

MIDI Clock
A MIDI device specific timing reference. It is not absolute time like MIDI timecode (MTC); instead, it is a tempo-dependent number of ticks per quarter note. MIDI clock is convenient for synchronizing devices that need to do tempo changes mid-song.

MIDI Port
A MIDI Port is the physical MIDI connection on a piece of MIDI gear. This port can be a MIDI in, out or through. Your computer must have a MIDI port to output MIDI timecode to an external device or to receive MIDI timecode from an external device.

MIDI Timecode (MTC)
MTC is an addendum to the MIDI 1.0 Specification and provides a way to specify absolute time for synchronizing MIDI-capable applications. Basically, it is a MIDI representation of SMPTE timecode.

Mix
The process of combining multiple audio events and effects into a final output. The analogous process of combining video events together is called compositing.

Musical Instrument Digital Interface (MIDI)
A standard language of control messages that provides for communication between any MIDI compliant devices. Anything from synthesizers to lights to stage equipment can be controlled via MIDI. Vegas utilizes MIDI for synchronization purposes.

Noise-shaping
Noise-shaping is a technique that can minimize the audibility of quantization noise by shifting its frequency spectrum. For example, in 44,100 Hz audio, quantization noise is shifted towards the Nyquist Frequency of 22,050 Hz. See also Dithering.
Nondestructive Editing
A type of editing used by Vegas that involves a pointer-based system of keeping track of edits. When you delete a section of audio in a nondestructive system, the audio on disk is not actually deleted. Instead, a set of pointers is established to tell the program to play the active sections during playback.

Nonlinear Editing (NLE)
A method of editing video non-sequentially or in random order. Editing video in Vegas is nonlinear as opposed to editing video tape, which is linear.

Normalize
Refers to raising the volume so that the highest level sample in the file reaches a user-defined level. Use this function to make sure you are fully utilizing the dynamic range available to you.

Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one-half of the sample rate and represents the highest frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz produce aliasing distortion in the sample if an anti-aliasing filter is not used while recording.

OPT Plug-In
A plug-in that uses Yamaha’s Open Plug-in Technology (OPT) standard. OPT plug-ins provide tools for working with MIDI such as edit views, effect processors and filters, arpeggiators, and real-time panel automation.

Pan
To place a mono or stereo sound source perceptually between two or more speakers.

Peak File (.sfk)
Vegas displays the waveform of audio files graphically on a computer monitor. This visual information must be generated by Vegas when the audio file is opened and can take a few seconds. Vegas then saves this information as a peak file (.sfk). This file stores the information for displaying waveform information so that opening a file is almost instantaneous. The peak file is stored in the directory in which the file resides and has an .sfk extension. If the peak file is not in the same directory as the file, or is deleted, Vegas regenerates it the next time you open the file.

Pixel Aspect Ratio
Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.9091 (NTSC DV, D1), 1.0926 (PAL DV, D1), or other rectangular variations. Using the wrong pixel aspect ratio can result in distortions or stretching of the video. You can set the pixel aspect ratio in the Project Properties dialog or, when rendering, in the Custom Template dialog. You should choose the aspect ratio based on the final movie’s destination. Consult your hardware manual if you are in doubt about the appropriate ratio. The pixel aspect ratio is unrelated to the frame’s aspect ratio.

Plug-In
An effect that can be added to the product to enhance the feature set. Vegas supports DirectX compatible plug-ins. The built-in EQ, Compression and Dithering effects are also considered plug-ins because they work in other DirectX-compatible applications.

Plug-In Chain
Plug-ins can be strung together into a chain so that the output of one effect feeds into the input of another. This allows for complex effects that couldn’t otherwise be created.
Pre-roll/Post-roll
Pre-roll is the amount of time elapsed before an event occurs. Post-roll is the amount of time after the event. The time selection defines the pre- and post-roll when recording into a selected event.

Preset
A snapshot of the current settings in a plug-in. Presets are created and named so that you can easily get back to a sound or look that you have previously created.

A preset calls up a bulk setting of a function in Vegas. If you like the way you tweaked that EQ, but do not want to have to spend the time getting it back for later use, save it as a preset. Presets appear in the top of plug-in windows in Vegas.

Pulldown
In telecine conversion, fields are added to convert 24 fps film to 30 fps video.

In 2-3 pulldown, for example, the first frame is scanned into two fields, the second frame is scanned into three fields, and so on for the duration of the film. 2-3 pulldown is the standard for NTSC broadcasts of 24p material. Use 2-3 pulldown when printing to tape, but not when you intend to use the rendered video in Vegas. Removing 2-3 pulldown is inefficient because the pulldown fields that are created for frame 3 span two frames:

Use 2-3-2-2 pulldown when you plan to use your rendered video in Vegas as source media. When removing 2-3-2-2 pulldown, Vegas simply discards frame three and merges the pulldown fields in the remaining frames:

Pulse Code Modulation (PCM)
PCM is the most common direct binary representation of a level of an uncompressed audio signal. This method of coding yields the highest fidelity possible when using digital storage.

Punch-In
Punching-in during recording means automatically starting and stopping recording at user-specified times. In Vegas, shorter events can be punched into longer ones.

Quadraphonic
A mixing implementation that allows for four discrete audio channels. These are usually routed to two front speakers and two back speakers to create immersive audio mixes.
Quantization (Audio)
The process by which measurements are rounded to discrete values. Specifically with respect to audio, quantization is a function of the analog-to-digital conversion process. The continuous variation of the voltages of a analog audio signal are quantized to discrete amplitude values represented by digital, binary numbers. The number of bits available to describe these values determines the resolution or accuracy of quantization. For example, if you have 8-bit analog-to-digital converters, the varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 values. Quantization is to level as sampling rate is to time.

Quantization Noise
A result of describing an analog signal in discrete digital terms (see Quantization). This noise is most easily heard in low resolution digital sounds that have low bit depths and is similar to a hiss while the audio is playing. It becomes more apparent when the signal is at low levels, such as when doing a fade out. See also Dithering.

Quantizing (MIDI)
The correction of rhythms to align with selected note lengths or beats in a MIDI sequence.

Quantizing (Video)
Limiting all editing to frame boundaries. For more information, see Quantizing to frames on page 87.

Red Book specification
The Red Book defines the specifications of every audio compact disc in every music store throughout the world. Red Book specifications define not only the information within the disc (digital audio recorded at 44.1 kHz), but also the disc size itself and the way in which the audio is arranged.

Region
A subsection of a sound file denoted by a start and end point. You can define any number of regions in a sound file.

Rendering
The process by which Vegas saves the project to a specific file format like AVI or WMA.

Resample
The act of recalculating samples in a sound file at a different rate than the file was originally recorded. If an audio file is resampled at a lower rate, Vegas decreases sample points. As a result, the file size and the frequency range are reduced. When resampling to a higher sample rate, Vegas interpolates extra sample points in the sound file. This increases the size of the sound file but does not increase the quality. When down-sampling, one must be aware of aliasing (see Aliasing). Vegas automatically resamples all audio to the project's sample rate.

Ripple; Ripple Editing
A type of editing where events are moved out of the way to make room for newly inserted events as opposed to simply being overwritten. When a one minute event is ripple inserted into a project, the duration of a project lengthens by one minute. If ripple editing is turned off, the same operation would not affect the overall duration of the project.
Roll
Originally, a conventional studio typically had two source decks that were used to play back video to a final destination or output deck. These two source decks were commonly referred to as the A and B rolls. In Vegas, a video track can be configured to display an A and a B roll, which appear as sub-tracks. The concept is extended further in Vegas to include a transition roll between the A and B rolls. For more information, see Understanding track layers on page 206.

Ruler
The ruler is the area above the tracks that shows the horizontal axis units.

Sample
The word sample is used in many different (and often confusing) ways when talking about digital sound. Here are some of the different meanings:

- A discrete point in time which a sound signal is divided into when digitizing. For example, an audio CD-ROM contains 44,100 samples per second. Each sample is really only a number that contains the amplitude value of a waveform measured over time.
- A sound that has been recorded in a digital format; used by musicians who make short recordings of musical instruments to be used for composition and performance of music or sound effects. These recordings are called samples. In this manual, we try to use sound file instead of sample whenever referring to a digital recording.
- The act of recording sound digitally (i.e., to sample an instrument) means to digitize and store it.

Sample Rate
The sample rate (also referred to as the sampling rate or sampling frequency) is the number of samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher sample rates. Sampling rate is to time as quantization is to level.

Sample Size
See Bit Depth.

Sample Value
The sample value (also referred to as sample amplitude) is the number stored by a single sample. In 16-bit audio, these values range from -32768 to 32767. In 8-bit audio, they range from -128 to 127. The maximum allowed sample value is often referred to as 100% or 0 dB.

.sfap0
Sonic Foundry audio proxy file. For more information, see Audio proxy files (.sfap0) on page 285.

.sfk
See Peak File.

Shortcut Menu
A context-sensitive menu that appears when you right-click certain areas of the screen. The functions available in the shortcut menu depend on the object being clicked on as well as the state of the program. As with any menu, you can select an item from the shortcut menu to perform an operation. Shortcut menus are used frequently in Vegas for quick access to many commands. An example of a shortcut menu can be found by right-clicking any event along the timeline.
Signal-to-Noise Ratio
The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded signal and noise levels. A high SNR is always the goal.

The maximum signal-to-noise ratio of digital audio is determined by the number of bits per sample. In 16-bit audio, the signal to noise ratio is 96 dB, while in 8-bit audio, the ratio is 48 dB. However, in practice, this SNR is never achieved, especially when using low-end electronics.

Small Computer Systems Interface (SCSI)
A standard interface protocol for connecting devices to your computer. The SCSI bus can accept up to seven devices at a time including CD-ROM drives, hard drives and samplers.

SMPTE
SMPTE is the acronym for the Society of Motion Picture and Television Engineers (SMPTE). SMPTE timecode is used to synchronize time between devices. The timecode is calculated in Hours:Minutes:Seconds:Frames, where Frames are fractions of a second based on the frame rate. Typical frame rates for SMPTE timecode can be 24, 25, 29.97 or 30 frames per second, depending on your local standards.

SMPTE Drop Frame Timecode
A method of measuring time in video. Drop frame involves skipping two frame numbers (no frames are actually dropped) every ten minutes to compensate for the difference between NTSC 29.97 fps video and 30 frame counts per second.

Telecine
The process of creating 30 fps video (television) from 24 fps film (cinema). See inverse telecine and pulldown.

Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in beats per minute (BPM).

Time Format
The format in which Vegas displays the ruler and selection times. These include: time, seconds, frames and all standard SMPTE frame rates.

Time Signature
See Beats Per Measure.

Timecode
For more information, see Timecode on page 287.

Track
A discrete timeline for audio or video data. Events are placed on tracks and determine when sound or images start and stop. Multiple audio tracks are mixed together to give you a composite sound that you hear. Multiple video tracks are composited on top of each other to create the final video output.

Track List
The track list appears at the left side of the Vegas workspace and contains the master controls for each track. From here you can adjust track volume or transparency, add track effects, mute or solo tracks, and reorder tracks.

Track View
The track view, or timeline, is the space events appear on tracks.
µ-Law

µ-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit PCM signals into a nonlinear 8-bit format. The algorithm is commonly used in European and Asian telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and decoder.

Undo Buffer

This is the temporary file created before you do any processing to a project. This undo buffer allows the ability to revert to previous versions of the project if you decide you don’t like changes you’ve made to the project. This undo buffer is erased when the file is closed or when you choose Clear Edit History from the Edit menu.

Undo/Redo

These commands allow you to change a project back to a previous state when you don’t like the changes you have made, or reapply the changes after you have undone them. The ability to undo/redo is only limited by the size of your hard drive. See Undo Buffer.

Undo/Redo History

A list of all of the functions that have been performed to a file that are available to be undone or redone. The undo/redo history gives you the ability to undo or redo multiple functions. To display the history list, click the down-arrow on the Undo ( ) or Redo ( ) button.

Video for Windows (AVI)

See AVI.

Virtual MIDI Router (VMR)

A software-only router for MIDI data between programs. Vegas uses the VMR to receive MIDI timecode and send MIDI clock. No MIDI hardware or cables are required for a VMR, so routing can only be performed between programs running on the same PC.

WAV

A digital audio file format developed by Microsoft and IBM. One minute of uncompressed audio requires 10 MB of storage.

Waveform

A waveform is the visual representation of wave-like phenomena, such as sound or light. For example, when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth waveform.

Waveform Display

A section inside of the Trimmer window or on an audio event that shows a graph of the sound data waveform. The vertical axis corresponds to the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. For 24-bit sounds, the range is -8,388,607 to +8,388,607. The horizontal axis corresponds to time, with the left-most point being the start of the waveform. In memory, the horizontal axis corresponds to the number of samples from the start of the sound file.

Zero-crossing

A zero-crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits at zero-crossings with the same slope, the chance of creating glitches is minimized. Vegas simulates zero crossings by applying short (10 mS default) fades to trimmed audio.
Zipper noise

Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain does not change in small enough increments, zipper noise can become very noticeable. Vegas fades are accomplished using 64-bit arithmetic, thereby creating no zipper noise.
## Index

### Numerics

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Surround Plug-In Pack, 166</td>
</tr>
<tr>
<td>5.1 Surround, See Surround</td>
</tr>
</tbody>
</table>

### A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/B roll, See Tracks, Track layers</td>
<td></td>
</tr>
<tr>
<td>Add channels panning model, 106, 161</td>
<td></td>
</tr>
<tr>
<td>Adding empty tracks</td>
<td>101</td>
</tr>
<tr>
<td>Adding media to a bin, 45</td>
<td></td>
</tr>
<tr>
<td>Alpha channel, 199</td>
<td></td>
</tr>
<tr>
<td>In images, 170, 173</td>
<td></td>
</tr>
<tr>
<td>Selecting type for media file, 170</td>
<td></td>
</tr>
<tr>
<td>Animation, 188</td>
<td></td>
</tr>
<tr>
<td>Arming tracks to record, 52, 147</td>
<td></td>
</tr>
<tr>
<td>ASR, See Envelopes</td>
<td></td>
</tr>
<tr>
<td>Assignable effects, 129, 142–143</td>
<td></td>
</tr>
<tr>
<td>Assigning tracks to, 143</td>
<td></td>
</tr>
<tr>
<td>Routing to busses, 143</td>
<td></td>
</tr>
<tr>
<td>Volume adjustment, 143</td>
<td></td>
</tr>
<tr>
<td>Volume envelope, 109</td>
<td></td>
</tr>
<tr>
<td>Attributes</td>
<td></td>
</tr>
<tr>
<td>Copying from one event to another, 123</td>
<td></td>
</tr>
<tr>
<td>Audio CD tab, 269</td>
<td></td>
</tr>
<tr>
<td>Audio channels, 122</td>
<td></td>
</tr>
<tr>
<td>Audio Device preferences, 275</td>
<td></td>
</tr>
<tr>
<td>Audio editor program, 84–85</td>
<td></td>
</tr>
<tr>
<td>Opening from Trimmer, 97</td>
<td></td>
</tr>
<tr>
<td>Opening from Vegas, 85</td>
<td></td>
</tr>
<tr>
<td>Setting up, 84</td>
<td></td>
</tr>
<tr>
<td>Audio effects, 129–135</td>
<td></td>
</tr>
<tr>
<td>Adding via Plug-in Chooser dialog, 130</td>
<td></td>
</tr>
<tr>
<td>Adding via Plug-Ins window, 131</td>
<td></td>
</tr>
<tr>
<td>Assignable effects, 142–143</td>
<td></td>
</tr>
<tr>
<td>Bypassing plug-ins, 133</td>
<td></td>
</tr>
<tr>
<td>Creating a plug-in chain, 130</td>
<td></td>
</tr>
<tr>
<td>Plug-Ins window, 27</td>
<td></td>
</tr>
<tr>
<td>Rearranging chain order, 132</td>
<td></td>
</tr>
<tr>
<td>Removing plug-ins from chain, 133</td>
<td></td>
</tr>
<tr>
<td>Audio preferences, 275</td>
<td></td>
</tr>
<tr>
<td>Advanced control settings, 276</td>
<td></td>
</tr>
<tr>
<td>Playback buffering slider, 276</td>
<td></td>
</tr>
<tr>
<td>Audio property settings, 268</td>
<td></td>
</tr>
<tr>
<td>Audio proxy files, 285</td>
<td></td>
</tr>
<tr>
<td>Audio tab, 268</td>
<td></td>
</tr>
<tr>
<td>Auto-crossfades, converting to transitions, 204</td>
<td></td>
</tr>
<tr>
<td>Automating</td>
<td></td>
</tr>
<tr>
<td>Mixer controls, 143</td>
<td></td>
</tr>
<tr>
<td>Surround panning, 162–165</td>
<td></td>
</tr>
<tr>
<td>Autosaving, 239</td>
<td></td>
</tr>
<tr>
<td>AVI</td>
<td></td>
</tr>
<tr>
<td>Bit depth, 245</td>
<td></td>
</tr>
<tr>
<td>Channels, 245</td>
<td></td>
</tr>
<tr>
<td>Creating a movie, 56</td>
<td></td>
</tr>
<tr>
<td>Format, 240, 244</td>
<td></td>
</tr>
<tr>
<td>Frame rate, 243</td>
<td></td>
</tr>
<tr>
<td>Frame size, 243</td>
<td></td>
</tr>
<tr>
<td>Sample rate, 245</td>
<td></td>
</tr>
<tr>
<td>Template, 242, 243</td>
<td></td>
</tr>
<tr>
<td>Video compression, 244</td>
<td></td>
</tr>
</tbody>
</table>

### B

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance panning model, 106, 161</td>
<td></td>
</tr>
<tr>
<td>Bins, media, 45</td>
<td></td>
</tr>
<tr>
<td>adding media, 45</td>
<td></td>
</tr>
<tr>
<td>adding recorded files automatically, 45</td>
<td></td>
</tr>
<tr>
<td>creating, 45</td>
<td></td>
</tr>
<tr>
<td>deleting media, 45</td>
<td></td>
</tr>
<tr>
<td>searching, 45</td>
<td></td>
</tr>
<tr>
<td>Blue screening, 200</td>
<td></td>
</tr>
<tr>
<td>Burning 5.1-channel audio to DVD, 166</td>
<td></td>
</tr>
<tr>
<td>Burning audio CDs, 249</td>
<td></td>
</tr>
<tr>
<td>Adding pauses between tracks, 252</td>
<td></td>
</tr>
<tr>
<td>Creating a CD layout, 251</td>
<td></td>
</tr>
<tr>
<td>Disc-at-once burning, 249, 255</td>
<td></td>
</tr>
<tr>
<td>Exporting a track list, 254</td>
<td></td>
</tr>
<tr>
<td>Importing CD Architect files, 250</td>
<td></td>
</tr>
<tr>
<td>Marking tracks and indices, 252</td>
<td></td>
</tr>
<tr>
<td>Settings and preferences, 250</td>
<td></td>
</tr>
<tr>
<td>Track-at-once burning, 249, 254</td>
<td></td>
</tr>
<tr>
<td>Burning video CDs, 256</td>
<td></td>
</tr>
<tr>
<td>Bus tracks, 144</td>
<td></td>
</tr>
<tr>
<td>Busses, 139–142</td>
<td></td>
</tr>
</tbody>
</table>
Adding to project, 139
Adjusting for clipping, 141
Adjusting volume, 140
Assigning plug-ins to, 129
Assigning tracks to, 52, 142
Bus send volume envelopes, 109
Controls, 139
Deleting from project, 140
Meter resolution, 141
Muting, 141
Naming/renaming, 141
Panning, 159
Routing to hardware, 140
Soloing, 141

Bypassing
Audio plug-ins, 133
Video plug-ins, 186

C
Capturing images
  From a scanner, 43
  From the Video Preview window, 171
Capturing Video
  Recapturing offline clips, 42
Capturing video, 42
CD
  Burning audio CDs, 249
  multimedia, 257
CD Architect files, 250
CD layout bar, 21
CD Settings tab, 278
CDs
  video, 256
Channels, audio, 122
Checkerboard, 189
Child tracks (compositing), 190, 194
Chromakeying, 200
  Multiple keys, 201
Chrominance
  monitoring, 230
Clean up prerendered video, 226
Clearing the edit history, 77
Closed captioning, 174–176
  Adding from a script, 174–176
  Adding line-by-line, 174
  Displaying, 176
Color
  Time Display window, 266
  Track, 104
Color channels, 229
Color gradient event, 189
Color key, 200
Color levels
  monitoring, 231
Command markers, 81
  Closed captioning, 174–176
  Command bar, 20
  Editing, 83
  Inserting, 82
  Scott Studios, 82
Composite level envelope, 109
Composite level slider, 51, 106, 193
Composite mode
  Setting default, 109
Compositing, 190–193
  Compositing modes, 51, 191–193
  parent/child tracks, 190, 194
Constant power panning model, 106, 161
Contrast
  monitoring, 231
Converting format, See Rendering
Copying events, 61
  Event attributes, 123
  Time and events, 61
  Time selections, 61
Creating a movie, 56, 239–245
Creating a multimedia CD, 257
Creating bins, 45
Creating DVD with DVD Architect, 166
Credit roll event, 189
Credits, 172
Cropping video, 167–169
  Copying and pasting cropping settings, 123
  Plug-in processing order, 187
Crossfades, 74–76, 203
  Automatic, 74
  Curve types, 75
  Manually setting, 75
  Overlapping files added to timeline, 172
  Sliding, 75
  Video, 203
Cursor indications, 34
Customizing DVD Architect
  toolbar, 269
Customizing Vegas, 263–274
  Frame number display, 263
  Grid spacing, 265
  Preferences, 272–279
  Project properties, 267
  Rendering settings, 242
  Ruler, 263
  Time Display window, 265–266
Toolbar, 19
Video Preview window, 223

Cuts, 203
Converting to transitions, 206
Cutting events, 62–63
Ripple mode, 62
Time and events, 63
Time selections, 62

Deleting
Busses, 140
CD layout bar markers, 253
Command markers, 84
Envelope points, 111
Events, 71
Keyframes, 210
Markers, 79
Regions, 80
Takes, 92
Tracks, 103
Deleting media from a bin, 45
Digital multitrack setup, 146
DirectX plug-ins, 129, 183
Disable resample, 121
Disc-at-once CD burning, 249, 255
Duplicating
Events, 65
Generated media events, 190
Keyframes, 210
Tracks, 101
DV capture cards, 274, 289

DV format, 178
Out-of-range colors, 179
Selecting source media for, 179
Setting project properties for, 179
Templates for, 179
DVD
burning 5.1-channel audio, 166
creating with DVD Architect, 166
DVD Architect, 166
Dynamic RAM video previews, 226

Editing a CD layout, 254
Events category, 99
Markers category, 99
Regions category, 99
Selected events category, 99
Edit history, clearing, 77
Editing audio in external editor, 85
Editing events, 61
Editing tools
Envelope, 126
Selection, 58
Zoom, 49
Effects
fine-tuning with split-screen previews, 227
Effects, See Plug-Ins
Empty events, 65
Envelope Edit Tool, 112, 126
Envelopes, 109–114, 123–127
Adding, 109
Adding points, 111
ASR, 123
Changing fade curves, 112
Deleting from track(s), 112
Deleting points, 111
Event envelopes, 123–127
Fade in and out, 124, 125
Fade types, 124, 125
Hiding on track(s), 112
Mixer controls, 143
Moving points, 111
Opacity, 125
Ripple editing, 73
Track envelopes, 109–114
Velocity, 125
Video, 124
Volume (event), 123
Volume (track), 109

Equipment setup for recording, 145–146
Basic, 145
mixer, 146
With digital multitrack, 146
With MIDI option, 146

Event editing, 61
Event properties
Copying and pasting, 123
Displaying names, 92
Name, changing, 92
Pitch shifting, 89
Event switches, 119–121
Copying and pasting, 123
Invert phase, 120
Lock, 119
Loop, 119

Edge trimming, 66

Edit Details window, 24, 97
Audio CD track list category, 98
Closed captioning, 174–176
Commands category, 98
Customizing, 100
Displaying, 98

D
INDEX

Maintain aspect ratio, 121
Mute, 119
Normalize, 120
Reduce interlace flicker, 121
Resample, 121

Event takes, 91
   Adding files as, 91
   Changing active, 91
   Deleting, 92
   Displaying names of, 92
   Previewing, 92
   Recording audio as new, 149
   Renaming, 92
   Selecting, 91

Events, 47
   adding transitions, 205
   Channels, 122
   Copying, 61
   Copying and pasting attributes, 123
   Crossfading, 74–76, 172, 203
   Cutting, 62
   Defined, 39
   Deleting, 71
   Duplicating, 65
   edge trimming with keyboard, 67
   Editing, 61
   Empty, 65
   Envelopes, 123–127
   Fade in and out, 124
   Grouping, 127–128
   Moving by small increments, 48
   Moving in time, 48
   Moving multiple, 48
   Moving single, 48
   Name, changing, 92
   Pasting, 63, 64
   Pitch shifting, 89
   Placing, 45, 46
   Playback rate, 122
   Recording into, 150
   Selecting multiple, 58
   Selecting with time, 60
   Shifting the contents of, 70
   Shuffling, 74
   Sliding, 71
   Slipping, 70
   Slip-trimming, 70
   Snapping, 87–88
   Splitting, 68–69
   Switches, 119–121
   Trimming, 66
   Undersample rate, 122
   viewing media markers, 97

Expand track keyframes, 51
Expand track layers, 51, 206
Explorer window, 23
   Transport bar, 41

External monitor, 234–235, 274

F
   Fade in and out, 124
   Fade to color, 109
   Fader
      Assignable effects, 106
      Bus send, 106, 142
      Pan, 106
      track, 105
   Fading in/out
      Mixer controls, 143
   Field order, 180, 285
   Filters, See Video effects
   Focus, 57
   Force resample, 121
   Frame
      freeze, 66, 120, 126
      Frame numbers, 263
      Frame-by-frame cursor movement, 57
      Freeze frame, 66, 120, 126

G
   General editing, 57–85
      Event vs. file, 47
   General preferences, 272
   Generator
      Adding, 189
      Duplicating, 190
      window, 27
   Glossary, 291–303
   Glow, 219
   Grid lines
      Safe areas, 228
      Snapping events to, 87
      Spacing, 265
   Grouping events, 127–128
      Adding to groups, 128
      Clearing groups, 128
      Creating new groups, 127
      Moving grouped events, 48
      Removing events from a group, 128
      Selecting events in groups, 128
      Suspending grouping, 128

H
   Hardware
      Routing surround to, 157
      Setting up for surround, 155
   Hiding/showing
Bus tracks, 144
Toolbar, 269
Histogram, 231
Hold keyframe, 211

IEEE-1394 DV capture cards, 15, 42, 179, 234, 245, 246, 274, 289
Ignore event grouping, 128
Image masks, 194
Images
Automatically crossfading, 172
Capturing in Vegas, 171, 224
Correcting for DV pixel aspect ratios, 171
Creating for use in Vegas, 170
Creating masks from, 194
Creating titles from, 173
Default length, 172
Working with, 170
Zooming in on, 213
Importing
Audio CD tracks, 43
CD Architect files, 250
Media, 42
Scanned images, 43
Still image sequences, 44
Inserting
Command markers, 82
Empty events, 65
Markers, 78
Media, 45
Regions, 79
Time, 65
Video files with associated audio, 47
Inserting empty tracks, 101
Installation, 17
System requirements, 15
Interlace, 285
Deinterlacing, 180
Field order, 180, 243, 285
Reduce interlace flicker, 121
Troubleshooting, 287
Inverting
Audio event, 120
Audio track, 108
Invert track phase, 52
Isolate channels, 197
Isolating color channels, 229

Keyframe animation, 188, 209
Event panning and cropping, 213
Generated text, 216
Track motion, 219
Video effects, 215
Keyframe controller, 209
Navigating, 210
Keyframes, 162–165
Adding, 210
Changing relative spacing, 211
Deleting, 210
In track view, 51, 212
Interpolation curves, 211
Modifying, 210
Ripple editing, 73
Keying, 200

Labeling busses, See Naming busses
Labeling tracks, See Naming tracks
Level slider, See Composite level slider
LFE channel, 155, 158
Locking events, 119
  To track envelopes, 114
  To track keyframes, 212
Loop playback, 60
Looping events, 119
Luminance, 199
  monitoring, 231

Main window, 19
Make compositing child, 51, 191, 194, 196
Marker bar, 20
Markers
  CD layout markers, 84
  Command markers, 81
  Deleting, 79
  Inserting, 78
  media, adding, 96
  media, viewing, 97
  Moving, 78
  Navigating, 78

Keyboard commands, 28–33
  Cursor placement, 29, 57, 60
  Edit, 29
INDEX

Renaming, 78
Ripple editing, 73
Snapping, 87

Markers and regions, 77–84
Snapping events to, 87

Masks, 194–201
Fine tuning, 197
Image, 194
Mask generator, 198
Video, 196

Match media settings, 38, 180

Media bin
adding recorded files automatically, 45

Media bins, 45
adding media, 45
creating, 45
deleting media, 45
searching, 45

Media files
Auto preview setting, 41
Inserting, 45
Previewing, 41
Properties, 181

Media generator
Adding, 189
Duplicating, 190
window, 27

Media generators, 189–190

Media markers
adding, 96
viewing in event, 97

Media Pool, 25, 41
Adding media, 42
Adding still image sequences, 44
Capturing video, 42
Extracting CD audio, 43
Getting images, 43
Replacing media in events, 42

Media region
viewing in event, 97

Media regions
adding, 96

Metronome, 148, 275

MIDI clock output, 279

MIDI timecode
Input devices, 279
Output devices, 279
Time Display window, 266
Triggering from, 151

Mixer, 24, 137
Busses, 139–142
Preview fader, 138
Toolbar, 138

Viewing/hiding, 137
Mixer setup (external), 146

Mixer window
Automating controls, 143
Routing surround through, 157

Mixing
Multiple tracks to a new track, 117
Video tracks, 190–193

Monitoring
chrominance, 230
color content, 230
color levels and contrast, 231
luminance, 231
RGB components, 232

Monitoring video with scopes, 229

Mouse scroll-wheel shortcuts, 33, 49, 57

MTC, See MIDI timecode

Multimedia CD
burning, 257

Multimedia controller
scrubbing, 54

Multiple takes
Previewing, 92
Recording, 152
Selecting among, 91

Multipurpose slider, 52, 105
Assignable effects send level, 106, 143
Bus send level, 106, 142
Panning, 106, 282

Muting
All audio or video tracks, 108
Busses, 141
Events, 119
Mute button, 51, 52
Tracks, 108

Naming
Busses, 141
CD layout markers, 253
Markers, 78
Regions, 80
Takes, 92
Tracks, 103

Noise texture, 189

Non-real-time event effects, 135
Normalize audio event, 120

OHCI 1394-IEEE cards, 15, 42, 179, 235, 245, 246, 274, 289

Online help, 17
Via the web, 18
What's This? help, 18
Optimizing previews, 225–233
Ordering of effects, 132, 186
Organizing tracks, 103–104
Overlays
  Animating, 220
  Compositing modes, 191–193
  Flipping, 222
  Masks, 194–201
  Position, 219
  Rotating, 221
  Safe areas, 228
  Shadow, 219
  Transparency, 200
Pan type
  Setting track default, 109
Panning
  Pan types, 161
  Surround, 158
Panning, audio
  Envelope, 109
  Multipurpose slider, 106
  Panning models, 106
Panning, video, 213
  Pan-and-scan effect, 214
  Plug-in processing order, 187
Parent/child tracks, 190, 194
Pasting
  Event attributes, 123
  Paste insert, 64
  Paste repeat, 63
Pasting
  Events, 63
Perfect Clarity (.pca) audio format, 241
Phase inverting
  Events, 120
  tracks, 108
Picture-in-picture effect, 220
Pitch shifting, 89
  Copying and pasting between events, 123
Pixel aspect ratio, 180
  Custom stream properties, 182
  Render settings, 243
  Still images, 171
Placing media
  As takes, 46
  Dragging/dropping, 45
  Multiple files, 46
  Same track, 46
Playback
  Buffer control, 276
  Event playback rate, 122
  Interpolate cursor position control, 276
  Keyboard shortcuts, 28
  Position bias control, 276
  Pre-roll buffer control, 276
  Scrubbing, 54
  Transport bar controls, 21
Plug-in chain
  Audio hierarchy, 35
  Changing order, 132, 133, 186
  Creating, 130, 184
  Saving presets, 132, 188
Plug-ins
  Animating, 188
  Audio, 129
  Bypassing, 133, 186
  Copying and pasting event plug-ins, 123
  Events with panning/cropping, 187
  Generators, 189–190
  Keyframes, 188
  Masks, 194–201
  Media generators, 189–190
  Modifying, 188
  Ordering, 132, 186
  Removing, 133, 187
  Transitioning into, 215
  Transitions, 203
  Video, 183
  Window, 27
Post-edit rippling, 73
Post-roll, 151
PQ list, See Track list
Preference settings, 272–279
  Audio tab, 275
  Audio tab, advanced settings, 276
  CD Settings tab, 278
  Editing tab, 277
  General tab, 272
  Sync tab, 278
  Sync tab, advanced settings, 278
  Video device tab, 274
  Video tab, 274
Preferences
  Audio Device tab, 275
Preparing video for broadcast
  Safe areas, 228
Preparing video for television
  DV format guidelines, 178
Preprocessing video, 225
Pre-roll, 151
Preset chains, 134–135
  Editing, 134
  Organizing, 135
Saving from existing chains, 134
Presets, saving, 132, 188, 208
Preview
  split screen, 227
Preview fader
  Adjusting for clipping, 141
  Adjusting volume, 138
  Hiding/viewing, 138
  Meter resolution, 138
Previewing
  split-screen view, 227
Previews, 53
  Full-quality, 225
  In media players, 55
  Optimizing, 225
  Prerendering, 225
  Resolution, 225
  Transitions, 207
Printing to tape
  from the timeline, 247
Printing video
  From the timeline, 246
  From Video Capture, 245
Project playback
  Entire, 53
  Media player, 55
  Time selection, 53
Project property settings, 267–269
  Audio CD tab, 269
  Audio tab, 268
  Matching video settings of existing file, 38, 180
  Ruler tab, 268
  Summary tab, 269
  Video tab, 267
Projects
  Creating, 37
  Renaming, 39
  Rendering, 239–245
  Saving, 38, 237–239
  Saving as EDLs, 178
Properties
  Events, 122
  Media file, 181
  Project, 37, 267–269
  Track defaults, 109
Proxy files, audio, 285
Punch-in, 65, 151

Q
  Quantizing to frames, 87
  Quick start, 37–56

R
  RAM cache for previews, 226
  RealMedia (.rm)
    commands, 82
    File format, 240
    file format, 56
  Recapturing offline video clips, 42
  Recording, 145–153
    Arming tracks, 147
    Into a time selection, 150
    Into an event, 150
    Into an event with time selection, 151
    Multiple takes, 152
    Previewing takes, 92
    Selecting track input devices, 148
    Specifying storage folder, 152–153
    Starting and stopping, 149
    Stereo, left, right channel options, 148
  Red book CD burning, 249, 255
  Redo/Undo commands, 76–77
    Clearing history, 77
    Multiple, 77
  Region, 79
  Regions
    Adding as takes, 96
    Deleting, 80
    Inserting, 79
    media, adding, 96
    media, viewing, 97
    Moving, 79
    Naming, 80
    Navigating to, 80
    Ripple editing, 73
    Selecting, 80
  Registering Vegas, 17
  Removing
    Events from a group, 128
    Plug-ins, 187
    plug-ins, 133
    Track envelopes, 112
    Velocity envelopes, 127
  Renaming
    Buses, 141
    CD layout markers, 253
    Markers, 78
    Projects, 39, 238
    Tracks, 103
  Rendering, 56, 239–245
    controls and templates, 242
    Custom settings, 242
    File formats, 56, 240
    Surround projects, 165
    To a new track, 117
  Reordering tracks, 103
Resampling, 177–178
   At final render, 177
   Event, 121, 126, 177
Reversing a video event, 126
RGB components, 232
Ripple editing, 63
   Automatically, 73
   Cutting, 62
   Deleting, 71
   Manually, 73
   Pasting, 63
   Post-edit rippling, 73
   Shuffling events, 74
Ruler, 20
   Offset, setting, 264
   Project property settings, 268
   Time formats, 264, 289
Ruler tab, 268

S
Safe areas, 228
Saving a project, 38, 237–239
   Autosaving, 239
   Using Save As, 39, 238
   With media files, 238
Scopes
   histogram, 231
   RGB parade, 232
   vectorscope, 230
   video, 229
   waveform, 231
Scott Studio
   Commands, 77, 82
   File format, 40, 240
Scribble strip, 51, 52, 103
Scrolling, 49
Scrubbing, 54–55
   Keyboard, 55
   Scrub control, 22, 54
   Timeline, 55
   with multimedia controllers, 54
Searching media bins, 45
Selecting
   all members of a group, 128
   Audio CD tracks, 253
   Envelope points, 113
   Events and a time range, 60
   Events to the end of the track, 59
   grouped events, 128
   Media files, 39
   Multiple events, 58
   Range of events, 58
   Regions, 80
   Takes, 91
time range, 59
SFAP files, 285
Shadow, 219
Shuffling events, 74
Signal flow, 35–36
Single session CD burning, 249
Slide show, creating, 172
Sliding
   Crossfades, 75
   Events, 71
Slipping events, 70
Slip-trimming events, 70
Smart resample, 121
SMPTE timecode, 287
   Changing, 264
Snap offset, 88
Snapping events, 87–88
   Quantizing to frames, 87
   Snap offset, 88
   To a selection, 88
   To grid lines, 87
   To marker lines, 87
   To the cursor, 88
Solid color event, 189
Soloing
   Assignable effects chains, 142
   Busses, 141
   Solo button, 51, 52
   Tracks, 108
Sorting media with bins, 45
Split-screen previews, 227
Splitting, 68–69
   All events at cursor, 68
   Selected events, 69
   Time selection, 69
Status bar, 22, 117
Streaming media commands, 82
   RealPlayer, 82
   Windows Media, 82, 174
Stretching events, 90
Summary tab, 269
Surround, 155–166
   Automating panning, 162–165
   Hardware setup, 155
   Keyframes, 162–165
   LFE channel, 155, 158
   Panning, 158
Rendering, 165
Surround Panner window, 160
Switches, 119–121
   Invert phase, 120
   Lock, 119
   Loop, 119
   Maintain aspect ratio, 121
   Mute, 119
   Normalize, 120
   Reduce interlace flicker, 121
   Resample, 121
Sync tab, 278
   Advanced control settings, 278
Synchronizing MIDI timecode, 146, 151
System requirements, 15

T
Takes, 91
   Adding files as, 91
   Deleting, 92
   Displaying names of, 92
   Placing media as, 46
   Previewing, 92
   Recording audio as new, 149
   Renaming, 92
   Selecting, 91
Technical support, 15
Test pattern
   Creating when printing to DV tape, 247
   Event, 189
Text
   Credit roll event, 189
   Keyframing, 216
   Media Generators window, 27
   Text event, 189
   Titles, 172
Time compressing events, 90
Time Display window, 20, 265–266
   Changing color, 266
   Changing time format, 265
   MIDI timecode settings, 266
Time selection, 59
   Copying, 61
   Cutting, 62
   Recording into, 150
   With events, 60
Timecode
   MIDI, 146, 151, 278–279
   Video, 287
Timeline
   Adding media to, 45
   Moving events along, 48
   Playback on external monitor, 234–235
   Print to DV tape from, 246
Titles
   Creating, 172
   Fading, 174
   Safe areas, 228
   Text generator, 189–190
Toolbar, 19
   adding buttons, 270
   customizing, 269
   hiding/showing, 269
   removing buttons, 271
   reordering buttons, 269
Track effects
   Setting default, 109
Track envelopes, 109–114
   Adding, 109
   Adding points, 111
   Changing fade curves, 112
   Colors, 109
   Deleting points, 111
   Envelope Edit Tool, 112
   Hiding on track(s), 112
   Locking to events, 114
   Moving points, 111
   Removing from track(s), 112
   Types, 109
Track FX button, 51, 52
Track list, 21, 51–52
Track list (audio CD)
   Creating from events, 252
   Editing in Edit Details window, 254
   Exporting, 254
Track motion, 217–222
   Button, 51
   Flipping, 222
   Glow, 219
   Keyframes, 219
   Picture-in-picture effect, 220
   Position, 219
   Rotating, 221
   Shadow, 219
   Shortcut menu, 218
   Workspace, 218
Track name, 51, 52
   Changing, 103
Track view, 21
Track-at-once CD burning, 249, 254
Tracks, 49, 101–117
   Adding empty, 101
   Arming for recording, 52
   Assigning plug-ins to, 129, 184
   Assigning to a bus, 52, 142
   Color, changing, 104
   Compositing modes, 51, 191–193
   Default properties, 109
   Deleting, 103
Duplicating, 101
Height, changing, 104
Height, setting default, 109
inserting empty, 101
Making compositing child, 51, 194
Mixing to a single track, 117
Multipurpose slider, 52
Muting, 51, 52, 108
Naming/renaming, 103
Number, 51, 52
Organizing, 103–104
Panning, 158
Phase inverting, 52, 108
Reordering, 103
Resizing, 104
Scribble strip, 51, 52, 103
Soloing, 51, 52, 108
Track effects, 51, 129–135, 183–188
Track FX button, 52
Track keyframes, 51, 212
Track layers, 51, 206
Track motion, 51, 217–222
View buttons, 51, 52
View options, 104
Volume fader, 52, 105

Transition
adding to all selected events, 205

Transitions, 203
Adding, 204
Animating, 209
From auto-crossfades, 204
From cuts, 206
Modifying, 208
Using, 203
Window, 26

Transparency, 125
And overlays, 200

Transport bar, 21, 53, 54
Keyboard shortcuts, 28

Triggering recording from MIDI timecode, 151

Trimmer window, 23, 93–95, 102, 105–106
Audio editor, opening from, 97
Events, placing on track, 94
Opening a file in, 93
Overview, 93
Regions and markers, adding, 96
Three-point editing, 95
Working with, 94

Trimming, 66–67
Adjacent events, 66
Beyond event edges, 66
events with keyboard, 67
selected events, 66
time and event selection, 67
time selection, 67

Troubleshooting
Audio, 281–282

Video, 281–289

Undersample rate, 122
Undo/Redo commands, 76–77
Clearing history, 77

Vectorscope, 230

Vegas
Installing, 17
Overview, 19–34
Registering, 17

Velocity envelope, 125

Version limitations, 16

Video
monitoring with scopes, 229
Video Capture
Capturing video with, 42
Printing to tape with, 245
Recapturing offline clips with, 42

Video CDs
burning, 256

Video effects, 183–188
Animating, 188
Keyframes, 188
Modifying, 188
Ordering, 186
Removing, 187
Window, 26

Video masks, 196

Video motion, See Track motion

Video preview
split-screen, 227

Video previews
Capturing images from, 171, 224
Dynamic RAM previews, 226
External monitor, 234–235
Optimizing, 225–233
Prerendering, 225
Previewing in a player, 233
Resolution, 225
Shortcut menu, 224
Window, 25

Video property settings, 267

Video scopes, 229
histogram, 231
RGB parade, 232
vectorscope, 230
waveform, 231

View buttons, 51, 52
Viewing
   media markers, 97
   media regions, 97

Volume
   Assignable effects fader, 143
   Bus send fader, 142
   Event envelopes, 123
   Setting track default, 109
   Track envelopes, 109
   Track fader, 52, 105

W
   Wave64 (.w64) audio format, 241

Web site
   Accessing help, 18
   Metadata examples, 77
   Technical support, 15
   Troubleshooting resources, 235, 281, 289

What’s This? help, using, 18

Window docking area, 22

Windows
   Surround Panner, 160

Windows Media streaming commands, 82

Z
   Zoom Edit Tool, 49
   Zooming, 49